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1 PRESENTATION

Lumiscaphe’s Patchwork 3D software suite enables organizations to convert
their original CAD data to Digital Aspect Mockups (DAMs) or to static images
and dynamic renderings while maintaining complete in-house control over the
process. Permanent data access is assured through local storage or via a
Product Lifecycle Management (PLM) system.

Patchwork 3D Design is a complete DAM production tool built to meet the
needs of design.

Used to perfect products during design phases, Patchwork 3D Design provides
an array of efficient tools for elaborating the style, colors, and materials of a
product.

The Patchwork 3D Design interface is divided into two modules :

l Shaper provides all of the features required for importing,
optimizing, and preparing 3D models.

l Matter provides the tools used to create a DAM through aspect
dressing and the creation of a scene around a model, including but
not limited to the creation and modification of materials.

1-1 About Lumiscaphe

Lumiscaphe helps to strategically connect the design and engineering worlds
with marketing and sales support by developing and publishing innovative
hybrid solutions employing the Digital Aspect Mockup (DAM) and
photorealistic, real-time 3D rendering.
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Lumiscaphe provides 3D visualization solutions built on solid experience in
real-time rendering technology. Lumiscaphe’s range of specialized products
includes online and offline 3D product configurators, applications and content
created for the web and for mobile devices, as well as tools for publishing and
sharing. For creators, a software development integration kit is also available.

Lumiscaphe’s clients are found in the automotive, aerospace and luxury goods
industries, as well as in the architecture world and in the product design
community.

Founded in Bordeaux in 2001, Lumiscaphe has become an innovative actor on
the worldwide technology market. With offices today in Paris, San Francisco
and Tokyo, Lumiscaphe is proud to provide its solutions to its clients directly or
through a network of certified partners.

1-2 About This Documentation

This documentation describes the interface and features in Patchwork
3D Design. It begins with a presentation of the new features, the hardware
requirements, and a short section on how to get started with Patchwork
3D Design.

This document is organized by topic. It does not need to be read in order, and
you do not need to read it from cover to cover unless you want to. Instead, use
the search function (Ctrl+F), the table of contents, and the index to help you
find what you are looking for. The chapter and first sub-heading are always
listed at the top of the page so that you will know where you are.

1-2.1 Interface Text

Text in the interface and shortcut keystrokes are written differently so that they
will be easy to see. They appear like this in the text.

1-2.2 Links

You will also see hyperlinks in the text. This is an example of a link to the index:
Index. If you are reading on a screen-based support, you can click on these links
to be taken to the related subject. Likewise, the page numbers in the table of
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contents and the index are links to the pages they indicate. You can click on
them to go directly to that page.

1-2.3 Boxes

Red boxes like this one are used to underscore the importance of the
information, to provide a warning, or to indicate new features that will be
unfamiliar.

Gray boxes provide you with additional information. This may be an related
remark, a tip, an example, or an additional explanation. These boxes provide
information you might find interesting, but don't necessarily need to understand
the operation or interface being described.

1-2.4 Step-by-Step Instructions

When step-by-step instructions are given, they are formatted as a numbered
list:

1. This is the first step.
2. This is the second step.
3. This is the final step.

1-2.5 Images of the Interface

Unless otherwise indicated, all images in this text use the default interface
theme,Dark. If you are using a different interface theme, the colors on your
screen will be different. However, the windows, the interface text, and the
symbols on the icons remain the same no matter what theme you choose.
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2 NEW FEATURES IN THIS VERSION

The Patchwork 3D Design documentation now contains an index. If you are
viewing this document on a computer, clicking either on the page numbers in
the index or on the links in the main text will take you to the corresponding
page.

l Addition of the possibility to use the roughness map for standard
and multilayer materials.

l Addition of the possibility to import AXF material.
l Addition of a start screen to assist users to start with Patchwork
3D Design.

l Addition of the possibility to create and dissociate a set of objects in
Shaper.
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3 REQUIRED HARDWARE

3-1 64-bit Architectures

Patchwork 3D Design runs on 64-bit architectures.

Patchwork 3D Design has supported 64-bit architectures since the release of
version 4.0. However, forward compatibility of Patchwork 3D data ensures that
data from various system architectures can be read. You can therefore continue
to work on your Patchwork 3D data created with earlier systems.

3-2 Minimal Configuration

Operating system:Windows 7 x64 or newer.

Processor: Intel Pentium Core i5 Sandy Bridge or higher, AMD Athlon II X4 or
higher.

RAM: 8 GB, 16 GB for raytracing.

NVIDIA® graphics cards:

l Quadro K4000 (3 GB - workstation)
l Quadro K2000 (2 GB - workstation)

l Quadro K3000M (2 GB - laptop)
l Quadro K2100M (2 GB - laptop)

Graphics cards must be used with latest certified NVIDIA® drivers.

3-3 Recommended Configuration

Operating system:Windows 7 x64 or newer.

Processor: Intel Core i7 Haswell or higher, AMD Bulldozer or higher.
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RAM: 16 GB, 24 GB for raytracing with large scenes and processor with at least
8 cores.

NVIDIA® graphics cards:

l Quadro GV100 (32 GB - workstation)
l Quadro GP100 (16 GB - workstation)
l Quadro P4000 (8 GB - workstation)
l Quadro M6000 (12 GB - workstation)
l Quadro K6000 (12 GB - workstation)
l Quadro M5000 (8 GB - workstation)
l Quadro M4000 (8 GB - workstation)
l Quadro K5200 (8 GB - workstation)
l Quadro K5000 (4 GB - workstation)
l Quadro K4200 (4 GB - workstation)
l Quadro K2200 (4 GB - workstation)

l Quadro M5100M (8 GB - laptop)
l Quadro M5000M (8 GB - laptop)
l Quadro M4000M (4 GB - laptop)
l Quadro M2000M (4 GB - laptop)
l Quadro K5100M (8 GB - laptop)
l Quadro K5000M (4 GB - laptop)
l Quadro K4100M (4 GB - laptop)
l Quadro K4000M (4 GB - laptop)
l Quadro K3100M (4 GB - laptop)

Graphics cards must be used with latest certified NVIDIA® drivers.

Visit our website for the latest up-to-date configurations.

http://www.patchwork3d.com/app_config?utm_campaign=v2019.1&utm_source=p3denterprise&utm_medium=app_desktop&utm_content=help_pdf
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4 GETTING STARTED

4-1 Installing Patchwork 3D Design on a Computer
User

This process installs Patchwork 3D Design on a location of your choosing. It
creates a listing in the Startmenu > Programs > Lumiscaphe folder, and
places a shortcut icon on the desktop.

You will need:

l Administrator privileges on the computer where you intend to
install Patchwork 3D Design.

l The software’s .msi installation file.

We strongly advise running the .msi executable file locally, that is, saving it to
the computer you wish to install the software on before running it. You can
place it on the desktop or in any other folder on your computer.

1. Run the .msi executable file for Patchwork 3D Design by double-
clicking on it. Unless you have deactivated alerts, Windows will ask
if you want to execute this file. Click the Execute button.

2. A wizard will guide you through the following steps of the
installation:
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a. Computation of space requirements. The installer will verify
that there is enough space on your hard drive to install the
software. Once this automated step is complete, you will be
asked to click Next in order to proceed.

b. Presentation of the End-User License Agreement. Read the
EULA carefully. You must agree and click the box I accept
the terms in the License Agreement in order to proceed.
At this stage, you may also print the EULA for your
reference. Click Next to continue.

c. Choice of destination folder. By default, the installation
wizard will install Patchwork 3D Design in the following
folder:

C:\Program Files\Lumiscaphe\Patchwork 3D Design
2019.1 X3 release 1\

If you would like to install it elsewhere on your computer,
click the Change… button and select or create a new folder
for the installation. If you know the directory path of the
folder you would like to use, you may also type it in. Click
Next to continue.

d. Validation. Click Install to continue, or, if you would like to
make changes, click Back to return to a previous step. You
may also cancel the installation by clicking the Cancel
button.

e. Installation. A status bar keeps you updated during the
installation process. When the installation has been
completed, click Finish to exit the installation wizard.
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4-1.1 Activating Patchwork 3D Design

4-1.1.1 Running Patchwork 3D Design for the First Time

The first time you run Patchwork 3D Design by selecting it from the Startmenu
> Programs > Lumiscaphe or by double-clicking on the icon on your desktop,
the activation wizard will open automatically. You are required to activate
Patchwork 3D Design before first use.

In order to complete the activation of your software, you will need a license.
The following procedures will walk you through the steps to activate your
software, including the steps to obtain your license key.

Follow the steps below or contact license@lumiscaphe.com for more help.

To purchase a license or to obtain an evaluation copy of Patchwork 3D Design,
please direct your inquiry to sales@lumiscaphe.com.

4-1.1.2 License Activation Wizard

The activation wizard will run when you open Patchwork 3D Design for the first
time. You can also run it yourself at any time from the Help menu > License
Activation > Change License button.

An activation wizard will guide you through the steps to activate Patchwork
3D Design.

First, choose your activation method. Four options are listed: two for nodelock
licenses, and two for floating licenses.

mailto:license@lumiscaphe.com
mailto:sales@lumiscaphe.com
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Choose one of the following options:

l Create an activation request,
l Activate the product with a licence file,
l Activate the product with a server over the network,

4-1.1.2.1 Requesting a Nodelock Activation for Your Computer

Choose this method if you don’t have a license activation key yet, but have
already purchased your license.

1. Select I need to ask for an activation for this computer on the
first screen of the activation wizard. Then, click Next >.

2. Provide the account information requested by the activation wizard
on the next screen. You will be asked for your name, your company,
and your email address. You must provide your company email.
This allows us to identify you. We will send the license key you
request to the company email address you provide in this step.
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3. Click the Save to file… button. Choose where this file should be
saved. We suggest saving it to your desktop. By default, this file will
have a name that looks something like this one: “20150315_Your
Company, Inc._Request_disksn=WD-WMAYUM849339.lar”. Leave
this name as it is.

4. Click Finish to leave the wizard.
5. Email the file you have created to license@lumiscaphe.com.

6. When we receive this file, we will send you your activation key.
Once you have received your activation key, you can run your P3D
software again. This time, choose I already have an activation
file for this computer when the activation wizard opens. (See
paragraph below.)

mailto:license@lumiscaphe.com
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4-1.1.2.2 Using an Existing Nodelock Activation Key for Your Com-
puter

Choose this method if you have already received a license activation key. These
are files ending with extensions .lic or .klic.

Choose the option I already have an activation file for this computer to
use the license activation file you received attached to the email with the
download links. This file must be saved to your computer.

1. Select I already have an activation file for this computer on the
first screen of the activation wizard. Then, click Next >.

2. Click Select license file… This will open a window in which you
can browse to the location of your license activation key file. Select
your license activation key file and click Open.

3. Click Next >.
4. Your activation is complete. Click Finish to launch Patchwork

3D Design.

We recommend moving your .lic or .klic file to the following directory for
safekeeping:

C:\Users\[Your User]\Documents\Lumiscaphe\Patchwork 3D Design
2019.1 X3\

This file will be useful in the future if you need to reactivate Patchwork
3D Design. It can also be used to provide us with information in the case of a
problem with your activation, whether now or later on.
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4-1.1.2.3 Using a Floating Activation from a RLM License Server on
Your Network

Choose this method if you have purchased a floating license and have installed
it on a RLM license server. Your computer must be connected to this server by
a network. Currently, this method should be used for all floating licenses for
Patchwork 3D Design.

1. Select I want to use an activation from a RLM license server on
my network on the first screen of the activation wizard. Then, click
Next >.

2. Enter the name of the RLM license server in the text box provided. If
you don’t know the name of your RLM license server, ask your
system administrator. Click theNext > button.

3. Your activation is complete. Click Finish.
4. On the next screen, all of the licenses available on your server will

be listed.
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Click on the license ID you want to use. If you only have one license ID
available, or if you always want to use the same license ID, you can also tick the
checkbox for the option Always use selected license. If you do not check this
option, you will be asked to select your license ID every time you open
Patchwork 3D Design.

Then, click OK. This will launch Patchwork 3D Design.

4-1.1.2.4 Using a Floating Activation from a Lumlis License Server on
Your Network

This option is not currently available.

4-2 Overview

Over the next pages, you'll be introduced to the structure of the user interface,
the way Patchwork 3D Design organizes data, and the application settings,



4    GETTING STARTED

Lumiscaphe Patchwork 3D Design 2019.1 X3 p.45

including the default keyboard shortcuts. This will help orient you in Patchwork
3D Design.

You will also need to know how to manipulate objects and how to navigate in a
3D viewport.

MANIPULATING OBJECTS AND NAVIGATING IN VIEWPORTS IN ANUTSHELL

Object manipulation in Shaper:

l Translation gizmo: use this to move an object along an axis or
on a plane.

l Rotation gizmo: use this to rotate an object.

Viewport navigation:

l  Middle mouse button: hold and drag to pan.

l Ctrl + middle mouse button: hold and drag to orbit (turn the
view in all directions).

l Shift + Ctrl + middle mouse button: hold and drag to zoom.
l Ctrl + Space: recenter the camera by placing the surface point under
the cursor at the center of the viewport.

Depending on how Patchwork 3D Design fits into your workflow, you might be
starting from scratch with a CAD file, or you might already have a
Patchwork 3D database created by a client or a coworker.

THE PATCHWORK 3D DESIGNWORKFLOW IN ANUTSHELL

In Shaper:

1. Import a CAD file to obtain a model.
2. Optimize the imported CAD data.
3. Add mapping, kinematics, and lighting.

InMatter:

1. Create and assign materials.
2. Develop a rich setting.
3. Add animation.
4. Render high-definition, photorealistic images, videos, and viewer-

readable files.
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4-2.1 Importing Data

Here's a few suggestions on how to start:

l If you have a CAD file, begin by importing it to create your first
Patchwork 3D model.

l If you don't have a CAD file on hand, you can take a trial run by
creating a simplified model using the geometric primitives available
directly in Patchwork 3D Design.

l If you have a Patchwork 3D database, it will likely already contain a
model.

4-2.2 Actions in Shaper

Here are some things to do in the Shapermodule once you've imported your
data:

l Move surfaces in the 3D world to position or orient them differently,
l Duplicate a surface or duplicate a surface with symmetry,
l Move a surface to a different geometry layer,
l Adjust the tessellation of a surface,
l Modify a surface's UV mapping,
l Parent a surface to a kinematic object for animation,
l Add lighting to your model.

Usually you'll have finished with the geometry-related tasks in the Shaper
module before switching to theMattermodule to dress your model, but you
may find yourself switching back and forth for certain tasks.

4-2.3 Actions inMatter

Here are some things you might want to do once you're ready to dress your
model:

l Create a product and open it in a viewport,
l Create a material and apply it to a surface of your product,
l Import a texture and use it as a background, as relief or as a pattern
in a material,

l Use materials to create the shadow of your product,
l Use materials to create reflective or transparent surfaces,
l Add a lighting environment,
l Use a lighting environment as a visual on a skydome,
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l Set up points of view using cameras,
l Add backgrounds, overlays, and 2D post-processing,
l Add configurability to your product:

o Create geometry, position, lighting, environment, and
aspect layers,

o Create configuration rules that impose the conditions
under which each layer should be displayed,

o Save combinations of rule states (and, consequently, layer
combinations) as configuration bookmarks.

l Add a real-time light to your product,
l Animate your product,
l Render with raytracing for true-to-life distortions wherever light is
reflected or refracted,

l Generate high-definition images or videos,
l Export a product for use in viewers and other Lumiscaphe satellite
applications.

4-2.4 Going Further

These are just ideas that skim the surface of the functions of Patchwork
3D Design. As you explore, you'll find additional functions and specific settings
that allow you to obtain the exact results you are aiming for. Most of these
functions and controls are described in the rest of this documentation.

For additional help, you can also contact our support department at
support@lumiscaphe.com or set up a personalized training session through your
account manager at sales@lumiscaphe.com.

4-3 Interface Regions

The interface of Patchwork 3D Design is composed of several main regions
where you can find tools and information.

4-3.1 Modules

Patchwork 3D Design consists of two modules, each with its own interface:
Shaper andMatter. Shaper combines all the tools for working on the 3D

mailto:support@lumiscaphe.com
mailto:sales@lumiscaphe.com
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models.Matter combines all the tools for creating materials, dressing the
models interactively and calculating high-definition images.

Only one of the two modules is active at any given moment. The
Shaper/Matter button visible in the toolbar enables you to switch from the
Shaper interface to theMatter interface and vice-versa.

The toggle button. You are currently working in Shaper. Click here to switch to the
Matter interface.

The toggle button. You are currently working in Matter. Click here to switch to the
Shaper interface.

4-3.2 Menus

Menus allow you to handle the application: set your preferences, manage the
operations stored in memory, open, save, and close databases.

The menus are organized according to the element your actions will affect; in
the corresponding menu, you will find the main actions for each of these
elements.
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4-3.2.1 Shaper Menus

File: provides the options concerning the software or the database, including
access to program settings and to the set-up of the program shortcuts.

Edit: offers access to the undo / redo options and to the selection options.

Mode: gives access to the various interface interaction modes.

Model: collects the options regarding models, including the functions for
creating surfaces that make up a model, as well as imports and exports.

Layer: offers various actions to be performed on layers, for example, showing /
hiding them or freezing / unfreezing them.

Surface: groups together the functions concerning surfaces.

Visualization: offers access to the visualization options, including the head up
display, antialiasing, grid and axis orientation, as well as the visibility/non-
visibility options for the current selection.

Viewport: allows the display windows called "viewports" to be manipulated.

Editors: gives access to the different editors available.

Help: gives access to the help and information files.

4-3.2.2 Matter Menus

File: provides the options concerning the software or the database, including
access to program settings and to the set-up of the program shortcuts.

Edit: offers access to the undo / redo options and to the options to purge
resources currently stored in memory.

Mode: gives access to the various interface interaction modes.

Product: groups together the options concerning products, including their
export.

Camera: contains functions related to cameras and to sensors.

Snapshot: provides access to the snapshot tools.

Visualization: offers access to the visualization options, including the grid and
axis orientation, as well as the stereoscopy options and the full screen mode.

Viewport: allows the display zones, called "viewports," to be manipulated and
reorganized.
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Editors: gives access to the different editors available.

Help: gives access to the help and information files.

4-3.3 Toolbars

In Shaper, the toolbars are located at the top and on the left of the screen.

In Matter, the toolbars are located at the top and on the left of the screen. The editor
toolbar is located at the bottom of the screen.

Toolbars provide quick access to the most common functions. You can move
the toolbars around your screen and anchor them to the top or the left edges of
the main window.
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4-3.4 Workspace

The workspace occupies the majority of the main window. It is composed of
one or more Viewports.

4-3.5 3D Viewport

Viewports in Shaper (left) and Matter (right).

A viewport is a display window within the workspace that is used to show a 3D
representation of the model or product being edited. Only one viewport can be
active at a time.

The representation of the model or product is determined, in each viewport, by
a viewpoint (the position of the observer) and by a look-at point (the point
being observed). Several types of representation exist, depending on the active
interface module. These render types are accessible via a right-click on the
name of the viewport type in order to display the viewport's context menu.
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4-3.6 Sidebar

The sidebar provides constant access to the most common tools and
determines the editing mode. The separator between the sidebar and the
workspace is mobile, which provides a greater flexibility in the organization and
division of the application's surface area.

In the sidebar in Shaper, you will find the model, dressing, pivot, kinematics,
and lighting tools.

InMatter, browse the products,Matter elements (materials, textures,
backgrounds, overlays, post-processing effects, and sensors) and their libraries.

4-3.7 Information Bar

The space at the bottom of the main window is used to display additional
information when you move a mouse over an option or an element of your
model or product.
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4-3.8 Editors

Editors are additional floating windows that give access to an element's
settings. Most editors are accessible from the Editorsmenu or the
corresponding toolbar, or from context menus.

4-3.9 Context Menu

You can right-click on most elements in Patchwork 3D Design, whether that
element is the upper-left corner of the viewports or a part of your model or
product. This action displays a context menu listing options associated with the
element in question.

4-4 Data

4-4.1 P3D Database

In Patchwork 3D Design, the authoring data for a Digital Aspect Mockup is
stored in a single file, a database using the .p3d format. This file contains all of
the raw editing information and the directory information for external
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resources, as well as all of the individual internal resources. Each element used
to create the final rendering is stored in the .pd3 database whether or not it is
used in the Digital Aspect Mockup that has been elaborated. For example, an
image used to create relief in a texture, in turn used in a material, is included in
the .p3d database. The .p3d database files are generally not readable by
viewers.

Only one database may be open at a time.

Operations on the .p3d database are available from the Filemenu :

l New,
l Open,
l Recents : a list of recently opened databases. The number of
databases listed can be set in the application settings.

l Save,

A database in a newer version of Patchwork 3D Design may no
longer be readable by earlier versions of the software. When
you attempt to save an older database with a newer version of
Patchwork 3D Design, the program will automatically ask you to
confirm this action. Confirming the save will change the
database version. To maintain a copy of the original file, use the
Save as option instead.

l Save as,
l Save and Clean,

This feature allows you to save a version of your database free
of unnecessary data such as deleted data which you no longer
need. Its benefit is to decrease the database size. But, on the
other hand the time to save the database is lengthened.

l Reload the last saved state of the database and discard any changes
made since then.

4-4.2 Start Screen

NEWFEATURES IN PATCHWORK3D DESIGN2019.1 X3.
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Start Screen has been made to quickly give you an idea of what Patchwork
3D Design can do for you. Several samples are available to guide you in a
creation of a Digital Aspect Mockup (DAM).

Start Screen consists of two tabs:

l the Recent Files that lists last modified files.
l and the Sample Files.

Start Screen window

Open... button allows you to open an existing DMA, whileNew... button lets
you start a DMA from scratch.

Lumiscaphe videos button links you to the Youtube channel of Lumiscaphe.

Uncheck Show this window at startup if you don't need this window shows
up on the next launch of Patchwork 3D Design. If you want to see it again, just
click File and Show Start Screen.

4-4.3 Model

A model is a full set of 3D geometric and spatial information derived from an
imported CAD file. It is composed of Shaper objects such as surfaces, positions,
and animation objects such as nulls, vectors, and axes. The model also contains
information regarding Shaper object properties, including UV mapping
coordinates, visibility settings, lightmaps, tessellation levels, and relationships
with other Shaper objects.
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A .p3d database may contain several models.

4-4.4 Product

A product is a 3D derivative of a model to which an aspect has been or can be
assigned.

Multiple products may be produced for a single model.

4-4.5 Resources in a .p3d File

The .p3d file contains many resources, including:

l Lighting sets,
l Color palettes,
l Image and video files used as textures,
l Materials,
l Image files used as backgrounds,
l Gradients,
l Lighting environments,
l Camera hierarchies,
l Sensors,
l Overlays,
l Post-processing sets.

All of these resources are fully integrated in the .p3d file. Even if they originally
came from external sources, once the database has been saved, Patchwork
3D Design will never require access to the original file.

When transferring a .p3d database from one computer to another, you will only
need to move the .p3d file. All of the resources are contained in this one file.

Many of these resources can also be exported or imported, making them
transferable between .p3d databases. They can, for example, be stored in a
common library which can be specified in the preferences and accessed via the
explorer in theMatter sidebar.

4-4.6 Digital Aspect Mockup

In order to be used with the Lumiscaphe software suite of 3D visualization
tools, the raw authoring data must be exported as a Digital Aspect Mockup
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(DAM) in the format .kdr. This format contains only the data required by the
rendering engine in order to display the product variants and configurations
created in Patchwork 3D Design. The image underlying the relief in a texture is
no longer present; only the resulting calculations needed to display a material
using that texture are conserved. Consequently, authoring is not supported in
this format. The .kdr is optimized to load more quickly: unlike the .p3d format,
in which the displayed images must be calculated when the file is opened, the
data in the .kdr can be transmitted directly to the graphics card without further
treatment.

The Digital Aspect Mockup may then be used as-is in any of the Lumiscaphe
visualization solutions.

4-5 Undo/RedoMechanism

The undo/redo level specified in the Settings (Editor) (page 59) defines the
number of operations that you can undo or redo at any moment and in a given
context. The greater the number, the more information saved in memory by
Patchwork 3D Design. It is possible to have an unlimited number of memorized
operations. However, each memorized operation may occupy a large amount
of memory. A limit of 20 operations is generally sufficient.

The undo/redo operations are not saved in the p3d database: when you load a
database, you cannot undo any of the operations performed during a previous
editing session.

l Edit >  Undo or Edit >  Redo: Undo or redo one
memorized operation.

l File > Discard P3D Operation History: Discard the memory of all
information used to undo previous operations in the application.
This operation can free up a large amount of memory and
significantly reduce the side of the file during the next save.

l Edit > Discard Module Undo History: Discard only the undo
operations in the current module (Shaper or Matter).
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4-5.1 Shaper

l Edit > Undo All or Edit > Redo All: Undo or redo all memorized
operations at once.

The Shaper viewports also have their own undo/redo history:

l Viewport > Undo in Viewport: Undo the last operation performed
in the active viewport.

l Viewport > Redo in Viewport: Redo the last operation undone in
the active viewport.

4-5.2 Matter

InMatter, products have their own undo/redo history:

l Product > Undo: Undo the last operation performed on the active
product.

l Product > Redo: Redo the last operation undone on the active
product.
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5 SETTINGS

5-1 Settings (Editor)

Available in: Shaper or Matter: File > Settings

The Settings editor covers application-wide settings.

5-1.1 General Tab

Patchwork 3D Design supports English, French, and Japanese. Choose your
preferred language for the interface here.

When the Remember size of windows option is checked, Patchwork
3D Design memorizes the size and position of its window when you close the
application.

On the next startup, the main window of the application resumes the size and
position previously memorized.

The Undo/Redo zone combines all the options concerning the undo/redo
system of the application. If the Limit to box is not checked, then the number
of memorized operations is infinite. When the box is checked, the number of
operations is limited to the value given on the right. You can change this value
by clicking in the editable field or by using the two arrowhead buttons on the
right. A limit of 20 operations is generally sufficient.The changes made to the
undo/redo system will not be taken into account when the application is
restarted. For more information, see the section on the Undo/Redo Mechanism
(page 57).

The Controllers zone offers a selection of additional controllers. Check the box
to the left of the additional controller you wish to select. The name of the
controller is a button that allows access to the window for setting the speed
and sensitivity for various actions. You can choose to add the following
additional controllers:
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l SpaceMouse
l Xbox controller

Use the keyboard to enter numerical values in order to increase/decrease the
speed/sensitivity of the mouse.

In the Tessellation zone, the Stitch tolerance zone allows you to personalize
the stitch tolerance criteria for scene geometry. By default, when the box is not
checked, the setting is calculated automatically depending on the size of
geometry.

With certain objects, this automatic calculation may not produce the desired
stitched result; thus, by checking this box, you can specify a tolerance in the unit
of your choice, which is fixed and not dependent on the size of the objects.

The Image Resolution zone allows you to constrain all the models to be
displayed in the same way.

5-1.2 File Tab

The recentDatabases zone allows you to indicate the maximum number of
files that will be available in the File > Recentmenu. The default value is 9; you
can change it to any value from 0 to 99.

The Opening Behavior zone allows you to specify which objects should be
loaded into memory when a database is opened. If loading a database is very
slow, it is often possible to speed up the initial loading to be able to open your
database more quickly.

The Reset loading warnings button enables the warnings for which you might
have previously checkedDo not tell me again.

TheMatter Explorer zone allows you to specify the directory from which you
will be able to search for the material, texture, background, environment or
overlay files. It functions like a standard file explorer.

The Color Books zone allows you to specify the Adobe directory from which
Patchwork 3D Design will be able to find color books in Adobe Color Book
format (*.acb) that are used in Photoshop. It functions like a standard file
explorer.

The Exporters zone groups together required information for certain exporters:

l The exporter for P3DXml has an option to Export ACIS files in
binary mode, which is enabled by default.
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5-1.3 User Interface (UI) Tab

The UI tab provides controls for elements of the user interface.

In the 3D viewport in Shaper, you can:

l Force Patchwork 3D Design to Switch to isometric in orbit. This
option is disabled by default. When enabled, the 3D viewport
switches automatically to isometric mode when the Orbit navigation
mode (Mode > Orbit or the C keyboard shortcut) is selected.

l Flip image vertically in all of the open viewports. This option,
which is disabled by default, is not compatible with the Head Up
display (Visualization > Head Up).

In the main interface of Shaper, you can:

l Show head up display at startup. This option is enabled by
default.

l Use same viewport configuration for all models, if your database
includes several. This option is disabled by default.

l Use custom interface color. This color is used for the background
of the menu bar and for the background of the information bar at
the bottom of the interface. Click on the color thumbnail in order to
choose a different color.

l Indicate the colors to use for the border around the active 3D
viewport and for the background when the option Show Selected
Only is enabled. Click on the color thumbnail in order to choose a
different color.

l Indicate the colors to use for the border around the active 3D
viewport and for the background when the option Lock Selection is
active. Click on the color thumbnail in order to choose a different
color.

In the main interface ofMatter, you can:

l Automatically update product thumbnail in the right-hand
sidebar. This option is enabled by default.

l User multilayer material as default material. This option is
disabled by default.

l Use stylized material thumbnail.
l Use custom interface color. This color is used for the background
of the menu bar and for the background of the information bar at
the bottom of the interface. Click on the color thumbnail in order to
choose a different color.
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l Set the product tab policy for the 3D viewports. In the Show product
tabs drop-down menu, choose one of the three options:

n Always: tabs will always be shown in viewports, even
when there is only one product loaded in the viewport.

n When needed: tabs will be visible when several products
are assigned to the same 3D viewport. Otherwise, tabs
will not be show in viewports.

n Never: tabs in viewports will never be show. Several
products may still be assigned to the same 3D viewport,
but the interface does not provide a clickable means of
navigating among them.

You also have control over certain properties of the main monitor. You can
correct the values calculated by default for theWidth of the main screen and
its Resolution.

5-1.4 Import Tab

The Import tab provides general options for importers, as well as various
options specific to the importers for Parasolid (IGES), ACIS, and Alias Studio.

In the General Import Options, the Define default units button gives you
access to the window for configuring the units used by default during the
importing of the 3D models.

The default measurement units for formats 3DS, DXF, WAVEFRONT OBJ, and
STL can be defined by using the associated drop-down menu. By choosing the
User-defined entry of the scroll-down menu, you have the possibility of
entering an arbitrary value in the editable field on the right.

Many of these imports are optional add-ons. Some may not be available
depending on your specific software license.

The Ignore files already imported zone allows you to optimize your imports
by not repeating the import of files which have already been imported. For
example if you regularly import all the files from a given directory, you don’t
need to worry about choosing only the new files the next time you import.

Access the options specific to the Parasolid (IGES), ACIS, and Alias Studio
importers by clicking on the name of the format that you wish to set up.
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Here is an example with IGES file option selected, which makes it possible to
manage parameters during the import of an Iges Parasolid model, which differ
depending on the format.

5-1.5 Lighting Tab

The lighting engine powers the lighting in Patchwork 3D Design. Depending on
the configuration of your computer and the settings in this tab, the lighting
engine may require a lot of resources. The default values, however, are
generally sufficient, though you have to option to disable the engine by
unchecking the box Enabled.

By default, the Render configuration is limited to:

Option Default value

Max shadowmap size 2048px

Max lightmap size 1024px

The Preview mode, available in the Lighting tab in the Shaper sidebar, can
also be personalized. You can set the length of time with no interaction before
the incremental refinement begins (Start incremental refinement after) and
enable or disable the following options:

Option Default value

Interactive degradation enabled

Restrict refinement to shadow integrity enabled

Also visible in Surface tab (when the Surface sidebar tab is active) disabled

Activate on first created light enabled

Preview in color disabled

If you use Distributed Lightmap Rendering, you also have the choice to set
the UDP port used to discover units used for rendering.

To manage the memory resources required by the use of a real-time sun,
provide the max size for hard and soft shadow buffers. The values by default
are sufficient in most cases.
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5-1.6 Color Tab

Color Management is responsible for many of the strong points in the render
quality. The color management profile defines the interpretation of the color
values (RVB, CMYK or LAB) by matching them with measurable physical
quantities (expressed in the space CIE XYZ or LAB).

5-1.7 Rendering Tab

This tab is composed of two zone grouping the settings for OpenGL engine and
the raytracing engine.

5-1.7.1 OpenGL Engine Options

TheHardware Antialiasing controls the behavior of the antialiasing system of
the application used to delete image aliasing effects. Depending on the video
card used, it is also possible to disable the hardware antialiasing, or to enable it
with different qualities (2x, 4x, 8x, 16x, 32x, 64x).

The antialiasing is enabled in both interfaces,Matter and Shaper, by default. If
you do not wish to view the effects of the antialiasing, you can increase
rendering speed in Shaper by deactivating antialiasing for Shaper only. To do
so, uncheck the box Available in Shaper.

The Default Depth Policy sets the depth buffer. If the default policy Frustrum
based does not meet your needs, you can choose between the options Look-At
point based and Fixed depth range . This latter option allows you to provide
personalized values for the minimum (ZMin) and maximum (ZMax) depths.

The Display Zone sets the default maximum resolution for viewports. Three
options are available: Main screen,Max dimensions, or Cover all screens.
Respectively, these options apply the resolution for the main screen, the
greatest height and greatest width of the available screens, or allow for the
creation of a viewport spanning all screens. When a viewport is displayed in a
zone larger than its maximum resolution, black bars are added to compensate
for the difference between the maximum resolution and the larger display
resolution.
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5-1.7.2 Raytracing Engine Options

This zone permits the CPU resources to be allocated to the raytracing engine to
be defined. Three options are available: Use all CPU cores, Use all CPU cores
but one, andManual thread count.

The Tile size in pixels can also be set. During the calculation of a rendering via
raytracing, the image is rendered and displayed tile by tile in the viewport. The
smaller the blocks are, the more fluid the display will be, but the rendering time
will also be longer. The height and width of these square tiles corresponds to
the number of pixels provided in this field.

5-1.8 User Preset Tab

Patchwork 3D Design provides the ability to add your own preset values to
certain lists in the interface.

Modifications to preset values are reflected in the list of presets as soon as they
are entered. The preset lists are then saved in the Windows registry when you
click OK and close the Settings editor.

5-1.8.1 Fresnel Value Presets

Used as shortcuts to load Fresnel values when setting up standard or multilayer
materials, these values are listed by name in the preset list found in the
Reflection tab of theMaterials editor. You can access this list by clicking on

the button next to the Fresnel values.

To create a new preset, click on .

To modify an existing preset, click on the corresponding line in the list of
presets. Then, modify theName, Refraction index, and Extinction coefficient

values, or delete the preset by clicking on .

Deleting or modifying a Fresnel preset has no effect on the materials whose
Fresnel values were initialized using a preset.

For additional information on the use of the Fresnel effect, see:
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l Fresnel (page 364)

5-1.8.2 Snapshot Dimension Presets

Used to define the size of a snapshot created with the Snapshot editors, these
presets appear at the end of the list of available snapshot formats in any of the
Snapshot editors.

To create a new preset, click on .

To modify an existing preset, click on the corresponding line in the list of
presets. Then, modify theName,width, height, and units (available for
modification if you have ticked the checkbox Defined with units), or delete the

preset by clicking on the button.

Deleting or modifying a snapshot dimension preset has no effect on snapshots
added to the Snapshot Batcher whose dimensions were initialized using a
preset. If the preset used was deleted or modified, the original values of the
preset will be applied using the format User defined or the format User
defined with units.

For additional information on snapshot dimensions, see:

l Dimensions of the Media Output (page 200)

5-2 ColorManagement

5-2.1 Color Management Profiles

Color management profiles are a major technical tool in Patchwork
3D Design. They are responsible for many improvements in render quality.
These improvements have made it possible for Patchwork 3D Design to make a
considerable leap towards ultimate realism in rendering.

The colorimetric profile defines the interpretation of the color values (RVB,
CMYK or LAB) by matching them with measurable physical quantities
(expressed in the space CIE XYZ or LAB). For the rendering and adjustment of
materials displayed on the screen to be consistent with the colors and the
shades of the real materials, it is essential to work in a defined colorimetric
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space. Patchwork 3D Design provides tools for defining, installing and
managing the colorimetric profiles of the workspace, of imported images and
of images produced by the software.

These adjustments can be accessed from the Color tab in the File > Settings
menu option.

5-3 Measurement Units

Patchwork 3D Design has numerical fields for physical lengths which show the
unit the value is expressed in and allow it to be modified.

These measurement units are contextual parameters, so it is possible to use a
different unit for each of the following categories:

l Geometry (shape of surfaces, placement in the scene, etc.),
l Geometric detail (various tolerances: stitching, etc.),
l Image (image size, screen size, etc.).

The preferred unit for each category is recorded in the database.

5-4 Shortcuts

Patchwork 3D Design includes the mechanism to assign operations to a
keyboard or mouse shortcut. You can keep the default configuration or define
your own shortcuts.

5-4.1 Default Keyboard Shortcuts

Available in: Shaper or Matter: File > Keyboard Map > Show as HTML

The default keyboard shortcuts may be consulted or modified at any time.
Custom shortcuts may also be assigned to additional operations. These
operations are listed in the Keyboard Map Editor.

Application
Edit Keyboard Map  Ctrl+B 
New Database  Ctrl+N 
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Open Database  Ctrl+O 
Print  Ctrl+P 
Save Database  Ctrl+S 
Save Database As  Ctrl+Shift+S 
Show Help  F1 
Show Matter Module  Ctrl+2 
Show Shaper Module  Ctrl+1 

Matter
Activate Full Screen Mode  Y 
Assign Active Material under Cursor  D 
Assign Background under Cursor  F 
Assign Environment to All Surfaces Using Material under Cursor  Shift+G 
Assign Environment to Surface under Cursor  G 
Background Library  3 
Edit Background under Cursor  Shift+R 
Edit Material under Cursor  Shift+E 
Environment Library  4 
Material Library  1 
Modify backface visibility for surface under cursor  N 
Next Active Viewport Tab  S 
Orbit Mode  C 
Overlay Library  5 
Pan Mode  X 
Pick Background under Cursor  R 
Pick Environment under Cursor  T 
Pick Material under Cursor  E 
Previous Active Viewport Tab  Q 
Redo Last  Ctrl+Y 
Redo Last for Active Product  Shift+Y 
Restore Bookmark 1  F9 
Restore Bookmark 2  F10 
Restore Bookmark 3  F11 
Restore Bookmark 4  F12 
Rotate Material Mode  F4 
Select Mode  F2 
Set Active Viewport Mode to Fly  V 
Set Active Viewport Mode to Walk  B 
Set Active Viewport to Isometric  Shift+L 
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Set Active Viewport to Perspective  L 
Set Active Viewport to view from Back  Shift+O 
Set Active Viewport to view from Bottom  Shift+I 
Set Active Viewport to view from Front  O 
Set Active Viewport to view from Left  K 
Set Active Viewport to view fromRight  Shift+K 
Set Active Viewport to view from Top  I 
Set Camera Focus Plane from Pick  Shift+Space 
Set Camera Look-At Point from Picker  Ctrl+Space 
Show All Surfaces  Ctrl+Shift+R 
Show Background Editor  F6 
Show Material Editor  F5 
Show product properties  F8 
Show Post-Processing Library  6 
Show Product Environment Editor  Shift+F8 
Store Bookmark 1  Ctrl+F9 
Store Bookmark 2  Ctrl+F10 
Store Bookmark 3  Ctrl+F11 
Store Bookmark 4  Ctrl+F12 
Surface Depth Write under Cursor  , 
Texture Library  2 
Tile Viewports  Ctrl+Shift+C 
Translate Material Mode  F3 
Undo Last  Ctrl+Z 
Undo Last for Active Product  Shift+Z 
Zoom to View Full Active Product  Z 

Shaper
Active Viewport Maximization  A 
Active Viewport: Enable Backface Cull  -
Carve Selected Surface  Shift+C 
Copy Selected Surfaces  Ctrl+C 
Cut Selected Surfaces  Ctrl+X 
Decrease Triangulation of Selected Surfaces  Ctrl+-
Delete Selected Surfaces  Del 
Dressing Component Interaction  F12 
Edit parameterization of surface unfolding  Shift+U 
Edit Properties of Selected Surfaces  P 
Freeze Selected Surfaces  F 
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Freeze Unselected Surfaces  Shift+F 
Hide Frozen Surfaces  D 
Hide Selected Surfaces  R 
Hide Unselected Surfaces  Shift+R 
Increase Triangulation of Selected Surfaces  Ctrl++ 
Invert Selection  Ctrl+Shift+A 
Lock Active Layer  Ctrl+Shift+T 
Lock Selection  Space 
Move Selected Surfaces  Shift+T 
New active layer  T 
Paste surfaces to active layer  Ctrl+V 
Pick Camera Look-At Point  Ctrl+Space 
Redo Last  Ctrl+Y 
Redo Last in Active Viewport  Shift+Y 
Render active viewport in bounding box mode  Shift+B 
Render active viewport in smooth and highlights mode  Shift+H 
Render active viewport in smooth mode  Shift+S 
Render active viewport in wireframe mode  Shift+W 
Restrict interaction to the X axis  F7 
Restrict interaction to the XY plane  Shift+F7 
Restrict interaction to the Y axis  F8 
Restrict interaction to the YZ plane  Shift+F8 
Restrict interaction to the Z axis  F9 
Restrict interaction to the ZX plane  Shift+F9 
Rotation Gizmo  F6 
Select All  Ctrl+A 
Select All Elements Enclosed by Region Mode  F4 
Select All Elements Touched by Region Mode  F3 
Select Mode  F2 
Select None  Shift+A 
Set Active Viewport to Back View  Shift+O 
Set Active Viewport to BottomView  Shift+I 
Set Active Viewport to Front View  O 
Set Active Viewport to Isometric  Shift+L 
Set Active Viewport to Left View  K 
Set Active Viewport to Perspective  L 
Set Active Viewport to Right View  Shift+K 
Set Active Viewport to Top View  I 
Set Interaction Mode to Orbit.  C 
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Set Interaction Mode to Pan.  X 
Set Interaction Mode to ZoomRegion.  V 
Set Interaction Mode to Zoom.  Z 
Show Active Layer  Ctrl+T 
Show All Surfaces  Ctrl+Shift+R 
Show Edged Faces  ( 
Show Selected Only  S 
Split Selected Surfaces  Shift+G 
Stitch Selected Surfaces  G 
Surface Component Interaction  F11 
Tag Manager  Ctrl+M 
Track Culling in Red in Active Viewport  ] 
Translation Gizmo  F5 
Undo Last  Ctrl+Z 
Undo Last in Active Viewport  Shift+Z 
Unfreeze All Surfaces  Ctrl+Shift+F 
ZoomActive Viewport to View Full Selected Surfaces  E 
ZoomActive Viewport to View Full World  Q 
ZoomAll to View Full Selected Surfaces  Shift+E 
ZoomAll to View Full World  Shift+Q 

Surface Cutting Workshop
Pick Camera Look-At Point  Ctrl+Space 

Timelines
no pre-defined shortcuts for this group

Unfolding Workshop
3D Selection Only  Space 
Pick Camera Look-At Point  Ctrl+Space 
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6 SHAPER

6-1 Shaper Graphical Interface

The Shaper interface is constructed around a system of interactive 3D views. By
default, four views are displayed: the top, front and left views, configured in
wireframe display, and a perspective view, configured as a solid display.

One of the four 3D views is active: it is surrounded by a zone displayed with
highlighting (in the above image, the perspective view is active). In Shaper, the
view-configuration options are applied by default to the active view.

Each view represents the 3D model that is being edited. Displaying a grid and
the 3D view cube of the model helps you understand the orientation of these
views. Each view displays the projection mode used in its upper left corner:
front view, top view, back view and perspective view.

Shaper provides you with several tools for modifying the point of observation
and the viewing method used to represent the model in a 3D view: orbital
movement about the model, viewing in wireframe mode or in solid mode,
isometric or perspective projection, etc.
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As in most of the applications, a menu and a toolbar located above the 3D
views allow access to most of the functions of the application. On the right, a
system of tabs gives access to the editing modes of Shaper: Surface,Mapping,
Pivots, Kinematics and Illumination.

A vertical panel just below presents the tools available in each editing mode
selected with the tabs. The above image shows the Surface editing mode of
Shaper with the model, layer and surface selectors.

6-2 Shaper Viewports

A 3D viewport is a rectangular window used to draw a 3D representation of
the model that is being edited.

The representation of the model is determined for each viewport by a
viewpoint (the position of the observer) and by a center of interest (the point
being observed). Several types of representation exist: a wireframe 3D
rendering gives a schematic vision of the model, whereas a surface 3D
rendering gives a more real and more intuitive impression of the surfaces and
volumes.

Shaper offers you four independent 3D viewports. The parameters of each
viewport can be modified to facilitate the observation and editing of the model.
One of the four viewports has a highlighted frame: this is the active viewport.
The viewport configuration operations are applied by default to the active
viewport. To activate a viewport, click on it with the left button of the mouse. By
activating the Viewport >Maximize Viewportmenu item, the active viewport
is enlarged to fill the whole workspace. You can return to the four-view mode
by deactivating the Viewport >Maximize Viewportmenu item. This can also
be done by pressing the A key.

6-2.1 Configuring 3D Viewports

Shaper offers nine types of view:

View Description

Perspective view

This type of view is similar to the objective lens of a photographic
camera: the perspective deforms the surfaces as a function of the
distance. An object viewed far away is represented smaller than
an object that is close to the viewpoint.

Isometric view Isometric views are used in industrial drafting: there is no
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View Description

perspective and the dimensions are not modified by the distance
to the viewpoint.

Top view
This is an isometric view alined on the axes of the model, showing
the model viewed from the top. The camera is placed on the Y+
axis.

Bottom view
This is an isometric view alined on the axes of the model, showing
the model viewed from the bottom. The camera is placed on the
Y- axis.

Left view
This is an isometric view alined on the axes of the model, showing
the model viewed from the left. The camera is placed on the X-
axis.

Right view This is an isometric view alined on the axes of the model. The
camera is placed on the X+ axis.

Front view This is an isometric view alined on the axes of the model. The
camera is placed on the Z+ axis.

Back view This is an isometric view alined on the axes of the model. The
camera is placed on the Z- axis.

UVW Mapping view This view shows the mapping coordinates of the model.

6-2.2 Interacting with the 3D Viewports

Shaper offers several operating modes for navigating in the 3D views. These
modes are accessible from theModemenu.

Icon Mode Behavior Mouse Shortcut

Pan
Clicking and dragging in a 3D view allows you to slide
the viewpoint in the plane of observation. The center
of interest moves with along with the viewpoint.

Middle mouse
button + drag the
mouse

Orbit

Clicking and dragging in a 3D view allows you to
rotate the viewpoint about the center of interest.
The position of the center of interest remains
unchanged.

Ctrl+Middle
mouse button +
drag the mouse

Zoom

Clicking and dragging in a 3D view brings the
viewpoint closer to the center of interest, which has
the effect of magnifying the objects located in the
field of vision.

Shift+Ctrl+Middle
mouse button +
drag the mouse

Zoom
region

Clicking and dragging in a 3D view draws a
rectangular region. When the mouse button is
released, the view is centered on this region. The
direction of observation is unchanged, but the
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Icon Mode Behavior Mouse Shortcut

viewpoint and the center of interest are moved in
relation to the new centered view.

Fly
mode

Can be used with a perspective view only.

Once this mode is enabled, navigation is in fly mode,
and by simplymoving the mouse (without clicking),
you can make the viewpoint rotate about the center
of interest. A (continuous) left-button click or a
(continuous) right-button click allows you to move
forwards or backwards, which has the effect of
magnifying the objects located in the field of vision.
Click and dragging allows you to fly around the
object.

Walk
mode

Can be used with a perspective view only.

When you enable this button, you go into walk
mode, and moving the mouse allows you to rotate
the viewpoint about the center of interest. Clicking
and dragging gives you the illusion of walking
(forwards or backwards) next to the object. Unlike
Fly mode, inWalk mode, the altitude of the point of
view remains constant.

TheModel > Zoom to Fitmenu offers several tools that facilitate centering of
the views:

Zoom type Description

Zoom selection to fit in active viewport This modifies the center of the active view to
view the selection in its entirety.

Zoom world to fit in active viewport
This modifies the center of the active
view to view the model that is being
edited, in its entirety.

Zoom selection to fit in all to viewports This modifies the center of each view to view
the selection in its entirety.

Zoom world to fit in all viewports This modifies the center of each view to view
the model in its entirety.

6-2.3 Configuring the Rendering in a 3D Viewport

The 3D rendering of the active view can be configured to modify the
representation of the model that is being edited.

The Viewport > Rendermenu gives access to seven rendering modes:
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Icon Render Mode Description

Wireframe
The surfaces are represented schematically with
plotting following the lattice structure of each
surface. The surfaces are not mutually masked.

Smooth The surfaces are shown smoothed out with solid
faces, lit by soft lighting.

Smooth and Highlights
The surfaces are shown smoothed out, as solid faces
with a specular reflection.

This is the default render mode.

Facets
The surfaces are represented by their lattice
structure, not smoothed out, as solid faces lit by soft
lighting.

Facets and Highlights
The surfaces are represented as a solid lattice
structure, not smoothed out, as solid faces with a
specular reflection.

Lit Wireframe The surfaces are represented by an illuminated
wireframe plot of their lattice structure.

Bounding Box

Each surface is represented by the wireframe
plot of its bounding box. This rendering mode
facilitates the handling of surfaces that have
lattice structures comprising a large number of
triangles.

Wireframe view. Smooth view.

Facets view. Bounding Box view.

Several options available from the Viewportmenu modify the appearance of
the rendering:

Option Description

Edged Faces The lattice structure of the surfaces is represented as a
wireframe 3D rendering overlaid on the surfaces.

Track Culling

The hidden faces (oriented away from the observer) are
shown in bright red. This mode facilitates the
identification of the surfaces that are not properly
oriented.

Ignore Backface Cull Enabled by default, this option enables the optimization of the
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Option Description

rendering, which removes the faces oriented away from the
observer.

Other viewing aides are available from the Visualization menu:

Viewing Aide Description

Head up display Shows the number of surfaces, triangles, and points selected in
the view.

Grid Displays a reference grid that facilitates understanding of the
3D viewport. The grid is enabled by default.

Axis orientation
Displays the indicator of the different axes for the model in the
bottom left corner of the window. This option is enabled by
default.

Antialiasing

The anti-aliasing improves the visual quality of the 3D rendering
by deleting the aliasing effects caused by screen pixels. You
have the possibility of modifying the anti-aliasing configuration
in the Patchwork 3D Design rendering settings.

Demonstration of the smoothing produced by the antialiasing algorithm.

6-2.4 Accessing the Viewport Context Menus

Each view contains a menu, accessible by right-click in the display on the name
of the view type (i.e. perspective, bottom, left) in the top left corner of each
view. You can also access a second menu with a right-click at the center of each
view, that combines the most commonly used functions of the application.

6-2.5 Selection VisibilityModes

Two options modify the behavior of Shaper for displaying a model that is
being edited without affecting the attributes of the surfaces:
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Icon Option Description

Editmenu > Show
Selected Only

When this option is enabled, only the selected surfaces are
visible. The selected surfaces are represented as unselected
surfaces to facilitate viewing.

The selection is locked to prevent errors: you can no longer
modify the selection with the mouse. This mode is
particularly helpful when it is necessary to isolate a subset of
surfaces in a complex model: enable this option to
momentarily isolate the selected surfaces and check the
consistency of your selection. You can use the keyboard
shortcut associated with this menu entry to quickly enable
and disable this option (S key by default).

Editmenu
> Shade Selected

When this option is enabled, the selected surfaces are
represented with smooth rendering in the views where you
are using wireframe shading.

6-3 Manipulating Shaper Objects

6-3.1 Selection

A selection is a group of surfaces designated by a user in the model being
edited.

Selected surfaces are represented in a 3D viewport with green highlighting.
One of the surfaces is designated as the leader. It is represented with white
highlighting. The leader surface is used for various operations that require the
identification of a single surface within the selection.

There are three manners of modifying surface selections:

l By selecting surfaces with the mouse directly from the graphic
representation in the 3D viewport. This uses the Selection mode.

l By enabling one of the operations affecting the selection from the
menu or the toolbar.

l By using the surface selector that can be found in the layer selector
in the Surfaces sidebar tab in Shaper.

Once you have defined a selection, you can use Freeze Selection,
available from the context menu that appears when you right-click in the
viewport. The current selection will be locked. To keep you from modifying it
and to make it easier to manipulate this selection, the tools for selecting and
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deselecting objects are deactivated until you unfreeze the current selection by
selecting Freeze Selection again.

6-3.1.1 Modifying the Selection Using MenuOperations

Operations for modifying the selection are available in the Selection menu:

Icon Function Description

Select All Select all the surfaces of the model.

Invert
Selection

Invert the selection: select all unselected surfaces and deselect the
surfaces that were previously selected.

Select
None Deselect all surfaces.

6-3.1.2 Surface Selector

The surface selector is placed under the layer selector in the Surfaces panel of
the Shaper sidebar. It shows the list of surfaces associated with the current
active layer. Each surface is represented by its name and three boxes
characterizing its state: visible, frozen, or selected.

The color of the first box corresponds to the color of a surface in the 3D
viewport.

The second box corresponds to the visibility of the surface. An eye
represents the visibility of the surface. When the eye is barred and grayed out

, the surface is not visible.

The third box indicates whether the surface is frozen or not. This condition is
represented by a lock . When the lock is closed and red , the surface's
selection state is locked. It cannot be selected or deselected.

The fourth box corresponds to the surface selection. When the checkmark is
highlighted in white, the surface is selected. A green checkmark indicates that
the tessellation for the selected NURBS surface can be modified.

At any moment, you can modify the state of a surface by clicking on the boxes.

A few operations are directly accessible from the surface selector via the icons
and the options menu. To open the options menu, place the mouse pointer on
the designated surface and right-click on it.
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When an operation is called up directly from the surface selector, it applies to
all the surfaces that are highlighted in the surface selector.

You can mark or unmark a surface with a Ctrl-click on its name in the surface
selector. You can extend the marking to other surfaces by Shift-click on their
names. You can cancel the marking by clicking in the selector outside the
surfaces.

Certain operations are available from the selector's context menu.

At the bottom of the surfaces selector, tools allows you to duplicate the marked
surfaces, to send the marked surfaces to the active layer, to call up the
properties box for the marked surfaces, or delete the marked surfaces.

You can move the marked surfaces to another layer with a drag and drop of the
marked surfaces to the destination layer.

By clicking on one of the column headers of the surface selector, you can
modify the sorting used for displaying the surfaces: sorting by name or sorting
by box.

6-3.1.3 SelectionMode

The Selection operating mode (F2) allows you to interact directly with the
3D surfaces to modify the selection.

Action Shortcut

Select a single surface Click on the surface.

Add a surface to the selection Shift + click on the surface.

Remove a surface from the selection Ctrl + click on the surface.

Cancel a selection Click anywhere in the background of a viewport.

By holding the mouse button down and moving the mouse cursor, you plot a
rectangular region. When you release the mouse button, all the surfaces that
are visible in this region are included in the selection operation.

Action Shortcut

Select all surfaces in a region Click and drag the mouse pointer in the
viewport.
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Action Shortcut

Add all surfaces in a region to the
selection

Shift + click and drag the mouse pointer in the
viewport.

Remove all surfaces in a region from the
selection

Ctrl + click and drag the mouse pointer in the
viewport.

Cancel a selection Click anywhere in the background of a
viewport.

There are two methods of determining which surfaces are included when using
regions to select groups of surfaces:

Icon Function Description

Edit menu > Touched
by Region (F3)

By default, the selection system is configured to
designate all the surfaces contained or partially
contained in the designated region during the click and
drag.

Edit menu > Enclosed
by Region (F4)

Only the surfaces that are fully contained in the region
are designated during the click and drag. This operating
mode is particularly advantageous when you wish to
designate the surfaces of a more complex assembly.

Clicking any area of the background in a 3D viewport will cancel the selection.

6-3.2 Manipulating Surfaces

6-3.2.1 Translation and Rotation Gizmos

Patchwork 3D Design includes gizmos that make it easier to manipulate 3D
objects in space. They appear automatically as an overlay on the selected

element when the Translation or Rotation gizmo is enabled.
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To move an element along an axis, click the part of the gizmo that represents
the movement axis and drag the mouse in the desired direction. To rotate an
element, the movement axis is either up-down or left-right. The farther you
drag the mouse along this axis, the greater the angle of rotation will be.

When you hold down the Alt key, the selected element moves at a preset pitch.
The value of this pitch can be customized (see the section on setting step values in
the chapter Positioning Surfaces from the Main Interface (page 86).

A numerical indicator placed close to the gizmo shows the value applied to
transformation in real time.

6-3.2.1.1 Translation

The translation gizmo allows a surface to be moved via a click and drag
effected on the selection.

The reference point used for moving the selection is always the leader surface's
pivot.

A surface is moved in relation to its transformation referential. The center of the
referential is placed over the surface's pivot.
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Translation Gizmo.

Shift-clicking on an axis of the translation gizmo lets you constrain the
movements of the selected object in the plane perpendicular to the axis. A small
square appears as an overlay for viewing this plane.

6-3.2.1.2 Rotation

The rotation gizmo allows the orientation of surfaces to be modified by
clicking and dragging the selection. This operational mode functions similarly
to the translation gizmo: you can modify the selection with the same mouse
and keyboard combinations.

The orientation of the surfaces is modified in relation to its transformation
referential. When the mouse is moved along an axis (up-down or left-right), the
selected surfaces rotate around one of the axes of their referential.

Rotation Gizmo.
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6-3.2.2 Transformation Tools

The drop-down menu in the top toolbar establishes the transformation
referential and contains four options: Screen, View,World, and Local.

Referential
option Description

Screen

The transformation referential is aligned with that of the screen on the XY
plane.

Moving a surface in XY occurs on a plane parallel to the screen and passing
through the surface's pivot.

View

For orthographic views (top, bottom, left, right, front, and back), the
behavior is the same as for the Screen orientation.

For isometric and perspective views, the behavior is the same as theWorld
orientation.

World The transformation referential is aligned with the axes of the model.

Local
The transformation referential is aligned with the local referential of the
surface.

In this mode, the transformation referential is identical to the pivot.

Moving a surface occurs in three dimensions along the transformation
referential, although the cursor is moved on the plane of the screen in two
dimensions. The movement of the mouse is therefore not sufficient to
determine the 3D movement of a surface. This is why moving a surface is
limited to one or two selected dimensions via the transformation referential.
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6-3.2.3 Surface Visibility and Frozen States

Shaper provides three operating modes that allow you to quickly modify the
visibility and the frozen state of surfaces:

Icon Function Description

Click to Hide Click on a surface to hide it.

Click to Freeze Click on a surface to freeze it.

Click to Unfreeze Click on a surface to unfreeze it.

6-3.3 Positioning Surfaces from the Main Interface

Patchwork 3D Design includes an area in its interface specifically for editing the
positions of surfaces. This editing area is beneath the 3D viewports in the
workspace. It allows for directly entering numerical values for the position of
surfaces relative to axes X, Y and Z.

Editing area dedicated to surface positioning.

The toggle button Enable user input for absolute coordinates in the
toolbar is for displaying or hiding this editing area. Entering numerical values
for these parameters is only possible when a surface is selected.

6-3.3.1 Coordinates inWorld Reference Frame

The Coordinates in World Reference Frame box is for specifying the surface’s
translation coordinates (TX, TY, and TZ) and the rotation orientation (RX, RY,
and RZ) of the selected surface’s pivot relative to the World frame. The selected
surface remains fixed relative to its own pivot.
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Top left: initial position of the cube’s pivot. Top right: intermediate position of the
cube’s pivot after entering coordinates TX=0.5 m and TZ=-0.3 m. Bottom: final position

of the cube’s pivot after entering angular coordinate RZ=10°.

In the Pivotmode, translation and rotation tools affect pivots only instead of
affecting surface-pivot couples, which they do in the other modes.

Coordinates in World Reference Frame box for the final position of the pivot shown in
the previous figure.

6-3.3.2 Coordinates Relative to Parent's Pivot

The Coordinates Relative to Parent's Pivot box is for specifying the position
coordinates (TX, TY, and TZ) of the pivot’s origin and the angular coordinates
(RX, RY, and RZ) of the pivot for the surface selected relative to the pivot of its
parent in the kinematics chain.

When no parent is defined for the surface selected, the values entered are
considered to apply to coordinates in the world frame reference like in the first
box.
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Positioning the blue cube's pivot relative to the parent surface's pivot, the green cube’s.
The entered coordinates are displayed in the Coordinates Relative to Parent's Pivot

box.

6-3.3.3 Relative Translation and Rotation

The function Enable user input for relative rotation or translation
may be accessed only when either the Translation or Rotation gizmo is
activated. It displays the Relative translation or rotation dialog box.

The value by which the surface selected is translated relative to the frame of the
gizmo displayed is entered in fields TX, TY, and TZ. The value by which the
surface selected rotates relative to the axes of the frame of the gizmo. The
frame of the gizmo depends on the frame of reference selected.
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The cube's translation gizmo origin is located at XX X=-0.4 m (on the left). A
translation of 0.3 m in the direction of the World frame’s X axis is applied to the cube

(final position on the right).

6-3.3.4 Applying a Transformation to a Selection of Surfaces

Two modes exist to apply a transformation to a selection of surfaces:

l Transform selected surfaces regarding the pivot of the leader of

the selection  : the transformation is applied to all selected
surfaces relative to the selection leader (displayed in white).

l Transform selected surfaces regarding their own pivot  : the
transformation is performed for each surface relative to its own
pivot.

A selection of surfaces. The selection leader is displayed in white.
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Rotation applied to the surface selection presented in the previous figure relative to the
selection leader's pivot (left) and relative to the surfaces' individual pivot (right).

6-3.3.5 Defining the Step Values

The box on the right side of the area dedicated to positioning surfaces allows
users to define fixed increments of movement or rotation for using the gizmos
while holding down the Alt key.

Steps box for specifying the step values (outlined in yellow).
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7 MATTER

7-1 Matter Graphical Interface

Matter is designed on the multi-document application model. It manages the
simultaneous editing of several products. These products are accessible via
tabs.

The graphic interface ofMatter is organized into three functional zones:

l Menu/Toolbar: Visual regrouping of the various operations that are
available according to the concepts handled.

l Workspace: Region receiving the various views.
l Sidebar: Organization of the tools in tabs.

l Product tab: This tab is specialized for managing
geometry and data. It also contains the product library.

l Library tab: This tab groups together the libraries
containing the visual elements used in developing a
product. These elements can be edited and managed
from their respective libraries.
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Seven different libraries are available as sub-tabs:
material, texture, environment, background, overlay,
post-processing, and sensor libraries.

This is the core ofMatter: it is here that the textures and
materials are created.

l Explorer tab: This tab allows you to explore external
libraries and to import the materials, textures,
backgrounds, environments, overlays, post-processing
blends and sensors saved on your computer or in other
locations external to the open P3D database.

7-2 Collision Detection System

The collision detection system inMatter enhances the immersive experience
when observing 3D scenes. When a scene is explored using eitherWalk or Fly
modes, the collision detection system prevents the observer from passing
through surfaces.

Collision detection includes two functions: Collisions and Prevent Collisions
with Transparent Surfaces.

Icon Function Description

Collisions
This function disables the passing of the camera through the
surfaces of the scene during its movement. The camera is
deflected along the surfaces.

Prevent Collisions
with Transparent
Surfaces

This function is available only if Collisionsmode is enabled.

It modifies the effects of the Collisions function by allowing
the camera to pass through the transparent surfaces of the
scene.

7-3 Matter Viewports

InMatter, a viewport is a movable window confined in the workspace. The
number of viewports is not set. You create them as needed by loading products
in the workspace by drag-and-drop. A viewport enables you to interact with the
product or products that you are editing. Each viewport consists of a list of tabs
for rapidly selecting an open product, and a large interaction and viewing zone.
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Like in the Shapermodule,Matter viewports can be maximized. To do so, use
the tools in the top right corner, as in Windows.

7-3.1 Importing anObject into the Active Viewport

The viewport is your means of editing a product. You can easily create
viewports by:

l Dragging and dropping a model onto the workspace.
l Dragging and dropping a group of products onto the workspace.
l Double-clicking on a product.
l Ctrl + dragging and dropping a model onto a viewport.
l Ctrl + dragging and dropping a group of products onto a viewport.

They can also be created using the product tabs in an existing viewport by:

l Ctrl + dragging and dropping a tab onto another viewport.
l Dragging and dropping a tab onto the workspace.
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Shift+Ctrl + dragging and dropping maximizes the new viewport in the
workspace. Ctrl + dragging and dropping cancels the maximization of the current
viewport and creates a new viewport.

Similarly, tabs in a viewport are created by:

l Double-clicking on a product in theMatter sidebar's product library.
l Dragging and dropping a model onto the interaction zone. The
Mattermodule will automatically create a new product.

l Dragging and dropping a product selection onto the interaction
zone.

To select the product to be edited (active product), simply click on a tab, and to
delete it ,click on the close tab button.

When closing the last tab associated with the product (a product may be
present in several viewports), theMattermodule captures a representation of
the product and updates the product's thumbnail image in the sidebar.

7-3.2 Interaction within 3D Viewports

These interaction modes are available from theModemenu.

Matter has several interaction modes:

Icon Mode Behavior Shortcut

Pan

Clicking and dragging in a 3D view allows you to
slide the viewpoint in the plane of observation. The
center of interest moves with along with the
viewpoint.

Middle mouse
button + drag the
mouse

Orbit

Clicking and dragging in a 3D view allows you to
rotate the viewpoint about the center of interest.
The position of the center of interest remains
unchanged.

Ctrl+Middle
mouse button +
drag the mouse

Zoom

Clicking and dragging in a 3D view brings the
viewpoint closer to the center of interest, which has
the effect of magnifying the objects located in the
field of vision.

Shift+Ctrl+Middle
mouse button +
drag the mouse

Camera
Roll

This mode rotate the product relative to the center
of the screen.

Focal
Angle

This mode is similar to the zoom ring on a photo
lens: it changes the field of view. The more the lens
is opened, the smaller the product appears. If you
approach too close to an object, it disappears.

Shift+Middle
mouse button +
drag the mouse
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Icon Mode Behavior Shortcut

Fly
Mode

As soon as this mode is enabled, navigation is in fly
mode, and by simplymoving the mouse (without
clicking), you can make the viewpoint rotate about
the center of interest. Clicking and holding down
the left or right mouse buttons allows you to move
forwards or backwards, respectively, which has the
effect of magnifying the objects located in the field
of vision. Click and dragging allows you to fly
around the object.

Walk
Mode

When this mode is enabled, moving the mouse
allows you to rotate the viewpoint about the center
of interest. Clicking and dragging gives you the
illusion of walking (forwards or backwards) next to
the object. Unlike Fly Mode, inWalk Mode, the
altitude of the point of view remains constant.

Head
Mode

When this mode is enabled, moving the mouse
(without clicking) allows you to make the world
turn around the point of view.

The shortcut Ctrl + Spacebar centers the camera by positioning the point on the
surface below the cursor at the center of the viewport.

7-3.3 Accessing the Viewport Context Menus

The reframing operation, Zoom to fit (Z), in the Camera menu positions the
point of observation in order to view the product as a whole while at the same
time maintaining the direction of observation.

7-3.4 Accessing the Viewport Context Menus

Each viewport offers a context menu accessible by right-clicking on the display
of the type of view in the upper left-hand corner of each viewport. This menu
provides access to the render configuration settings.

Additionally, you can reach a second contextual menu by right-clicking on the
center of the viewport. This menu groups together the application operations
that are most often used in viewports.
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7-3.5 Configuring the Rendering in a Viewport

The viewport context menu allows you to choose the type of view in the View
submenu.

In the submenu Render, you have access to the eight render modes.

The Render Presets allow you to activate one of the three default modes,
Default, Fastest, andNicest. If you choose, you can also define a new render
preset to have it added to this menu for easy access.

7-3.6 Linking the Updates of the 3D Viewports

Accessible from :Matter: Viewport > Link

To facilitate the comparison of products spread among separate viewports
from the same viewpoint (interactive comparison), theMattermodule has a
viewpoint synchronization mechanism. Thus, when the viewpoint of the active
viewport changes, the other views are informed and can update their viewpoint
under certain conditions:

Icon Type of link Description

None No updating of the point of view between viewports.

All Update all viewports to correspond to the point of view in the
active viewport.

Same model
Update all viewports containing products based on the same
model. This way, all of the products obtained from that model are
observed at the same angle.

Link
Interactively

Enabled by default, this mode allows synchronized viewports to be
updated while you are interacting with them.

However, for very heavy scenes, this interactive synchronization is
detrimental to the smoothness of movement. When this option is
disabled, synchronization is possible only at the end of a phase of
interactive manipulation.

7-3.7 Grid and Axis Orientation

A grid of a set size serves as a reference and can help improve the
understanding of volumes within a 3D viewport. This grid is available under
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Visualization > Grid.

Similarly, a reference icon illustrating the placement of the axes in the direction

of observation is available under Visualization > Axis Orientation.

7-3.8 Render Statistics

The  Render Statistics are available from the Visualization menu.

This option displays data related to rendering delays, the number of surfaces,
summits and triangles processed, and the GPU memory used.

The consumption of GPU memory is displayed as a gauge for the following
elements:

l The images and videos used as textures and rendered in the active
viewport,

l Themeshes rendered in the active viewport,
l The textures used to calculate relief (bumpmaps) that are rendered
in the active viewport,

l The lighting environments rendered in the active viewport,
l The lightmaps calculated in Shaper and used during the rendering
in the active viewport,

l Other: other sources of GPU memory consumption, including
database resources that are not used in the active viewport, other
open software, and the memory reserved by the graphics card's
driver,

l Free: unused GPU memory.

7-3.9 Full ScreenMode

Accessible in:Matter: Visualization > Full Screen Mode
Keyboard shortcut Y

TheMattermodule has a Full Screen mode. In this mode, the viewing and
interaction zone of the active view occupies the maximum amount of space
available for the Windows applications.

The interface of Patchwork 3D Design is no longer accessible, but the floating
editors maintain their visibility and their position.
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As the tabs are no longer visible, product selection is performed via theNext
tab in active viewport (S) and Previous tab in active viewport (Q)
operations.

7-3.10 Modifying Default Properties

Click on the Viewport Properties button at the top right of a viewport to
modify the viewport properties. This opens the editor for Viewport Properties.

By default, clippings planes are visible in viewport according to the settings
used in the Clipping Planes editor. This behavior corresponds to theNo
override property.

You can force clipping planes to be enabled or disabled in this viewport by
selecting the desired option from the drop-down list.

7-3.11 Unlinking from the Shaper Configuration

Click on the Link Configuration button at the top right of a viewport to
enable or disable the configuration link to Shaper for this viewport.

By default, the configuration in eachMatter viewport is linked to the
configuration in Shaper. The configuration in each viewport is not independent.

When linked to the Shaper configuration, this viewport will show the current
configuration for geometry layers, position layers, and lighting layers as set in
Shaper. When this viewport is modified, it will change the configuration in
Shaper. Any modifications to the configuration displayed in Shaper will be
shown in this viewport when you return toMatter.

If multiple viewports are linked to the Shaper configuration, changing the
configuration for geometry layers, position layers, or lighting layers in one of
the viewports will cause the same change in all other viewports linked to the
Shaper configuration.

7-3.12 Viewport Rendering Modes

Patchwork 3D Design offers eight rendering modes.
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The first modes,Wireframe, Fill, UV, and Lightmap, provide a view inMatter
of certain Shaper elements: tessellation, Shaper colors, mapping UV
coordinates, and lightmaps, respectively.

TheMaterialmode shows the rendering of theMattermaterials.

TheMix mode displays a mix of all of the previous modes.

The Z-buffer and the G-buffer are used to view the Patchwork 3D Design
scene by showing the positioning of the objects relative to one another and the
distinction of the elements by surface group.

These rendering modes can be accessed from the Render submenu of View in
theMatter viewport. right-click on the name of the viewport to access the
contextual menu.

Z-buffer is a viewing method making it easier to understand a 3D scene by
using the information relating to the depth level of the objects.

This view shows the various elements of the scene with respect to the
viewpoint, in grey scale. The closest objects are shown darker than the distant
objects.
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Material rendering mode. Z-buffer rendering mode.

G-buffer is a viewing method for quickly discerning the various elements of a
3D scene by representing them as single-color tones.

G-buffer rendering mode.

In the G-buffer rendering mode, the color used to represent an object is the color
that has been assigned to the group of surfaces of this object in Shaper.

By combining these rendering modes with the post-processing effects, you can
obtain many interesting visual effects.

G-buffer rendering + "Edge detector" effect.
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7-4 ManagingMatter Resources

7-4.1 Dragging and Dropping Matter Resources

You can add materials files (.kmt), environments (.hdr), images (.jpg, .png, etc.),
to the Patchwork 3D Design libraries by drag and drop.

7-4.2 Purging Unused Matter Resources

Patchwork 3D Design includes tools for permanently deleting unused
resources. This allows you to optimize the size of your Patchwork 3D Design
files.

These tools take the form of buttons in the toolbars of the various Matter
resource libraries in the sidebar.

Icon Description

Permanently delete unused materials.

Permanently delete unused textures.

Permanently delete unused backgrounds.

Permanently delete unused environments.

Permanently delete unused overlays.

Permanently delete unused post-processing blends.

Permanently delete unused sensors.

7-4.3 Listing Matter Resources

Patchwork 3D Design will inform you of all o f the products in which a resource
is used.
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This function is available via the context menu for each resource. In the
corresponding sidebar library, right-click on the resource (material, texture,
background, etc.) and select Usage List to display the list of products in which
the resource is used.

7-4.4 Purging Unused GPUResources

Access:Matter > Edit > Purge Unused GPU Resources

When products are opened inMatter, each of them consumes GPU resources
even if the product is not currently being modified. Materials, textures,
backgrounds, environments, overlays and post-processes are stored in the
memory. Closing a product’s viewport will free up the GPU resources assigned
to this product.

Another means of freeing GPU resources while keeping multiple products open
in viewports is to use the Purge Unused GPU Resources option by simply

clicking the corresponding button located in the Editmenu inMatter.

7-5 External Library Explorer

This sidebar tab allows you to load and filter materials, textures, backgrounds,
environments, overlays and post processes from your hard drive or network.

By default, the external library explorer points to the C:\Program
Files\Lumiscaphe\P3D 2019.1 X3\Library directory where you will find
samples of materials and environments for your use. This directory is
organized into several sub-folders: Backgrounds, Environments,Materials,
Overlays, Textures.

Each file format is filed away in its category, i.e. the material files are filed under
the Material tab, etc.

From the explorer you can drag and drop elements such as backgrounds onto a
product in a viewport. This background will automatically be associated with
the active product. It will also be added to the already-existing library of
backgrounds in the open P3D database. If you rename imported files in the
explorer or import new files, the changes will be reflected in the P3D database's
internal library for the modified resource.



8-1   List of Editors in Patchwork 3D Design

Lumiscaphe Patchwork 3D Design 2019.1 X3 p.103

8 EDITORS

8-1 List of Editors in Patchwork 3D Design

Editor Shaper Matter Usage

Advanced Triangulation
Parameters

ü

allows minimums and
maximums to be applied to
the calculation of surface
tessellation (a CAD import
license option is required)

Animation Sliders
ü ü

allows animated meshes and
geometry animations
associated with translation
vectors or rotation axes, as
well as timeline clips, to be
played back manually, one
by one

Aspect Layers
ü

manages layers containing
color and material
information, as well as saved
groups of aspect layer
visibility settings

Backgrounds
ü

assembles settings
associated with the aspect
of 2D backgrounds

Camera Animations
ü

available via the Timelines
editor; sets up an animation
in which a camera or a
viewpoint is modified

Cameras
ü

manages the hierarchical
camera list, the favorite
cameras for each product,
and the settings of the
camera currently being
edited

Channels
ü

available via the Timelines
editor; sets up an animation
of almost any parameter
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Editor Shaper Matter Usage

related to a product's aspect

Clipping Planes
ü

positions, displays, and
modifies the display settings
of the clipping planes that
bisect a product

Color Chooser ü ü

available in any editor where
a color choice is possible;
contains a color selection
widget and means of
managing a color palette

Configuration Browser
ü ü

allows a user to explore
configurations set up for a
product

Configurations
ü ü

defines the display rules for
layers and groups them into
product configurations

Configuration Keys
ü

available via the Timelines
editor; sets up the
animation element allowing
the visible configuration to
be changed

Cubic VR Panoramas
ü

prepares and creates VR
cubic panoramas from
Patchwork 3D Design
rendering

Database Properties
ü ü

contains information
concerning the color profile
and the origin of the file

Environment Properties
ü

contains settings associated
with a lighting environment,
including its orientation and
its alternate background
texture

GPU Consumption
ü ü

analyzes GPU consumption
and detects ways it can be
reduced (requires the
product analysis license
option)

Gradients
ü

available via theMaterials
editor; creates or imports
gradients

HDR Light Studio (plug-in)
ü

creates or modifies a
lighting environment with
HDR Light Studio
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Editor Shaper Matter Usage

Import Manager
ü ü

displays the status (events,
warnings, and errors) of an
import

Imported File History ü
lists files that have been
imported into the model
currently being edited

Keyboard Map
ü ü

lists and can modify
keyboard and mouse
shortcuts used in Patchwork
3D Design

Layer Visibility
ü

displays and can modify the
visibility state of each
individual geometry and
lighting layer

Layer Visibility Bookmarks
ü ü

saves and calls up visibility
states for geometry layers
and for surfaces

Live Mode
ü

creates associations
between a click on a specific
surface and a channel
animation clip or a timeline,
for playback when Live mode
is enabled

Materials
ü

contains settings associated
with the aspect of materials

Measuring Tool
ü ü

measures the distance
between two points in the
3D space

Model Properties
ü ü

displays and can edit the
name of the model and the
display size for nulls

Overlays
ü

contains the settings
associated with the aspect
of overlays

Panoramas
ü

prepares and creates 360-
degree panoramic videos
from Patchwork 3D Design
rendering

Position Layers
ü ü

manages layers containing
modified positions for the
geometric objects in the
model, as well as their
visibility; object positions in
the layers can only be
modified in Shaper
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Editor Shaper Matter Usage

Post-Processing
ü

contains the settings for a
series of 2D post-processing
effects, from effect-specific
settings to the order in
which effects are applied

Product Environments
ü

manages lighting
environment layers and
environment properties per
product (orientation, setup
for use with the real-time
sun)

Product Properties
ü

displays and can edit the
name of the product, the
disassociation of Shaper
andMatter visibility states,
and the rendering policy for
backfaces

Raytracing Settings
ü

establishes the settings
used by the raytracing
engine

Real-Time Sun
ü

adds a sun-type lighting
that can be set up and
modified in real time

Render Quality Settings ü

defines render mode presets
in the viewport and contains
tools to limit, if necessary,
extensive calculations
during interaction with the
scene

Rendered Views History
ü

provides a history of
snapshots that have been
rendered with Patchwork
3D Design

Selections
ü

contains advanced selection
tools, including selection by
type, selection by search,
and saved selection
groupings

Sensors
ü

contains the settings
associated with sensors,
including the assignment of
backgrounds, overlays, and
post-processing

Snapshot Batcher
ü

assembles rendering tasks
for creating videos, images,
VR objects and VR
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Editor Shaper Matter Usage

panoramas for which
immediate rendering was
not selected, and runs
batched rendering

Snapshots (Images)
ü

prepares and creates image
files from Patchwork
3D Design rendering

Stereo
ü

modifies the basic
stereoscopy settings when
the stereoscopymode is
enabled

Surface Cutting Workshop
ü

contains advanced surface
cutting tools

Surface Properties
ü

provides information on the
surface or object and
manages associated options

Surface Properties
ü

contains aspect properties
(material, labels, specific
lighting environment) for a
surface, by aspect layer and
by environment layer

Tag Manager
ü

creates tags and assigns
them to objects or groups of
objects

Text Image
ü

creates an image based on
text, which can then be used
as a texture

Textures
ü

manages image, resolution,
and color properties for
textures

Timelines
ü

creates animation
sequences called "timelines"

Triangulation
ü

manages the interactive
tessellation of a NURBS
surface or group of NURBS
surfaces (a CAD import
license option is required)

Unfolding Workshop
ü

contains advanced surface
flattening (unfolding) tools

Videos
ü

prepares and creates video
files from a timeline

Viewport Properties ü can require a specific display
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Editor Shaper Matter Usage

behavior for clipping planes
in the corresponding
viewport

VR Objects
ü

prepares and creates
VR objects

8-2 Animation Sliders (Editor)

Available in: Shaper or Matter:  Editors > Animation Sliders

This editor allows you to test the effect of certain animations. It presents the
different parts that can be animated by rotation or by translation, the animated
meshes, and any animation clips that you have dragged and dropped from the
libraries in the Timelines editor.

For existing translatable or rotatable parts to appear in this editor, the Show in
Animation Sliders editor option must be checked for that part in the
Kinematics sidebar tab in Shaper.

For each part, use the slider to manually animate the part. The animations are
displayed in the active viewport. This allows you to view one animation in one
viewport and another animation in a different viewport.

8-2.1 Animated Meshes

Using the slider for animated meshes allows you to move through the frames
of the animation. The frame number is displayed to the right. You can also
position the slider by typing a different frame number in this field.

8-2.2 Translations

The translation is limited by the distance set for the directional vector of the
part. The value of the cursor position is displayed to the right and is expressed
in the preferred units of measure for distances. You can also position the cursor
by providing a new value in this field.
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8-2.3 Rotations

The rotation is limited by the values set as min and max angles for the part. The
value of the cursor position is displayed to the right and is expressed in
degrees. You can also position the cursor by providing a new value in this field.

8-2.4 Clips

InMatter, from the libraries on the right of the Timelines editor, drag and drop
clips you would like to manipulate onto the Animation Slider editor. This adds
the clip to the editor. Clips are only visible in the editor while in theMatter
module.

The slider allows you to scan through the clip. The value of the cursor position
is displayed to the right and expressed in seconds. You can also position the
cursor by providing a new value in this field.

8-3 Aspect Layers (Editor)

Available in:Matter: Editors > Aspect Layers

Aspect Layers is an editor that organizes the aspect of a product in layers.
Different materials and their UV mapping projections can be assigned to the
same surface in different layers. Using aspect layers will allow you to create
configurations for the materials used to dress your product.

This editor consists of three tabs that can be used to manage the aspect layers,
the visibility bookmarks and the material assignment method.

The Layer tab is for configuring the aspect layers.

The Bookmark tab is for creating bookmarks associated with the aspect layers.

The Assignment tab is for defining the method for assigning materials,
specifying which aspect layer and affectation mode should be used when
materials are applied.

The Product field identifies the active product.
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8-3.1 Layer Tab

Layers: List of aspect layers that have been created.

: The visibility toggle button is for enabling/disabling visibility of the aspect
layer.
When the visibility button is disabled for a group of aspect layers, none of the
layers in the group are visible, but layers keep their own state.

: This icon indicates the active aspect layer.

Icon Function Description

Pick active aspect layer
Select the aspect layer associated with the
material of the surface you click in the
viewport.

New aspect layer Create a new aspect layer in the list of
layers.

Duplicate the selected item Create a copy of the selected item: aspect
layer(s) or a group of aspect layers.

New group Create a new group of aspect layers.

Merge selected layers Combine the selected layers into a single
layer.

Flatten all layers Combine all layers into a single layer.

Delete aspect layer Delete the selected layer.

Split layer by picked material Assign a new aspect layer to the picked
material.

Split layer by labels Assign a new aspect layer to the picked
label.

Split layer by visibility

Create an aspect layer, skipping the
surfaces hidden in Shaper. Only the
surfaces that are visible will be taken into
account. (Switch to Evaluate active layer
only to enable this function.)

Explode layer selection by
assignment

Partition products in layers that have
common material assignments.
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Icon Function Description

Explode layer selection by material

Divide an aspect layer by the number of
materials constituting it. The names
assigned by default to these new layers
are those of the materials.

Import aspect layer Import aspect layers from another
product.

Flatten all layers in new product Create a new product using all aspect
layers.

Evaluate all layers in stack View the product by taking all aspect
layers into account.

Evaluate layers stack until active
layer

View the product by taking into account
the lowest level of aspect layers up
through the active layer only. A red
border around the viewport indicates
that the view is restricted to a limited
selection of layers.

Evaluate active layer only View the active aspect layer only.

Highlight active layer assignments Enable/disable highlighting of surfaces
with a material in the active aspect layer.

Hide surfaces without assignment Hide/show surfaces that have no material
assigned to them.

Mask labels with materials

This button allows you to enable or
disable the display of aspect layers
containing labels on top of all layers
containing materials in the list. When a list
of aspect layers is displayed on a product,
the layers are applied above those located
under them in the list. Thus, when a layer
containing a material is applied above a
layer containing a label, the label should
probably be hidden. However, you can
choose to force the label to be visible on
the material.

l The icon indicates
that labels are currently
visible even if materials were
applied above them. Clicking
this icon disables label
visibility.

l The icon indicates
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Icon Function Description

that labels are currently
hidden bymaterials applied
above them. Clicking the icon
makes labels visible.

Replace String Rename a selection of layers and assign a
prefix and/or suffix to them.

The Layer field is for renaming the active aspect layer.

8-3.2 Bookmark Tab

The Bookmark tab is for creating bookmarks according to the visibility state of
the aspect layers.

Layer Visibility Bookmarks: Lists the bookmarks of layer visibility
configurations that have been created. double-click on a bookmark to enable it.

Icon Function Description

New aspect layer
bookmark

Create a new bookmark in the list of aspect layer
visibility bookmarks. A bookmark is a saved set of
the elements visible in the current configuration of
layers.

Store aspect layer
bookmark

Update the active bookmark by storing the current
aspect layer configuration.

Restore aspect layer
bookmark

Display the configuration saved in the active
bookmark. his function can also be accessed by
double-clicking on the bookmark in the list.

Delete aspect layer
bookmark

Delete a bookmark from the list of visibility
bookmarks.

The Bookmark field is for renaming the active visibility bookmark.

8-3.3 Assignment Tab

The Assignment tab is for configuring the mode of assignment of the aspect
layers.

Parameter Description

Target Set whether a material being assigned should be applied to the active aspect
layer or to the layer to which the current visible material belongs.
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Parameter Description

Assign as

Sets the default assignment mode for the layer. This determines whether a
material should be assigned by default as a material or as a label.

For an aspect layer dedicated to labels, setting the default assignment mode to
Label will prevent you from applying material types (matte, mirror) that cannot
be used as labels.

UV reset Indicate whether the UVs should be reset to 0.0 (yes) or used as-is (no)
during assignment.

Affectation
mode Choose whether to use the assignment mode Assign or the mode Replace.

The Reset to default button is used to restore the default parameters.

8-4 Backgrounds (Editor)

Available in:Matter: Editors > Backgrounds

Backgrounds is a floating editor that allows you to create backgrounds
and to change the parameters of the active background.

The interface is organized into three zones:

l Operations bar and name of the active background: Displays
operations available in theMatter sidebar's background library.

l Gradient: Displays the controls and parameters of a color gradient
background.

l ImageMap: Regrouping of the parameters concerning the
superposition pattern.

The following buttons are present in the operations bar:

Icon Description

Start point for dragging and dropping the background to assign it to a sensor or
to a viewport.

Enables an eyedropper for selecting the background used in a viewport in order
to edit it.

Assigns the background being edited to the sensor in the active viewport.
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Icon Description

Creates a new background.

Duplicates the background currently being edited.

In the Gradient zone, the gradient type of background can be enabled and the
beginning and end colors for the gradient can be defined. You can also:

l Lock the color to force a solid color to be used as the
background,

l Modify the Orientation of the gradient.

In theMap zone, you can edit the properties for an image type of background:

l The check-box next to theMap image allows use of the texture to be
enabled or disabled.

l Drag and drop a texture from theMatter sidebar's texture library.
This field accepts video textures. Clicking on the name of theMap in
use takes you to the current texture group in theMatter sidebar's
texture library.

l Check the Preserve texture aspect box to prevent the image scale
defined in this editor from being modified when the viewport is
resized.

l Provide the Offset (position of the texture in the viewport), the Scale
and the degrees to Rotate the background texture.

l Lock the transformation scale to apply uniform scaling of the
texture's vertical and horizontal axes.

You can combine an image with the gradient and configure the image's
transformation to shift it using the Offset values, repeat it with the Scale
values, and rotate it.
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First row: Solid background, gradient background.
Second row: Using different values of rotation (left: 90 degrees; right: 180 degrees) to

orient the gradient.
Third row: Combining and image and a gradient. On the right, the image has been

rotated 28 degrees and the scale has been set to 3.
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8-5 Camera Animations (Editor)

Available in:Matter: Timelines > Camera Animations library tab > double-
click on an animation name
Timelines > Camera track > double-click on a clip

Camera Animations is an editor that allows you to set up a camera animation
by defining a camera path. You have a choice between three different types of
camera path:

l Kam File type,
l Bookmark Animator type,
l Bézier Curve Path type.

When open, the Camera Animations editor will always show the information
for the current active clip in the Timelines editor. To change the clip shown in
the Camera Animations editor, select a different clip in the Timelines editor:

l Click on the name of a clip in the camera animations list,
l Click on the representation of a clip in the Camera track,
l Create a new camera animation using the button below the camera
animations list in the library. This will create a new clip and activate
it.

Rename your animation in the text zone at the top of the editor. It is
recommended that you give each animation a different name.

8-5.1 Kam File Type

If you have selected Kam File as your camera path, the scene will be animated
according to an existing animation path, which might have been created, for
example, by the export of a bookmark animation as a .kam file. The Kam Files
options are displayed in the Camera Animations editor.

In the box File you have access to the tools to:

Icon Function

Import Kam File

Update Kam File
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Icon Function

Export Kam Animation

Delete Kam Animation

In the Parameters zone, the Filename and the number of Frames are
displayed for your information. In order to convert from a frame-based kam file
to a real-time animation, you must provide the Frame rate here.

You can indicate whether the Fov, or Field of view, is expressed as a vertical or
a horizontal value. You can also opt to Ignore Fov value supplied by the .kam
file.

8-5.2 Bookmark Animator Type

The Bookmark Animator type allows you to define a camera path passing by
one or more animation bookmarks that you set up in the animator. You
establish the order of the bookmarks, the time spent at each point, and the type
of animation used to move from one point to another. The corresponding
options are displayed in the Camera Animations editor.

The Time Parameters zone concerns the global duration of the animation.
Define the pauses between bookmarks and the duration of each bookmark. The
Total Time of the animation is calculated based on this information.

Tick the Close Path checkbox to animate the transition between the last and
the first bookmarks when the animation playback is looped. This option is
checked by default.

The Bookmark Sequence zone summarizes the animation bookmarks
according to their order in your animation list. It also provides the information
concerning each bookmark as a step in the animation.

This zone offers multiple buttons to modify the list of bookmarks:

Icon Function Description

New
Animation
Bookmark

Adds the current viewport's view of the product to your list as a new
animation bookmark.

Update
Animation
Bookmark

Replaces the selected bookmark with the current view of the
product.
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Icon Function Description

Duplicate
Animation
Bookmark

Creates a bookmark identical to the selected bookmark and adds it
to the end of the list.

Insert
Active
Camera
Set

Inserts the cameras from the last active group in the Cameras editor.
The position and orientation of the cameras are imported as
bookmarks and placed below the current selected bookmark.

Import
Bookmark
Animation

Opens and loads bookmark animations previously saved in .kba or
.kam formats.

Export
Bookmark
Animation

Saves the current bookmark animation in .kba or .kam format.

Move
Bookmark
Up in List

Moves the selected bookmark to position it higher in the list.

Move
Bookmark
Down in
List

Moves the selected bookmark to position it lower in the list.

Convert to
Bézier
path

Creates a Bézier path for the camera animation described by the
bookmarks in the list.

Delete
Animation
Bookmark

Removes the bookmark from the list. Its settings will not be saved.

The Bookmark zone concerns the set-up of the selected bookmark:

Setting Description

Checkbox Includes the bookmark in the animation (checked) or excludes it
(unchecked).

Label Allows you to set or modify the name of the bookmark.

Sleep Defines the duration of the pause of the bookmarked image.

Duration Defines the duration of the animated transition to the next bookmark.

Smoothness Sets the fluidity of the camera behavior.

Type

Type of path:

l Linear: sets a straight path (the rotation parameter fields are
grayed out),

l Jump: moves from one stage to the next with no transition,
l Orbit: sets a circular path (the rotation parameter fields are
accessible),
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Setting Description

l Head: pivots the camera (the rotation parameter fields are
accessible),

l Spline: smooths the transitions when the camera moves from
bookmark to bookmark.

Orbit/Head

Provides rotation parameters, which are modifiable if you have selected
Orbit or Head as the type:

l During…%of step: percentage of the step dedicated to the
rotation,

l Turn…times: number of 360-degree turns to carry out.

8-5.3 Bézier Curve Path Type

For a Bézier Path animation, Camera Animations defines the behavior of the
camera's position and orientation as well as that of the camera target's
position.

For the purposes of this editor, the camera is the position of observation, along
with properties such as zoom and camera angle. The target, or the point being
observed, is the center of the viewport when the scene is viewed using this
camera. The center of the current active viewport at the time the clip is created
is used as the initial target position for the clip. However, you can set a different
initial target in this editor.

The camera's position, its target, or both can be animated by Bézier curve path.
Selecting an option for each element allows you to set its behavior for this clip.

To find the name of a curve, hover over it with your cursor. Its name is displayed
in the information bar at the bottom of the screen.

Position path options:

Position Use Settings

Follow Bézier
path

Choose this option to enable the drop-down
menu. This menu lists all of the Bézier curves
created in your product. Select the curve you wish
to use as the path for the camera's position. The
camera will move along the Bézier path at a
constant speed.

The button
beside this option
reverses the
direction of the path.

Follow null

Choose this option to enable the drop-down
menu. This menu lists all of the null objects in the
product and is available only if you have at least
one null. A null constrained by Follow path to a
Bézier path and animated by channel animation
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Position Use Settings

serves as a moving tripod for the camera. The
camera will move with the null object, respecting
the easing established by the channel animation.

The camera animation and the path constraint
animation must start and end at the same time in
the timeline.

For more information see:

l Channels (Editor) (page 128)
l Animation Constraints (page 312)

Stationary Choose this option in order not to animate the
camera's position.

The button
beside this option
sets the fixed camera
position using the
camera position in
the active viewport.

Target path options:

Target Use Settings

Follow Bézier
path

Choose this option to enable the
drop-down menu. This menu lists all
of the Bézier curves created in your
product. Select the curve you wish to
use as the path for the camera's
target

The button beside
this option reverses the
direction of the path.

Follow position
path

Choose this option to have the
target's position be calculated
automatically in order to precede the
camera along the camera's position
path.

Only available if you have selected
Follow Bézier path as the Position
path.

Follow null

Choose this option to enable the
drop-down menu. This menu lists all
of the null objects in your product.
Select the object you wish to use as
the camera's target.

Only available if you have at least one
null. A null constrained by Follow
path to a Bézier path and animated by
channel animation serves as a moving
base for the camera's target.

The camera animation and the path
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Target Use Settings

constraint animation must start and
end at the same time in the timeline.

Fixed direction

Choose this option to lock the target's
position in relation to the camera and
prevent the modification of the
camera's orientation. As the camera
moves along its path, the target
moves in exactly the same way.

Only available if you have selected
Follow Bézier path as the Position
path.

The button beside
this option sets the relative
target and camera positions
based on the current
relationship in the active
viewport.

Stationary

Choose this option in order not to
animate the target's position. The
camera's orientation will change to
continue to view the stationary target
no matter where the camera is along
its path.

The button beside
this option modifies the
initial target position by
replacing the previous initial
position with the current
center of the active viewport.

In the Duration field, provide the clip length in seconds.

A camera animation by Bézier Path provides a linear development of the
camera and target positions over time, and takes into account all of the curve as
the path.

The start point along the curve is defined on the Bézier path itself. Right-click on

the curve where you would like to place the start point and select Place
start here.

8-5.4 Example: Creating a Rotor Animation

The "rotor" camera path with a ping-pong effect simulates the rotation of a
product as if it had been placed on a rotating pedestal whose center
corresponds to the point at the center of the active viewport. In other words, a
rotor animation is a rotation around the Y axis at the coordinates of the ZX
plane at the center of the active viewport.

A rotor animation can be easily created using a bookmark animation camera
path.
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1. Open Timelines  and create a new camera animation.
2. In the Camera Animations editor, give your animation a

meaningful name, such as "Rotor Animation."
3. Choose the bookmark animator camera path type.
4. Position your product. The point at the center of the viewport will

provide the ZX coordinates to use as the central point of the
rotating plane.

5. Create a bookmark in the Camera Animations editor by using the

New Animation Bookmark button .
6. In the Bookmark zone, provide the following information:

l Duration: Enter the desired duration of the rotation in
seconds.

l Type: Choose the value Orbit. This will create a rotor
movement.

l Orbit/Head > During… % of step: Enter 100 to have
the rotor movement occupy the full duration of the
bookmark.

l Orbit/Head > Turn… times: Supply the number of
times to turn. For a rotor movement, this value is usually
between 0 and 1. 1 corresponds to a full rotation around
the center point; 0.5, for example, corresponds to half of
a rotation around this point.

To implement a ping-pong effect:

1. Place your animation clip in the timeline.
2. Place a second instance of the same clip in the timeline, positioned

so that it begins exactly when the previous instance ends.
3. Select the second clip by clicking on it.
4. Using the mouse, right-click on your selection to open the context

menu and select the option Reverse playback.

To make the transition from one bookmark to the next during a ping-pong effect
appear more fluid, increase the Smoothness value for your bookmark. A value
between 0.5 and 1 is usually appropriate.
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8-6 Cameras (Editor)

Available in: Matter or Shaper: Editorsmenu > Cameras

Cameras is an editor that contains two parts: the list of cameras that are
available in your database, and the zone that displays the properties of the
camera being edited.

8-6.1 Camera List

The camera list is organized in a hierarchy composed of groups and cameras.
Each group can contain both cameras and other groups. The elements in the
hierarchy — cameras and groups of cameras — can be moved within the
hierarchy by drag-and-drop.

You can select a camera from the camera list to edit or to activate in the current
viewport.

Icon Operation Description

Activate a
camera Click on a camera to recall its settings in the current viewport.

Edit
current
camera

Double-click on a camera or click the icon to activate the editing
mode that allows you to view or edit the camera settings in the right-
hand side of the editor. In this mode, navigation in the viewport will
modify the camera's settings.

Use the buttons below the list to manage the cameras in the hierarchy. You can:

Icon Operation Description

Add a new
camera

The camera is initialized using the settings in the current
viewport.

Add a camera
group

Enable or disable
the Edit current
cameramode

The camera currently being edited is marked in the Camera

list with the icon. If no camera is marked with this icon,
the viewport's free camera information is shown and can be
edited on the right-hand side of the editor.

Update camera
settings with the
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Icon Operation Description

settings used in
the active
viewport

Assign selected
camera as one of
the product's
favorite cameras

The selected camera is assigned to the favorite camera you
select for the product in the active viewport. Cameras marked
as favorites for the product in the active viewport are

displayed in the Camera List with the icon.

Rename a camera
or a group of
cameras

Duplicate a
camera or a
group of cameras

Delete a camera
or a group of
cameras

If you attempt to delete a camera currently assigned to a
viewport, an alert will appear informing you of the camera's
current use. If you confirm that you would like to delete the
camera, the viewport will return to its free camera.

Import a camera
or group of
cameras in the
KCH or KBE
format

This button also allows you to generate cameras from a .kam
file. See Generating Bookmarks from a Kam File (page 482).

Export a camera
or group of
cameras in the
KCH format

8-6.2 Editing Camera Properties

The right-hand side of the editor displays the settings of the camera being
edited. Select a camera from the list on the left by clicking on it and enabling

the Edit current cameramode to view or edit the camera settings in the
right-hand side of the editor. You can also double-click on the camera.

In this mode, navigation in the viewport will also modify the camera's
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settings.

If no camera is selected for editing, the settings for the active viewport's free
camera are displayed.

You can click in the field you would like to modify and provide a new value.

8-6.2.1 Renaming the Camera

The name of the camera being edited is shown. You can modify it by clicking
within this zone. It is also possible to use the button below the camera list to
rename the camera.

8-6.2.2 Choosing a Sensor

To modify the associated sensor, drag a sensor from theMatter sidebar's
sensor library and drop it on the Sensor field.

To remove a sensor from the camera, click on the Remove current
sensor button. This will not delete the sensor. When you remove a sensor, the
camera will automatically return the default sensor settings instead.

8-6.2.3 Lens

The basic camera parameters can be set in the Photo tab or the CG (Computer
Graphics) tab. The Photo tab displays the parameters in analog form, using the
vocabulary associated with a physical camera as a metaphor. The CG tab allows
you to provide the same information.

Photo CG
Focal length: provide the focal length. The
sensor size is displayed below this field for
reference. Sensor size influences the
interpretation of this value.

Field of view (FOV): provide the
angle corresponding to the field of
view.

Portrait mode: tick this box to impose a
portrait orientation. Lenses have a landscape
orientation by default.

Field of view axis: from the drop-
down menu, choose the axis to
which the angle of the field of view
should be applied.
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8-6.2.3.1 Depth of Field

The Depth of Field zone brings together settings that were previously available
in the Depth of Field Editor for versions up to and including v5.7.

Depth of field is an effect by which objects at the focal distance from the
camera appear clearly. Objects at other distances appear progressively blurrier
as their distance from the zone in focus increases. This effect can be activated
by checking the option Active.

By default, the depth of field is also active during navigation within a scene or
when playing an animation.

For the depth of field to be displayed in the 3D viewport, antialiasing must be
activated under the Render Quality Settingsmenu accessible from the viewport
context menu. See Render Quality Settings (Editor) (page 187).

For an image snapshot, the option Antialiasing must be activated in the
Snapshot Images editor.

The value provided in the Aperture field sets the diameter of the aperture of
the lens shutter. The aperture is expressed in millimeters.

The focal distance can be provided here in numerical form. If you prefer to
defined the focal distance interactively, activate the camera.

Once the camera is active in a 3D viewport, you can define the focal distance by
placing the cursor over the zone where the focal point should be positioned
and using one of the following keyboard shortcuts:

Shortcut Action

Ctrl+Spacebar
Places the point indicated by the cursor at the center of the focal plane.
This manipulation may change the direction in which the camera is
facing.

Shift+Spacebar
Places the point indicated by the cursor at the center of the focal plane
without modifying the direction in which the camera is facing. Use this
method to modify the focal point without changing the camera position.

The smoothness of the blurriness, or quality, can be modified by moving the
slider. A higher value increases the quality but requires a longer calculation
time.
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8-6.2.3.2 Motion Blur

The motion blur effect simulates the streaking effect of moving objects or a
moving camera when the object or camera is moving during the time of
exposure.

When theMotion Blur option is enabled, modifying the camera orientation
and position produces a motion blur effect. This simulates the effect of a
physical camera with the capture speed (framerate) provided in the Frames per
second field.

To limit the effects on rendering speed, this effect is applied only to the camera
motion by default. To apply it to animated objects as well, check the Apply to
moving objects option. When applied to moving objects, place the cursor at
the appropriate time in the Timelines editor to see the effects on a static
image.

The motion blur effect is visible in video captures, but is not available in renders
by raytracing.

8-6.2.3.3 Depth Range

The Depth Range box shows the automatically-calculated placement of the
two Z planes between which the camera's view is in focus. You can force a
different position for the Z-near and the Z-far planes by providing new values.

8-6.2.3.4 Point of View

The point of view defines the position and the orientation of the camera. You
can choose between two different modes:

Mode Description

From-To-
Up

Provide the point (X, Y, Z) for the position of the camera, a point along the
camera’s viewing vector, and a point along the vector indicating the upward
vertical axis of the camera.

Position-
Orientation

Provide the point (X, Y, Z) for the position of the camera and its orientation
in Euler angles.
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8-7 Channels (Editor)

Available in:Matter: Timelines > Channel Animation Clips library tab >
double-click on a clip name
Timelines > Channel Animation tracks > double-click on a clip

Channels is an editor that allows you to set up and rename channel animation
clips. The editor will open when you create a new channel animation clip or
when you double-click on an existing clip in order to modify it.

Once open, it will always show the information for the current active clip in the
Timelines editor. To change the clip shown in the editor, select a different clip
in the Timelines editor using one of the following methods:

l Click on the name of a clip in the Channel Animation library tab,
l Click on the representation of a channel animation clip in one of the
Channel tracks,

l Create a new channel animation clip using the button below the list
of existing clips in the Channel Animation library tab. This will
create a new clip and activate it. It will also open theNew Channel
Selector window, where you can provide a name for the clip, select
the channel or channels that will be animated in the clip, and select
the desired type of control over the animation: Standard (basic,
single-channel animation) or Advanced (custom, multi-channel
animation). Validating this choice will open the Channels editor.

The editor will display different controls depending on which configuration
mode you have chosen.

8-7.1 Channel Selector

Access: Timelines > Channel Animation Clips library tab > New channel
animation
Timelines > Channels > Channel Selector

The Channel Selector determines which channels will be available for
animation in a clip. When creating a channel animation clip, you must first
select the channel or channels to include in the clip. The Channel Selector
therefore appears automatically when you create a new clip.
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When using advanced configuration, you can also modify the channels in the
clip at a later time. To add or remove channels from the clip, open the Channel
Selector from the toolbar of the Channels editor.

The main body of the Channel Selector is the hierarchy of channels available
for the active product. There are four ways to find a channel:

l Expand the entries in the hierarchy until you reach the channel you
want to use. Channels are grouped by type, then by option. If, for
example, you want to modify the orientation of an environment
called "Studio_Default", expand the nodes Environment, Studio_
Default, andOrientation. Select the axis or axes you want to
modify.

l By using the mesh eyedropper to pick the animated mesh you
want to use. Click on the eyedropper, then click on the surface in the
3D viewport. This selects the mesh. Expand the mesh in order to
select the Frame channel.

l By using the material eyedropper to pick the material in which
the channel you want to use is found. Click on the eyedropper, then
click on the material in the 3D viewport. This selects the material.
Expand the material in order to view its channels and select the
pertinent ones.

l By using the transformation eyedropper to pick the part that
will undergo the transformation you want to use. Click on the
eyedropper, then click on one of the surfaces of the part in the 3D
viewport. This selects the first parent of that surface in the
Kinematics tab in Shaper.

To add a channel, click within the selection column next to the name of the
channel, or right-click on the channel and select Add channel from the context
menu that appears. The same actions will remove a channel that has already
been added: to remove a channel, click in the selection column of a selected
channel or right-click and select Remove channel from the context menu that
appears. The selection column lists the status of each channel:

Icon Description

Channel included in the clip.

Channel excluded from the clip.

Multiple channels can be added to the clip at once. Highlight the channels you
want to add by clicking on their names while holding down Shift to select a
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range of channels or Ctrl to select separate individual channels. Right-click to
open the context menu and select Add channel to select these channels, or
Remove channel to deselect them.

Once you have selected the channel or channels to add to the clip, choose the
configuration mode. If you have selected only one channel, you will be able to
select Standard configuration if you prefer. Multi-channel clips, however, must
be configured in Advancedmode.

8-7.2 Standard Configuration

The standard configuration of an animation clip is a single-channel mode that
gives you access to all of the parameters needed to animate a channel. The
speed of the animation is calculated automatically based on the range of the
change and the duration of the clip. Both the interval of values for this channel
(the range) and the duration are set in this editor.

At the top of the editor, a text field displays the name of the clip. It can be edited
directly in this field. Use the Enter key to validate your changes.

Below the name of the clip, the following settings are available:

l Initial value of the animated parameter,
l Final value of the animated parameter,
l Duration of the clip in seconds,
l Easing. The value of this option smooths the animation so that the
beginning, the end, or both appear less abrupt. Choose from the
following options:

n Linear : The development of the animation will be
linear. No easing is added.

n Ease in : Easing is added at the beginning of the
animation.

n Ease out : Easing is added at the end of the
animation.

n Ease in and out : Easing is added at the beginning
and at the end of the animation.

Depending on the channel select, the initial and final positions are expressed:

l in the Patchwork 3D Design default units for translation and other
distances,
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l in degrees for rotation and other angles,
l in whole numbers from 0 to 255 for colors,
l in decimal numbers between the minimum and maximum values for
other parameters such as intensity,

l in 0 (disabled) or 1 (enabled) for the state of a binary parameter.

8-7.2.1 Using Preset Values for an Animated Mesh

Choosing an animated mesh and the standard configuration mode allows you
to automatically replicate the animation exactly as it was prepared in Autodesk
Maya or Autodesk 3ds Max.

1. In the Timelines editor's Channel Animation Library, create a new
channel animation.

2. The Channel Selector will appear. Select the animated mesh you

want to use. You can use the mesh eyedropper to pick the
mesh directly from the viewport. Do not select any other channels.

3. Select Standard configuration.

The animation parameters for the mesh are initialized with the values taken
directly from the imported settings that were established in Autodesk Maya or
Autodesk 3ds Max:

l Initial value: frame 0, the first frame of the animation,
l Final value: frame N, the last frame of the animation,
l Duration: the original length of the animation, expressed in
seconds,

l Easing: linear.

8-7.3 Advanced Configuration

Advanced configuration of a channel animation clip handles the animation of
multiple channels at once. It also gives you direct control over the temporal
development of the animation using points placed along a graph representing
time on the X axis and the range of animation of the part on the Y axis. This
produces a curve representing the development of a given channel over time.
Each channel has its own curve.

The Y-axis is expressed in the default units for the selected channel:

l in the Patchwork 3D Design default units for translation and other
distances,
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l in degrees for rotation and other angles,
l in whole numbers from 0 to 255 for colors,
l in decimal numbers between the minimum and maximum values for
other parameters such as intensity,

l in 0 (disabled) or 1 (enabled) for the state of a binary parameter.

The typical steps for using this mode are outlined in the chapter Animating
Channels with Advanced Configuration (page 498).

At the top of the editor, a text field displays the name of the clip. It can be edited
directly in this field. Use the Enter key to validate your changes.

The operations toolbar above the graph provides the following tools:

Icon Function Description

Selection Use this mode to select points placed along the curve.

Pan
In this mode, the mouse is used to move the curve so as to display
the section you are interested in. This does not change the scale of
the graph.

Zoom In this mode, the mouse is used to zoom in or out on the curve,
changing the scale of the graph.

New key
frame

In this mode, clicking places a new key frame along the curve.

A new key frame can also be added by holding down Alt and clicking
when using any of the modes to select and move key frames (see
below).

Select and
change
value

Dragging a key frame changes the value, but not the time. You can
also provide a exact value in the Value field.

Select and
change
time

Dragging a key frame changes the time of the point, but not the
value that has been set. You can also provide a exact value in the
Time field.

Select and
move

Dragging a key frame changes the time and the value. You can also
provide its exact time and value in the corresponding fields.

For any two key frames, increasing the time (horizontal distance)
between them will make the animation slower. Increasing the
difference in values (vertical distance) will make the change more
pronounced.

Key
Frames
editor

Provides access to the key frame options:

n Current key frame,

n Previous key frame,
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Icon Function Description

n Next key frame,
n Key frame Time (horizontal position),
n Key frame Value (vertical position),
n The variations of a channel's value between two
successive key points over time are represented by
curves. The forms of the curves to the Left and to the
Right of a key frame can be one of the following types:

o Curve type  (default),

o Linear type  ,

o Step type  .

The form chosen at a key point for the curve to the left
of the point is applied to all of the curve starting from
the previous key frame. Likewise, the form chosen at a
key point for the curve to the right of the point is
applied to all of the curve until the next key frame. If
another formwas previously applied at a different key
point for the same segment of curve, it will be
overriden by the current choice.

Capture
current
values

Places new key frames at the time cursor position for each of the
selected channels. Each key frame is positioned at the current value
for its channel in the active viewport.

Capture
RGB values

When the curves for the R, G, and B channels of a color parameter
are selected, this button appears. It can be used to open the color
picker, in which you can select a color for the parameter. Once the
choice of a new color has been validated, the new R, G, and B values
are placed at the time cursor's position on the corresponding
curves. If key points do not already exist at this location, they will be
created for the new values.

Channel
Selector Allows you to modify the channels used in this clip.

Zoom to fit Zoom to adjust the scale to fill the display area with the curve,
vertically and horizontally.

Zoom to fit
(selection)

Zoom to adjust the scale so that the selected key frame and curve
segments fill the display area.

Zoom to fit
(horizontal)

Zoom to adjust the scale so that length (time) of the curve fills the
display area.

Zoom to fit
(vertical)

Zoom to adjust the scale so that the height (changes in position or
orientation) of the curve fills the display area.
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To the left of the graph, the list of all of the available curves is displayed. By
default, all of the curves are selected. Modify the selection by clicking on the
names of the curves. Only the selected curves are visible on the graph.

The color of a curve can be customized. Right-click on name of the curve and
choose Change curve color to open the color chooser.

To check the name of a curve on the graph, hover over it with the mouse cursor.
Its name will be displayed in the information bar at the bottom of the main
window.

Below the graph, you have options to provide the maximum duration in
seconds of the animation, and an indicator of the cursor's current position in
theMouse at field.

8-8 Clipping Planes (Editor)

Available in: Matter: Editors > Advanced > Clipping Planes

Clipping Planes is an editor that allows you to section the object of the scene
in a pre-designated plane in order to see its interior.

Active clipping planes are visible in all open viewports and will clip through all
products.

Clipping planes are positioned in the world. Consequently, modifying the position
of a geometry in the world will not move the plane. The position at which the
plane clips the element will be modified.

8-8.1 General Settings for Clipping Planes

The General Options zone provides render settings with the Face Elimination
Policy function, which allows you to show or to hide the backfaces of the
surfaces.

In the Face Elimination Policy drop-down list, the option Surfaces displays
backfaces according to the settings provided in the Surface Properties in
Shaper.

The Show Gizmo option displays a translation gizmo that can be manipulated
to quickly move the plane of the active section.
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The Tags section can be used to prevent surfaces from being clipped by the
plane. Use the button to open a list of tags; select the tag that marks the
surfaces that should not be clipped. Tags are assigned to surfaces using the Tag
Manager in Shaper.

Patchwork 3D Design allows management and display of several Clipping
planes simultaneously. Each plane is listed separately, followed by indicators
for the clipping plane's state (enabled or disabled), the visibility of its contour,
and the visibility of its grid. Clicking on the indicators modifies the state of the
associated property.

8-8.2 Settings for the Selected Plane

The Enabled function in the Clipping Plane zone must be checked in order to
view the clipping plane.

The Clipping Plane zone provides the planar equation used to define the
clipping plane. You can modify it by providing new numerical values.

Alternatively, you can choose a cross-section plane in the Select the Plane
zone:
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l Select the desired cross-section plane in the drop-down list.
l Via the function Pick Plane, you can perform a cross-section
starting with a plane directly selected in the active viewport, using
the eyedropper tool, or alternatively a precise cross-section point by
checking the Position option.

The cross sections are represented automatically in the interactive view each time
the eyedropper tool is used.

8-8.2.1 Creating a Contour

The contour of the clipped surface edges can be visually represented by
enabling the Show option within the Contour zone. The color of the contour
can be modified by clicking on the colored square to open the color selector.
You can also modify the thickness of the line by entering a numerical value, or
by using the up and down arrows of the keyboard.

8-8.2.2 Additional Display Options

The Plane box proposes a set of display options for the active cross-section
plane.

Thus the display of a plane can be activated (Plane zone > Show checkbox)
and the value of its transparency (Alpha field), size (Width andHeight fields),
orientation, and color of its representation (Color1 and Color2) can all be
modified. Alternatively, just a metric grid is displayed (Grid and Step options).
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8-9 Color Chooser

Available in: Matter or Shaper: click on a modifiable color square

Modifiable colors can be clicked on in order to open a color chooser and to set
a new color to be used for the element in question.

Modifiable color squares. Click to open the color chooser.

The interface of the color chooser is divided into two parts:

l On the left, the Color from Picker and Color from Temperature
tabs provide tools for choosing a color. Below them, a zone listing
the color management profiles used by the database.

l On the right, two tabs help you manage the groups of colors used in
your database as color palettes or Adobe color books.

The buttons at the bottom allow you to save or ignore modifications:

Button Description

OK To validate your color selection, which appears in the rectangle to the left, and
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Button Description

to close the color chooser, click on OK. This updates the color of the element
that you are currently modifying.

Reset The Reset button allows you to return at anymoment to the initial color of the
element, shown in the rectangle on the right.

Cancel The Cancel button closes the color chooser without saving any changes.

8-9.1 Color from Picker

The Color from Picker tab provides multiple ways of setting a color:

l Select a color hue, shade, and tint by clicking on the selector.
l Enter color values. Color values can be entered in the following
formats:

n HSV
n RGB
n LAB
n CMYK

8-9.2 Color from Temperature

The Color from Temperature tab provides an alternative method of setting a
color by choosing the temperature of a light source and applying the
corresponding color.



8    EDITORS

Lumiscaphe Patchwork 3D Design 2019.1 X3 p.139

Use the slider or enter a temperature value in Kelvin. The button beside the
Temperature field provides shortcuts to values for common color
temperatures.

8-9.3 Color Palettes

Color palettes group together colors and can save them as an external
resource. A saved palette can be loaded later in another database.

Clicking on a color in the palette will load it in the color picker for use.

The buttons below the list of colors in the open palette allow you to manage
the palette:

Button Description

New

This button allows a new color to be added to the palette. The new color will
appear in the Color Palette list.

The color appears in the color palette. Each newly-created color is named by
default: Color 1. You can rename each color in the text zone situated below the color
palette.

Assign This button allows you to update the selected color in the color palette with the
hue you have set in the color picker to the left.

Delete This button deletes the selected color from the list of colors in your palette.

l Color palettes are saved in the *.kpl format using the button Save to
file.

l Files in the *.kpl format can be loaded by clicking on Load from file
or directly by drag-and-drop from the Windows explorer onto the
Color Palette tab.



8    EDITORS

p.140 Lumiscaphe Patchwork 3D Design 2019.1 X3

Loading a *.kpl file in the Color Palette by drag-and-drop replaces the colors
that are currently listed with those from the *.kpl file. To add the list of colors in
a *.kpl file to the list of colors already present in the tab, hold down the Shift
key during the drag-and-drop.

8-9.4 Adobe Color Books

Patchwork 3D Design supports color books used by Photoshop in the Adobe
Color Book format (*.acb) . In the File Tab (page 60) of the Patchwork
3D Design Settings, you can set the access path to the Adobe directory where
these color books can be found.

Color books present in this directory are accessible via the Color Books tab in
the color chooser. Select your color book from the drop-down list in order to
access the colors.

8-10 Configuration Browser

Available in: Matter or Shaper: Editors > Configuration Browser

The Configuration Browser is for testing and exploring product derivatives.
The Configuration Browser interface is updated automatically according to
the configuration rules created: all symbols used in rules pertaining to the
active product are gathered and displayed in it. The browser lists all available
symbols for the product displayed in the active viewport.

The browser allows you to select which symbols among those available should
be defined for rule evaluation. The selection is made either with checkboxes or
from drop-down lists. All product derivatives may thus be explored.

In Shaper, the Configuration Browser displays only the parameters associated
with geometry, illumination, and position layers. Aspect and environment
layers have no meaning in Shaper and are consequently hidden. If rules using
aspect, overlay, and environment layers have been configured for your product,
you will find these parameters again when you return to theMatter interface.
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8-11 Configurations (Editor)

Available in:Matter or Shaper: Editors > Create Configurations

The configuration system's main tool is the Configurations editor.

Configurations is an editor used to create configuration rules that establish
the behavior of configurable layers for each product in your database. You can
also associate rules together as sets to create configurations, or complex
product variants.

Configurations is organized into tabs:

8-11.1 RULE TAB 141

8-11.2 BROWSER TAB 142

8-11.3 LIBRARY TAB 143

8-11.4 INSPECTION TAB 143

8-11.1 Rule Tab

Configuration rules are created in the Rule tab.

The Rule tab consists of two boxes.

The existing rules are listed in the first, the Rules box.

The following functions are available:

Icon Function Description

New
Simple
Rule

This function opens the Simple Rules editor. In this dialog box, users
create rules that have the following expression: (defined "symbol").
Simple rule creation is detailed in the section Creating Simple Rules
(page 454).

New
Complex
Rule

This function is for creating a rule with the Complex Rules editor.
Complex rules involve the function "defined" as well as the logical
operators "and", "or", "not" and "xor". Complex rule creation is
described in the section Creating Complex Rules (page 461).
Information on complex rule syntax can be found in the chapter Rule
Syntax (page 463).

Replace
String

This function is for replacing the name of a symbol with a new string of
text. It is particularly helpful for changing the prefixes ("partition.") of
several "partition.value_n" symbols simultaneously. The name of the
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Icon Function Description

symbol will be replaced simultaneously in all of the rules where it is
used, as well as in the Configuration Browser.

Delete
Rule This function is for deleting the rule selected in the list.

Rule expressions are entered directly inside the Expression box. The Insert
Tool is for inserting a string corresponding to a simple rule for a defined
symbol.

The Compiler Output box allows for checking rule syntax. If syntax problems
are detected during rule validation, an error message is displayed in this box.

The second box in the Rule tab shows the properties for the selected rule. It
includes the Rule field which allows the selected rule in the list to be renamed.

Edit Rule Expression opens the Complex Rules editor for modifying
rule expressions directly.

The Targets box indicates the target layer(s) of the selected rule.

When a geometry, aspect, position, overlay, or environment layer is defined as

a target for a configuration rule, the icon is displayed next to that layer in
the corresponding layer editor. Clicking on this icon selects the rule in the
Configurations editor.

8-11.2 Browser Tab

This tab is the Configuration Browser. It can also be accessed from Editors >
Configuration Browser.

The Configuration Browser is for testing and exploring product derivatives.
The Configuration Browser interface is updated automatically according to
the configuration rules created: all symbols used in rules pertaining to the
active product are gathered and displayed in it. The browser lists all available
symbols for the product displayed in the active viewport.

The browser allows you to select which symbols among those available should
be defined for rule evaluation. The selection is made either with checkboxes or
from drop-down lists. All product derivatives may thus be explored.
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8-11.3 Library Tab

The Library is for managing and editing configuration sets, that is, groupings of
defined symbols. It includes the following functions:

Icon Function Description

New
Configuration Creates a configuration.

Store
Configuration

Saves changes made to an existing configuration .The current set
of defined symbols is saved, replacing the previous set of defined
symbols.

Restore
Configuration

Load the selected configuration. The defined symbols are then
reloaded into the Browser. You can also double-click the
configuration in the list to load it.

Delete
Configuration Deletes the configuration selected in the list.

The second box includes a field for renaming configurations.

Edit Configuration opens the Symbol Sets editor. This editor lists all
available and defined symbols. In the Available Symbols list, defined symbols
are grayed-out.

Icon Function Description

Define Symbol Adds the symbol selected in the Available Symbols list to the
Defined Symbols list.

Delete Defined
Symbol Deletes the selected symbol from the Defined Symbols list.

8-11.4 Inspection Tab

In the Rules Value box, the list of existing rules is displayed. Rules evaluated as
true with the current defined symbols are highlighted in green, and highlighted
in red otherwise. The expression of the rule selected is displayed in the Rule
Evaluation Trace box. The parts of the rule’s expression displayed in green are
true and the parts displayed in red are false. This tool allows for quick
determination of the reason why a rule is evaluated as false.
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8-12 Configuration Keys (Editor)

Available in:Matter: Timelines > Configuration Keys library tab > double-
click on a key name
Timelines > Configuration track > double-click on a key

Configuration Keys is an editor that allows you to set up and rename
configuration keys used to change the configuration in an animation. The editor
will open when you create a new configuration key or when you double-click
on an existing key in order to modify it.

When creating or modifying a configuration key, the Configuration Key editor
will open. Once open, it will always show the information for the current active
key in the Timelines editor. To change the key shown in the editor, select a
different key in the Timelines editor:

l Click on the name of a key in the Configuration Key library tab,
l Click on the representation of a configuration key in the
Configuration track,

l Create a new configuration key using the button below the list of
existing keys in the Configuration Key library tab. This will create a
new key and activate it.

In the text zone at the top of the Configuration Keys editor, provide a name
for the configuration key or change the key’s current name. It is recommended
that you give each key a different name.

In the Configuration zone, all of the configuration symbols are listed. Each
symbol is paired with a drop-down menu of the possible values. Choose a
value for each symbol.

You can choose to impose a new value for each of the symbols, or you can use
the default value, Keep previous value, for certain symbols. As a general rule, it
is best to impose a new value only for the symbol(s) that should be modified by
the configuration key.

Choosing symbol values will determine the animation behavior when the
playback reaches the activation point of the key in a timeline:

l If you set a new value, the configuration will be modified.
l If you leave the default Keep previous value for a symbol, the value
of the symbol will not change during playback. Use this value to
create keys that can be used in multiple situations. This is
particularly useful if you have configuration elements that are
independent of one another.
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8-13 Database Properties (Editor)

Available in: Shaper or Matter: File > Edit Database Properties

Each database possesses a set of properties concerning the displayed
rendering, the color management, and the database format and creation. This
information can be viewed or modified in the Database Properties.

8-13.1 Rendering Tab

A database's rendering options are used to optimize Patchwork 3D Design's
performance with certain less powerful hardware configurations. In the
Rendering tab, the options Force texture dimensions in powers of two and
Reduce Lightmap Size work to limit the resources required for rendering.

These options are intended for advanced users. Enabling these options can
affect your rendering in unexpected ways, particularly where smaller
databases are concerned.

8-13.2 Color Management Tab

The colorimetric profile defines the interpretation of the color values (RVB,
CMYK or LAB) by matching them with measurable physical quantities
(expressed in the space CIE XYZ or LAB). For the rendering and adjustment of
materials displayed on the screen to be consistent with the colors and the
shades of the real materials, it is essential to work in a defined colorimetric
space. Patchwork 3D Design provides tools for defining, installing and
managing the colorimetric profiles of the workspace, of imported images and
of images produced by the software.

In this tab, you can consult and modify the profiles used by the open database.

To set the behavior concerning color management profiles for new databases,
refer to the settings available in the Color tab of the File > Settingsmenu item.
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8-13.3 Application Tab

This tab contains information on the origins of the open database. The name
and version of the application with which it was last saved are displayed.

8-14 Environment Properties (Editor)

Available in:Matter: sidebar environment library > Edit

The Environment Properties is an editor used to modify the properties
of the active lighting environment.

Certain HDR environment properties are updated in real time as they are
modified. These properties are indicated below.

8-14.1 General Properties

General Properties:

Property Description

Name
Displays the name of the environment. This name can be changed by
providing a new name in this field. Use the Enter key to validate any
changes.

Gamma Allows you to change the gamma value of your image. Useful in some
cases for correcting the gamma value of the imported HDRI image.

Saturation

Allows you to adjust the color saturation of the environment image. Its
value varies from 0 (environment image in black and white) to 1
(environment image in saturated colors). This property can be adjusted
in real time.

Mapping Type Allows you to define the projection method for the type of HDRI image.

Invert Allows you to invert the projection of the environment image.

Default
Orientation

Initializes the orientation of the environment in order to position it
correctly with regard to the product.
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Diffuse:

Property Description

Exposure
Correction

Allows you to adjust the influence of the exposure of the environment
on the diffuse layer of a material. It is a coefficient applied to this
contribution. This property can be adjusted in real time.

Lightmap
Coloration

Allows you to adjust the influence of the environment color on the
diffusion of the materials using lighting textures.

Specular:

Property Description

Exposure
Correction

Allows you to adjust the influence of the exposure of the environment
on the specular or reflection layer of a material. It is a coefficient applied
to this contribution. This property can be adjusted in real time.

Resolution Allows you to define the resolution of the image used for adjusting the
mirroring.

High Quality
Filtering

Eliminates whitening and aliasing effects environment reflections on
sharp geometries in scenes with very intense areas.

Reflection of an environment featuring a high intensity area in a specular material
without the High quality filtering option.
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Reflection of an environment featuring a high intensity area in a specular material with
the High quality filtering option.

Background:

Property Description

Alternative
background
map

Allows a high resolution texture in a low dynamic range format (jpg,
png...) to be used instead of the HDR environment for environment
materials.

Exposure
Correction

Allows you to adjust the influence of the exposure of the environment
on the background. Its value is a coefficient applied to this
contribution. This property can be adjusted in real time.

Altitude Allows you to adjust the altitude of the background.

Resolution Allows you to define the resolution of the image used for the
background.

The image below illustrates the impact of the general properties on the render:
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Here the red light source is placed out of the viewport, to the right of the image.
This red component can be seen bleeding across the white bodywork.

8-14.2 Parallax Correction

Reflections generated by a local environment are calculated from the
environment's position. However, the observer's position is often different
from the environment's position. This may produce a visible difference
between the physically realistic reflection of the environment and the reflection
actually observed in the scene.

Parallax correction uses proxy surfaces in order to correct for the shift due to
the use of different reference points for the observer and the environment.
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Property Description

Type

The type of proxy surface to use:

l None: no correction,
l Box: a cube,
l Hemisphere: a hemisphere,

The settings for each type of proxy surface are discussed below.

Automatic
adjustment (...)

When a box or hemisphere proxy surface is used, Patchwork 3D Design
can estimate its required volume in order to match the environment
zone as closely as possible. Run this operation using the ... button. It
may be necessary to fine-tune the results.

Gizmo Show or hide the highlighting of the proxy surfaces.

8-14.2.1 Box

Use a box as a proxy when the space that should be used for the environment
is mostly box-like.

Boxes are always aligned on the grid. They are defined by their minimum and
maximum values along the X, Y and Z axes.

In the corresponding fields, enter the minimum and maximum coordinates
along the X, Y and Z axes.

8-14.2.2 Hemisphere

Use a hemisphere as a proxy when the space that will be used for the
environment is similar to a hemisphere shape.

A hemisphere is defined by the length of its radius and by the position of the
hemisphere's central point.

Provide the coordinates for the central point, and indicate the length of the
radius.

8-14.3 Local Environment Properties

Local environment properties set the capture zone for a local environment.

Icon Property Description

Product Associate the environment with an existing product. Drag and
drop the product onto this field.
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Icon Property Description

Dynamically
rebuild when
configuration
changes

Activate automatic updating for the local environment when
changing configurations. This insures visual coherence in the
reflections of geometries, colors and lighting in the scene when
the displayed configuration is modified.

Position Set the origin point at which the local environment will be
captured by providing the origin's XYZ coordinates.

Display and
move the
capture box

The capture box makes it easier to visualize the zones fromwhich
the local environment images are going to be captured. It can
repositioned with the mouse.

Pick the
capture
origin

Set the origin point of the local environment capture in the
viewport using the eyedropper. The X, Y, and Z values of the
clicked point are automatically entered in the Position fields.

Refresh
environment

Update the environment by recalculating the images captured by
the local environment box.

Radius Adjust the size of the capture box.

Resolution Block the resolution of the environment texture at a chosen
resolution. Select the desired resolution from the list.

Exclude
surfaces with
tags

If the surfaces of an object around which an environment local is
assigned have been tagged, they can be ignored by the local
environment. Provide the tags of these surfaces here.

For more information on tags, see Tag Manager (page 226).

8-15 GPU Consumption (Editor)

Available in: Shaper or Matter: Editors > Advanced > GPU Consumption

In order to render a database, Patchwork 3D Design consumes GPU resources.
The elements to be rendered are stored in the graphics card. The amount of
resources required will vary with the complexity, size, and detail of the element
to be rendered, while the total quantity of available resources depends on the
graphics card.

The analysis tools provided in GPU Consumption help to find anomalies or
user practices that contribute to an overconsumption of GPU resources.

8-15.1 Running an Analysis

Before moving forward, you run an analysis of the GPU resources that are used.
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This analysis must be run from Matter.

1. Choose what you would like to analyze from the drop-down menu.
The analysis can be limited to what is currently displayed in the
active viewport, or it can reflect all of the products, along with their
configurations, that are part of your database. An analysis of the
current viewport will take less time to run than an analysis of the full
database.

2. Start the analysis by clicking on . This operation may take
some time.

Once the analysis has finished, you have access to the two tabs that provide
two different overviews of the results: the summary of consumption and the
detection of overconsumption.

8-15.2 Summary of Consumption

The Summary tab provides a global overview of the GPU consumption.

The consumption is organized by tab based on the type of Patchwork
3D Design resource. The label for each table shows the type of Patchwork
3D Design resource, followed by the total consumption for this type of
resource. The unused Patchwork 3D Design resources that are still present in
the database are not taken into account in the total consumption.

The following categories of resources are analyzed:

Type of
resource Definition Additional information

provided

Textures Images and videos used as textures,
including backgrounds

Resolution in pixels, color
profile format

Lightmaps Resolution in pixels,
lightmap format

Bumpmaps Textures used as bumpmaps Resolution in pixels

Environments Resolution in pixels

Meshes Number of vertices, number
of triangles

The summary presents the analysis results as a table:
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l Resource: the name of the Patchwork 3D Design resource,

Environments created by Patchwork 3D Design in order to display
specular reflections are listed under the name "Cube map."

l Size: amount of GPU memory allocated,
l Information,
l Activation: This column is only present for textures and bumpmaps.
A comment is displayed if the resource is inactive. A texture will be
classified as inactive, for example, if it is used as a Color map in a
material applied to a surface in the active viewport but for which the
checkbox enabling use of a color map is not checked in the
Materials editor.

Several operations to manage this information are available:

l Click on a column header to sort by that column.
l Double-click on an item to expand the list of elements using this
resource.

l Right-click, then choose Activate to select the element in the
interface.

The Show only selected surfacesmode displays only the elements
concerned by an operation. In Shaper, activate the mode Show only
selected surfaces with the S key. When you choose the option
Activate for a group of surfaces, they are displayed. The rest of the
model is hidden. InMatter, when the Activate option opens the

Materials editor, use the Only show active material button
to display only the surfaces using this material.

A total consumption of GPU resources is indicated at the bottom of the editor.
This total is the sum of the subtotals listed for each resource tab. The total
consumption corresponds to the analyzed context only: if the analysis covers
only the current viewport, other viewports are ignored. If the analysis covers all
products in the database, other databases that might be open in another
instance of Patchwork 3D Design and other sources of GPU consumption are
not included.

From this tab you can export the summary in .csv format.

The GPU memory consumption gauge, which is available in the render statistics,
shows total GPU consumption, including consumption sources external to
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Patchwork 3D Design. By contrast, the summary of consumption only shows
elements created directly or indirectly by a user in Patchwork 3D Design.
Consequently, slight differences may exist between the totals reported by the two
tools. See Render Statistics (page 97).

The GPU resource purge wipes the resources used for inactive viewports from the
graphics card. This operation has no impact on the summary of consumption,
which provides information regarding either the active viewport or all products in
the database, regardless of their presence or absence in a viewport. For more
information on this function, see Purging Unused GPU Resources (page 102).

8-15.3 Detection of Overconsumption

The Detection tab offers customizable detection rules that can be used to find
the elements that use significantly more resources than others without
contributing to an improved overall rendering.

8-15.3.1 Rules

Each rule is based on a limit that can be set based on your requirements. The
limits that you indicate are saved by Patchwork 3D Design and will be available
in all databases that you open on the same computer.

The default values are given for demonstration purposes only and may not be
appropriate for your usage of Patchwork 3D Design.

The following rules are available:

l Size of the texture in pixels,
l Number of layers in a multilayer material,
l Number of triangles in a surface,
l Average area of a triangle for a surface in mm2.

Check the boxes next to the rules you would like to use in your detection.

Verify the value of the limits. If necessary, modify them by typing a new value
directly in the field, by clicking on the field and using the up and down arrows
on the keyboard, or by clicking on the arrows beside the field.

Obtain the results by clicking on one of the buttons at the bottom right of the
editor.



8    EDITORS

Lumiscaphe Patchwork 3D Design 2019.1 X3 p.155

8-15.3.2 Colored Display

displays the results of the detection in the viewport by coloring each
surface.

Color Level

Gray This surface was not included in the analysis
that was run.

Green No over-consumption was detected for this
surface.

Yellow This surface exceeds a detection rule by up
to 50%.

Orange This surface exceeds a detection rule by 50-
100%.

Red This surface exceeds a detection rule by
100% or more.

While the colored display is active, the viewport is surrounded by a white box.
To quit this display mode:

l Press the Esc key.

l Click the button again.

8-15.3.3 List of Results for All Surfaces

opens a window listing the results of the detection for all surfaces. These
results are presented in the same format as the summary. However, only the
cases exceeding the rules' limits are listed.

The color of each line indicates the magnitude of noncompliance with the
provided rule limits:

Color Magnitude of noncompliance

Yellow Between 100% and 150% of the limit

Orange Between 150% and 200% of the limit

Red Greater than 200% of the limit

Various operations allow you to manage the results of the detection:
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l Sort: Click on the column header to sort the list.
l Find an element: Right-click on an entry, then choose Activate to
find the element in the interface.

Close this window by clickingOK.

8-15.3.4 Results for a Picked Surface

allows you to pick a specific surface to analyze. The cursor will change to
an eyedropper.

Click on the desired surface in the viewport. A new window will open.

This window contains the detection results for the selected surface only. The
results are presented in the same format as the summary. However, only the
cases exceeding the rules' limits are listed.

The color of each line indicates the magnitude of noncompliance with the
provided rule limits:

Color Magnitude of noncompliance

Yellow Between 100% and 150% of the limit

Orange Between 150% and 200% of the limit

Red Greater than 200% of the limit

Various operations allow you to manage the results of the detection:

l Sort: Click on the column header to sort the list.
l Find an element: Right-click on an entry, then choose Activate to
find the element in the interface.

Close this window by clickingOK.

8-16 Gradients (Editor)

Available in:Matter: Editors > Materials >  in the Gradient zone

The editor Materials gives access to Gradients, an editor that allows you to
create your own gradients or to modify pre-existing gradients in Patchwork
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3D Design. These gradients are used to display a different color depending on
the angle at which a surface is viewed.

This parameter is available for the following types of material:

l Standard material:Diffuse andDiffuse and Reflection types,
l Multilayer material:Diffuse and Illumination layers,
l Labels using the same types or layers as above.

To open this editor, click on the gradient icon in the Gradient zone.

You will find the same configuration of operations, namely operations to
Create, Import, Save or Delete a gradient, as in the other types of editor.

The new gradient created appears in the Gradient palette and is named by
default gradient 0, gradient 1, etc. You can rename it directly in the input field
relating thereto.

Icon Function Description

Delete Delete a gradient from the palette

Import Load a gradient. The imported gradient is saved in the Gradients
directory by default.

Save Save a gradient. The modifications are saved in the Gradients
directory by default.

l In the Gradient zone, slide one of the two squares under the
Gradient banner head to modify the gradient, or enter a value
directly in the Angle field.

l Modify the color using the Color Chooser, accessible by clicking on
the Color square.

To open the Color Chooser, click on one of the two squares of the Gradient
banner head. The gradient created is displayed in the banner head. For more
information on modifying colors, see Color Chooser (page 137).

Icon Function Description

Create a
new
gradient

Create your gradient directly using the color chooser, then click this
button.

Assign
the new
gradient

To assign a new gradient to an element in the palette, select the
gradient you want to assign the new colors to, then click this button.
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To modify a gradient of the Gradient Palette, select it and double-click on it.
The gradient is displayed in the viewer.

The Position as Ramp Access Angle parameter allows you to specify a
gradient angle.

8-16.1 Importing Gradient Ramps in .csv Format

Gradient ramp files in *.csv format are supported.

With the Import gradient button, you can import *.kgr gradient files
generated by this editor, or *.csv gradient files.

l Select the gradient file in *.kgr or *.csv format that you would like to
import from your workstation.

l Click on Open to validate.

The imported gradient is added to the gradient palette.

For a *.csv file, the name of the *.csv file is used as the name of the new
gradient.

Valid .csv files begin with a header line, followed by lines listing the gradient
angle and the colors to apply at that angle. The colors are expressed in one of
the following encodings:

l RGB Profile (page 159)
l CIE Lab Profile (page 159)

The values contained in each line must be separated by a comma (,); if the line
contains decimal numbers, they must use a point (.) as the decimal separator.

Element Accepted Values

Header as first line Required

Value separator ,

Decimal separator .

End of line No special character

If the file structure is not respected, the importer will stop. The error message
that is show will indicate the line in your file where the first structural error was
found.
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8-16.1.1 RGB Profile

Element Accepted Values

Required header line angle,R,G,B

Angle Whole numbers from 0 to 90 inclusive

R Whole numbers from 0 to 255 inclusive

G Whole numbers from 0 to 255 inclusive

B Whole numbers from 0 to 255 inclusive

If the accepted values are not respected, the importer will replace any value that
is out of range with the minimum or maximum accepted value, whichever is
closer. For example, an angle value of 100 degrees will be replaced by the
maximum accepted value, that is, 90.

EXAMPLE

angle,R,G,B
0,255,255,255
1,255,255,255
2,255,255,255
3,255,255,255
…
90,255,204,0

8-16.1.2 CIE Lab Profile

Element Accepted Values

Required header line angle,L,a,b

Angle Whole numbers from 0 to 90 inclusive

L Decimals from -128.0 to 128.0 inclusive

a Decimals from 0.0 to 100.0 inclusive

b Decimals from 0.0 to 100.0 inclusive

If the accepted values are not respected, the importer will replace any value that
is out of range with the minimum or maximum accepted value, whichever is
closer. For example, a L value of -130 will be replaced by the minimum
accepted value, that is, -128.

EXAMPLE
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angle,L,a,b
0,100.0,0.0,0.0
1,100.0,0.0,-0.000001
2,100.0,0.0,-0.000001
3,100.0,0.0,-0.000001
…
90,88.122,1.933,50.797

8-17 KeyboardMap (Editor)

Available in: Shaper or Matter: File > Keyboard Map

The Keyboard Map is an editor used to verify the default keyboard and mouse
shortcuts and to modify them. By default, shortcuts are assigned to a small
portion of the available actions. This editor can be used to assign shortcuts to
any available operations or to remove shortcuts from actions you don't often
use.

The editor is divided into two tabs: Actions andNavigation.

8-17.1 Actions

In the Actions tab, on the left of this window is the list of operations used in
Patchwork 3D Design. These operations are combined into several groups:
Application,Matter, Shaper, Surface Cutting Workshop, Timelines, and
Unfolding Workshop. The group selector allows you to display the operations
of a group in the list of operations. By selecting an operation, its description, the
associated icon and the assigned shortcut if there is one will appear on the
right.

To assign a new shortcut to the selected operation, click the Enter... button and
then press the desired key on your keyboard that you wish to use. The shortcut
entered then appears in theNew shortcut zone. If an operation is currently
assigned to this shortcut, it is displayed in the Currently assigned to zone. By
clicking the Assign button, this shortcut is assigned to the selected operation.
An operation previously assigned to this shortcut is no longer assigned to it.
You can remove the shortcut assigned to an operation at any moment by
clicking the Remove button.

The system of predefined configurations allows you to easily load one of the
keyboard configurations supplied by default with Patchwork 3D Design. The
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user configuration corresponds to the keyboard configuration that is currently
being use in Patchwork 3D Design. Use the OK button to assign your new
configuration to the keyboard. Use the Cancel button to cancel any changes
you have made. It is also possible to display the keyboard shortcuts in an HTML
file by clicking the Show as HTML button.

8-17.2 Navigation

TheNavigation tab displays the navigation modes that are accessible via
shortcuts. The profiles in the Presets list offer default choices among the
shortcut navigation configurations used in 3ds Max, Alias, Maya, and
Solidworks, as well as those used by default in the Patchwork 3D universe. The
buttons New, Rename, andDelete to the right manage the list of presets. Each
preset configuration is entirely modifiable.

Modifications are made in the same manner as in the Actions tab. To assign a
new shortcut to a camera action, select the action from the list on the left. Select
the mouse button, and, if necessary, the modifier keys for the navigation
shortcut. If a camera action is currently assigned to this shortcut, it is shown in
the Currently assigned to zone. By clicking the Assign button, shortcut is
assigned to the selected camera action. A camera action previously assigned to
this shortcut is no longer assigned to it. You can remove the shortcut assigned
to a camera action at any moment by clicking the Remove button.

8-18 Layer Visibility (Editor)

Available in: Matter: Editors > Layer Visibility

Layer Visibility is a control panel for the visibility of geometry and lighting
layers, as well as lighting layer colors. These types of layers are managed
directly in the Shaper sidebar, without the help of a dedicated editor. Layer
Visibility affords an overview of the hierarchy of layers and provides controls
over their visibility inMatter.

The editor is organized into two tabs: Geometry and Illumination. The layer
hierarchy is displayed in the corresponding tab. Next to each layer's name, an
icon indicates the layer's current state: visible or hidden. An illumination
layer's color sets are indicated as enabled or disabled in the same manner as in
the Shaper sidebar tab.
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The visibility of lighting layers is a viewport-level property. When the first
viewport is opened, the visibility state is initialized with the state set in Shaper.
From then on, modifications made in Layer Visibility are applied both to the
active viewport and to the visibility state saved in Shaper. When additional
viewports are opened, the last saved state in Shaper is used.

8-18.1 Modifying a Layer's Visibility

Modifying a layer's visibility changes what is shown in the active viewport.

Modify the visibility state of a layer in the Layer Visibility Editor:

l To modify the visibility state of a geometry layer, click on the
Geometry tab. Find the layer you would like to modify, then click on
the icon representing that layer's current visibility state.

l To modify the visibility state of a lighting layer, click on the
Illumination tab. Find the layer you would like to modify, then click
on the icon representing that layer's current visibility state.

This switches the visibility state. If the layer was hidden, it will now be visible. If
it was visible, it will now be hidden.

The visibility state icon will change to reflect the new state.

8-18.2 Modifying the Intensity and the Color of an Illumination
Layer

Color and intensity of lighting layers are model-level properties. Modifying the
intensity or the color of a lighting layer will have an effect on all of the
viewports displaying the model.

In the Illumination tab, find the layer you would like to modify. Click on the
color or the intensity of the lighting layer in order to modify its value.

Modifications are made in real time.

8-19 Layer Visibility Bookmarks (Editor)

Available in: Shaper or Matter: Editors > Layer Visibility Bookmarks
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Layer Visibility Bookmarks is an editor that stores sets of visibility states of
geometry layers.

This editor's interface consists of an area for exploring layer visibility
bookmarks and includes some simple tools for editing and enabling these
bookmarks.

In the exploration zone, Bookmarks, the bookmarks are listed by name and can
be selected. This zone contains the list of all existing layer visibility bookmarks.

Icon Function Description

New

Creates a new bookmark. This button saves the current set of
visibility states.

To create layer visibility bookmarks, set each layer's desired visibility
option directly in the Layers zone in the Shapersidebar, then create a
new bookmark.

Rename Modifies the name of the selected bookmark.

Sort Sorts the list of saved bookmarks in alphabetical order by name.

Activate Loads the layer visible states saved in the selected bookmark.

Update Updates the selected bookmark by replacing the saved state with
the current visibility states in the active viewport.

Delete Deletes the selected bookmark.

8-20 Live Mode (Editor)

Available in:Matter: Editors > Live Mode > 

Live Mode is an editor that associates a chosen surface with one or more
chosen animations. These associations are then used in Livemode, a
navigation mode in which clicking on designated surfaces or pressing preset
keys triggers animations.
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8-20.1 Defining Triggers

The editor that sets up Livemode is composed of two main sections: the list of
animations associated with a trigger, followed by the operations toolbar where
the buttons are located.

The list of triggers contains all of the animations with a trigger. For each
animation, the following information is displayed:

Title Information

Trigger The name of the surface or Shaper object that acts as a trigger when clicked
to start the animation.

Play Mode The name of the playback mode. This mode defines what happens when a
trigger is clicked again after the playback of an animation has been started.

Animation The name of the channel clip or the timeline that will be played.

This list can be sorted. Click on the column header by which you want to sort
the list.

You can double click on a trigger in the list to edit it.>

The operations toolbar contains the following buttons:

Icon Operation

Add a trigger.

Switch to Live mode in the main window.

Delete the selected triggered animation. This disassociates the trigger and the clip
or timeline, and removes the animation from the list in this editor. The clip or
timeline is not deleted from the database.

Creating a new triggered animation requires two steps: creating a trigger, then
associating it with a clip or a timeline.

You must have created at least one clip or timeline in the Timelines editor.
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8-20.2 Creating a Trigger

Use the button to add a trigger. Two types of triggers are available:

Type Function

Mouse This type of trigger plays a clip or a timeline when you click on a specific surface
in the scene.

Keyboard This type of trigger plays a clip or a timeline when you press a specific key on
the keyboard.

First, select the type of trigger.

For a mouse trigger, select the surface, or kinematics node. You can do so using

the list or by clicking on the button to use an eyedropper to pick a
surface, a null, a vector or a rotation axis. When using a null, a vector, or a
rotation axis, all of its child surfaces will function as triggers.

For a keyboard trigger, click on the button to record the keystroke that will
function as a trigger.

8-20.3 Associating a Clip or a Timeline

Once the trigger has been saved, a new window opens. Select the clip or the
timeline to be associated with this trigger.

One trigger can play multiple clips or activate multiple timelines. Each triggered
action will be listed separately. You can select multiple clips or timelines by
holding down Shift or Ctrl; this simultaneously creates several different lines with
the same trigger, one for each selected element.

8-20.4 Choosing a PlayMode

Choose one of the four modes from the Play Mode drop-down list. This mode
defines the behavior of the playback if the trigger is clicked again while the
animation is playing.

Mode Description

Continue Click on the trigger for a playing animation to pause it.
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Mode Description

Click on the trigger for a paused animation to resume playback fromwhere it
left off.

Reset Click on the trigger for a playing animation to restart it from the beginning.

Reverse
with pause

Click on the trigger for a playing animation to pause it.

Click on the trigger for a paused animation to resume playback fromwhere it
left off, playing the animation backwards.

Reverse
without
pause

Click on the trigger for a playing animation to reverse the direction of
playback: the animation will play backwards from the current point.

If you do not choose a mode, the Continuemode is used by default.

Click OK to save this triggered animation or click Cancel to close this window
without saving.

8-21 Materials (Editor)

Available in: Matter: Editors > Materials (F5)

Materials is an editor that provides access to the parameters of the
active material.

The interface is organized into two functional zones:

l Operations bar and material name.
l Settings for a given type of material, usually organized in tabs,
followed by global options applied to all tabs. You can find more
information on the options specific to each type of material in the
corresponding sections.

The operations bar provides access to basic material operations:

Icon Function Description

Drag-and-
drop start
point

Drag the material being edited from this point and drop it on a
surface in a 3D viewport to assign it.

Selection
eyedropper

Select the eyedropper, then click on a material assigned to a surface
in a 3D viewport. This will make the selected material active and
allows it to be edited.
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Icon Function Description

Solo
Material

The Solo Materialmode hides all surfaces except the ones to which
the current material is assigned. This visualization mode applies in
all of the open viewports. This button both enables and disables the
Solo Materialmode.

Select all
the
surfaces

Click on this button to select in Shaper all the surfaces that have the
same material.

Create a
new
material

Click on this button to open the window to choose a type of
material. When you validate your choice, a new material of that type
will be created.

Duplicate
the
material

Click on this button to duplicate the active material whose settings
are shown in the editor. The new material is made active when it is
created.

Text
field

Name of
the
material

The text field shows the name of the active material. Tho change it,
click within the text field and use the Enter key to validate your
changes once you have finished.

The specific settings for each material class make up the rest of this editor. They
are described in the chapter Materials (page 351).

8-22 Measuring Tool

Available in: Shaper or Matter: Editors > Advanced > Measuring Tool

TheMeasuring Tool shows the distance between two points that you have
chosen. This distance between these two points may thus be represented
visually in the active view.

The Show the gizmos option must be checked to use the eyedroppers.

l Click on the green eyedropper and select your starting point in the
viewing window.

l Click on the yellow eyedropper and designate the end point in the
scene.

The result is displayed in the Distance field of theMeasure zone at the bottom
of the editor.

The distance is represented visually.
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The Enable Depth Test function allows you to show the gizmos measuring the
distance between measuring points in the scene without them being obscured
by surfaces. Uncheck this parameter to display the points and the measurement
above all the surfaces.

8-23 Overlays (Editor)

Available in: Matter: Editors > Overlays

Overlays is an editor that enables the parameters of the active overlay to
be edited.

The interface is divided into four zones:

l Operations bar and name of the active overlay: Displays operations
available in the overlay library.

l Global parameters: Field for managing the alpha coefficient, which
sets the level of transparency.

l Layers: Manages the appearance, placement and location of images
used as an overlay, as well as any background gradation. You must
create at least one layer.

As with other types of layers in Patchwork 3D Design, the layers in an
overlay can be used to create configurations. To make overlay layers
configurable, drag them from this zone and drop them in the
Configurations editor, where they can be placed either in the target
zone, or in the rules zone to create a basic configuration. For more
information, see the section Configurations (Editor) (page 141)

l Map: Used for managing the texture file and scale of the texture.

The following operations are available from the operations bar:

Icon Description

Start point for assigning an overlay by drag-and-drop to a sensor or to a
viewpoint.

Picking eyedropper used to choose, activate and edit an overlay used in a
viewport.

Apply the overlay currently being edited to the camera sensor in the active
viewport.
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Icon Description

Create a new overlay.

Duplicate the current overlay.

Overlays also includes functions that simplify editing:

l Clicking on the name of theMap in use leads to the current texture
group in theMatter sidebar's texture library.

l The Layer visibility icon is automatically selected when a layer is
created, rendering the layer visible by default.

8-24 Position Layers (Editor)

Available in: Shaper or Matter: Editors > Position Layers

Position Layers is an editor used to create layers in which Shaper object
positions can vary. These layers can then be used in the configuration system to
create variants in which the position of certain objects is not the same.

This editor consists of a Layer tab at the top of which is found a list of existing
position layers. The default position layer named Base Layer is displayed in this
list.

Each position layer in this list has a visibility toggle button for enabling and
disabling visibility. The symbol indicates which position layer is visible.
When a layer is hidden, the symbol is displayed. The icon indicates the
active position layer. In order to make a position layer active, click within the
check-mark column beside the layer you want to make active.

The following operations can be performed on position layers:

Icon Function Description

Pick Active Position Layer
Mode

This command is for selecting the position layer
associated with the position of the clicked surface
from the viewport.

New Position Layer A new position layer is created and added to the list
of layers.

Duplicate Position Layer This command creates a copy of the selected
position layer. The Base Layer cannot be duplicated.
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Icon Function Description

Merge Layer Selection This command merges selected position layers.

Delete Position Layer The selected position layer is deleted. Base Layers
cannot be deleted.

Evaluate All Layers in
Stack

This command displays the product taking all
position layers in the list into account.

Evaluate Layer Stack
Until Active Layer

This command displays the product taking into
account the selected position layer and the layers
lower in the hierarchy only. A red border around
the viewport indicates that the view is displayed
with a restricted list of position layers.

Evaluate Active Layer
Only

This command is for restricting the visibility of the
position layers to the selected layer.

Highlight Active Layer
Assignments

This command enables/disables highlighting of
surfaces that have an assignment in the active
position layer.

Hide Surfaces Without
Assignments

This command enables/disables the displaying of
the surfaces without an assignment.

The Layer field of the Layer box at the bottom of the editor is for renaming
selected position layers. It should be noted that the Base Layer cannot be
renamed.

8-25 Post Processing (Editor)

Available in:Matter: Editors > Post-Processing

Post-Processing is an editor used to create, enable/disable, combine,
program and assign 2D post-processing effects interactively. It creates and
modifies a blend of effects, their properties, and the way they are combined.

Once post-processing blend is assigned to the Patchwork 3D Design scene,
viewing of the created effects is instantaneous; adjustment of the various
effects is done in real time.
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Function Description

Start point for assignment by drag-and-drop.

Assignment of a post-process is also possible fromMatter sidebar's post-
processing library. See Post-Processing Library (page 421) for more
information.

Allows an post-processing blend to be selected with a click on the viewport
in which it is active.

Creates a new post-processing blend.

Duplicates the active post-processing blend.

Text field The text field is for renaming the active post-processing blend.

Apply to
background

Enables or disables the application of the post-processing effects to the
background in the Patchwork 3D Design scene.

Apply to
overlays

Enables or disables the application of the post-processing effects to the
overlays in the Patchwork 3D Design scene.

In the Post-Processing Effects box:

Function Description

This toggle button is for enabling/disabling a specified post-processing effect.
This icon indicates that the effect is enabled.

This icon indicates that the effect is disabled.

TheNew effect button is for adding a new effect to the post-processing
currently being edited. Many effects are available. See the chapter Post-
Processing Effects (page 411).

The Solo effect toggle button is for momentarily isolating the selected effect.
A green frame around the 3D view indicates that only the isolated effect is
displayed.

The Delete effect button is for deleting the selected effect from the list of
post-processing effects in the blend being edited.

Effect
properties
zone

The effect properties frame is for precisely defining the various parameters
contained in a post-process, by assigning precise numerical value.
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8-25.1 Advanced Menu

The Advanced sub-menu gives access to the various tools and options for
combining several effects with one another.

The rendering possibilities are numerous and the effects obtained can be
extremely variable depending on the parameters used for combining the
effects.

Typical effect obtained by combining effects: Film grain + Edge detector + Tone
Mapping + Hand drawing + Get 3D image.

Get 3D image is for restoring the initial 3D image (without post-processing).

Store current result is for saving the image with the combination of activated
effects.

Restore saved result is for restoring the image with the previously saved
combination of effects.

Combine with saved result is for combining the image obtained by the latest
activated post-processing effect with the previously stored image.

The associated parameters are for precisely adjusting the influence of one
image relative to the other.

Multiply/Add is for adding or multiplying the image by a factor.
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Grain generator is for generating grain (simple filter used in the photo grain
advanced filter).

8-26 Product Environments (Editor)

Available in:Matter: Editors > Product Environments.

Product Environments provides the tools to prepare your environments
for displaying your products. It also manages environment layers. Environment
layers allow for the creation of several product variants with different
environments. These layers can then be used in the configuration system.

8-26.1 Environment Layers Tab

Environment layers are created in the Environment Layers tab.

The name of the product in the active viewport is displayed at the top of this
tab. The rest of the tab is composed of the Environment Layers,
Environments, and Surfaces using environment boxes.
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8-26.1.1 Environment Layers Box

This box contains a list of the existing environment layers. Each layer has a
toggle button to activate or deactivate its visibility. The symbol means that
the layer is visible. When a layer is hidden, this symbol is barred. The icon is
used to pinpoint the active layer, which will receive all the new environment
allocations.

The following operations can be performed on the environment layers:

Icon Function Description

New
Environment
Layer

A new environment layer is created and added to the list of
existing layers.

Duplicate
Environment
Layer

Creates a copy of the selected environment layer. The mention
"Copy" is added to the name of the created layer.

Rename
Environment
Layer

This operation opens a dialog box which allows the selected
layer to be renamed.

Solo
Environment
Layer

This operation displays the surfaces affected by an
environment contained in the selected layer only.

Delete
Environment
Layer

The selected environment layer is deleted. The minimum
number of environment layers is one.

When the Product Environments editor is opened, it already contains a layer
calledDefault. When opening a database created with a version of Patchwork
3D Design prior to version 5.5, the environments assigned to the product are
automatically imported in this layer.

When no environment layer is selected, the name of the default environment is
displayed in the Environments box. When all environment layers are hidden, the
default environment is used.

As with aspect and position layers, the position of environment layers in the
layer list is taken into account when displaying environments on the product.
The layer hierarchy is assessed from the top to the bottom of the list:

l The first allocation of a global environment found in a layer is
displayed in the product.
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l If, for a given surface, any environments are specifically assigned,
the highest-ranking of these environments is applied, even if a
higher-ranking global environment is defined.

8-26.1.2 Environments Box

This box displays the list of environments contained in the selected layer of the
Environment layers box. A global and several surface-specific environments
can be present is the same layer.

Selecting an environment in this box displays the list of surfaces affected by this
environment in the Surfaces using environment box.

The following actions can be performed on a selected environment:

Icon Function Description

Solo
Environment

Restricts the rendering to the surfaces affected by the
environment selected in the list.

Set Active
Environment

Defines the selected environment as the one considered active in
theMatter sidebar's environment library.

Find
Environment

Selects the corresponding environment in theMatter sidebar's
environment library.

Remove
Environment

Removes the assignment of the selected environment from the
surfaces using it in the current layer.

To set an environment as a global environment in the active layer, drag and
drop it onto the product.

To assign a local environment, drag and drop it onto the targeted surfaces.

In order to replace an environment in the active layer, drag and drop the
desired environment from theMatter sidebar's environment library onto the
name of the environment to be replaced in the list of the Environments box. It
is also possible to drag and drop the desired environment onto a selection of
surfaces in the Surfaces using environment box to assign it to the selection.

8-26.1.3 Surfaces Using Environment Box

This box lists the surfaces affected by the environment selected in the
Environments box.

The following actions can be performed on the selected environment(s):
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Icon Function Description

Solo
Surfaces Restricts rendering to the selected surfaces.

Reset
Orientation

Resets the orientation of the environment affecting the selected
surfaces. This feature applies only to surfaces for which the
environment has been specifically reoriented. These surfaces are

tagged with the icon .

Remove
Environment

Removes the assignment of the environment specific to the
selected surfaces.

Surface names displayed in italics and crossed out correspond to surfaces
which possess an unused environment allocation. For a global environment
allocation this occurs either when another global environment allocation is
listed higher in the layer hierarchy, or when a surface-specific environment
exists. For a surface-specific environment, this occurs when another surface-
specific environment allocation is listed higher in the layer hierarchy.

8-26.2 Product Environment Properties Tab

The Product Environment Properties tab presents the functions used to
prepare environments by adjusting their orientation or by defining the specific
settings for the use of a real-time sun.

It contains four boxes: Environments,Orientation, Real-Time Sun, and
Environment’s Brightest Point.

8-26.2.1 Environments Box

This box lists the environments that are globally allocated in the product or
specifically allocated to certain product surfaces. Selecting an environment
from this list gives access to its orientation settings, to the real-time sun
settings, and to the settings for the definition of its brightest point. The settings
for the selected environment are modifiable when the environment is the
product’s active environment. Otherwise, they are visible as read-only.
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8-26.2.2 Orientation Box

The Orientation box is designed to modify the two following types of
orientation:

l Environment orientation in the product. This orientation can also be

modified by activating the Environment Orientation mode
and moving the environment directly using the mouse. The global
orientation of the visible environment under the mouse is modified,
even when the environment is a surface-specific environment
affected to multiple surfaces.

l Surface-specific orientation, typically used to reorient reflections on
a given surface. This operation is also performed by activating the

Environment Orientation mode and moving the
environment by using the mouse to click and drag while holding the
Shift key, or from the Surface Properties.

This orientation feature does not impact the environment’s default orientation
stored in the environment properties, which is used for initializing the
environment orientation in the product upon allocation.

In order to change the selected environment’s orientation from the
Environments box, enter the desired value for the orientation with regard to
the X, Y and Z axis in the corresponding fields.

You can reload the default orientation at any time by clicking the Use default
orientation button.

In order to save an environment orientation as the default, click on the Set as
default orientation button.

8-26.2.3 Real-Time Sun Box

The settings in this box are used to adjust the real-time sun specific to the
selected environment.

The settings established for the Real-Time Sun can be overridden by the
settings established specifically for the selected environment by checking the
box Use the following Sun Settings for this environment. The available sun
settings function identically to those in the Sun Settings box of the Real-Time
Sun editor.
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If no real-time sun is active for the product as a whole, it is still possible to use a
specific real-time sun in an environment by ticking the checkboxes Apply the
following sun settings when using this environment andOn.

8-26.2.4 Environment’s Brightest Point Box

This box is used to specify the brightest point of an environment in order to
position the real-time sun with the help of the positioning option Extracted
from Environment. This can be set up either manually or by an automatically
search.

To run the automatic identification of the position of the brightest point in the
environment, select the environment in the Environments box, then click Find
automatically. The brightest point of the current environment is then
identified by a square on the displayed environment.

It is also possible to click directly on the displayed environment to pinpoint the
desired direction of the real-time sun.

The sun remains fixed relative to the environment when the environment
Orientation feature is used.

8-27 Product Properties (Editor)

Available in:Matter > Editors > Advanced > Product Properties (F8)

Product Properties is an advanced editor used to override surface property
settings from Shaper when viewing the product.

The product name displayed at the top of the editor indicates which product is
being edited. The product name can be modified from this field.

Property Description

Has its
own
surface
visibility

When this option is checked, surface visibility states in Shaper are ignored.
This enables you to hide a surface in Shaper, but still view the surface in
Matter, allowing you to work on your model simultaneously in Shaper and in
Matter.

When this option is enabled, a surface may also be hidden in Matter but visible in
Shaper. Set the visibility of a surface in Matter by right-clicking on it and selecting
Visibility to change its state.

Always When this option is enabled, all backs of surfaces are rendered, even if they
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Property Description

draw
backfaces

8-28 Raytracing Settings (Editor)

Available in: Matter: Editors > Raytracing Settings

8-28.1 Rendering tab

The Raytracing Settings window contains all parameters needed to configure
the rendering.

The image quality is determined by the activation of various options:

Parameter Description

Adaptive
antialiasing

Enables the adaptive sampling of the scene: more rays are sent on pixels
representing a zone with high color variations, thus strongly reducing
aliasing. This option is enabled by default.

Use surface
environments

Instructs the raytracing motor to use the lighting environment assigned
to surfaces rather than the global environment when reflecting zones
outside of the scene. Disable this option to use the global environment
instead. This option is enabled by default.

If the surface is dressed with a material that has a roughness value greater
than zero, by default the surface will not be rendered by the raytracer. To
render a material with roughness using the raytracing engine, make sure that
the Raytrace roughness option is selected in the Raytracing tab of the
Materials editor.

You may adjust the Ray rebounds parameters to obtain a rendered view with
the desired quality, by first adjusting theMaximum Recursion Level
(maximum number of rebounds) reached during calculation.

In the Reflections box, the adjustable parameters are:

Parameter Description

Max Reflections Maximumnumber of reflections allowed during calculation.

Max Rough
Reflections

Maximumnumber of rough reflections allowed during
calculation.
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Similarly, the following parameters can be set in the Transmissions box:

Parameter Description

Max Transmissions Maximumnumber of transmissions allowed during calculation.

Max Rough
Transmissions

Maximumnumber of rough transmissions allowed during
calculation.

When a pixel is rendered, reflections and transmissions are computed until
Max Recursion level,Max Reflections, or Max Transmissions is reached. The
End of course color parameter from the last material hit is then used to
determine if either a predefined color or the environment should be used to
compute the render. The End of course color parameter is set in the
Raytracing tab of theMaterial editor.

It should be noted that setting the maximum number of rough reflections and
transmissions to a high value will drastically increase computation time. Rough
reflections and transmissions exponentially increase the number of traced rays.
If a ray is sent through a ground glass with a transmission roughness value set
to 100, 100 rays will be generated for the first hit, and then 100 other rays will
be generated when each of these rays will touch the rear face of the glass. More
than 10 000 rays will be therefore used to compute a single pixel. TheMax
Rough Reflections andMax Rough Transmissions parameters should thus
be used with caution to reduce computation time.

The Raytrace roughness for all materials option in the Reflections and
Transmissions boxes overrides roughness raytracing for all materials without
considering parameters from the Raytracing tab of theMaterial editor.

The Override roughness sampling option is also available in these two boxes.
It allows the roughness sampling value from the Raytracing tab of the
Material editor to be disregarded. This override applies to all materials.

The option Use environment instead of background for refracted rays
determines the behavior taken into account when rays pass through a
transparent surface. When this option is enabled, the refraction of rays passing
through a transparent surface redirects them towards the lighting environment
instead of the background. If a significant difference, such as a difference in
color, exists between the lighting environment and the background, this can
produce unexpected effects. Consequently, it is possible to ignore the refraction
of rays passing through transparent surfaces by unchecking this box. This
option is enabled by default but is never taken into account when rendering
multi-layer images in a .psd format.

The Viewport Raytracing box provides the option to automatically add views
rendered by raytracing to the Rendered Views History. To activate this option,
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tick the Automatically add to Rendered Views History on render checkbox.
This option is deactivated by default.

8-28.2 Remote tab

Patchwork 3D Design allows you to configure and use remote CPU from units
(cluster) to generate a snapshot with raytracing rendering engine.

For hardware requirements (main PC and calculation units) please, see Minimal
Configuration (page 35) and Recommended Configuration (page 35)

In the Remote tab, parameter are:

Parameter Description

Use remote
raytracing

Enables raytracing calculation on remote units (PC) running a
specific software:Raytracing cluster unit.

Check the Use remote rendering checkbox to enable remote
raytracing feature.

Units to be used
for rendering Allows you to add remote rendering units for raytracing calculation.

IP IP from each remote rendering unit.

Port
Port of each remote rendering unit.

This port can be changed.

Status

Status of each remote rendering unit.

l Offline (remote rendering unit is not ready for
raytracing calculation)

l Available (remote rendering unit is ready for raytracing
calculation)

l Uploading (send data to a remote rendering unit)
l Rendering (sending data to the remote rendering unit)

This box contains a list of configured remote rendering units. You can also
select or unselect separately units with this symbol .

The following operations can be performed on this box:

Icon Function Description

Add remote rendering unit Add a remote rendering unit.
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Icon Function Description

Remove remote rendering unit Remove highlighted remote rendering unit.

Load remote rendering units
file Import a list of IP units from a text file.

Select all remote rendering
units Select all remote rendering units.

Disable all rendering units Disable all remote rendering units

8-29 Real-Time Sun (Editor)

Available in:Matter: Editors > Real-Time Sun

Real-Time Sun is an editor used to set up and display a sun that can be
modified in real time in your products.

Example of real-time sun usage.

In order to spare memory usage, decrease the maximum size of lighting and
shadow textures in File > Settings > Lighting tab. Default values are
nevertheless desirable.

This editor is composed of five boxes: Sun Settings, Shadow Settings,North
Setting, Position, and Raytracing.
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This editor state is saved individually for each product. Data related to the Real-
Time Sun is included in databases exported in KDR format.

8-29.1 Sun Settings Box

The Sun Settings box provides a set of adjustable parameters for creating a
real-time sun.

Setting Description

On Check the On box to activate the real-time sun in your product.

Color Click on the Color box to open the color chooser and pick the color
to assign to the sun.

Intensity

Enter in this field the value of the desired intensity of the sun. This
value must be positive. Unlike the sun type lightings available in the
Shapermodule, intensity is adjusted according to the sun altitude.

Example of sun intensity variation.

Real-time sun lighting is added linearly to the existing lightmaps in the
model. If your model has very bright lightmaps, the effects of the sun
will not be as visible.

Shadow
intensity

By default, no light intensity is added to areas which are not sunlit.
However, by entering a value in the Shadow intensity field, you can
apply an additional light intensity in these shadow areas. The value
entered must be positive. The value 0 corresponds to a realistic
effect.

Example of shadow intensity variation.

Lightmap Adding a real-time sun to the lightmap of a product can produce an
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Setting Description

modulator

intensity of a lightmap that is too strong. If this is the case, you can
modify the intensity of the lightmap. The field Lightmap modulator
is used to set a modulation coefficient for the intensity of the
lighting calculated in the Shapermodule. The value of this
coefficient must be between 0 and 1. The value 0 assigns a null
intensity to the lightmap. The value 1 corresponds to the
assignment of the lightmap as it is calculated in the Shapermodule.

Specular

Tick this check box to display the sun’s specular reflection on your
product. Enter its intensity in the corresponding field.

Example of a scene without and with the sun’s specular reflection.

8-29.2 Shadow Settings Box

Parameters specific to shadows are included in this box.

Setting Description

Shadows in
mirrors

Tick this check box to display shadows on reflective surfaces. The
activation of this option extends the rendering time.

Shadow
quality

Select the quality of shadows to display from the drop-down
menu. The higher the selected quality is, the longer the rendering
time will be.

Shadow
smoothness

Select the width for the blur effect on shadow edges from this
drop-down menu. The more the shadows are smoothed, the
longer the rendering time will be.

Examples of different smoothness in shadows.
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8-29.3 North Setting Box

TheNorth Setting box is used to set up the north relative to the reference axis
of the database. There are three ways to set up the north direction:

l By entering a value between 0 and 360° for the angle between the X
axis and the North arrow of the compass,

l By clicking on the compass while holding the left button of the
mouse, and dragging it to the desired position,

l By clicking on the grid to define the orientation of the compass.

Positioning the compass at a 20.2° angle between the x axis and the compass.

8-29.4 Position Box

The Position box consists of three tabs, one for each sun positioning mode.

8-29.4.1 Manual Tab

This tab allows for defining the sun position by entering a value for the
Azimuth and the Altitude or directly with the widgets by clicking or bringing
the sun onto the desired position.

Manual tab.

Azimuth is the angle in the horizontal plane between the sun direction and the
north.
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Altitude is the angle between the sun direction and its projection onto the
horizontal plane.

8-29.4.2 Date, Time and Location Tab

This tab allows the sun to be located so as to mimic its position in the sky at a
given date and time for a specific location. To do this, select or enter the date
and time of your choice in the corresponding data field. Then provide the time
zone with the drop-down menu. Areas of the world in darkness are updated on
the map.

To activate the shift for daylight saving time, check the Daylight savings box
and enter the value in minutes of the desired shift. This is only active on days
when daylight saving time is applicable (from the last Sunday of March to the
last Sunday of October).

Next, specify your location of choice:

l By entering values for latitude and longitude in the data fields – the
City field then displays User defined,

l By selecting a city in the City drop-down menu, or
l By clicking directly on a point on the map – the City field also
displays User defined.

8-29.4.3 Extracted from Environment Tab

Select this tab in order to position the sun at the point defined in the
Environment’s Brightest Point box in the Product Environment Properties
tab of the Product Environments editor. Positioning the sun in the Product
Environments editor is explained in the section Environment’s Brightest Point
Box (page 178).

8-29.5 Raytracing Box

The features in this box are used to activate the calculation of smooth shadows
in the raytracing computation.

Check the Use soft shadows box to activate smooth shadows in the raytracing
computation. Then, specify the desired Sun angular diameter and Sample
count for the sun. The shadow smoothness increases with the angular aperture
of the sun.
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8-30 Render Quality Settings (Editor)

Accessible from: Matter: viewport context menu (right click on the name of
the current camera) > Render Presets > Edit Render Quality Settings

The render quality settings establish the rendering strategy in the 3D viewport.
These are advanced settings. Three preset profiles are available in the Render
Presets submenu to simplify modification of the render quality settings:

l Standard,
l Fastest,
l Nicest.

The presets cannot be modified or deleted. To use a similar profile, first copy
the preset, then modify the new profile.

The top of the editor is dedicated to a preset profile management section:

l Drop-down menu: all of the existing profiles are listed,
l New: create a new profile,
l Delete: delete the selected profile. Preset profiles cannot be deleted.
l Rename: rename the selected profile,
l Copy: create a copy of the selected profile,
l Make default: set the selected profile as the default profile to use
when opening a new viewport. This profile is saved in your
application preferences and is also applied when you open a new
editing session in Patchwork 3D Design.

The render settings in this editor are applied or disabled depending on the
phase of your interaction with the 3D viewport. The current interaction or
inactivity with the viewport constitutes the context, shown in the drop-down
menu:

Context Description

All The settings displayed when the context All is selected are applied to all
contexts. That is, they are always applied.

During
interaction

The settings displayed when the context During interaction is selected are
applied while you navigate or work in the 3D viewport.

At end of
interaction

The settings displayed when the context At the end of interaction is
selected are applied immediately after you stop navigating or working in the
3D viewport. 

While idle The settings displayed when the contextWhile idle is selected are applied
only when the viewport is inactive.
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Each context is associated with a set of parameters:

Parameter Description

Render Mode

Imposes a rendering style. In addition to theMaterialmode, which is
the standard rendering mode inMatter, all of the Shaper rendering
options are also available:

n Wireframe: surfaces are represented schematically with
plotting following the lattice structure of each surface. The
surfaces are not mutually masked.

n Smooth: surfaces are shown smoothed out with solid
faces, lit by soft lighting.

n Smooth and Highlights: surfaces are shown smoothed
out, as solid faces with a specular reflection.

n Facets: surfaces are represented by their lattice structure,
not smoothed out, as solid faces lit by soft lighting.

n Facets and Highlights: surfaces are represented as a solid
lattice structure, not smoothed out, as solid faces with a
specular reflection.

n Lit Wireframe: surfaces are represented by an illuminated
wireframe plot of their lattice structure.

n Bounding Box: each surface is represented by the
wireframe plot of its bounding box. This rendering mode
facilitates the handling of surfaces that have lattice
structures comprising a large number of triangles.

Mirror
reflections Displays reflections in mirror materials when this option is checked.

Mipmaps

Allows the use of texture mipmaps. This option, which may use a
significant amount of GPUmemory depending on the capacities of your
graphics card, improves the render of textures when they are displayed
on the screen on a scale much smaller than their natural size. This is the
case, for example, when they are applied to objects that are positioned
far from the camera.

Post-Processing Allows post-processing effects to be displayed.

Real-time depth
of field

Activates the real-time depth of field, which applies to navigation and
to the playback of animations.

For the depth of field to be displayed in the 3D viewport, the software
antialiasing must be activated (see below). For an image snapshot, the
option Antialiasingmust be activated in the Snapshot Images editor.

FXAA
Enables or disables the fast approximate GPU antialiasing filter. It is best
to use either the software antialiasing or the GPU's fast approximate
antialiasing, but not both at the same time.

Specular
anisotropic
filtering

The slider's position set the level of samples for the specular anisotropic
filtering. This filter is enabled when its value is greater than 1. It
provides improved rendering for textures viewed and an oblique angle.

The parameter for the software antialiasing is composed of multiple options:
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Option Description

Enabled Enables software antialiasing when the checkbox is ticked.

Progressive
depth of
field

Displays the various stages of progressive render refinement during the
calculation of depth of field (except real-time depth of field).

This option is not recommended if you are also using Real-time depth of
field.

Samples Sets the level of definition via the number of renders per pixel of the final
image.

Wait time

Sets the wait time before passing from the context At end of interaction to
the contextWhile idle. This delay does not include the time required by the
refinement to the rendering, which can be consequential with certain
configurations.

It is also possible to exclude certain types of materials from the render in a
given context. By default all material types are rendered. Untick the checkboxes
of the materials to exclude:

l Error: the render when an error prevents the material from being
displayed,

l Null opaque: the render when no material is applied to the surface,
l Opaque standard,
l Transparent standard,
l Seam,
l Matte,
l Environment,
l Opaque mirror,
l Transparent mirror,
l Multilayer,
l Labels.

8-31 Rendered Views History

The Rendered Views History is a tool available to compare several views of
products in Patchwork 3D Design. It saves rendered views, displays them as
miniature images, and restores their original size. It shows views taken of any
of the products in a database.

Available in: Matter: Editors > Rendered Views History.

The views are saved as soon as they are added to the Rendered Views History.
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To select a view in the Rendered Views History, click on the corresponding
miniature. Several views can be selected at once:

l By holding down the Shift key (for a continuous selection) or the
Ctrl key (for a discontinuous selection).

l By holding down the left mouse button and drawing a rectangle
over the desired views.

The Rendered Views Historyin Patchwork 3D Design also loads the views
rendered with the Raytracing Editorin versions 5.2 to 5.4.

8-31.1 Operations Toolbar

This toolbar located at the bottom of the Rendered Views History provides the
tools to manage the views in the history.

Icon Function Description

Add
rendered
view

Saves the view in the active viewport to the history.

Export
views

Allows the selected views to be exported by saving each view as a
separate image file. When this button is clicked, it opens the Export
images dialogue box.

Reload
view
bookmark

Repositions the camera in the active viewport to the position that
was used to create the selected view.

Rename
rendered
view

Allows the view to be renamed. Each view must have a unique name.
If the user enters a name that has already been assigned to another
view in the history, the Rename rendered view function will add a
number to the end of the duplicate name: Product (1).

Delete
selected
views

Deletes the selected views.

The Export images dialogue box shows a list of the selected views, the choice
of the directory where the files will be saved, and the choice of file format to be
generated.

Some of these operations are available in the context menu that is accessed by
right-clicking on a view. The actions chosen from the context menu affect only
one view at a time.
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From the context menu, you can Export view, Reload view bookmark,
Rename view or Delete view.

8-31.2 Engines Used for Rendering

The view image is rendered by the engine used to calculate it in the active
viewport. If any part of the active view is calculated by raytracing, the image will
be rendered by the raytracing engine. However, if the view is calculated by the
OpenGL engine, the image will be rendered by this engine.

The engine used to render the view (OpenGL or Raytracing) is indicated on the
upper part of the thumbnail.

Indication of rendering engine on thumbnails (OpenGL engine on the left; raytracing
engine on the right).

The raytracing engine can be set up to automatically add views rendered by
raytracing to the Rendered Views History.

Click on Raytracing Settings in the Editors toolbar or browse to Editors>
Raytracing Settings. An option in the Viewport Raytracing box allows the
Automatically add to Rendered Views History on render option to be
activated or deactivated. This option is deactivated by default.

8-31.3 Recalling a View

Double-clicking on a view will recall it in the active viewport. The size of the
original image is restored and the viewport is resized accordingly.

8-32 Selections (Editor)

Available in: Shaper: Editors > Selections
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Selections is an editor used to save sets of selected Shaper objects.

This editor's interface consists of three tabs.

8-32.1 Saved Selections

The Saved selections tab provides access to the operations on simple
selections.

Operation
element Description

TheNew Selection button is for saving the currently-selected
surfaces as a new selection set.

This text field is for renaming the current selection.

This zone provides a list of the saved selections.

The Delete selection button is for deleting the active selection.

To activate one of these saved selections, double-click on its name in the list.

8-32.2 Selection by Type

Surfaces can be selected by type.

8-32.3 Regular Expression Selections

The Regular expression selections tab provides access to the operations on
advanced selections by regular expressions.

Icon Function Description

Save all the regular
expressions

Saves all expressions of complex selections in a file. This
allows the same expressions to be used in several
databases.
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Icon Function Description

Open regular
expressions file Import and recall a saved file of complex selections.

Create regular
expressions group Creates a new group of regular expressions.

Delete regular
expressions group Deletes the selected group of regular expressions.

Create regular
expressions based
selection

Creates a new regular expression to use as a selection
criterion.

Delete regular
expressions Deletes the selected regular selection expression.

EXAMPLE

A selection of all the objects named box will have the following regular
expression: box*.

A group of regular expressions containing the following regular expressions: box*
and cyl* will select in one go all the objects named box and all the objects named
cylinder.

To activate a selection by regular expression, double-click on its name in the list
of regular expressions.

To activate a selection group by regular expression, double-click on its name in
the list of regular expression groups.

8-33 Sensors (Editor)

Available in:Matter sidebar sensor library > New Sensor
sidebar sensor library > Edit the Selected Sensor
Editors > Sensors

The interface is organized into two functional zones:

l Operations toolbar and sensor name,
l Sensor settings.

The operations toolbar contains the basic operators for sensors:
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l Drag the sensor that is currently being edited from this point
and drop it onto a 3D viewport to use it.

l Select the eyedropper, then click on a 3D viewport. This sets
the sensor used in that viewport as the current active sensor and
allows it to be edited.

l Click on this button to create a new sensor.

l Click on this button to duplicate the sensor currently being
edited, whose settings are shown in the editor. The new sensor is
activated as soon as it is created.

l The text field indicates the name of the active sensor. Click in the text
field to modify the sensor's name and validate your changes with
the Enter key when you have finished.

Choose the projection type. By default, a sensor is created in perspective mode,
but you can activate the isometric mode instead by ticking the Isometric
projection checkbox. Isometric projections are used in industrial drafting: there
is no perspective and the dimensions are not modified by the distance to the
viewpoint. When the isometric mode is active, the options in the Aspect Ratio
zone are grayed out. This zone contains settings that are not applicable to an
isometric projection.

If you set up a camera in perspective mode, you can set the sensor size in the
Aspect Ratio zone:

l Aspect preset: Select an option from the drop-down list. You can
choose from among common formats (such as 16:9) or select the
option to define your own format. To the left, the Sensor size field
displays the equivalent size in terms of a sensor of a physical camera
(such as 36x24).

l If you have chosen a custom ratio in the list of presets, provide the
ratio you would like to use as a ratio in the Aspect ratio field or in
camera sensor sizes in the Sensor size field. Some sensor sizes are
preset for you; you can choose one of these in the Preset drop-down
menu if you have chosen a preset aspect ratio.

Overlays, backgrounds, and post-processing effects are applied to the sensor.
To apply an effect, drag it from its library in theMatter sidebar and drop it in
the corresponding field in this editor. You can remove the application of an
effect to a sensor by clicking on the Remove button beside the effect.
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8-34 Snapshot Batcher

Available in:Matter: Snapshot > Snapshot Batcher

The Snapshot Batcher is used to delay the rendering of a list of snapshots. It
improves the fluidity of the workflow by allowing a user to batch snapshots in
order to launch the rendering operations at a more convenient time.

Snapshots batched for delayed rendering are automatically saved when the
database is saved.

8-34.1 Snapshots Box

The Snapshots box contains a summary of all of the snapshots listed for
delayed rendering. Snapshots are added using the various snapshot editors
(Snapshot Image, Snapshot Video, Snapshot VR Object, Snapshot Cubic VR
Panorama).

The list of captures is associated with the active viewport. When the active
viewport is changed, the snapshots corresponding to that viewport or product are
no longer shown, though they remain in memory. Reactivate the original viewport
to recover the corresponding snapshots.

The Snapshots box contains a list organized into four columns. Each row of the
list represents a snapshot.

l The selection column shows an icon of a checked box when the
snapshot is selected. Selected snapshots will be rendered by the
batcher when the rendering is launched.

l TheName column shows the name of the snapshot. This name is
either provided by the user or automatically assigned by the batcher.
During rendering, this name will become the filename.

l The image column displays a miniature image of the snapshot to be
rendered. The rendering engine that will be used (OpenGL or
Raytracing) is indicated on the upper part of the miniature. In the
lower right-hand corner, a symbol represents the type of snapshot.

l The Parameters column provides the following information:
n image size,
n file format,
n snapshot type;
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n rendering engine to be used for the snapshot (OpenGL or
Raytracing) and corresponding options;

The list of snapshots can be ordered alphabetically by column by clicking on
the column header.

Double-clicking on a snapshot in the Snapshots box restores the snapshot in
the active viewport with that of the snapshot and opens the editor that
produced the snapshot. According to the type of snapshot created, the
following information, saved at the moment the snapshot was taken, is
restored.

Type of snapshot Information

Image snapshot

l image size,
l rendering engine used for the snapshot (OpenGL or
Raytracing) and engine specific options,

l point of view, camera specific parameters and depth of
field,

l product’s aspect, position, environment, overlay, and
geometry layer visibility,

l clipping planes and real-time sun settings.

Video snapshot

l image size,
l render engine used for the snapshot (OpenGL or
Raytracing) and engine specific options,

l animation frame rate,
l camera path and specific options,
l product’s aspect, position, environment, overlay, and
geometry layers visibility,

l clipping planes and real-time sun settings.

Cubic VR panorama
snapshot

l render size,
l render engine used for the snapshot (OpenGL or
Raytracing) and engine specific options,

l cubic VR panorama specific options,
l product’s aspect, position, environment, overlay, and
geometry layer visibility,

l clipping planes and real-time sun settings.

VR object snapshot

l image size,
l render engine used for the snapshot (OpenGL or
Raytracing) and engine specific options,

l camera path,
l VR Object specific options,
l product’s aspect, position, environment, overlay, and
geometry layers visibility,

l clipping planes and real-time sun settings.
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8-34.1.1 Selecting Snapshots

The Snapshot Batcher differentiates between the current active snapshot and
the captures selected for rendering.

The current active snapshot is designated by clicking on it. It is shown with a
light gray background or surrounded by a dotted border.

The selected snapshots are marked with the selection icon in the Snapshots
box.

To select or deselect a snapshot, click within the space of the first column to
show or hide the selection icon.

8-34.1.2 Snapshot Context Menu

Right-clicking on one of the snapshots brings up the Snapshot context menu.

This menu, which affects the current active snapshot, allows the user to:

Operation Description

Render
current
snapshot
item

Clicking on this option opens the Save options dialogue box containing the
save settings. This rendering operation does not delete the snapshot from
the Snapshot Batcher.

Duplicate
snapshot The text "Copy" is added to the name of the duplicate snapshots.

Rename
snapshot You cannot have multiple snapshots with the same name.

Delete
snapshot The programmed capture will be deleted.

8-34.2 Operations Toolbar

This toolbar provides the tools to lance rendering and to manage the selected
captures in the Snapshots box.

Icon Function Description

Render
snapshots

Launches the rendering for all of the selected snapshots. Clicking on
this button opens the Save options dialogue box. This dialogue box
contains the save settings for the snapshots to be rendered.
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Icon Function Description

Select
none

Unchecks the selection boxes for all of the snapshots in the
Snapshots box.

Select all Checks the selection boxes for all of the snapshots in the Snapshots
box.

Rename
snapshot

Renames the current active snapshot in the Snapshots box. You
cannot have multiple snapshots with the same name.

Duplicate
snapshot

Duplicates the current active snapshot in the Snapshots box. The
text "Copy" is added to the end of the name of the duplicate
snapshots.

Delete
snapshot Deletes the current active snapshot.

8-34.3 Adding and Modifying Screenshots Using the Screenshot
Editors

Snapshots are added to the Snapshot Batcher using the various snapshot
editors: Snapshot Image, Snapshot Video, Snapshot VR Object, or Snapshot
Cubic VR Panorama. These editors can be accessed via the Snapshot menu.

The validations buttons are located at the bottom of each of the editors.

Validation buttons in the snapshot editors

The Replace Current Snapshot Batcher Item button replaces the active
snapshot in the Snapshot Batcher with the snapshot created by the open
snapshot editor.

The Add to Snapshot Batcher places the current capture parameters from the
Snapshots box of any snapshot editor in the Snapshot Batcher for rendering
at a later time.

8-34.4 Rendering from the Snapshot Batcher

Launch the rendering of the selected snapshots by clicking on the Render

snapshots button . The Save options dialogue box will open.
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The Output directory sets the directory in which the snapshots are saved. The
image files for the snapshots are named after the corresponding view.

When Confirm overwrite is not checked, all files with conflicting names in the
output directory automatically are overwritten. If Confirm overwrite is
checked, you are asked confirmation for each conflicting file before rendering.
If you choose not to overwrite a file, the rendering for the corresponding view
is skipped.

Once the saving options are set, click OK to start rendering. Clicking on Cancel
closes the Save options dialogue box and brings you back to the Contact sheet.

During the rendering, a dialogue box displays the operations performed, along
with any potential errors and warnings.

8-35 Snapshots (Editors)

Available in:Matter: Snapshot > Snapshot Image / Snapshot Videos /
Snapshot VR Objects / Snapshot Cubic VR Panoramas

The five snapshot editors capture the rendering in a viewport and use it to
generate a high-definition image, video or 3D environment. Each editor is
adapted to its specific media format: images, videos, 360-degree videos, 3D
virtual reality objects, or virtual reality cubic panoramas of 3D spaces.

All five editors, however, have the same structure and many shared settings.

Once the settings are defined, click on the Render button to generate each
snapshot used to compose the required media output.

In this section:

8-35.1 SHARED SETTINGS 200

8-35.2 SPECIFIC SETTINGS FOR IMAGES 205

8-35.3 SPECIFIC SETTINGS FOR VIDEOS 206

8-35.4 SPECIFIC SETTINGS FOR PANORAMAS 209

8-35.5 SPECIFIC SETTINGS FOR VR OBJECTS 214

8-35.6 SPECIFIC SETTINGS FOR CUBIC VR PANORAMAS 215
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8-35.1 Shared Settings

8-35.1.1 Dimensions of the Media Output

The dimensions and resolution for the image to be rendered are provided in
the Dimensions zone.

The Format drop-down list, available for all types of snapshot except cubic VR
panoramas, provides access to the most commonly-used sizes and formats.
Certain formats, such as User Defined or User Defined in Units allow the
dimensions to be provided directly as values. By default, Patchwork 3D Design
proposes the formatDefined by Viewport.

Custom formats can be added to this list from the User Presets tab in the
Patchwork 3D Design Settings.

8-35.1.2 Rendering Engine

Each editor offers the choice of the rendering engine to be used: OpenGL or the
Raytracing engine.

8-35.1.2.1 OpenGL

The Configure button beside the OpenGL selection opens the OpenGL
Settings window.

Choose whether or not to apply:

l Antialiasing,
Mipmaps,

l Mirror reflections,
l Alpha background.

Choose the level of Super Sampling from the drop-down list.

Use the slider to define the level of Specular Anisotropic Filtering.

Click on OK to save your changes.
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8-35.1.2.2 Raytracing

The Configure button beside the Raytracing selection opens the Raytracing
Settings window. For more information on these settings, see the chapter
Raytracing Settings (Editor) (page 179).

8-35.1.3 Files

The Files zone contains the controls for the creation of an image file.

In this zone you can set:

l The output directory where the image file will be saved, as well as
the name of the file and its extension,

l Whether to Open File Selector or not when rendering. When this
option is selected, clicking on the Render button will show the
dialogue box offering the choice of file name and type. This option is
selected by default.

Image rendered for VR objects and for cubic VR panoramas are saved
in the Snapshots directory by default.

To change the format of the file to be created, change the extension
of the file name. The following file formats are supported for image
output:

n .jpg
n .png
n .bmp
n .tif
n .exr
n .hdf
n .psd

The following file formats are supported for video output:

n .avi
n .png
n .jpg
n .bmp
n .tif

l Whether to Confirm Overwrite or not when rendering. When this
option is selected, if a file with an identical name is detected,
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P3D Conf Explorer requests your confirmation before replacing it
with the file being created. This option is selected by default.

l The configuration of the compression according to the file type,
l The configuration of the layered export for .psd files.

Images with an alpha layer must be saved as .png files to keep their transparency.
In these cases, the format .png is automatically proposed by default.

8-35.1.3.1 Compression

Click on the Configure Compression button to open the Compression
window.

The compression can be adjusted for each file format for export. For each
format, the higher the value is, the better the quality will be.

l JPEG: slide the cursor to define the compression.
l PNG: slide the cursor to define the compression. Tick the Export as
16 bits checkbox if you want to activate this option.

l Image Compression for Animations: slide the cursor to define the
compression.

l Image Compression for VR Objects and Cubic VR Panoramas:
slide the cursor to define the compression.

If you are configuring the compression for a multilayer image, use the PSD
options. The available options for multilayer images are:

l No compression: the output file will not be compress,
l RLE: RLE compression mode is used,
l ZIP: output file is compressed using the ZIP format.

To export as a file using 16 integer bits, check Export as 16 bits. By default,
export is performed using 8 integer bits. Floating point formats (with 16 or 32
bits) are not available.

8-35.1.3.2 Layered Image Options

The snapshot export in PSD format feature allows for exporting various layers
of a view being captured. Each exported layer is saved as a layer in the PSD file.

To export an multilayer image, select the file extension *.psd, then choose the
layers to add to the file. Click on the Configure Layered Export to open the
Layered Image Options window. The settings defined in this window apply to
images exported as *.psd files only.
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You can choose to export a layer for each of the following options:

l Composable Image containing three layers: a background, a
multiplicative layer, and a layer of the product’s opaque surfaces,

l Composited Image,
l G-Buffer,
l Wireframe,
l Z-Buffer,
l Lightmaps.

By default, only the Composable Image option is selected.

Samples of layers from an exported PSD file: lightmap, wireframe and G-buffer views.

Samples of composable layers and composited image generated using Composable
Image and Composited Image options respectively.
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Compression configuration is performed in the Compression window which is
accessed by clicking the Configure Compression. Available compression
options are:

l No compression: output file is not compressed,
l RLE: RLE compression mode is used,
l ZIP: output file is compressed using the ZIP format.

To export as a file using 16 integer bits, check Export as 16 bits. By default,
export is performed using 8 integer bits. Floating point formats (with 16 or 32
bits) are not available.

8-35.1.3.2.1 Using Composable Layers

The following composable layers can be obtained using the Composable
Image option:

l A layer with the background of the snapshot,
l A multiplicative layer. When applied to the previous layer, areas
corresponding to transparent surfaces are colored,

l An additive layer which adds opaque areas and reflections on
transparent surfaces to the final image.

Example of view reconstruction: over the background layer (left) the multiplicative layer (result of the
process shown on the right) is applied. Then the additive layer is applied on the resulting view to

reconstruct the final image (bottom).

The compositing technique described above allows the substitution of the
background while maintaining a correct filtering by semi-transparent surfaces.
This would be impossible to achieve with a transparency based on an alpha
layer.
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However, this technique is not compatible with the use of post-processes.
Therefore, post-processes are disabled for rendering of composable layers.

8-35.1.4 Internal Render Info

The Internal Render Info zone summarizes various settings. The applicable
elements from among following information are displayed:

l Width of the image in pixels,
l Height of the image in pixels,
l Pass, the number of passes to render the image,
l The number of Frames to render,
l Sampling,
l Memory.

8-35.1.5 Snapshot Process

Various options are available in the Snapshot zone, depending on the type of
output:

l Show Info: displays, along the bottom border of the active viewport,
a summary of the dimensions settings of the snapshot.

l Viewer: sets the image viewing window to open automatically
during rendering.

l Background:  to open the color chooser. The selected color will be
used as a background in the rendering where the view is not entirely
enclosed by geometric elements.

8-35.1.6 Rendering Buttons

Once all of the settings have been defined, click on the Render button to start
the generation of each snapshot used to compose the required output.

You can also Add to Snapshot Batcher to delay rendering until later, or
Replace current Snapshot Batcher item with the current settings of the open
snapshot editor.

8-35.2 Specific Settings for Images

Available in: Matter: Snapshot > Snapshot Image
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From the image snapshot editor, you can modify the rendering settings and
render a view of a product to an image file. This editor uses the material
abilities of the interactive viewport to calculate an image whose size can be
significantly larger than the screen resolution. The maximum size of the image
depends only on your computer’s memory.

Once the desired settings have been indicated, the Render button initiates the
creation of the image file.

8-35.2.1 Dimensions Zone

The button next to the Resolution box is a shortcut to standard
resolutions expressed in dpi (dots per inch). If the resolution is provided in units
other than dpi, the chosen standard resolution will be converted to the selected
units.

In the Orientation zone, select one of the radio buttons for Portrait or
Landscape. This choice is not available if you have selected one of the
predefined formats:Defined by Viewport,Defined by Product, or Fill
Viewport.

8-35.3 Specific Settings for Videos

Available in: Matter: Snapshot > Snapshot Video

Videos exports a timeline as a sequence of frames in a video file. This editor
allows you to specify all of the parameters for the conversion of your real-time
animation to a frame-based video format that can be saved to your computer
and read by common video players.

From this editor, you can set the parameters for the conversion from real-time
to video file:

l The dimensions,
l The video format, including file name, file extension, codec, and
compression,

l The rendering engine to use,
l The timeline that will provide the animation, and the frame rate to
apply,

l The frames to include in the video file,
l A preview of the frames that will be created.
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Once all of the parameters have been defined, click the Render button to
launch the rendering of each frame and the production of the video file.

During rendering, a dialogue box is displayed to show the progression of the
creation of the video file. The Viewer button at the bottom of this dialogue box
opens a frame viewing window.

At any time, you can pause the progression by clicking the Pause button, or
cancel it by clicking the Cancel button. If you have paused the rendering, start it
again by clicking on Resume.

8-35.3.1 Configuring the Codec

Video formats are defined by three parameters:

l Container (file format),
l Codec (encoding algorithm),
l Bitrate (encoding quality).

Access to video format settings.

When the container is changed, the codecs available in the drop-down list are
updated according to the codecs supported by the format.

Video format settings.

The available containers (formats) are the following:
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l AVI (Audio / Video Interleaved),
l MKV (Matrovska Video),
l FLV (Flash Video).

Each video format can embed different encoding algorithms called codecs.
Some of them are specific to a format. For example, only Sorenson codec is
available for FLV format. Check the documentation of your movie processing
software to known which format and codec best fit your needs.

The bitrate defines the amount of data stored to represent the frames. A low
value will generate a small-sized file, but visual quality will be low. Conversely,
a high value will generate a good quality video but the file will be larger.

Frame samples from videos generated using respectively a low bitrate (on the left) and
a high bitrate (on the right).

8-35.3.2 Timeline Zone

The Timeline zone provides the Timeline drop-down list from which you can
choose the timeline to be rendered as a video.

Next to the timeline selection, specify the frame rate for the conversion from
real-time animation to frame-based video.

8-35.3.3 Frame Output Zone

You have the option to render only a portion of the timeline range by providing
the numbers of the desired frames:

l Current Frame,
l All Frames,
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l A Range of frames.

It is also possible to indicate the initial number for the index appended to the
filename of each frame in the Output Filename zone. By default, the value of
this option is "0."

8-35.3.4 Preview Zone

The Preview zone provides a preview of each of the frames that will be
rendered.

You can move within the preview sequence:

l By using the buttons to step backwards (<) and forwards (>) one
frame at a time in the sequence,

l By providing a frame number,
l By sliding the cursor along the bar.

You can also visualize the sequence by using the Play and Stop buttons. The
frame sequence playback is displayed in the current active viewport.

Tick the Loop checkbox to play the video preview in a loop.

The editors Videos and Timelines both use the active viewport to display
playback. Consequently, you cannot view playback from both editors at the same
time.

If the real-time playback in Timelines is playing, you will not be able to play the
video preview. Use the controls in the Timelines to pause the real-time playback
before playing the video preview.

Conversely, if the video preview is playing, you must stop it in Videos before
running real-time playback from Timelines.

8-35.4 Specific Settings for Panoramas

Available in: Matter: Snapshot > Snapshot Panorama

Panoramas exports a timeline as a sequence of frames in a 360-degree
panoramic video file. This editor allows you to specify all of the parameters for
the conversion of your real-time animation to a frame-based video format that
can be saved to your computer and read by interactive video players including
YouTube, as well as virtual reality displays.
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360-degree panoramic videos differ from standard videos in that the viewer is
able to change the direction of view during playback by interacting with the
video using a mouse, by changing the position of a mobile device, or by turning
her head when using a VR set-up.

From this editor, you can set the parameters for the conversion from real-time
to a 360-degree panoramic video file:

l The dimensions,
l The panoramic settings, including the dimensions in angles of the
slices used to compose the 360 degrees of the scene and the choice
of mono or stereo feeds,

l The video format, including file name, file extension, codec, and
compression,

l The settings for the OpenGL rendering engine,
l The timeline that will provide the animation, and the frame rate to
apply,

l The frames to include in the video file,
l A on-screen view of the frames as they are generated.

Once all of the parameters have been defined, click the Render button to
launch the rendering of each frame and the production of the video file.

During rendering, a dialogue box is displayed to show the progression of the
creation of the video file. The Viewer button at the bottom of this dialogue box
opens a frame viewing window.

At any time, you can pause the progression by clicking the Pause button, or
cancel it by clicking the Cancel button. If you have paused the rendering, start it
again by clicking on Resume.

8-35.4.1 Panorama Settings

Panoramas are composed of a number of slices, which are then assembled
around the camera position to create the 360-degree visual environment. You
will need to determine the width and the height of the slices required by your
video. These dimensions are given in angle degrees.

The smaller the angle, the more slices your video will require. Each slice
requires a separate pass. As there is a direct relationship between rendering
time and the number of passes required, videos using smaller slice angles will
require longer rendering times. It is recommended that you choose the widest
angle with no rendering artifacts in order to reduce rendering time.
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l Horizontal degrees/slice: In stereo mode, separate feeds for the left
and the right eyes are produced in order to provide depth
perception. This increases the sensitivity to slight differences in
horizontal points of view, particularly for objects in the foreground,
which in turn requires more slices. When rendering in stereo mode,
horizontal slices of a maximum of 3 degrees are recommended. In
mono mode, most scenes will support a horizontal slice width of up
to 45 degrees.

l Vertical degrees/slice: Most environments will support a vertical
slice height of up to 45 degrees.

l Interpupilary distance: When stereo mode is enabled, the
interpupilary distance can be personalized. This distance measures
the space between the left and the right pupils of the viewer and is
given in meters. If the Stereomode is not enabled, the value in the
Interpupilary distance field is not taken into account.

8-35.4.2 Configuring the Codec

Video formats are defined by three parameters:

l Container (file format),
l Codec (encoding algorithm),
l Bitrate (encoding quality).

Access to video format settings.

When the container is changed, the codecs available in the drop-down list are
updated according to the codecs supported by the format.
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Video format settings.

The available containers (formats) are the following:

l AVI (Audio / Video Interleaved),
l MKV (Matrovska Video),
l FLV (Flash Video).

Each video format can embed different encoding algorithms called codecs.
Some of them are specific to a format. For example, only Sorenson codec is
available for FLV format. Check the documentation of your movie processing
software to known which format and codec best fit your needs.

The bitrate defines the amount of data stored to represent the frames. A low
value will generate a small-sized file, but visual quality will be low. Conversely,
a high value will generate a good quality video but the file will be larger.

Frame samples from videos generated using respectively a low bitrate (on the left) and
a high bitrate (on the right).

8-35.4.3 Timeline Zone

The Timeline zone provides the Timeline drop-down list from which you can
choose the timeline to be rendered as a video.
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Next to the timeline selection, specify the frame rate for the conversion from
real-time animation to frame-based video.

8-35.4.4 Frame Output Zone

You have the option to render only a portion of the timeline range by providing
the numbers of the desired frames:

l Current Frame,
l All Frames,
l A Range of frames.

It is also possible to indicate the initial number for the index appended to the
filename of each frame in the Output Filename zone. By default, the value of
this option is "0."

8-35.4.5 Preview Zone

The Preview zone provides a preview of each of the frames that will be
rendered.

You can move within the preview sequence:

l By using the buttons to step backwards (<) and forwards (>) one
frame at a time in the sequence,

l By providing a frame number,
l By sliding the cursor along the bar.

You can also visualize the sequence by using the Play and Stop buttons. The
frame sequence playback is displayed in the current active viewport.

Tick the Loop checkbox to play the video preview in a loop.

The editors Videos and Timelines both use the active viewport to display
playback. Consequently, you cannot view playback from both editors at the same
time.

If the real-time playback in Timelines is playing, you will not be able to play the
video preview. Use the controls in the Timelines to pause the real-time playback
before playing the video preview.

Conversely, if the video preview is playing, you must stop it in Videos before
running real-time playback from Timelines.
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8-35.5 Specific Settings for VR Objects

Available in: Matter: Snapshot > Snapshot VR Object

VR Objects produces a 3D image of the product. In this 3D image, the camera
is stationary. The object is posed on a plane that turns at regular intervals of
time. This allows you to view the object from every angle, with the ability to
examine every detail.

Once the desired settings have been indicated, the Render button initiates the
creation of the image files that constitute the VR object.

During rendering, a dialogue box is displayed to show the progression of the
creation of the VR object files. The Viewer button at the bottom of this dialogue
box opens a frame viewing window.

At any time, you can pause the progression by clicking the Pause button, or
cancel it by clicking on the Cancel button. If you have paused the rendering, start
it again by clicking on Resume.

8-35.5.1 Preview Frame Zone

The Preview Frame zone allows you to preview each frame of the camera’s
path around the object by moving the slider along the bar.

This preview allows you to check the point of observation. By default, the
product is observed with a very large field of view. You can modify the point of
observation at any time, either in the active viewport or with the tools in the
Camera Path zone. To apply a modification to the point of observation, click the
Acquire button in the Camera Path zone.

8-35.5.2 Camera Path Zone

The Camera Path zone defines the camera’s position and its path.

To create a VR object, a series of images will be generated. In this series, each
image is taken from a point on a circle around a central point. The Center
values are used to position this central point in relation to the origin in the
world frame of reference. The Radius value sets the distance between the
camera and this central point.

The value FovY in degrees provides the vertical field of view.
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If you have made changes, click on the Acquire button in order to validate and
apply these settings.

8-35.5.3 VR Object Settings

The VR object settings establish:

l The Pan Range: frames can be created either for a complete circle
on a horizontal plane (the checkbox Complete Loop is ticked by
default) or for a limited arc only. In this latter case, you must supply
the angles between which your product will be observed.

l The Tilt Range: frames can be created to form a circle on a
horizontal plane around the camera path’s central point or to form a
sphere or portion of a sphere around this same point. In these latter
cases, you must supply the angles between which your product can
be viewed. By default, the camera angles cover a full sphere. The
viewing angles range from -90 degrees (the negative Y axis) to +90
degrees (the positive Y axis).

l TheNumber of Frames: frames can be created closer together or
farther apart along the camera path. Pan provides the number of
frames along the circle on the horizontal plane. Tilt provides the
number of frames between the top and bottom angles, if you have
defined a vertical plane.

8-35.6 Specific Settings for Cubic VR Panoramas

Available in:Matter: Snapshot > Snapshot Cubic VR Panorama

Cubic VR Panorama produces a 3D image of the product in a 3D space. It
creates a cubic viewing space that gives the observer the impression to be in
the product’s 3D space.

Once the desired settings have been indicated, the Render button initiates the
creation of the image files that constitute the cubic VR panorama.

During rendering, a dialogue box is displayed to show the progression of the
creation of the video file. The Viewer button at the bottom of this dialogue box
opens a frame viewing window.

At any time, you can pause the progression by clicking the Pause button, or
cancel it by clicking on the Cancel button. If you have paused the rendering, start
it again by clicking on Resume.
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8-36 Surface CuttingWorkshop

Available in: Shaper: Surface > Unfolding > Edit unfolding >  Surface
Cutting Workshop

The Suface Cutting Workshop is a tool available from the Unfolding
Workshop.

The Unfolding Workshop enables users to define the UV mapping of complex
surfaces. However, for some surfaces, the UV mapping obtained is not always
relevant. This is especially true for surfaces that can’t be unfolded onto a plane
without being cut in places. In such cases, the surface cutting workshop can be
used to manually work out a cutting line that will ensure a quality UV mapping.
Cutting paths are defined using control points that are positioned manually.

8-36.1 Surface Cutting Workshop Interface

The surface cutting workshop has a dedicated interface which can be accessed
from the standard unfolding workshop once a surface has been selected.

Open the surface cutting workshop by clicking on the icon in the panel
on the right. The surface cutting workshop consists of four zones:

l Validation commands toolbar.
l 3D view.
l 3D geometry toolbar.
l Cut Properties panel.



8    EDITORS

Lumiscaphe Patchwork 3D Design 2019.1 X3 p.217

Surface Cutting Workshop interface.

8-36.1.1 Validation Commands Toolbar

The validation commands toolbar in the top left corner of the surface cutting workshop
interface.

The validation toolbar has three options:

l The green checkmark validates the defined cutting path and returns
to the unfolding workshop.

l The red cross discards the cutting path and returns to the unfolding
workshop.

l The back arrow button is a reset button which restores the original
uncut surface. The surface cutting workshop remains open.

8-36.1.2 3D Geometry Toolbar

3D geometry toolbar above the 3D view in the surface cutting workshop interface.

The 3D geometry toolbar gives access to tools for managing control points and
observing surfaces. The four operating modes for navigating in the 3D view are
Zoom, Pan,Orbit and Zoom extents. 

The two tools for managing control points are:
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l Select and Move tool for selecting an existing control point
and moving it to another position.

l Quick Assignment mode for inserting a new control point.

8-36.1.3 3D View

This window is an interactive view in which the surfaces to unfold are
displayed. It possesses the same functions as all other 3D views in Patchwork
3D Design.

In this 3D view, the control points are marked in green and the delimited
cutting path is displayed in red.

8-36.1.4 Cut Properties Panel

The Cut Properties panel is divided into two boxes, the Preprocess box and the
Cut Points box.

The Preprocess box provides access to three modes for preparing surfaces
before defining a cutting path:None, Sew,Weld and Sew. The Cut Points box
allows the user to keep track of the number of control points defined. The Cut!
button performs a defined cut based upon control points.

8-36.2 Defining a Cutting Path

8-36.2.1 Preprocessing Boundaries

Depending on surface topology, users may want to prepare it before defining a
cutting path. The preprocess tools available in the Preprocess box of the Cut
Properties panel are Sew andWeld and Sew. They have the same effects as
the preprocess options in the Unfolding workshop.

8-36.2.2 Defining Control Points

Control points are set using the Quick Assignmentmode in the 3D geometry
toolbar. They may be placed on any triangle vertex. Control points define
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cutting path segments. Users need to set at least two control points and may
set more.

To set a control point, users click on the matching vertex.

Control points are displayed in green. The cutting path segment defined by two
control points is the shortest path between them. It is displayed in red.

If a control point is behind the surface from the user’s standpoint, the green dot
will not be visible.

A cutting path defined by four control points: the cutting path is displayed in red and
the control points in green.

8-36.2.3 Modifying Existing Control Points

The Select and Move tool is for dragging any of the points belonging to the
red line, control points included, and assigning them to another triangle vertex.

Right-clicking on a control point opens a box containing three options.  The
user may then:

l Delete current control point.
l Continue inserting markers using the Insert New Marker After
option. When this option is activated, the next triangle vertex
selected becomes a control point.

l Delete All Markers.
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The three options available when right-clicking on a marker.

8-36.2.4 Applying the Cutting Path

The final cutting path is displayed in yellow. No markers exist any longer.

Once the cut path is defined, cutting is performed by pressing the Cut! button.
It is displayed in yellow afterward. Users may define additional cutting paths if
needed.

In order to unfold a surface, users validate the cut from the validation
commands toolbar and return to the unfolding workshop to get the proper UV-
mapping of the surface.

In the case of a sphere, the surface cannot be unfolded onto a plane without
being cut in places: use of the surface cutting workshop is recommended.
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UV-mapping obtained when defining a cutting path in the surface cutting workshop.

UV-mapping obtained without using the surface cutting workshop.

8-37 Surface Properties (Shaper Editor)

Available in: Shaper: Surface > Properties (P)

Surface Properties displays and edits the properties of the selected surfaces.
This editor is composed of three tabs and an information zone.

Each surface has several properties listed in the zone labeled Information:

l Its name,

The name allows for rapid identification of a surface, both in Shaper
and inMatter.

l Its drawing color in Shaper,
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l A comment (initially, the name of the import file),

The comment contains, once a surface has been imported, the path
to the source file.

l The layer to which it belongs,
l The type of surface.

Its name and comment can be modified by clicking in the text field and typing a
new value.

To change the Shaper drawing color, you have access to a color chooser:

l Select a color, either by clicking on it in a color palette or in a color
book, or by setting it in the color picker on the left.

l To validate the selection and close the color chooser, click on the OK
button.

l The button Reset allows you to return at any time to the original
color.

8-37.1 Lighting

In this tab, set the default behavior of this surface when lit.

By default, all surfaces created cast shadows and receive shadows unless
these values are overridden for a given surface. This behavior can be modified
by unchecking the boxes here.

Default lightmap format and size options are also available. The lightmap size is
determined by Patchwork 3D Design based on the size of the surface.

The Factor option allows the calculated size to be increased or decreased. The
values available are multiplicative values applied to the length and to the width
of the lightmap. Consequently, a factor of 2 will double the length and the
width of the lightmap, for a total size increase of four. A factor of 0.25 will
divide the total lightmap size by four.

Increasing the size makes a lightmap more precise but requires more
computational time and takes up more disk space. A maximum size for
lightmaps is set in the application settings. However, you can impose a different
limit for this surface in theMax size field.

8-37.2 Geometry

The Geometry properties of the surface:
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l Its scale initially defined on importing,

The scale of a surface is the same used in the CAD tool used to
model the surface. The scale of a surface is generally detected
automatically during the CAD import. However, it can be
subsequently modified.

l The number of points and triangles used to represent it.

The number of points and the number of triangles give information
regarding the fineness of the lattice structure used to represent the
surface.

The Symmetry properties of the surface:

l Whether the symmetry is enabled or not,
l The plane of symmetry (XY, YZ, ZX),
l The position of the plane of symmetry.

The Animated Mesh properties of the surface:

l The default frame to display, if the surface is an animated mesh. The
frame corresponding to the slider position is used as the default
visual for the surface. The frame number is also displayed to the left.

8-37.3 Display

Surface State properties:

l Hidden,
l Frozen.

Just like the layers, the surfaces can be frozen or hidden individually. Each
surface has two boxes: the first encodes the visibility, the second the freezing. In
order to be visible, a surface must belong to a visible layer. It is editable if it is
not frozen and if the layer to which it belongs is not frozen either.

The Optimization properties:

l Removal of the hidden faces (back culling),

By default, removal of the faces turned away from the viewer (back
culling) is enabled for all the surfaces. You can disable this
optimization for one or more surfaces by modifying theHide
backfaces option in the Display tab of the properties dialog box.
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l Simplified display: drawing of the bounding box.

When the lattice structure of a surface comprises a high number of
triangles and points, its display may become overloaded. You can
simplify the representation of a surface in Shaper by enabling the
Display as Box option: the surface is no longer represented by its
lattice structure but by its bounding box.

Billboard properties:

l None, Rotate Y, or Rotate XY.

8-37.4 Properties of a Selection of Several Surfaces

If several surfaces are selected, you can modify their color, their scale, their
state and their display properties.

8-38 Surface Properties (Matter Editor)

Available in:Matter: right-click on a surface > Edit properties

When you right-click on a surface and choose Edit properties, an editor
appears. From this editor, you can edit the surface's properties.

8-38.1 Visibility

This property indicates whether the surface is visible. It is taken into account
only if the property of the Visibility of the different surfaces product is
enabled.

You can modify this property by:

l Visibility in the viewport context menu (right-click on a surface),
l Using the Click to Hidemode,
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l Running the Show All operation available in the Visualization
menu or the viewport context menu.

8-38.2 Back-Face Culling

This property enables the removal of the faces that are not oriented toward the
observer. This removal of the rear faces consequently improves rendering
speed.

Closed volume: Both surfaces opaque; only front
(outer) faces are visible. Open volume: Only front (outer) faces are visible.

Open volume: The transparent top surface's front
face is visible, and the bottom surfaces front (outer)

and back (inner) faces are visible.

Closed volume: Both surfaces' front (outer) and
back (inner) surfaces are visible.

A rear face is generally obscured by one or more front faces in a closed volume.
If a face becomes transparent (application of a transparent material), it no
longer performs its occlusion function. It is then essential to make the front and
rear faces visible in order to close the volume.

This property is modified by:
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l Enabling/disabling the option Hide backfaces available in the
viewport context menu.

8-38.3 DepthWriting (Transparent Materials Only)

This property, which is available from the viewport context menu, indicates that
the surface leaves its imprint in the depth buffer. It is most importantly used for
solving transparency conflicts. This property is modified by theWrite depth
option in the viewport context menu.

8-38.4 Transforming aMaterial

The Transformation zone allows you to manually position a material on a
surface, by directly modifying the numerical values U and V and also the
rotation values in the Surface Properties.

With this, you have the capability of rotating and moving a material precisely
and interactively by means of the keyboard.

8-39 TagManager

Available in: Shaper: Surface > Tag Manager (Ctrl+M)

The Tag Manager uses buttons to manage the list of tags, to create tags, to add
tags to a selection, and to manage a selection using tags.

Tags are used in Shaper and inMatter to manage the selection and to:

l apply a material to several surfaces at the same time,
l exclude surfaces from a local environment,
l filter surfaces that appear in a reflection,
l indicate the surface that are not affected by clipping planes,
l indicate the surfaces that function as configuration triggers in Live
Mode.

Managing the list of displayed tags:
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Icon Operation

Remove all tags from the display list. This does not delete the tags.

Recover the tags from all surfaces and display them in the list.

Recover only the tags from the selected surfaces and add them to the list.

Creating tags:

Icon Operation

Add the edited tag to the selection.

Create a tag with the name in the text box and add it to the list.

Applying or removing tags from a selection:

Icon Operation

Delete the tag highlighted in the list from the selected surfaces.

Add the tag highlighted in the list to the selected surfaces.

Managing the selection:

Icon Operation

Select the surfaces using the tag highlighted in the list.

When some surfaces are already selected, add the surface using this tag to the
selection.

When some surface are already selected, deselect only the surfaces using this tag.

8-39.1 Using Tags to Create Configuration Triggers

Tags can be used to create configuration triggers for the Live Mode.
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When a properly tagged surface is clicked during Live Mode, the next
configuration value is displayed. If the configuration property is displayed in
the Configuration Browser as a check-box, successive clicks will enable and
disable the option. If the configuration property contains a set of values, such as
a series of colors, successive clicks will cycle through the colors one by one.

To do so, you will need to create specific tags for the surfaces that will act as
triggers. The tag must correspond to the partition of the configuration that you
want to cycle through. To add rules associated with the partition type, use the
tag partition. To add rules associated with the partition.value type, use the
tag partition.

EXAMPLES

Type Configuration
symbol

Tag to
apply Result

partition armrest armrest show/hides an armrest

partition.value material.wood material shows the different values (wood, marble...)
one after the other

partition.value material.marble material shows the different values (wood, marble...)
one after the other

You may also be interested in the following subjects:

l Product Configurations (page 447)
l Live Mode (page 498)

8-40 Text Image (Editor)

Available in:Matter: Textures Library (right-hand sidebar) > Edit or Create
a new text texture

The Text Image editor creates, based on a provided text, an image that can be
used as a texture. This text texture can be used in all of the same contexts as a
standard texture.

The editor interface is divided into four functional zones:

l Operations toolbar and name of the active text image: shortcuts to
the operations of the texture library.

l Settings for Geometry, Colors, and Font: management of the look of
the text to be displayed.
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l Text: input field for the text to be displayed.
l Preview: full-size preview of the text to be displayed.

8-40.1 Operations Toolbar

The following operations are available in the toolbar:

Icon Description

Drag-and-drop start point for assigning the texture to the appropriate field in a
material, an overlay...

Create a new text texture.

Duplicate the current text texture.

You can also rename this texture by modifying the name in this zone and
saving your changes by pressing Enter.

8-40.2 Display Settings

Geometry
Settings Description

Size Dimensions of the image textbox in which the text will appear, in pixels.

Anchor Placement of the upper left-hand corner of the text with regard to the upper
left-hand corner of the textbox in which the text appears.

Color
Settings Description

Background
Color and level of opacity of the image background.

Opacity is given as a value between 0 (fully transparent) and 1 (fully
opaque).

Font
Color and level of opacity of the text.

Opacity is given as a value between 0 (fully transparent) and 1 (fully
opaque).



8    EDITORS

p.230 Lumiscaphe Patchwork 3D Design 2019.1 X3

Font
Settings Description

Font

Drop-down menu offering a choice of fonts from among the fonts installed on
the current computer.

Fonts used in text images are not embedded in the database. If this
database will be handled on another machine, make sure that the chosen
fonts are also installed on the other machine.

The texture created by this editor will remain usable as-is on anymachine,
regardless of the availability of the original fonts, until it is modified.

Style Drop-down menu offering the choice of styles available for the chosen font.
Common styles include bold or italics.

Size Side of the font's characters in points (pt).

8-40.3 Text

Insert your text in the Text zone.

Supported text includes all characters rendered in the UTF-8 encoding, as long
as these characters can be displayed in the selected font.

Text is displayed with no styling. Text wrapping is not applied, but new lines
inserted manually are taken into account.

No character limit is imposed, but only the text that fits in the image textbox
will be displayed. This is determined by the size of the textbox as set in the
geometry settings as well as by the font size provided.

8-40.4 Preview

The button updates the text preview, which is displayed in full-size. This
action also saves the current settings.

The button undoes any modifications to the settings that have been
applied after the last save and update of the preview. The display settings are
reset to the state displayed in the preview zone.
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8-41 Textures (Editor)

Available in:Matter: Textures Library (right-hand sidebar) > Edit

Textures is an editor that displays a texture in detail. Dragging and dropping a
texture onto the interaction zone changes the texture visible in the editor.

Patchwork 3D Design includes metric dimensional management of textures
which allows accurate association to the metric dimensions of physical
materials.

The mapping modes (planar, box, circular etc.) and the Unfolding Workshop
define the sets of UV coordinates on the metric scale. It is therefore necessary
to verify the dimensions of the textures so that they precisely match the
surfaces to which they will be assigned.

8-42 Timelines (Editor)

Available in:Matter: Editorsmenu > Timelines

Timelines is an editor used to develop animation sequences, called
"timelines." From this editor, you can create, duplicate, rename, and delete
timelines. You can also add, remove, and modify elements in the different
animation tracks of each timeline. When played back, the animated result will
be displayed in the current active viewport in the main interface of Patchwork
3D Design.

The editor is divided into two sections: the timeline editing area to the left, and
the libraries to the right. The Timeline box is the editing area. It contains the
playback and time controls, as well as the animation tracks and their content.
The libraries are organized into tabs for each type of item:

Tab Type of animatable element

Timelines

Products
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Tab Type of animatable element

Camera Animations

Configuration Keys

Channel Animations

Video Textures

Use the arrows in the upper right corner of the library zone to scroll through
the tabs.

8-42.1 Timeline Controls

Verify that the timeline shown is the timeline you wish to play back. The current
timeline’s name is displayed in theName zone. This zone contains a drop-
down list that provides direct access to a list of all the existing timelines.

To modify a timeline’s name or to create a new timeline, use the controls
available in the Timeline library tab to the right.

From the Camera drop-down menu, choose the camera to be used to initialize
the timeline. If your timeline contains camera clips, these will be applied to the
selected camera and will modify its settings. The free camera is selected by
default.

The chosen camera is modified by camera clips during timeline playback.
The original camera settings will be overwritten.
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8-42.1.1 Timeline Playback Controls

The playback is controlled using the set of playback buttons at the top of the
Timeline zone.

Icon Function Description

Timeline range
start

Returns the time cursor to the beginning of the animation
range.

Play / Pause Start the playback if it is stopped, or pause it if it is
currently running.

Timeline range end Move the time cursor to the end of the animation range.

Loop timeline
playback Loop the playback of the animation range.

You can also control playback with optional keyboard shortcuts that can be set up
in File > Keyboard Map editor for the following actions:

l Timeline Range Start returns the time cursor to the beginning of the
animation range.

l Timeline Range End moves the time cursor to the end of the
animation range.

l Play/Pause Timeline Playback starts the playback if it is stopped,
or pauses it if it is currently running.
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8-42.1.2 Navigation Controls for Timeline Tracks

To move within the timeline tracks:

l Use the scroll wheel of the mouse to zoom in on and out from the
mouse cursor position.

l Click on the buttons at the top of the Timelines editor
corresponding to the mouse modes, then move the mouse while
holding down the left mouse button:

o Select and move an item.

o Pan the track display zone.

o Zoom .
l Use the shortcuts configured in the Keyboard Map editor. By
default, you can:

o Pan by holding down the middle mouse button and
moving the mouse,

o Zoom by holding down Ctrl + Shift + the middle mouse
button and moving the mouse.

The button in the upper right-hand corner resets the level of zoom to fit
the width of the entire playback range in the display zone.
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8-42.1.3 Precise Positioning Controls

This bottom of this zone also allows you to:

l Position the time cursor as precisely as possible by providing its
temporal position in seconds in the Cursor Time box. You can also
drag the cursor with the mouse.

l Position the selected item or group of items in the animation tracks
as precisely as possible by providing its activation time in seconds in
the Item time box.

l Define the animation range, or the playback start and end times in
seconds, by specifying values in the Range:From and To boxes.

8-42.2 Timeline Library

The libraries on the right-hand side of the Timelines editor include a tab for

the list of Timelines .

From this list you can select the timeline animation to edit by clicking on its
name. The selected timeline’s contents and settings are shown in the Timeline
editing zone on the left of the editor. Only one timeline can be selected at a
time.

Use the buttons to manage the list:

Icon Function Description

New Create a new timeline.

Duplicate Duplicate the selected timeline.
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Icon Function Description

Rename Rename the selected timeline. Give each timeline a unique name.

Remove Delete the selected timeline.

You must have at least one timeline. The Remove button will be grayed out if the
selected timeline is the only timeline in the list.

8-42.3 Product Library

The products in your database can be added to any timeline as product keys.
For quick access from within the Timelines editor, the libraries on the right-

hand side include a Products tab that lists all of the products in the open
database.

From the Products library, you can load database products as product keys by
dragging products from the library and dropping them onto the Product track.

Products can also be dragged directly from the Matter sidebar's product library.

The first product key will be used to determine the initial product shown in
your timeline. If you have not added any product keys, the product in the active
viewport will be displayed instead.

8-42.4 Camera Animations Library

Camera animations provide the source content for clips in the Camera track of

a timeline. The Camera Animations tab in the library on the right-hand
side of the Timelines editor consists of a list of defined camera animations. It
provides buttons allowing you to create new ones and duplicate, rename, or
delete the current ones.

From the list in this library tab, you can:

l Load camera clips by dragging animations from the library and
dropping them onto the Camera track.
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Dropping a camera animation onto the Camera track creates a
solid-colored clip whose length corresponds to the duration of the
clip. In a bookmark animation clip, the positions of the bookmarks
are visible. Each bookmark is displayed as a vertical bar within the
clip.

When a clip is selected, you can modify a bookmark's position by
clicking on it and dragging it to a new position.

The initial camera position of the first clip will be used from the
beginning of the timeline. If no clips exist in your timeline, the camera
position in the active viewport will be used instead.

l Modify an existing animation by double-clicking on its name in the
list.

Use the buttons to manage the list:

Icon Function Description

New
Create a new camera animation. You will be asked to provide a name
for the new animation and to select the type of camera path (Kam
file, bookmark animation or Bézier path) from the drop-down list.

Duplicate Duplicate the selected camera animation.

Rename Rename the selected camera animation. Give each camera animation a
unique name.

Remove Delete the selected camera animation.

The camera animations were added to Patchwork 3D Design in version 5.7.
However, if you are working on a database created with an earlier version, any
bookmark animations and Kam files saved in your database will be automatically
converted and listed in the camera animations library tab of the Timelines
editor.

They can be edited with the Camera Animations editor as if they had been
produced in Patchwork 3D Design v5.7 or later.
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8-42.5 Configuration Keys Library

If you are working with a multi-product database, please note that configurations
will apply to the first product in your product list only. If a different product is
animated in the Product track, the configuration keys activated during that
period will appear to have no effect.

Configurations set up in your database with the configuration system can be
animated on the Configuration track in any timeline.

To animate configurations, configuration keys need to be created in the

Configuration Keys library tab on the right-hand side of the Timelines
editor. This tab contains a list of existing configuration keys and buttons
allowing you to create new ones and duplicate, rename, or delete the current
ones.

From the list in this library tab, you can:

l Add a configuration key to the Configuration track by dragging it
from the library and dropping it onto the track.

l Modify an existing key by double-clicking on its name in the list.

Use the buttons to manage the list:

Icon Function Description

New
Create a new configuration key. This will open the Configuration Key
editor, where you can provide a name for the key and set the
configuration it corresponds to.

Duplicate Duplicate the selected configuration key.

Rename Rename the selected configuration key. Give each configuration key a
unique name.

Remove Delete the selected configuration key.

If you do not have a configuration key or its colored influence zone at the
beginning of your timeline range, the initial configuration will be adopted from
the global configuration set in the Configuration Browser. During the playback,
the Configuration Browser will be updated with the configuration changes
imposed by the configuration keys.
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This allows the initial configuration in your timeline to vary. Consequently, looped
playback and configuration manipulations can be used to create variations in the
playback at the beginning of your timeline.

If this is not the desired behavior, initialize your timeline with a configuration key
placed at the beginning of the playback range. In the Configuration Key Editor,
make sure that this configuration key imposes a value other than the default
Keep previous value for each of the symbol selections.

8-42.6 Channel Clip Library

Channels allow diverse elements of your Digital Aspect Mockup to be
animated. Channels exist for:

l Animated geometries set up in the Kinematics tab of the Shaper
sidebar.

For freely transformable parts, six different channels control the
animation of a part: the angles of rotation around the three axes (X,
Y, and Z) and the distances of translation along the three axes (X, Y,
and Z).

For rotating and translatable parts, a single channel controls the
animation of the part: the angle around the rotation axis in the case
of a rotation, or the distance along the vector in the case of a
translation.

l Animations imported from an FBX file.
l Color and intensity of lighting layers.
l Animated meshes.
l Most modifiable options for any type of material.
l Lighting environments.
l Real-time sun settings.
l Overlays.
l Post-processing.

A material, environment, overlay, or post-processing effect must be used in the
active product for its channels to be available for animation.

To add channel-based animations to the timeline, channel animation clips need

to be created in the Channel Animations library tab on the right-hand
side of the Timelines editor. This tab contains a list of existing channel
animation clips and buttons allowing you to create new ones and to duplicate,
rename, or delete the current ones.
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From the list in this library tab, you can:

l Add a channel animation clip to any Channel track by dragging it
from the library and dropping it onto the track.

l Modify an existing clip by double-clicking on its name in the list.

Animations imported from an FBX file cannot be modified.

Use the buttons to manage the list:

Icon Function Description

New

Create a new channel animation clip. This will open theNew Channel
Selectorwindow, where you can provide a name for the clip, select
the channel or channels that will be animated in the clip, and select
the desired type of control over the animation: Standard (basic,
single-channel animation) or Advanced (custom, multi-channel
animation).

Duplicate Duplicate the selected channel animation clip.

Rename Rename the selected channel animation clip. Give each channel
animation clip a unique name.

Remove Delete the selected channel animation clip.

8-42.7 Texture Library

The video textures in your database can be added to any timeline as texture
clips. For quick access from within the Timelines editor, the libraries on the

right-hand side include a Texture tab that lists all of the video textures in
the open database.

From the Texture library, you can load database video textures as texture clips
by dragging textures from the library and dropping them onto a Texture track.

Textures can also be dragged directly from the Matter sidebar's texture library .

When the timeline is played, the video will be animated simultaneously in all
materials using it that are assigned to surfaces in the active viewport.
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8-43 UnfoldingWorkshop

Available in: Shaper: Surface > Unfolding > Edit unfolding
Available in: Shaper: Surface > Unfolding > Edit unfolding

The Unfolding Workshop enables you to define the UV-mapping of complex
surfaces.

To access the unfolding workshop, you must first select the surfaces to be
unfolded.

The unfolding workshop interface consists of four zones:

l The main tool bar,
l The 2D UV zone,
l The 3D Geometry zone,
l The Surfaces zone.

8-43.1 Main Toolbar

The main toolbar contains two buttons validate or cancel the adjustments made
in the unfold workshop, as well as six background texture options to make it
visually easier to understand the unfold procedure that has taken place.
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: The Validate button is for confirming and accepting the UV changes that
have been made in the unfold workshop.

: The Cancel button is for cancelling and exiting the unfold workshop
changes, disregarding the UV modifications that have been made.

: The texture options change the background and surface
texture for the selected unfolded surfaces.

: Checker : Grid

: Frame : Letters

: Rulers + + + +

: The User-defined texture toggle is for enabling/disabling the background
texture of your choice.

: User-Defined



8    EDITORS

Lumiscaphe Patchwork 3D Design 2019.1 X3 p.243

The procedure for loading a texture file of your choice is explained below in the
User Texture subsection of the Surfaces section.

8-43.2 2D UV Zone

The 2D UV zone contains an interactive 2D view in which the surface is
displayed when it is unfolded, as well as several special tools.

Icon Operation Description

Zoom Zoom in the 2D view.

Pan Pan in the 2D view.

Background Enable/disable the display of the background textures (see
the Main Toolbar subsection).
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Icon Operation Description

Zoom Selection
to Fit

Reframe the 2D view and center it on the selected unfolded
surface.

Auto Zoom
Selection to Fit

Enable/disable the automatic reframing of the view on the
unfolded surfaces when they are selected.

Edit
parametrization
margin

Open an editor for defining margins around the unfolding so
that it will be easier to use after export.

Show bounding-
box Enable/disable the display of the previously defined margins.

Export
parameterization

Open an editor for configuring and then exporting the 2D
image of the unfold that has taken place. In this way you can
use your surface-unfolding work with graphic creation tools
to edit textures that are perfectly suited to the programming
of your surfaces.

8-43.2.1 Defining a Constraint

The user can convert the markers previously set on the surface in the 3D view
into constraints either by simply left-clicking in the UVW 2D window or by
using the Convert Markers to Constraints option accessed by right-clicking in
the 2D view.

l For a surface unfolded using the One-click option in theHit mode
tab of the Surfaces panel, the three vertices of the triangle the
marker is set on will be converted into constraints.

l For a surface unfolded with theMulti-constraints option, the
vertices of all triangles containing a marker will be transformed into
constraints.

l When a surface was unfolded with the Follow Boundary option, all
vertices on the corresponding boundary are converted into
constraints.

These constraints are represented by yellow and red dots in the UVW mapping.
Any point thus highlighted represents a constraint.

Any point in the UVW mapping may be moved in order to create a deformation
using the Select and Translate tool from the UV 2D toolbar. The
parameterization is updated in real time. Moving a point with no constraint
assigned to it defines a new constraint. The point is then highlighted.
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8-43.2.2 Modifying a Constraint

In order to modify a constraint, the Select and Translate tool must be
activated. The highlighted point may be set to another position by dragging it,
thus modifying the constraint.

UV mapping of a surface unfolded using the one-click method and corresponding 3D
view.

UV mapping of the surface after an additional constraint was added and corresponding
3D view.

8-43.2.3 Releasing a Constraint

In order to release the constraint set on a point, the option Release Constraint
on Selected Pointmust be chosen. This option is accessible by right-clicking
on the corresponding highlighted point.

All the constraints set on the UV mapping can be released at the same time by
using the option Delete All Markers accessible by right-clicking in the UVW
mapping view.
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Right-clicking inside the UVW mapping window gives access to the two options
Delete All Markers and Convert Markers to Constraints. The third option,
Release Constraint on Selected Point, is only displayed by right-clicking on a
highlighted point.

8-43.3 3D Geometry Zone

The 3D Geometry zone contains an interactive 3D view in which the surfaces
to be unfolded and several tools for unfolding and manipulating the surfaces
are displayed.

Icon Operation Description

Select Select surfaces.

Quick
Assignment Create markers by clicking directly on the surface.

Move Marker Select and move a marker on the unfolded surface.



8    EDITORS

Lumiscaphe Patchwork 3D Design 2019.1 X3 p.247

Icon Operation Description

Zoom Zoom in the 3D view.

Pan Move around in the 3D view.

Orbit Control the rotation of the 3D view in order to observe the
surfaces from different points of view.

Set Render to
Texture View the background textures of an unfolded surface.

Set Render to
Deformation

View a highlighted distribution of the physical forces associated
with the deformation of the unfolded surfaces.

Show
Wireframe Enable/disable the display of the surfaces' wireframe.

Zoom to Fit Reframe and center the 3D view on of the surfaces in the
unfolding workshop.

Zoom
Selection to
Fit

Reframe and center the 3D view on a selection.

Auto Zoom to
Selection to
Fit

Enable/disable the automatic reframing of the view on the
unfolded surfaces when they are selected.

3D Selection
Only

Limits the display of the 3D view to the surface being unfolded. To
return to a view of all selected surfaces, click on this button again.

8-43.4 Surfaces Zone

The Surfaces zone contains an area for exploring the surfaces involved, and
three menu tabs for configuring the methods for unfolds and viewing them.

The area for exploring the surfaces lets you select the surfaces by their name
and view the unfolding method used. (The selected surface is highlighted.)
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Each surface can combine up to 32 separate unfolding sets. At the bottom of
the box,Displayed UV channel allows you to choose the set of UV targeted by
the unfolding.

This zone is followed by several tabs which give access to the workshop
settings.

8-43.4.1 Click Mode

The Click Mode tab provides access to the fast unfold general options.

Preprocess provides access to three types of preparation:None, Sew andWeld
& Sew.

Preparation Description

None Uses the current topology of the surface.

Sew Carries out a sewing operation on the edges.

Weld & Sew Carries out a sewing and joining operation on the edges.

Welding Tolerance assigns a numerical value to the tolerance of the CV's
when theWeld & Sew mode of preprocess is selected.

Method provides access to three types of unfolding methods:None, Copy and
Unfolding.

Method Description

None Remove and cancel the previous unfolding work.

Copy

Is used to retrieve an existing unfolding method.

In Copymode, the unfolding workshop offers the choice of currently-defined
UV sets. A drop-down menu allows you to browse the UV sets and select the
most suitable set for unfolding the selected surfaces.

Unfolding

Create an unfolding of the surface using the 3D view.

Unfolding Properties: Technique provides access to three different unfolding
techniques: One click,Multi constraints and Follow boundary. These
techniques are described below.

The Quick Assignmentmode must be enabled in order to execute an unfold
operation and view its representation (see "3D Geometry Zone" above).

l One click: is for creating a new unfold with just one click on the
surface to be unfolded. The origin of the unfold is on the surface at
the precise location where the click has been made. With this
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technique, the orientation of the texture is always positioned so that
the y axis of the texture is parallel to the vertical edges of the 3D
view.

l Multi constraints: is for assigning several markers to the unfold so
that it precisely follows the form of the surface.

One click method. Multi-constraints method.

It is possible to change the position of the markers at any time using the Move
marker tool (see "3D Geometry Zone" above).

l Follow boundary: is for constraining the unfold to a specific edge of
a surface. Two markers are necessary for this unfolding technique.
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One click method. Follow boundary method.

l The Auto centered option is for positioning the origin of the texture
in the center of the surface, regardless of where the click has been
performed.

Auto-centered disabled. Auto-center enabled.

8-43.4.2 Surface Properties

The Surface properties tab provides access to the unfold options depending on
the selected unfolded surface.

: The Reset button is for re-establishing the initial unfold assigned to the
surface.

The Parametrization frame provides the same unfolding options as in theHit
mode tab (see the Hit Mode Tab section).
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When the unfolding methods Multi constraints or Follow boundary are
chosen, the placement of markers that define the constraints are handled using
the following buttons:

Icon Use Description

Place marker Place a new marker at the clicked location on the selected
surface

Delete all
markers

Delete the markers created with theMulti constraints
unfolding technique.

Swap boundary
markers

Reverse the direction of the markers created with the Follow
boundary unfolding technique.

Apply Confirm the adjustments made on the selected surface.

The UV Transformation frame is for positioning the texture using numerical
values.

The Automatic centering option is for positioning the origin of the texture in
the center of the surface (see the Surfaces Zone section).

8-43.4.3 User Texture

The User texture tab provides access to the properties of a user texture.

: The Open texture button is for loading a texture from your documents.

: The Reload texture button is for updating the loaded image.

The Dimensions frame is for assigning metric values to the texture
dimensions.

: The Reset texture dimensions button is for canceling the values assigned
to the texture dimensions and for returning to the initial values.

The Preview frame is for viewing the image loaded for the texture.
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9 PLUG-INS

9-1 HDR Light Studio Plug-In

Available in:Matter: sidebar environment library >  Create
environment with HDR Light Studio

In order to use HDR Light Studio plug-in, you have to directly purchase
Lightmap HDR Light Studio software with its connector for Patchwork
3D Design from Lightmap website.

LINK TO THE PRODUCT : https://www.lightmap.co.uk/hdrlightstudio/

Patchwork 3D Design supports HDR Light Studio plug-in from version 5.

When using HDR Light Studio version 5 to create an environment, the
following features are available in the Patchwork 3D Design Product tools
toolbar:

l HDR Light Studio LightPaint Reflection: in Patchwork
3D Design, click on the point of a surface on which you want the
reflection of the light source selected in HDR Light Studio to be
displayed. The light source is repositioned in the environment so as
to be reflected on this point. The angle between the new light
direction and the normal to the surface at the selected point equals
the angle between the observation direction and this same normal.

l HDR Light Studio LightPaint Illumination: in Patchwork
3D Design, click on the point of a surface you want to illuminate. The
light selected in HDR Light Studio is repositioned in the environment
so as to illuminate this point. The light is positioned along the

https://www.lightmap.co.uk/hdrlightstudio/
https://www.lightmap.co.uk/hdrlightstudio/
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normal to the surface at this point in order to obtain a maximum
intensity where desired.

To gain access to the functions of HDR Light Studio, click the Create
environment with HDR Light Studio in the sidebar environment library.

Patchwork 3D Design creates a new HDRI environment of the "live" type as
soon as the plug-in is launched.

To manipulate the HDRI parameters and see the effects in the Patchwork
3D Design viewport, simply assign this environment to your scene by a simple
drag and drop.

Lights created in HDR Light Studio are instantly visible in viewport.

To update the environment in Patchwork 3D Design, click the Refresh
button in theMatter sidebar's environment library.

The lights created in HDR Light Studio can be seen in the 3D view of Patchwork
3D Design as soon as the environment is updated.

The Process interactions immediately option in theHDR Light Studio
section of the Environments properties window allows you to automatically
update the environment as soon as an HDRLS parameter is modified.

Patchwork 3D Design makes it possible to create several HDR Light Studio
environments. To call up the plug-in window for an environment, simply click

the Edit environment with HDR Light Studio button in the
environments window.

The illustration below shows how the position of lights in HDR Light Studio
corresponds in Patchwork 3D Design:

TheHDR button at the bottom left of theHDRLS interface is for rendering and
saving the HDR image in high resolution on your hard drive:

When the high-definition environment image is saved, it is automatically sent
to Patchwork 3D Design. To benefit from the high-definition quality of the
saved environment, simply increase the resolution of the environment for the
reflection and/or for the background. These parameters can be accessed by
Product > Environment properties.
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The High-quality environment button in theMatter sidebar's
environment library lets you increase the quality of the HDRI environment sent
to Patchwork 3D Design by the plug-in.

This button calls up the same action as the Render button at the bottom left of
the HDRLS interface. It lets you save the HDR image in high resolution on the
workstation’s hard drive.

If you edit your existing lighting setup in HDR Light Studio, your HDR is sent to
Patchwork 3D Design as a low-definition environment. When your environment
changes are finished, remember to save your HDR environment again to your disk
(HDR button) so that it will be sent to Patchwork 3D Design.

For additional information concerning HDR Light Studio uses see online help or
PDF User Guide at https://www.lightmap.co.uk/support/.

https://www.lightmap.co.uk/support/
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10 IMPORT AND EXPORT

10-1 CAD Models

10-1.1 Importing 3D CADModels

In the Shaper interface, CAD models are imported using the menuModel >
Import. To import a model, select the desired file format, and then select your
file using the browser. A status bar will appear, indicating the progress of this
import.

The list of recognized formats depends on the software options selected during
the purchase of your Patchwork 3D Design license. The following file formats
are available:

l FBX (*.fbx)
l DXF (*.dxf)
l Wavefront OBJ (*.obj)
l 3DS (*.3ds)
l STL (*.stl / *.sta)
l Parasolid (*.x_t / *.x_b)
l Parasolid IGES (*.iges / *.igs)
l Solid Edge Assembly
l Solid Edge Part
l ACIS SAT (*.sat / *.sab)
l ACIS XML (*.xml)
l ACIS IGES (*.iges / *.igs)
l ACIS STEP (*.step / *.stp)
l ACIS Creo, PRO Engineer (*.prt / *.asm)
l ACIS Catia V4 (*.model / *.exp)
l ACIS Catia V5 (*.CATPart. /*.CATProduct)
l ACIS CATProduct V2 (*.CATProduct)
l Wire File
l Wire Folder
l ACIS NX Assembly (*.prt)
l SolidWorks Assembly
l SolidWorks Part
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l Lumiscaphe P3DXml (*.xml)
l Lumiscaphe Patchwork 3D Lite (*.p3dlite)

The import compatibilities in 2019.1 X3 are as follows:

Source Format Support in Patchwork 3D Design

Adobe Illustrator .dxf Through Illustrator CC 2016
Siemens NX .prt Through NX 12
SolidWorks .sldasm, .sldprt From 98 through 2018

Autodesk Maya .fbx Through 2019.0
Autodesk 3ds
Max

.fbx Through 2019.0

Acis .sat Through 2019.1.0

Parasolid .x_t, .x_b Through 31.0

Alias .Wire Through 2019
SolidEdge .asm, .par, .psm, .x_t Through ST10 (with Parasolid

export)

Creo
Pro/Engineer

.asm, .prt Through Creo 5.0

Catia V4 .model, .exp 4.1.9 through 4.2.4
Catia V5 .CATPart, .CATProduct V5R8 through V5-6R2018

Catia V6 .CATPart (v5), .CATProduct
(v5)

Through V6 R2018x

OBJ .obj All versions

STL .stl All versions

3DS .3ds All versions

Step .stp 203, 214, 242 versions

IGES .iges, .igs All versions

Based on the format of the file you would like to import, it is recommended to
use the first possible line in the following table:

From To Importer to Use

Catia, Acis, NX, SolidWorks,
Parasolid, software supporting
FBX

Patchwork
3D Design

Direct interoperability (for example,
use the NX importer for NX files)

software supporting STEP Patchwork
3D Design

STEP

software supporting IGES Patchwork
3D Design

IGES

software supporting OBJ Patchwork
3D Design

OBJ

any other software Patchwork
3D Design

DXF, STL
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Patchwork 3D Design uses two 3D modeling engines to import file formats
storing geometry elements as NURBS:

l ACIS
l Parasolid

Formats imported using these powerful geometry engines will allow users to
work directly with the surface topology. Tessellation and assembly options are
available for surfaces imported in these formats.

Autocad DXF,Wavefront OBJ, Ksc formats store the models as lattice mesh
geometry. Tessellation and assembly options are not available for surfaces
imported in these formats.

Patchwork 3D Design works on a metric scale. Certain CAD formats specify the
scale used for the design of models. In this case, Patchwork 3D Design
interprets this information and converts the dimensions of the model from the
original scale to the metric scale. When the scale information is not available in
the CAD file, Patchwork 3D Design uses the default scale specified for each
format in the general preferences of the software.

To open the window used to set the application’s importers default units,
navigate to the Filemenu > Settings > Import tab > Importer default units
button.

10-1.2 Exporting CADmodels

In Shaper, CAD models are exported using the menu optionModel > Export. To
export a model, select the desired file format, then enter the filename you
would like to save the model under.

The following file formats are available:

l Wavefront OBJ (*.obj)
l Lumiscaphe P3DXml (*.xml)
l FBX (*.fbx)
l Lumiscaphe Ksc (*.ksc) (optional, based on your license)

The following table gives version compatibilities:

Format Compatible versions

OBJ All versions

P3DXml P3D software suite 2019.1 X3
FBX Autodesk Maya / Autodesk 3ds Max from 2013
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10-1.3 P3DXml Format

This format is for exporting and importing P3D data in XML format via the
Shapermodule of Patchwork 3D Design.

It is used mainly for merging several elements from different P3D databases
(e.g. vehicle interior and exterior).

List of transferred elements:

l Layers,
l Surfaces and their geometries (nurbs, meshes),
l UV coordinates,
l Lighting effects,
l Kinematic hierarchy (All of the work done to prepare a synchronized
animation of surfaces is preserved during the export.),

l Configurations,
l Materials,
l Environments, including alternate background textures,
l Timelines,
l Camera hierarchy,
l Sensors.

The P3DXml format is an open format and facilitates the creation of
customized gateways between Patchwork 3D Design and the other software.

10-1.4 FBX Import

The FBX import allows information related to surfaces and surface
parameterization, textures, camera animation paths, and materials to be
imported. Furthermore, Patchwork 3D Design supports FBX files up to version
2012 included.

10-1.4.1 FBX Import User Interface

The user interface is accessed from Shaper > Model > Import > Import FBX.
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FBX Import Options dialog box

Import to timeline with user-provided name checkbox lets you to replace
the original name of the animation by your own.

Simplify animated meshes if needeed simplifies the animation as explained
in Timelines (page 491) paragraph.

Animated meshes box allows you to import FBX animation with two different
modes.

l Basic mode: The animation will be imported as a standard channel
animation in your timeline.

l Advanced mode: The animation will be imported as a advanced
channel animation in your timeline.

Node curve box allows you to select between two different options depending
if you want to edit or not the animation curve.

l Import curve option will convert to a editable format by Patchwork
3D which allows later on the edition of the curve.

l Bake animation option will import the animation curve without the
possibility to edit it.

When you have done a selection, click OK button.

During the import process of one or more FBX files, a log window displays its
progression. The log window shows events, warnings (printed in orange) and
errors (printed in red).
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10-1.4.2 Imported FBX Data

10-1.4.2.1 Surfaces

The Patchwork 3D Design FBX importer only supports FBX mesh surfaces. If the
FBX surface contains quadrangles or polygons which have more than four
vertices, they are triangulated.

If the FBX file contains NURBS or Patch nodes, the importer carries out a
preprocessing step in order to triangulate these geometries using the FBX SDK.
After this preprocessing step, these surfaces are imported as Shaper mesh
surfaces. The FBX importer does not try to stitch surfaces automatically.

If the surface contains more than one material, it is split into sub-surfaces. Each
sub-surface corresponds to the restriction of the original surface to one
material. In this case, a null surface is created and serves as a parent for the
sub-surfaces.

10-1.4.2.2 Point cache

If references to point cache files containing information for vertex displacement
are found in the FBX file, the animation of the meshes are imported at the same
time as the surfaces.

Point cache files are exported from Autodesk Maya or Autodesk 3ds Max
during the FBX export. This plugin is included in both Autodesk Maya 2017 and
Autodesk 3ds Max 2017.The Geometry Cache File(s) option (Autodesk Maya)
or the Point Cache File(s) option (Autodesk 3ds Max) must be selected.

The MC (XML) format is preferred. Point cache files in pc2 or MC (XML) format
are supported.
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EXAMPLE: EXPORTING FROMAUTODESK 3DSMAX 2017

1. Create an object with a mesh animation.
2. Select the menu option Edit > Manage Selection Sets. The named

selection set management window will open.
3. Select the object with a mesh animation, then create a new selection

set. This new set contains the animated mesh.
4. Select the option from the main menu > Export > Export. Choose the

FBX export and confirm. You will need to provide a filename and a
location to save the export.

5. An options dialogue will open. Expand the Animation section. Check
the box beside the Animation option.

6. Expand the Cache Point File section. Check the box beside the
Cache Point File(s) option. Then, in the drop-down list, choose the
selection set you created for the animated mesh.

7. Validate. This operation will create an FBX file with the vertex
displacement information. It also creates a folder with the same name
and the _FPC suffix, containing an MC file and an XML file. These are
the point cache.

If you prefer, you can modify the type of point cache file to be created:

1. Create an object with a mesh animation.
2. In the sidebar, select the Modify group.
3. Select the mesh.
4. Add a modifier by selecting Point Cache from the List of Modifiers.
5. In the Parameters zone, click on New. At this point, you can select the

file format: XML (the default format) or PC2. Validate your choice.

When exporting an FBX file with point cache files as described above, the selected
point cache format will be respected.

For additional information on creating animated meshes and their properties,
refer to the Autodesk Maya documentation under the Geometry Cache section,
or to the Autodesk 3dsMax documentation under the sections Modifiers, Point
Cache Modifier (Object Space) or Point Cache Files.

10-1.4.2.3 Surface Parameterization

The Patchwork 3D Design FBX importer supports the import of the FBX UV sets,
which are copied automatically into the fields uvw:0, uvw:1… of the Patchwork
3D Design surfaces. For each of these UV sets, the surface mapping type is set
to Extract.
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10-1.4.2.4 Materials

The Patchwork 3D Design FBX importer also imports some of the materials
used on mesh surfaces. The imported materials are assigned to the imported
surfaces.

Lambert and Phong materials can be imported. The imported properties are the
following:

l Diffuse color,
l Ambient color,
l Opacity modulator,
l Reflection Factor (for Phong materials),
l Specular color and factor (for Phong materials).

The following figure shows the expected behavior when importing a FBX file
created using Maya software (note:  the lighting is different between the two
screenshots).

Maya shading (left) and Matter shading (right) for an imported FBX file.

10-1.4.2.5 Textures

If a texture file is found on the diffuse, bump or specular layer of a Lambert or
Phong material, it is imported provided the FBX importer is able to retrieve it.
Only the first texture file on each layer can be imported. If more than one
texture file is found on a given layer of a FBX material, all files starting from the
second one are ignored. In such cases, a warning is inserted in the log file.

The Patchwork 3D Design FBX importer looks for texture files as follows: it tries
to retrieve the file using the absolute file name found in the FBX file first, and
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then using the relative file name generated by the FBX export module. Lastly, it
tries to retrieve the file in the FBX file directory using only the texture file name.

The texture is assigned to the corresponding layer of the material, and is also
visible in the Texture tab ofMatter.

10-1.4.2.6 Camera Animation Path

The Patchwork 3D Design FBX importer imports camera paths as follows: each
key frame is imported as a tuple (from, to, up, fov) written in a Patchwork
3D Design Kam file. Thus, baking the animation at the desired frame rate while
exporting a FBX file is necessary as intermediate positions cannot be rebuilt
from Kam files.

The FBX importer creates one Kam file per camera. The Kam file name is built as
follows: "<fbx_file_name> FBX import – <camera_name>".

10-1.4.2.7 Animations

Transformations of the scene graph saved in FBX format are imported as a
timeline containing channel animations. Each channel animation corresponds
to the animation of a node in the FBX scene graph and is placed at the correct
time in the timeline.

As channel animations, these elements appear in the Channel Animations
library in the Timelines editor and can be reused in other timelines. Channel
animations created by the FBX importer are not editable.

The FBX importer creates the following elements:

l A timeline with the name of the imported FBX file. This timeline is
shared with imported animated meshes.

l One channel animation per node animation, each with the name of
the corresponding node.

10-1.4.2.8 Other FBX Nodes

Any other FBX nodes are imported as null surfaces. The null surface name in
Patchwork 3D Design is the node name read in the FBX file.
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10-1.4.2.9 Visibility Layer Hierarchy

The FBX importer first creates a layer with the time stamp and the path to the
directory used to store the temporary files generated during the import
process. Then, it creates a layer for each imported file using the file name as
layer name.

For each file, the FBX importer builds a layer hierarchy corresponding to the
FBX file node hierarchy.

Layer hierarchy from data in the .fbx format in Maya (left) and Patchwork 3D Design
(right).

10-1.4.2.10 Kinematic Hierarchy

The FBX importer also builds a kinematic hierarchy that follows the FBX node
hierarchy.
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Example of kinematic hierarchy in Shaper built according to a FBX node hierarchy.

10-1.5 Wire Import

10-1.5.1 Importing Files in the Wire Format

10-1.5.1.1 Geometry Data

The different types of geometry data interpreted are:

l Groups,
l Meshes,
l Polysets,
l Shells,
l Surfaces.

Existing parameterizations are not interpreted. As a result, imported surfaces
are given the default parameterization (type BOX).

For each node (Group) in the Wire object tree, Meshes, Polysets, Shells and
Surfaces are retrieved. Each of the NURBS surfaces forming Shells and Surfaces
is extracted along with its trim curves and converted into Parasolid data. The
surfaces are sewn together by the Parasolid engine to build the element
described with Alias. It is possible to obtain several surfaces if sewing fails. The
last step consists in sewing the surfaces sharing the same shader and layer
inside a Group together. A Shaper group is created from the result of this
sewing process and inserted in the right place in Shaper layers.
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10-1.5.1.2 Material Data

The material data interpreted are:

l "File" textures,
l RGB color parameters,
l Some parameters from the Phong and Lambert models.

For each Surface or Shell, the first shader only is retrieved. AMattermaterial is
created from this shader and assigned to the corresponding object.

A standard Matter material is created by retrieving color data. Furthermore:

l For "Phong" materials, intensity and specular roughness data, along
with the diffuse intensity, specular filter and transparency, are
retrieved,

l For "Lambert" materials, diffuse intensity is retrieved.

"File" textures in the original material are added to the texture library, and the
first one is assigned to the diffuse color map of the material.

10-1.5.2 Wire File Format Import Options

All options for importing Wire files or folders are gathered in a dedicated
dialog box.  This dialog box is accessed from Shaper either by selecting
Model > Import > Import Wire files or Import Wire folder, or from the
Model tab.

10-1.5.2.1 Surfaces

This dialog box contains the options for importing surfaces.

Visual quality: the tessellation size may be set using either the slider or the
field linked to it. By default, the tessellation is generated with a Tolerance of
0.5 mm between the triangulated surface and the NURBS surface.

Grouping surfaces: three options are available for grouping surfaces.

l By Layer: A Shaper layer is created for each Wire layer. Groups of
imported surfaces are assigned to the Shaper layer associated to
their initial Wire layer. The groups are made up as follows: for a
given Wire group containing at least one Shell or Surface, a Shaper
group is created with the surfaces it contains.  This option is
activated by default.
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l By shader: A Shaper visibility layer is created for each Wire shader.
The groups are created similarly to when using the By Layer option.

l By Layer Hierarchy: A Shaper visibility layer hierarchy that
reproduces the Wire layer/group hierarchy is created.

Transformation: this option is for defining how surfaces with symmetry are
imported.

l No symmetry: no symmetry is imported.
l Use layer symmetry: the symmetry defined in the layers of the
Wire file is used (the plane of symmetry is retrieved). This option is
activated by default.

l No symmetry on shaders with suffix: a symmetry with the
default plane (equation z = 0) is used for all surfaces whose shader
does not have a name including the specified suffix.

Kinematics: this option allows importing object graphs as kinematics graphs. A
null surface is attached for each group of the Wire data tree. The null surfaces
are attached to a visibility layer namedWire Import Kinematics and the
kinematics hierarchy is accessible in the dedicated tab. This option is enabled
by default.

Topology: these options control the sewing process and grouping the surfaces.

l If Use topology is activated, then an attempt at converting Shells
into Parasolid surfaces is made. Shells may be imported as meshes if
the option Convert to mesh in the Topology conversion failures
box is enabled. These meshes are built using the Alias tessellation
engine.

l Autostitch is for controlling the attempts at sewing imported
surfaces. If Autostitch is enabled, then an attempt is made to :

o sew the surfaces of a Shell together,
o sew the surfaces of a group of objects with the same
shader,

o sew the various parts in a list of Shells.

The options Use topology and Autostitch are enabled by default.

10-1.5.2.2 Camera

This option imports the file’s cameras as cameras. These cameras are saved in a
group of cameras namedwire import – filename. This option is activated by
default.
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10-1.5.2.3 Shaders

The options for importing textures and materials are contained in this box.

Import textures: this option is for importing the "file" type textures and
specifying maximum dimensions if necessary. This is enabled by default.

Reuse shader information: if a material with the same name already exists in
Matter library, then it is used. Otherwise, this option allows the material library
to:

l Create a new material systematically (No),
l Create a new material only if there is no material with the same
name in the default library (Use default library),

l Create a new material if there is no material with the same name in
the specified library (Use specified library).

10-1.5.2.4 Topology Conversion Failures

This box is for defining the actions to perform in case of a topology conversion
failure.

Save failed objects: this option is for saving Shells that could not be imported
as files, using Alias file format. It is disabled by default.

Convert to mesh:  this option converts Shells whose import failed using Alias
tessellation engine into meshes. It is disabled by default.

10-1.5.2.5 Log

A log file can be specified using this option. This file may be deleted if no
problem occurred during the import by selectingDelete if everything went
OK. No default file is specified.

10-1.5.2.6 Update Mode

Update current model with imported file: when this option is enabled,
existing surfaces of the current model with the same name as surfaces of the
imported file are updated. The geometry, comment, symmetry and material are
updated. If a group of surfaces with the same name exists, its color and material
are updated, and the new surfaces attached to it.

The group name is defined as follows:
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l For a Shell, it is the name of the Wire Shell node,
l For a list of Shells, it is the name of the Group and the shader name
linked with #.

Keep textures: when this option is enabled, updates of a surface or a group of
surfaces do not take the material into account.

10-1.6 NX Import

Available in: Shaper:Model > Import > Acis NX Assembly

Patchwork 3D Design includes an import for files in Acis NX Assembly format
(*.prt). This import is compatible with NX versions 11 – NX 9.

To import an Acis NX Assembly model, browse to theModelmenu in Shaper.
Select Import. Then, choose Acis NX Assembly. In the window that appears,
select your *.prt file, and click OK.

You can cancel the import during the reading of the .prt file by clicking on the
Abort button.

This procedure imports:

l The surfaces as NURBS,
l The geometry,
l The file structure: a layer containing all of the corresponding
surfaces is created for each file in the assembly.

10-1.7 SolidWorks Import

Available in: Shaper:Model > Import > SolidWorks Assembly

Patchwork 3D Design includes an import for files in SolidWorks Assembly
(*.sldasm) and Part (*.sldprt) formats. This import is compatible with versions of
SolidWorks up to and including SolidWorks 2017.

To import a SolidWorks model, browse to theModelmenu in Shaper. Select
Import. Then, choose SolidWorks Assembly. In the window that appears,
select your *.sldasm file, and click OK.

You can cancel the import during the reading of the *.sldasm file by clicking on
the Abort button.

This procedure imports:
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l The surfaces as NURBS,
l The geometry,
l The file structure: a layer containing all of the corresponding
surfaces is created for each file in the assembly.

10-2 ExportingMatter Products

Matter products can be exported via the menu Product > Export.

10-2.1 Export KDR

Available in: Matter: Protect > Export

In order to be used with the Lumiscaphe software suite of 3D visualization
tools, the raw authoring data must be exported as a Digital Aspect Mockup
(DAM) in the format .kdr. This format contains only the data required by the
rendering engine in order to display the product variants and configurations
created in Patchwork 3D Design. The image underlying the relief in a texture is
no longer present; only the resulting calculations needed to display a material
using that texture are conserved. Consequently, authoring is not supported in
this format. The .kdr is optimized to load more quickly: unlike the .p3d format,
in which the displayed images must be calculated when the file is opened, the
data in the .kdr can be transmitted directly to the graphics card without further
treatment.

The Digital Aspect Mockup may then be used as-is in any of the Lumiscaphe
visualization solutions.

Depending on the case, the addition of new features in Patchwork 3D Design
has an impact on the data to be exported in KDR format.
To clearly identify which KDR format works with the version of Patchwork 3D,
Xi has been added in the software naming.

l If adding the features in Patchwork 3D do not modify the KDR
format, we could have the following examples: Patchwork 3D Design
8.3 X2, Patchwork 3D Design 8.4 X2, Patchwork 3D Design 8.5 X2
and so on.

l However, if adding the features in Patchwork 3D modify the KDR
format, we could have the following examples: Patchwork 3D Design
8.3 X2, Patchwork 3D Design 8.4 X3, Patchwork 3D Design 8.5 X4
and so on.
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When exporting a product in KDR format you will have the ability to choose
between:

l The current version of the KDR > KDR
In the Export to KDR Xi window that shows up, type the name of
the file under which you want to save it.

l The previous version of the KDR > KDR (previous version)
In the Export to KDR window that shows up, select the version of
the KDR you want to export from the drop-down menu. Then type
the name of the file under which you want to save it.

A lower version means a better compatibility with other software, but
less features supported.

A higher version means more features supported, but the compatibility
with other software might be broken.

The following format are available:

Format Versions and features that make this export impossible

KDR X1 Software Suite v8.0 or higher

l U or V repetition for labels and textures.
l Repetition for labels and textures in mirror.

KDR X2 Using the roughness map.

KDR X3 Compatible software X3

10-2.2 Export FBX

Available in: Matter: Product > Export

To export an FBX product, select the FBX file format, an FBX Exporter window
shows up, select the desired settings and click on Export button and then type
the name of the file under which you want to save it.

The following file format is available:

Format Compatible Versions

FBX FBX 2013
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11 MODELS

11-1 Definition

The highest-level object handled by Shaper is the model. A model is a
collection of geometric and null objects and their properties.

Several related models can be stored in the same database. Shaper functions as
a model explorer: you select the model on which you wish to work, by means of
the model selector.

11-2 Operations on Models

Operations concerning models can be found in the Shaper Modelmenu or in
the Shaper Geometry sidebar tab:

Icon Function

Create a new model.

Duplicate a model.

During the duplication of a model, Patchwork 3D Design shares the geometrical
elements constituting the surfaces of the model between the original and the
duplicate models. This means that duplicating a model uses very little memory.

Rename a model.

Import a model.

Export a model.

Delete a model.
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A 3D model can occupy a large amount of memory. A model is loaded into the
memory only when it is to be edited. All the models loaded during your work
session are held in the memory and are instantly available by means of a
system of tabs located just below the top toolbar.

On the right, in the same bar as the tabs, the button can be used to close
the current model. You can also clear a mode from the memory by closing it by
means of theModel > Closemenu option.
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12 SURFACES

12-1 Definition

The surfaces are the 3D geometrical elements used to construct the models.
The surfaces are directly derived from importing the CAD models into
Patchwork 3D Design. The surfaces are represented by a lattice of triangles (a
mesh).

A surface may contain several non-contiguous geometrical elements. Dressing
models inMatter is performed surface by surface.

The same surface, whether it consists of one or more geometrical elements, can
receive only one material. It is therefore important to split surface elements in
your CAD tool before importing them into Patchwork 3D Design.

12-2 Operations on Surfaces

Operations concerning surfaces can be found in the Shaper Surfacemenu or
in the Shaper Geometry sidebar tab:



12    SURFACES

p.278 Lumiscaphe Patchwork 3D Design 2019.1 X3

Icon Operation Description

Duplicate
Makes a copy of the selected surfaces in the active layer. The original
surfaces are unselected and the duplicate surfaces are selected
instead.

Move Moves all the selected surfaces into the active layer.

Properties Opens the Surface Properties (Shaper Editor) (page 221).

Delete Deletes the selected surfaces.

Certain operations are available only from the Surfacemenu:

Icon Operation Description

Duplicate
with
Symmetry

Duplicates a surface using a symmetry function. The duplicated
surface is fully independent of the original, unlike the surface
symmetry property, which can be activated in the Surface Properties.

Copy Copies the selected surfaces to the clipboard.

Cut Cuts the selected surfaces to the clipboard.

Paste Pastes the contents of the clipboard in the active layer.

YZ symmetrical duplication.
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12-3 Surface Optimization

Surface optimization is carried out in Shaper.

Surface optimization adds, corrects or perfects surface information after
importing.

12-3.1 Triangulation

Patchwork 3D Design uses a powerful geometry engine that enables it to
preserve the geometrical information of each surface.

When a surface is derived from a parametric definition (for example, a NURBS),
it is possible to modify its degree of tessellation, that is, the resolution of the
triangular mesh that makes up the surface. This allows you to optimize the ratio
of the rendering quality relative to the number of triangles generated.

Patchwork 3D Design will also tessellate groups of surfaces. Interactive
tessellation is possible for the applicable surface, no matter what types of
surfaces make up the mixed selection.

Modifying triangulation requires particular license options. These functions
are automatically available when a CAD import option is present.

Surface tessellation can be modified in Shaper using the toolbar buttons or the
options in the Surface > Triangulation submenu:

Icon Function Description

Increase
Triangulation

Increases the tessellation of a surface by one degree (refine the
surface by increasing the number of triangles).

Decrease
Triangulation Reduces the tessellation of a surface by one degree.

Set
Triangulation Sets and imposes a specific level of tessellation.

Set Advanced
Triangulation Gives access to the advanced triangulation settings.
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Modification of the tessellation parameter on a parametric surface.

l Convert to Mesh: deletes the parametric representation of
the selected surfaces. The current tessellation is permanently
affected to the surface. This reduces the space taken up by surfaces
in the database.

12-3.2 Stitch and Split Functions

In the Surface > Surface Topology menu:

Icon Function Description

Stitch Combines several selected surfaces into one.

Split Disassembles a surface composed of several geometric elements. Each
geometric element becomes a surface in its own right.

12-3.3 Orientation: Front and Back Faces

A surface is an oriented geometrical element with a front side and a rear side.
By default, the back faces of surfaces are culled, that is, not displayed. In
Shaper, culled backfaces are displayed in red.

Two visualization options are available in the Viewportmenu:

Icon Function Description

Track
culling

Renders culled backfaces in red, making it possible to tell which faces
aren't displayed. This option is enabled by default.

Backface
culling

Optimizes rendering by not calculating the back of surfaces,
substantially accelerates the calculation of interactive 3D images. This
option is enabled by default.
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To use backface culling correctly, the front face of the surfaces needs to be
oriented to the visible side of the delimited volume. You can modify the
orientation of the surface front and back faces from the Surfacemenu:

l Reverse: flips the orientation of the selected surfaces.

The incorrectly oriented surfaces are selected... ... and then inverted.

Example of the Reverse function (initial orientation on the left, final orientation on the
right).

12-3.3.1 Surface Auto-Orientation

Three automatic orientation modes are available in the toolbar and from the
Surface > Auto-Orientation menu:

Icon Function

Auto-orient visible surfaces

Auto-orient selected surfaces
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Icon Function

Auto-orient surfaces towards interior

Visible Surfaces: automatically orients all surfaces visible from the
current point of view. In order to determine if the front or the rear face of a
surface is visible from this point of view, a rendering is performed. The number
of red pixels is compared to the number of pixels of another color among the
visible pixels of the surface (i.e. pixels not occluded by another surface). If most
pixels are red, the surface is considered to be inside out and its orientation is
flipped.

Example of the auto-orientation of visible surfaces function. Initially, some of the seat’s surfaces are
inside out (top left). With the door closed (top right), some of these surfaces are not visible. The auto-
orientation function for visible surfaces is used (bottom): the inside out, non-visible surface retains its

original orientation.
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Selected Surfaces: automatically orients a selection of surfaces. When a
set of surfaces is selected, the function determines the corresponding bounding
volume. Fourteen renderings of the selected surfaces are performed for camera
positions spread around the bounding volume. If more red pixels than pixels of
another color are visible for a given surface, this surface is considered to be
inside out and its orientation is flipped.

Only visible pixels are taken into account. If a surface is completely occluded by
another surface in the selection, it will never be reversed.

Example of the auto-orientation of selected surfaces function. Initially, some of the
seat’s surfaces are inside out (top left). All the surfaces of the seat are selected (top
right), and the door closed (bottom left). The auto-orientation function for selected

surfaces is used in order to orient the surface properly (bottom right).



12    SURFACES

p.284 Lumiscaphe Patchwork 3D Design 2019.1 X3

The fourteen intermediate renderings of the selected surfaces performed for the
example presented in the previous figure.

Surface towards Interior: automatically orients surfaces towards an
interior volume. Six renderings taking all the surfaces in the scene into account
are performed from the current camera position in the following directions:
forward, backward, up, down, left and right. If more red pixels than pixels of
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another color are visible for a given surface, this surface is considered to be
inside out and its orientation is flipped.

As for the auto-orientation function for Selected Surfaces, only visible pixels are
taken into account. If a surface is completely occluded by another in the selection,
it will never be reversed.

Example of the auto-orientation function for surface interiors on the 3D scene in the
top image: the surfaces identified as inside out have been reversed.
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Renderings performed to identify the orientation of each surface with the auto-
orientation function for surface interiors. Top: forward and backward. Middle: up and

down. Bottom: left and right.

12-4 Positioning Surfaces

In Shaper, the gizmos allow surfaces to be positioned using the mouse directly
in the 3D interface:

l Translation: movement along the X, Y and Z axes.

l Rotation: rotation around the X, Y and Z axes.
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Surface translation along the Y axis; Surface rotation around the X axis.

Surfaces can also be positioned by providing numerical values for the desired
orientation and position.

12-5 Recalculating Normals

Normals may have to be recomputed when they are either missing or
incorrectly imported.

Display the normals for a selected surface by ticking the Normals option in the
Display box of the Mapping sidebar tab.

From the Surfacemenu or the toolbar:

l Reverse Normals: reverses the normals for the selected
surface.

l Recompute Normals: recalculates the normals for the
selected surface based on the threshold angle you supply.

Recomputing will overwrite the current normals.

When two triangles share an edge, the vertices located on the edge
can be associated with several normals that may not have the same
direction. In this case, the normals form an angle. If the threshold
angle smaller than the angle between the normals, the normals
remain untouched. However, if the threshold angle is larger than the
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angle between the normals, the normals will be averaged, thus
smoothing out their orientation on the shared edge.

Results of applying the Recompute normals function with a threshold angle of 85° on a
box.

Results of applying the Recompute normals function with a threshold angle of 95° on a
box.

12-6 Surface States

Surfaces can be hidden or frozen.
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l A hidden surface is not visible in any viewport. This includes Matter
viewports.

l A frozen surface cannot be selected or modified.

In Shaper, a surface's state is listed:

l As icons in the Surfaces box of the Geometry sidebar tab,
l As check-boxes in the Geometry tab of the Surface Properties
editor (keyboard shortcut: P).

InMatter, a surface's frozen state has no meaning. It's visibility state is listed:

l As a check-box in the Surface Properties editor (right-click on the
surface in a viewport and choose Edit properties).

You can use interaction modes to set the state of several surfaces by clicking on
them. These are available from the Shaper > Modemenu or from the toolbar:

Icon Description

Click to Hide

Click to Freeze

Click to Unfreeze

You can set which surfaces are visible from the Shaper > Visualization menu:

Icon Function Description

Hide
Selected The selected surfaces are hidden.

Hide
Unselected The unselected surfaces are hidden.

Hide
Frozen The frozen surfaces are hidden.

Show All

All hidden surfaces are made visible.

Show All is also available from the context menu that appears
when you right-click in a Matter viewport.



12    SURFACES

p.290 Lumiscaphe Patchwork 3D Design 2019.1 X3

You can set surface states from the viewport context menu that appears when
you right-click on a surface in a Shaper viewport.

12-7 Surface groupings

12-7.1 Merge and unmerge surfaces

Icon Function Description

Merge
surfaces

Allows you to create a single surface from the selected
surfaces. This function share UV unfolding and
lightmaps in particular.

Unmerge
surfaces Retrieves initial surfaces fromMerge Surfaces function.

UV unfolding and lightmaps are lost with the functions below:

l Merge surfaces
l Unmerge surfaces

12-7.2 Create and dissociate a set of objects

NEWFEATURES IN PATCHWORK3D DESIGN2019.1 X3.

Icon Function Description

Create a
set of objects

Creates a group of objects in which all of the selected
objects will keep their initial states. This is called
creating a set of objects.

Dissociate a
set of objects Dissociates a set of the objects.

l Create a set of objects saves the selection in the Selection editor. Cf.
Selections (Editor) (page 191).

l Doing an operation on a set of objects it amounts to doing an
operation on each object of the set.

l Clicking on a surface of a set selects all objects.
l Unlike the merge of surfaces this feature keeps all the properties of the
surfaces.



12    SURFACES

Lumiscaphe Patchwork 3D Design 2019.1 X3 p.291

l Compared to a multiple selection, this feature adds the ability to
assign a material to a set of objects.

Below are the shortcuts for creating and deleting a set of objects.
Action Shortcut

Create a set of objects Ctrl + G

Dissociate a set of objects Ctrl + Shift + G

A surface could belong to more than one set of objects.
In this case a contextual menu shows up to let you choose what set of objects you
want to work on it.

Sets of objects can then contain kinematic objects, Bezier paths and mergers of
surfaces.

12-7.3 Visual representation

A multiple selection of surfaces

With the Merge surfaces feature, the different
geometries form only one surface and therefore

have the same color.
The selection box is white.

With the Create a set of objects function all the
objects keep their own color.
The selection box is pink.
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12-8 Geometric Primitives

Patchwork 3D Design can be used to create simple geometric primitives: plane,
cube, sphere, hemisphere and cylinder. These primitives can be created under
theModelmenu of Shaper.

12-8.1 Plane Primitive

Available parameters:

l Name,
l Steps: number of tessellated divisions per axis,
l Width: X axis dimensions,
l Depth: Z axis dimensions.

12-8.2 Box Primitive

Available parameters:

l Name,
l Side steps: number of tessellated divisions per box face,
l Width: X axis dimensions,
l Height: Y axis dimensions,
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l Depth: Z axis dimensions,
l Laid on grid: positions the base of the box on the XZ plane usually
used for defining the ground of the 3D scene.

12-8.3 Sphere Primitive

Available parameters:

l Name,
l Number of meridians: number of tessellated divisions running
from pole to pole. The poles are aligned to the Y axis.

l Number of parallels: number of tessellated divisions wrapping
around the sphere. These are parallel to the XZ plane.

l Radius,
l Laid on grid: positions the base of the sphere on the XZ plane
usually used for defining the ground of the 3D scene.

12-8.4 Hemisphere Primitive

Available parameters:

l Name,
l Number of meridians: number of tessellated divisions running
from pole to pole. The poles are aligned to the Y axis.

l Number of parallels: number of tessellated divisions wrapping
around the sphere. These are parallel to the XZ plane.

l Main radius: radius of the corresponding sphere. Consequently, this
is also the height of the hemisphere.

l Edge radius: radius of the bottom edge of the hemisphere. This
dimension must be smaller than the main radius. This creates a
rounded bottom edge, which improves visual quality when the
hemisphere is used as a skydome.

A hemisphere is always automatically positioned on the XZ plane usually used
for defining the ground of the 3D scene.

12-8.5 Cylinder Primitive

Available parameters:
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l Name,
l Circle steps: number of tessellated divisions around the edge of the
circular cap of the cylinder,

l Height steps: number of tessellated divisions along the vertical
edge of the cylinder,

l Radius,
l Height,
l Axis: sets the axis along which the height of the cylinder is aligned,
l Laid on grid: positions the base of the cylinder on the XZ plane
usually used for defining the ground of the 3D scene.

12-8.6 Kinematic Primitives

Kinematic primitives are used to parent surfaces and create kinematic,
animatable groups. They have no creation parameters but can be edited from
the Kinematics sidebar tab. These objects are not surfaces; they are invisible in
finished products and cannot receive materials.

Three kinematic primitives are available:

l Axis,
l Null,
l Vector.

For more information, see the section Animation Utility Objects (page 488).
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13 PIVOTS

13-1 Definition

Each surface has a local tab known as a Pivot. A pivot is a surface's attachment
point. It is generally positioned at the origin of the surface's local axes and it
indicates the orientation of the axes. Local axes are used when you wish to
group surfaces and move the group together, or when you are preparing an
animation.

If the Pivot tab is active in Shaper, the pivot of a surface is visible when
the surface is selected.

A pivot of a surface.
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13-2 Operations on Pivots

The operations in the Pivot tab in the Shaper sidebar make it possible to
move the pivot without modifying the position of the surface in the
environment (the relative position of the surface to its pivot is thus modified in
consequence).

The operations for translating the pivot are the following:

Translation option Description

Center on Surface Centers the pivot on the surface.

Center on Selection Centers the pivot on a group of surfaces.

Center to Selection
Leader

Centers the pivot on the surface designated as the leader of the
selection.

Center in World Places the pivot point at the origin, at the intersection of the
world axes.

Reset Returns the pivot to its original position.

The orientation of the pivot can also be modified:

Orientation option Description

Align to World Orients the pivot along the environment origin.

Reset Returns the pivot to its original orientation.

The transformation function Reset Position Relative to Pivotmoves the
surface to the center it at the location of the pivot.

The other transformations that can be performed on a pivot (translation,
rotation, constraints on axes, etc...) are the same as those that may be
performed on the surfaces.
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14 UV MAPPING

14-1 Definition

Mapping is an operation that consists of drawing a regular grid directly on the
surface. The materials that will be applied to the surfaces inMatter are cut
along and positioned in accordance with the grid. If the grid is deformed, the
material applied to the surface will present the same deformation.

Most materials are not deformable or support only slight deformations.
Consequently, the mapping grids must be regular and only slightly deformed.

Before mapping.

Mapping assignment.
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After mapping.

The Dressing tab in the Shaper sidebar contains a panel which shows the
tools used for mapping surfaces.

By default, surfaces created in Patchwork 3D Design are mapped using box
projection.

14-2 AssigningMapping

To assign mapping to the surfaces, you will use one of the following processes:
the extraction of mapping predefined in the CAD tool before importing into
Patchwork 3D Design, and the creation of mapping by projecting a geometric
grid onto the surface.

Several types of projection may be used: planar projection, spherical projection,
cylindrical projection, etc. The appropriate choice of the projection method
makes it possible to obtain a regular or almost regular grid on the majority of
surfaces and thus to minimize the deformation of the materials that will be
applied inMatter.

Adjusting the projection parameters is facilitated by using gizmos. A gizmo is
the symbolic representation of a projection in a 3D view. They are in the form
of simplified 3D objects attached to surfaces.

Each is positioned in space relative to the pivot of the surface to which it is
attached. The relative position of a gizmo with respect to its surface is therefore
not modified when you move the surface.
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A certain number of parameters influence the projection: by modifying the
position, the orientation, the length, the height and the width of the gizmo, you
can squash or stretch the mapping grid along the main projection axes.

To assign mapping to a surface, select the surface and choose a mapping
function in Type drop-down menu of theMapping box.

The gizmo represents the two main axes U and V of the projected grid. The U
axis corresponds by default to the horizontal line of the materials, and the V
axis to the vertical line. Certain gizmos project several grids onto the surface
and locally select the most suitable one.

14-3 MappingOperators

There are eight different functions for defining the mapping of a surface:

l Extraction,
l Planar projection,
l Box projection,
l Open box projection,
l Spherical projection,
l Cylindrical projection,
l Closed cylindrical projection,
l Torus operator.

The choice of mapping operator is made by means of a selector in the
Mapping panel of the Shaper interface. By default, no mapping operator is
assigned to a surface.
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14-3.1 Extraction

Certain 3D modeling tools can attach UV mapping information to the surfaces.
When importing models, Patchwork 3D Design attempts to conserve this
information, which remains attached to the surfaces. This is the case, for
example, for the importation of Autodesk 3DS Max models.

Extractmapping operator allows you to apply, depending on the selected UV
set, the unfolding made in the unfolding workshop. Cf. Unfolding Workshop
(page 241)
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14-3.2 Planar Projection

The planar projection projects a grid perpendicular to a plane. The effect
obtained is similar to the projection of a transparency slide onto the surface.
This type of projection is suitable for flat, sparingly deformed surfaces. The
gizmo represents the plane containing the grid.

14-3.3 Box Projection

The box projection is the simplest projection to use and the one that is the most
multi-purpose. The gizmo takes the form of a box that surrounds the surface.
Each face of the box corresponds to a planar projection.
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You can use this projection operator in most situations, since the resulting
mapping grid is sparingly deformed, irrespective of the geometry of the
surface.

On the other hand, the material can be cut into several pieces to cover the
surface.

This mapping operator is ideal when you use uniform materials bearing no
pattern.

14-3.4 Open Box Projection

This projection operator is similar to the box projection. The gizmo takes the
form of a four-sided box with no base and no lid.

14-3.5 Spherical Projection

The spherical projection projects the grid as polar coordinates. The gizmo takes
the form of a sphere. The longitude and latitude correspond, respectively, to the
U and V axes of the grid.
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14-3.6 Cylindrical Projection

The cylindrical projection projects the grid as cylindrical coordinates. The gizmo
takes the form of a cylinder. The longitude and the height in the cylinder
correspond, respectively, to the U and V axes of the grid.

14-3.7 Cylindrical with Cap Projection

The cylindrical with cap projection is similar to the cylindrical projection. The
gizmo takes the form of a cylinder that is capped at both ends.

The two faces at the ends of the cylinder behave like planar projections. The
orientation of the surface is used to determine which grid should be used.
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14-4 TransformingMapping Gizmos

InMappingmode, activated by clicking on theMapping sidebar tab in Shaper,
you can modify the position of a gizmo with the translation and orientation
tools. The dimensions of a gizmo can be edited from theMapping sidebar tab.

14-5 Repetition on the U and U Axes

The repetition factors enable the grid to be expanded in the U or V direction.
The orientation of the U and V axes can be inverted by specifying negative
values or by directly using the commands Flip U and Flip V in the Tiling zone
of theMapping sidebar tab.

14-6 Automatic Alignment

Several tools in the Alignment box in the sidebar facilitate the alignment of the
gizmo on the surface:

Tool Description

Fit to Size Adjusts the size and position of the gizmo so that it bounds the
surface.

Center Positions the center of the gizmo on the center of the box bounding
the surface.

Align XY Aligns the gizmo on the XY plane.

Align YZ Aligns the gizmo on the YZ plane.

Align ZX Aligns the gizmo on the XZ plane.

Fit Size to
Selection Aligns the gizmo on the plane of the 3D active view.

Center on
Selection

Positions the center of the gizmo at the center of the box bounding
the selection.
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14-7 Viewing the Mapping Information

You can view the surface mapping directly in the solid 3D views by enabling
one of the options in the Reference Texture option box. A setting texture
appears on the surface and gives a preview of the position of the mapping grid
on the surface. Two reference textures are available: a checkerboard and a
coordinate texture showing the corners and the center of the grid.
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15 KINEMATICS

15-1 Kinematics Sidebar

The Kinematics tab in Shaper has two functions.

First, it allows a functional hierarchy of moving parts to be developed. Each
movement is represented by a null object: a null, an axis of rotation, or a
translation vector. Axes of rotation and translation vectors create a single type
of movement : an axis of rotation is only animated in a rotation around its axis,
and a translation vector is only animated along the direction it defines.

Secondly, the Kinematics tab also allows parts to be associated with groups of
objects. During an animation, these objects move together following the
movement of the part to which they are attached.

Because the kinematics system is a hierarchy, rather than a list, the parts being
translated or rotated are linked to their parent and child parts. A right-click on
an element in the hierarchy opens a context menu that offers the following
options:

l Insert Axis child part,

l Insert Null child part,

l Insert Vector child part.

Clicking on one of the creation options adds a new part to the kinematic
hierarchical tree and selects this new part.

When a part is selected, the panel in the sidebar will show the options for
editing the part’s properties. The rotation axis or the translation vector is also
presented in the 3D viewport. They allow the animation to be manipulated
manually. They are visible only when the Surfaces tab or the Kinematics tab is
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selected. The representations for null objects, rotation axes, and translation
vectors each have their own Shaper colors. When they are selected, they
behave like other Shaper objects such as surfaces: they are highlighted in white
when selected, or in green when they are part of a selection but not the
selection leader.

15-1.1 Modifying the Hierarchy

Drag and drop parts within the sidebar to change their position in the
hierarchy. When you move a part, all of its child objects are moved with it.

Additional options are available in the context menu. Bring this menu up by
right-clicking on the part you would like to modify.

Hierarchy parts are all Shaper objects. This means that you can modify their
properties in the Properties editor. For easy access, the Properties are also
available from the context menu that appears when you right-click on a part.

You can rename the object directly by choosing the Rename option in the
same context menu.

15-1.2 Saving the Hierarchy

The kinematic hierarchy can be saved by exporting it.

Use the button to export the hierarchy.

This action saves the hierarchy of nulls, vectors, and axes as a KKI file. The
parenting of surfaces to the hierarchy parts is not saved.

KKI files can be reimported into this database, or imported into any other P3D

database using the button.

When a kinematic hierarchic file is imported, its nodes are added to the current
kinematic hierarchy. If you wish to replace the current kinematic hierarchy with
a saved hierarchy, delete the current hierarchy parts before importing.
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15-1.3 Kinematic Properties of Hierarchy Parts

15-1.3.1 Properties of Rotating Parts

The Endpoints zones set the world coordinates of the endpoints of the axis

around which the part pivots. The Pick buttons allow you to set the
position of an endpoint of the axis with a click in the 3D view. Clicking on this
button opens a menu that defines the picking behavior. You can choose
whether the endpoint should be placed:

l At the location of your click,
l At the center of the clicked surface,
l At the pivot of the clicked surface.

The button switches the position of the endpoints. This can be useful to
reverse the direction of rotation around the axis.

TheMin andMax angle fields set the limits between which the part can be
animated.

The Show in Animation Slider Editor option is checked by default. This
allows the animation of this part to be played manually using the Animation
Slider Editor inMatter.

15-1.3.2 Properties of Translatable Parts

The Vector zone allows the endpoints of the translation vector to be provided

in world coordinates. The Pick buttons allow you to set the position of an
endpoint of the vector with a click in the 3D view. Clicking on this button opens
a menu that defines the picking behavior. You can choose whether the
endpoint should be placed:

l At the location of your click,
l At the center of the clicked surface,
l At the pivot of the clicked surface.

The button switches the position of the endpoints.
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Themin andmax distance fields limit the distance over which the part can be
animated.

The Show in Animation Slider Editor option is checked by default. This
allows the animation of this part to be played manually using the Animation
Slider Editor inMatter.

15-1.3.3 Properties of Freely Transformable Parts

In the Settings zone, you can provide the world coordinates of a null’s position.

The Pick button allows you to set the position of the null with a click in
the 3D view. Clicking on this button opens a menu that defines the picking
behavior. You can choose whether the null should be placed:

l At the location of your click,
l At the center of the clicked surface,
l At the pivot of the clicked surface.

15-1.4 List of Objects Belonging to Parts

The objects belonging to the part, whether other parts or surfaces, appear listed
as children under the part node. These objects will be moved when the part is
animated.

If the Sync with selection box is checked, selecting an object in the list also
selects it in the 3D viewport and vice-versa. This helps you locate objects easily
in the viewport.

15-1.4.1 Assigning Objects to a Parent Part

Objects to be assigned to parent parts must not be frozen.

Surfaces cannot be used as parent parts.

Icon Assignment action

This is the assignment shortcut. In the viewport, select the objects you want to
assign as children. Drag and drop this icon onto the kinematic hierarchy node to
be used as their parent.
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Icon Assignment action

The Pick parent of selected objects tool assigns a parent to the selected objects.
First, select the desired child objects. Click the button, then click on the
representation of the parent in the viewport.

The Unparent selected objects tool removes the parent-child links from the
selected objects. Select the objects to be unparented in the kinematic hierarchy or
in the viewport, then click the button.

You can also right-click on an object or a group of objects listed in the
kinematic hierarchy in the sidebar. This will bring up a context menu offering
several operations that can be performed on this object.

15-1.4.2 Assignment Modes

The kinematic function proposes two modes for associating objects with a
parent. One keeps the objects' positions relative to the origin, or center, of the
3D scene; the other orients their positions relative to the parent's position.

15-1.4.2.1 Keeps Child'sWorld Position

This mode conserves the position of the surface as a function of the scene
origin.

No change in position will occur, but the child object will be listed under the
parent node in the kinematic hierarchy.

1. Select the child object.
2. Select the keeps child's world position option in the Parenting an
object zone.

3. Click on the Pick parent button located in the Operations on
selection zone.

15-1.4.2.2 Aligns to Parent-Relative Position

This mode conserves the position of the child objects relative to that of the
parent part.

1. Choose the aligns to parent-relative position option in the
Parenting an object zone.

2. Click on the Pick the Parent button.

The child objects derived from the relationship appear highlighted and position
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themselves relative to the parent, and also relative to the reference in the 3D
space.

If no change appears on the screen once the parent relationship has been
established, zoom out to obtain a wider field of view and observe the
transformations.

15-1.5 Repositioning Parts and Their Associated Objects

The mode , enabled by default, allows objects such as surfaces to be
transformed when their parents are transformed. Deselect this mode in order
to reposition objects that are already part of a parent-child relationship. This
will prevent objects such as surfaces associated with a part from being moved
when you reposition the representation of the null, axis, or vector.

You can reposition all objects by using the translation and rotation gizmos
located in the Shaper toolbar.

15-1.6 Animation Constraints

Animation constraints define how certain Shaper objects move in relation to
others. This relationship is defined by the object to be constrained, its target,
and the type of constraint. Constraints can affect the position of an object, the
orientation of an object, or both at the same time.

Animation constraints are defined in the Kinematics tab of the Shaper sidebar:

1. Select the objects to be constrained.

2. Click on the button to add a constraint to the selected
objects.

3. A context menu appears. Select the type of constraint that will be
created.

4. An eyedropper appears. Use this tool to select the target in the
viewport. For example, if the selected null should follow a Bézier
path, use the eyedropper to select the Bézier path.
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15-1.6.1 Managing the List of Constraints

The list of constraints in the Kinematics tab shows the constraints applied to
the selected object or objects in the Shaper viewports. To view all of the
constraints for a model, select all Shaper objects.

Constraints are taken into account in the order that they are listed. The position
and the orientation of an object are evaluated separately and assigned to the
first constraint in the list that applies to them. Constraints further down the list
will have no effect on an object's orientation or an object's position if it has
already been constrained.

Constraints cannot create circular reasoning. When a new constraint would
create circular reasoning, an error will appear indicating the object of the
constraint causing the conflict. If you really want to create the new constraint,
you must first delete the conflicting constraint from the list.

To modify an existing constraint, select it in the list. Use the button to
activate an eyedropper, then select a new target in the viewport. The new target
will replace the old target in the selected constraint.

Use the button to delete the selected constraint from the list.

15-1.6.2 Position Constraints

Position constraints assign the target's position to the object. If the target is a
moving part, the object will also be affected by the changes to the target's
position.

To avoid having two objects that occupy the same position in the 3D world,
assign an offset to the constrained object. An offset is defined below the list of
constraints using the XYZ coordinates to express the difference between the
target's position and the object's position. When the target is repositioned, the
object will also be repositioned and the offset distance will be maintained.

15-1.6.3 Orientation Constraints

Orientation constraints assign the target's orientation to the object. If the
target is a moving part, the object will also be affected by changes to the
target's orientation.
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The object's orientation and the target's orientation are defined by their pivots,
which set their local coordinates. The rotational transformation that is applied
to the target's pivot will be applied to the object’s pivot.

Two methods exist for setting different orientations for the object and the
target with an orientation constraint:

l Modify the orientation of the local pivot for either the object, the
target, or both.

l Set an orientation offset below the list of constraints. The offset
should be provided in X, Y, and Z angles. It will be applied to the
object's pivot.

15-1.6.4 Look At Constraints

Look At constraints use the position of the target to set the orientation of the
object. If the target is a moving part, when the target is repositioned in the
3D world, the object will rotate in order to face it.

The object’s face is defined by its pivot and by the settings below the list of
constraints:

Setting Default Description

Aim
axis

local X
axis

Defines the local axis of the object's pivot that is oriented towards
the target.

Up
vector

local Y
axis Defines the local axis of the object's pivot that points upwards.

To make fine adjustments the alignment of the object's face, adjust the object's
pivot.

15-1.6.5 Follow Path Constraints

Follow Path constraints allow an object to use a target Bézier curve as a path.
When the Bézier curve's path constraint is animated as a channel animation,
this affects the object's position. If the option Align to path is checked, it also
affects the object's orientation.

The object follows the Bézier path starting from the path's start point and
progressing in the same sense as the path. You can change the start point by:

l Right-clicking on the Bézier path where the start point should be
placed and selecting Place start here.
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l Modifying the Position along path setting below the list of
constraints. Provide location along the Bézier curve by entering a
percentage of the curve.

If the option Align to path is checked, the object will rotate so that its face is
always oriented in the direction of travel along the Bézier path. Below the list of
constraints, you can define:

Setting Default Description

Aim
axis

local X
axis

Defines the local axis of the object's pivot that is oriented towards the
direction of travel along the Bézier path.

Up
vector

local Y
axis Defines the local axis of the object's pivot that points upwards.
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16 LIGHTING

This chapter covers:

16-1 DEFINITION 318

16-2 TYPE OF ILLUMINATION RENDERING 318

16-2.1 Preview Mode 319

16-2.2 Calculating Lightmaps 319

16-3 LIGHT SOURCES 322

16-3.1 Light Source Groups 323

16-3.2 Properties of All Light Sources Types 323

16-3.3 Properties of Sky Sources 329

16-3.4 Properties of Spot Sources 329

16-3.5 Properties of Sun Sources 331

16-3.6 Properties of Omni Sources 331

16-3.7 Properties of Area Sources 332

16-4 LIGHTING PLANNER 333

16-4.1 Planning a Lighting Sequence 333

You may also find the following information helpful:

l Lighting Layers (page 435),
l Distributed Lightmap Rendering (page 337).

To be able to render lighting, the lighting engine must be enabled in the
application settings.
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16-1 Definition

Illumination in Patchwork 3D Design is provided by light sources. These light
sources can be any of various types: sky, spot, omni, sun or area. Light sources
of all types are grouped into lighting layers, which can be combined to create
complex illumination set-ups. The set of visible layers and their coverage
provides a total illumination set-up which is used to calculate lightmaps.

Lighting is managed in the Lighting tab of the Shaper sidebar. At each
level — light sources, lighting layers, and full illumination set-up— settings are
available to adjust the lighting properties.

16-2 Type of illumination rendering

The render configuration settings apply to the entire illumination set-up. They
take into account all of the lights and layers, and their properties, including
visibility and activation.

In the Rendering zone, you can set the type of lighting:

Type of
lighting Description

Environment

The Environmentmode is the type of lighting established by default. In this
mode, none of the existing light sources are taken into account. Sufficient
light is assumed to be generated by the model's environment. The model is
not affected by the illumination configuration.

Lightmap The Lightmapmode allows you to apply calculated lighting on the model.

Preview

The Previewmode provides an interactive rendering of the shadow
regions. This allows you to evaluate the placement and orientation of the
light sources relative to the objects and camera viewpoint. Only the active
lighting layer is visible in Previewmode.

The type of rendering that is chosen will also be applied inMatter, except in the
case of Preview mode, which will be replaced with Environment.

Type-specific settings are available below the Type of lighting list for the
chosen lighting type.
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16-2.1 PreviewMode

When the Preview mode is selected, the following options can be enabled or
disabled:

Option Description

Interactive
degradation

When enabled, this option pauses the calculation when the object is being
manipulated in the Ctrl+left mouse button and middle mouse button
operating modes.

Restrict to
shadow
integrity

When enabled, this option restricts the calculation of Preview illumination
depending upon the selected shadow integrity mode.

Preview
color

When enabled, the preview takes the light sources' colors into account.
When disabled, the preview is shown in grayscale.

Preview
bounded
attenuation

When enabled, the attenuation gizmo indicates the full effect and falloff
distances. The surface parts illuminated without light attenuation are
displayed in red. The surface parts illuminated with light attenuation are
displayed in pink.

The default shadowmap size provided in the application settings is used for the
preview mode.

16-2.2 Calculating Lightmaps

When at least one of the visible lighting layers is a lightmap, the lightmap must
be calculated before the illumination will be visible.

The lighting resolution and the shadow size are each set by default at 2048 and
1024 pixels, respectively. In the settings, you can increase the lighting or shadow
definition for greater fineness when working on an object. Keep in mind, however,
that the calculation will be slower as a result of more intensive image information
processing.

Select the Lightmapmode. Choose the layers and the surfaces for which
lightmaps should be calculated, then use the rendering buttons to render the
lightmaps.
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16-2.2.1 Filtering Layers

The Layers filter specifies which layer or layers to take into account when
calculating lightmaps.

Filter Description

All Lightmaps will be calculated for all of the layers.

Visible Only the lightmaps for the layers that are visible in the current configuration will
be calculated.

Active
The lightmap for the active layer will be calculated, even if this lighting is not
visible. The active layer is the layer that is currently selected. If multiple layers are
selected, the active layer is the layer bordered by a dotted line in the Layers list.

16-2.2.2 Filtering Surfaces

The Surfaces filter allows you to restrict the surfaces for which lightmaps will
be calculated.

Filter Description

All Lightmaps will be rendered for all surfaces.

Selected

Select surfaces directly in the 3D product view from the Lighting tab of Shaper.
Direct surface selection saves time as it is not necessary to switch to the Surface
tab to select a surface requiring a lightmap computation. The selected surfaces
for which lightmaps will be calculated will be highlighted in green.

Unlit Lightmaps will be rendered only for surfaces for which no lightmap has been
calculated yet.

16-2.2.3 Setting the Render Quality

A slider allows you to determine the speed at which lightmaps are calculated by
setting the balance between speed and precision. The default slider position
(50) sets an advantageous rendering speed that preserves global lightmap
quality in most contexts.

You can modify this setting by moving the slider towards one of the extremes:

Rendering
quality Description

Faster Rendering speed is increased. The precision of the lightmaps created by this
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Rendering
quality Description

calculation is decreased.

More
accurate

Priority is given to the precision of the lightmaps being calculated. This
calculation takes longer to carry out.

16-2.2.4 Launching a Lightmap Render

Two render calculation modes exist:

Mode Description

Start Local
Rendering Use this option to calculate lightmaps using your computer's resources.

Start
Distributed
Rendering

Use this option to calculate lightmaps using the resources of a network of
computers running Patchwork Lightmap Render. More information on
distributed rendering can be found in the chapter Distributed Lightmap
Rendering (page 337).

The option Show while rendering allows you to visualize the result of the
calculation before the calculation has been completed. When this option is
enabled, as soon as the lightmap for a surface is calculated, it is shown in the
viewport. Surfaces for which the lightmap has not yet been calculated are
displayed in red.

If you are calculating lightmaps for multiple layers, the display will switch to the
layer for which lighting is being calculated if Show while rendering is checked.

When no lightmap has been calculated for a given surface, it is displayed in red in
both Shaper and Matter.

16-2.2.5 Options for Existing Lightmaps

Surface and layer filters for lightmap calculation are also applied to the following
functions.

Once a lightmap has been calculated, you can:

Operation Description

Update Update the lightmap to view the lightmap in a different lightmap format.

Export Export the lightmap as a series of image files.
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Operation Description

Remove Remove the lightmap. This deletes the lightmap completely. A deleted
lightmap can be recalculated from scratch but cannot be restored.

16-3 Light Sources

Lighting is organized into lighting layers. Each layer contains at least one light
source.

Select a layer by clicking on it in order to add, delete, or modify the light
sources in that layer. In the Lights zone, the light sources in the current layer
are listed.

As soon as you create a light, you have a near-immediate view of the result in
Patchwork 3D Design's material render mode. This interactive mode is useful
for fine-tuning your lighting, placing your light sources and for adjusting their
intensity.

Icon Description

New light group.

New light source.

Duplicate the light source.

Delete the light source.

Align the main light source with the camera.

Align the camera with the main light source.

Position the lights at a point to be selected.

Orient the lights towards a point to be selected.

Show Light Gizmos shows or hides the representation of the lights in the
viewports.
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To create a new light source, click on theNew light icon.

The first light created is always of the type sky. The following lights are of the
type spot, sun, omni, or area.

Once the light source has been created, the type of source can be modified at
any time.

Right-click on a selection of sources in the list. This opens a context menu that
can be used to create a copy of the selected light sources in another lighting
layer.

To delete a light source, select the light source to delete in the lights list, then

click on the Delete light icon.

To be able to delete a light source, you must have more than one source.

16-3.1 Light Source Groups

Light sources can be grouped together to help organize the list of light sources.
Light source groups also allow you to enable or disable all of the light sources
within the group with a single click by clicking on the Enabled column next to
the group in the list of light sources.

Create a new group by clicking on the New group button.

To place a new light inside this group, click on the group on the list, then click

on theNew light button.

To place an existing light inside this group, select the light you want to move by
clicking on it in the list. Drag and drop it on the group where you would like to
place it.

Groups of light sources may also contain other groups.

16-3.2 Properties of All Light Sources Types

To modify the properties of a light source, click on it to select it in the list of
lights or in the viewport. When selected, a light source's representation in the
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viewport is highlighted in yellow.

The Light Source zone lists the properties of the selected light source.

16-3.2.1 Applying the Light to Surfaces

Check the box beside the light's name to enable the light source. A disabled
light is visible in the 3D view in black, but casts no light.

The light source's name is displayed in the text field beside the activation
checkbox. Type a new name to modify it. Validate your changes with the Enter
key.

The Type drop-down list allows you to change the type of light source.

The Filter Surfaces button beside this drop-down list allows you to set up a list
of surfaces to include or to exclude for the selected light source. This button
opens a new window in which you can select the Type of list (surfaces to
Include or to Exclude) and themode, which allows you to apply the inclusion
or exclusion to shadows only, to illumination only, or to both. Below the filter
type choices are two columns listing all surfaces of the model on the left and
the list of surfaces to include or exclude on the right. Select surfaces by clicking
on them in the list. Then, use the buttons between the lists to move the selected
surfaces from one list to the other.

16-3.2.2 Adjusting the Light Source's Properties

l Color: Click on the colored square to open the color chooser and
select a different color.

Color change visible in the instant preview of Shaper.
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l Intensity: Modify the intensity by entering a value in the input field
and pressing Enter. Decimal values greater than or equal to 0 are
accepted. The default value is 1.

l IES: Light sources of type Spot,Omni, and Area can accept an IES
profile. IES profiles describe the physical properties of a light source.
Select an IES profile from your computer and activate the application
of the profile by ticking the check-box.

l Attenuation: The attenuation for light sources of type Spot,Omni,
and Area can be modified. In order to improve performances, the
contribution of a light can be canceled at a certain distance from the
light source. The parameters Ramp, Full Effect and Falloff are used
for setting this distance.

The list Type determines the rate at which the intensity of the light
changes. Fast and slow options are available for linear and quadratic
rates. You can also chooseNone or Physical, which provides a
physically realistic rate.

The light attenuation type Bounded is selected by checking a check-
box. The Ramp type (linear or quadratic) is selected from the drop-
down list.

Ramp: type of attenuation model applied between the Full effect
and the Falloff distances.

Full Effect: distance from the source for which the surfaces are
illuminated without light attenuation.

Falloff: distance from the source beyond which the surfaces are not
illuminated. The attenuation model selected is applied between the
full effect and the falloff distance.

In Preview mode, the attenuation gizmo indicates the full effect and
falloff distances. It is activated by checking the Preview Bounded
Attenuation check box. The surface parts illuminated without light
attenuation are displayed in red. The surface parts illuminated with
light attenuation are displayed in pink.
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Attenuation gizmo. The sphere parts represent the full effect distance and
the falloff distances.

l Shadow: Shadows are cast by default by light from a light source.
Unchecking the Cast checkbox disables shadows for the selected
source. If shadows are enabled, the intensity and integrity of
shadows can be adjusted:

l Intensity: The higher the value, the lighter and more
attenuated the shadows will be. The intensity must be a
decimal value greater than or equal to zero. Use the Enter
key to validate any changes.

l Integrity: Choose an integrity from the drop-down list.
Integrity values range fromWeak toMax. Higher values
increase shadow quality and shadow calculation time.

16-3.2.3 Positioning Light Sources

Light sources can be positioned individually or in groups.

16-3.2.3.1 Translating a Light Source

1. Select the light.

2. Enable the Translation gizmo .
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3. For a manual modification: hover over the gizmo to make the
pointer change to four white arrows. Then, move the light source by
dragging the mouse while holding down the left button.

4. To modify according to exact values: enter relative or absolute

coordinates in the dialog box.

16-3.2.3.2 Modifying the Orientation of the Source

1. Select the light.

2. Enable the Rotation gizmo .
3. For a manual modification: hover over the gizmo to make the

pointer change to a white rotating arrow. Then, orient the light
source by dragging the mouse while holding down the left button.

4. To obtain a modification according to exact values, enter relative

or absolute coordinates in the dialog box.

16-3.2.3.3 Making the Anchor Point of the Light Source Coincide with
the Viewport

1. Select the light.
2. Orient the viewpoint of the 3D window so that the viewport would

be looking directly into the light in its desired position.

3. Click on the Align the light on the camera icon.
4. The light is aligned to point to the camera.

16-3.2.3.4 Positioning a Selection of Multiple Light Sources

Two modes exist for applying transformations to a selection of lights:

Icon Function Description

Transform selected
surfaces using the pivot of
the leader selection

The transformation is applied to all selected lights
relative to the pivot of the selection leader (whose
gizmo is displayed in white).

Transform selected
surfaces using their own

The transformation is applied to all lights in the
selection relative to their own pivot.
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Icon Function Description

pivot

A selection of two lights. The light selection leader’s gizmo is displayed in white.

A rotation is applied to a light selection relative to the selection leader’s pivot (left) or
relative to the lights’ individual pivots (right).
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16-3.3 Properties of Sky Sources

Parameters specific to the sky light source:

1. A Sky angle top: value between 0 and 90 degrees.
2. Sky angle bottom: value between 0 and 90 degrees.
3. HDR environment: allows an HDR image to be loaded, which will

tint the lighting color generated by the sky.

16-3.4 Properties of Spot Sources

Spot type light sources imitate spotlights.

Parameters specific to the spot light source:

l Attenuation: angle of aperture of the spot, value between 0 and
175 degrees.

l Aperture: angle of aperture of the intensity zone, value between 0
and 175 degrees.

l Choose one of the Attenuation type list items: Slow linear
attenuation, Rapid linear attenuation, Slow quadratic
attenuation, Rapid quadratic attenuation, Physical attenuation.
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16-3.4.1 Gizmos for Aperture and Attenuation Cones

The spot light gizmo involves a target point. This target point is located on the
symmetry axis of Aperture and light Attenuation cones.

The target point of the spot has its own translation and rotation gizmos, which
simplifies its positioning. The spot light source orientation is updated during
the movement when the translation and rotation gizmos are used.

Translation gizmo: a normal translation gizmo is attached to the target point.

Rotation gizmo: manipulating the rotation gizmo of the target point moves
this point the same way manipulating the rotation gizmo of the light source
would.

Positioning a spot light directly using its own gizmos is still possible.

Moving the target point of the spot light using the translation gizmo.

Moving the target point of the spot light using the rotation gizmo.

It is also possible to move a source and a target simultaneously by clicking on
the blue part of the gizmo.
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16-3.5 Properties of Sun Sources

A Sun type light source is a light with infinite directions, whose beams are
parallel.

1. Fill in all the input fields.
2. Select one of the Attenuation type list items.

16-3.6 Properties of Omni Sources

An Omni type light source is omnidirectional, which illuminates all around
itself.
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1. Fill in all the input fields.
2. Choose one of the Attenuation type list items.

16-3.7 Properties of Area Sources

In the case of area light sources, light is emitted from any surface chosen by the
user. Since pre-existing meshes can be used, lighting creation becomes
intuitive. Moreover, even if no dedicated meshes are present in a scene, specific
primitives that can be modified on the fly are provided to simplify lighting
creation.

Example of render involving area lights.

To add an area light to your scene, create a new light and select area in the
Type drop-down list.

The surface geometry to use as a light source is specified in the area lights
parameters box of the Lighting tab using two methods.

l If a dedicated mesh already exists, it is set as a light source geometry
by first selectingMesh as an area light type (default), then by

enabling the function Pick Surface before selecting the
surface directly.

The name of the surface attached to this area light is then displayed.

l If no dedicated mesh exists, specific predefined primitives (planes
and cylinders) whose dimensions can be updated on the fly can be
used.
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The translation and rotation gizmos and the Align Leader Light to Camera

function can be used to move and orient these primitives.

In both cases, the light is emitted according to the surface normals.

16-4 Lighting Planner

The Lighting Planner provides an advanced method for baking the
illumination of a scene when using lightmaps. In the simple baking scenario,
the layers and the surfaces to light can be selected, but lighting is calculated in
a single step. Using the Lighting Planner, lighting can be calculated in as many
steps as necessary.

The advantage of multiple-step calculation is the variety of lighting scenarios
that can be calculated, which makes it possible to use lightmaps to light scenes
containing animations or multiple geometry positions.

16-4.1 Planning a Lighting Sequence

To access the lighting planner, make sure you are in the Lighting tab in the
Shaper interface.

1. Set the renderingMode to Lightmap.
2. Modify the Baking scenario: choose the Advanced option.

3. Click on the button.

Once a sequence has been defined, close the Lighting Planner and calculate
the lightmaps normally.

16-4.1.1 Lighting Layer

Create a step by selecting the lighting layer:

1. Click the Add Step button.
2. Select the lighting layer you want to use from the context menu that

appears.

You can add as many steps as necessary. You can also:
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l Delete steps that you do not want to keep,
l Rename steps.

Steps will be calculated one by one starting at the top of the list.

It is possible to modify the layer targeted by a step at a later moment:

1. Select a step in the list.
2. Modify the selected layer in the Target layer dropdown list.

16-4.1.2 Configuration

For the selected step, assign a set of configuration parameters. Lighting,
geometry, and position layers will have an influence on the lightmaps that will
be calculated.

Button Description

Acquire Apply the configuration that is visible in the active viewport to the active step in
the Lighting Planner.

Set
Apply the configuration for the active step in the Lighting Planner to the active
viewport. This is one way to verify that the chosen configuration parameters
correspond to the desired model configuration.

16-4.1.3 Part Animator

For the selected step, assign a position to the moving parts of the kinematics
hierarchy. The sliders available in the Animation Sliders editor are available
within the Lightmap Planner. Move the sliders to set kinematics positions.

Button Description

Acquire Apply the kinematics positions that are visible in the active viewport to the active
step in the Lighting Planner.

Set
Apply the kinematics positions for the active step in the Lighting Planner to the
active viewport. This is one way to verify that the chosen kinematics positions
correspond to the desired model state.

16-4.1.4 Selected Surfaces

For the selected step, choose the surfaces that should be lit.
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Button Description

Acquire Apply the surface selection that is visible in the active viewport to the active step
in the Lighting Planner.

Set Select the surfaces the list in the Lighting Planner in the active viewport. This is
one way to verify that the correct surfaces have been selected for this step.

Clear Clear the list of selected surfaces.
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17 DISTRIBUTED LIGHTMAP RENDERING

Depending on the hardware configuration in use, lightmap rendering can be
performed either locally or on a networked set of computers. Distributing the
rendering to a networked set of computers will significantly reduce the time
required for rendering lightmaps.

The lightmap rendering mode is selected in the Lighting Tab in the Shaper
sidebar. The Tools box is displayed when the selected Lighting Type is set to
Lightmap.

Start Local Rendering is used to render the lightmaps locally. Local lightmap
rendering is based on the use of the processor and graphic cards of the
computer on which Patchwork 3D Design is executed.

Start Distributed Rendering is used to render the lightmaps on the rendering
machines running Patchwork Lightmap Render.

17-1 Patchwork Lightmap Render

17-1.1 Installing Patchwork Lightmap Render

Install the Patchwork Lightmap Render software on the computers you wish to
use for distributed rendering.

This application must be run manually in order to provide the distributed
rendering service. If you restart Windows on one of the computers functioning
with Patchwork Lightmap Render, you must also restart the Patchwork
Lightmap Render application.

You can add this application to the list of programs that will run at the start up
of Windows. To do so, in Windows 7, drag and drop the application into the
following location: Start > All Programs > Startup.
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Drag and drop the application into Start > All Programs > Startup.

If you have installed Patchwork Lightmap Render on computers that are
listening for a render task, but which aren't found by Patchwork 3D Design
in the unit discovery window, verify that no network agents are set to block
discovery broadcast packets.

If you do not have access to the network configuration in order to disable
broadcast filtering, you can manually enter the name or the IP address of
the Patchwork Lightmap Render machines.

17-1.2 How Patchwork Lightmap Render MachinesWork

Should the Patchwork Lightmap Render application crash, it will restart itself
automatically.

A Patchwork Lightmap Render machine can only participate in a single
rendering session at a time. If another instance of Patchwork 3D Design sends a
request for the computer's availability while it is already participating in a
render session, the Patchwork Lightmap Render machine will send back the
status "Busy." Patchwork 3D Design will continue to attempt to open a session
at regular intervals until a session is opened or the rendering is completed on
the available machines.

17-2 Distributed Lightmap RenderingMode in Patch-
work 3D Design

The distributed lightmap rendering mode uses resources from several
computers running Patchwork Lightmap Render. The Patchwork Lightmap
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Render software must be set up and run on the computers you want to use.
The same applies to the computer on which Patchwork 3D Design is installed if
you wish to use it for distributed rendering.

17-2.1 Setting up the Distributed Rendering

The port used for finding the Patchwork Lightmap Render computers is
specified in the Settings. Browse to File > Settings > Lighting tab >
Distributed lightmap rendering box.

The default UDP port for finding Lightmap Render Units is 4242. Enter
another value if required.

Clicking on Start Distributed Rendering displays the Distributed lightmap
rendering configuration window, dedicated to management of Patchwork
Lightmap Render machines.

Distributed Lightmap Rendering Configuration window.

If your network infrastructure allows it, Patchwork Lightmap Render machines
are automatically found by broadcast. They appear directly in the list of known
Patchwork Lightmap Render machines.

The following data is displayed for each of the known Patchwork Lightmap
Render machines:
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l The name of the host computer on which the Patchwork Lightmap
Render software is running,

l The IP address of this computer,
l The status of the Patchwork Lightmap Render machine – the various
statuses are detailed thereafter,

l A checkbox specifying whether a Patchwork Lightmap Render
machine is selected for the rendering.

The various statuses of the Patchwork Lightmap Render machines are the
following:

Status Description

Available The computer is ready to perform a rendering.

Busy The computer is being used by the Patchwork 3D Design software on
the specified computer.

Disconnected:
connection
denied

The Patchwork Lightmap Render software is not currently running on
the computer.

Disconnected:
host not found

The host computer cannot be found on the network – the rendering
machine might not be turned on.

Disconnected:
incompatible
protocol version

The version of the Patchwork Lightmap Render software is not
compatible with the Patchwork 3D Design version used. Patchwork
Lightmap Render must be updated.

Some network infrastructures do not allow automated discovery of Patchwork
Lightmap Render machines. In that case, the units need to be added to the list
manually. In order to do this, click on Add unit. Next, enter the name of the
computer you want to use. The computer is now displayed in the list. The
asterisk added to the name of the computer specifies that this machine has
been added manually. The Patchwork Lightmap Render software must already
be installed on any computer you wish to add manually as a Patchwork
Lightmap Render machine.

The list of available machines is updated with the Refresh button.

The buttons Use all and Use none allow the user to select all or none of the
units, respectively.

To delete a machine added manually from the list, select it and click on Remove
unit.

Exiting the Distributed Lightmap Rendering Configuration window is
possible at any time by clicking the Cancel button. The list of manually added
machines and their state of use during the latest rendering are saved on exit.
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17-2.2 Starting a Distributed Rendering

Once the Patchwork Lightmap Render machines have been set up, start the
lightmap rendering by clicking the Ok button.

At the start of a distributed rendering, allowing the connection with the
Patchwork Lightmap Render machines through the firewall of your Windows
OS may be required.

The lightmap rendering progression window displays a progress bar, the
estimated remaining time, the elapsed time since the beginning of the
rendering, the count of surfaces for which the rendering has been completed,
and the status of the rendering.

Lightmap rendering progress monitoring window.

The status of each rendering machine is also displayed. Several statuses are
possible:

Status Description

Transferring data Transferring data to the rendering machine.

Initialization Initialization of the rendering machine.

Computing Lightmap rendering in progress.

The window closes automatically when the rendering is over if the Close this
window when finished checkbox is checked.
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17-2.3 Stopping Distributed Rendering

The rendering in progress can be stopped at any time by clicking the Stop
button. A window opens to offer you the choice of how to proceed:

Option Description

Continue Restart the calculation of the illumination for the remaining surfaces. Data may
be transferred to the rendering machine.

Keep Abandon the calculation for the remaining surfaces, but display the
illumination that has already been calculated.

Discard
Abandon the calculation for the remaining surfaces and do not display the
illumination that has already been calculated. This option will restore the
previous illumination.

Three options are available when the rendering has been stopped: Continue, Keep, and
Discard.

During the rendering, the model’s surfaces whose lightmap is being rendered
are displayed in white and in wireframe mode. Surfaces whose lightmap has
not been rendered yet are displayed in red. Once rendered, a lightmap is
displayed on the model.

17-3 Resources Consumed

A Patchwork Lightmap Render machine listening for requests for rendering
consumes no system resources.

During a render session, a rendering machine calculates lightmaps from the
geometric information concerning all of the visible surfaces. In order to
optimize the render speed, all of the surfaces are stored in the GPU. Then, the
lightmaps are calculated one by one at Patchwork 3D Design's request.
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The resources of a rendering machine that can be used by Patchwork
3D Design are only limited by the hardware configuration of the machine.

For a standard Patchwork 3D Design model, containing between 3 and 5
million triangles for 300-500 surfaces, the GPU consumption is about 2 GB. The
consumption of RAM resources is approximately identical to the GPU
consumption.

Network events between Patchwork 3D Design and a Patchwork Lightmap Render
machine

For a standard Patchwork 3D Design model, the following illustration
represents a typical resource consumption:
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17-4 Behavior Following Loss of Connection

17-4.1 Loss of Network Connection

Patchwork 3D Design and the Patchwork Lightmap Render machines will
automatically detect the loss of a network connection.

Patchwork 3D Design will redistribute the render calculations left to perform to
the rendering machines that are still connected. Patchwork 3D Design will
continue to attempt to reconnect with the rendering machines that were
disconnected.

If no machines are connected, Patchwork 3D Design will continue to try to
reconnect with the Patchwork Lightmap Render machines at regular intervals.
During this time, the rendering is paused. You may choose to cancel the
rendering at this point. You may either save or dismiss the results for the
surfaces for which lighting has already been calculated.
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A rendering machine that has lost its connection to Patchwork 3D Design
becomes available on the network. It will accept the first session request that it
receives from an instance of Patchwork 3D Design looking for a machine
running Patchwork Lightmap Render.

17-4.2 Patchwork 3D Design Crash

A crash of the Patchwork 3D Design application will break the connection with
the Patchwork Lightmap Render machines.

A rendering machine that has lost its connection to Patchwork 3D Design
becomes available on the network. It will accept the first session request that it
receives from an instance of Patchwork 3D Design looking for a rendering
machine.
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18 PRODUCTS

18-1 Definition

A product is a geometrical model that is or can be dressed. Once dressed, a
product is used in producing synthetic images for design purposes. Its general
appearance is obtained by assigning a photorealistic material (wood, leather,
gold, plastic, etc.), by inserting it into a complex lighting environment (photo
studio, forest, industrial environment, desert, etc.), and by adding effects such
as backgrounds, post-processing, and overlays.

Products are managed in the Product tab of theMatter sidebar.

18-2 Product Library

For this library, an organization by model is imposed. Models are created in
Shaper. The Create andDuplicate operations for models are not available in
Matter.

Some product thumbnails may appear with an icon. This indicator means
that the image shown in the thumbnail no longer corresponds to the current
representation of the product. The thumbnail will be recalculated and the
indicator will disappear the next time you finish editing the product. Thumbnail
images are updated either at the time the file is saved, or as a background task
in order to maintain the smoothness of movement needed for correct
functioning of theMattermodule.

Patchwork 3D Design allows you to memorize 4 favorite cameras per product. If
favorite camera 1 is defined, it is then used as the viewpoint for calculating the
thumbnail. Otherwise, the thumbnail will be calculated when you close the last
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viewport or viewport tab in which the product was active, using the camera
viewpoint from that viewport.

18-3 Product Properties

18-3.1 Surface Visibility

This property defines the strategy used to obtain the visibility of surfaces in a
product. The inactive box indicates that a surface visible in Shaper is visible in
Matter. The enabling this option breaks this dependency, and each surface will
have its own visibility attribute. This property can be edited in the product
properties.

18-3.2 Environment

This property allows you to define the environment used to place the product
in a setting (photo studio, exterior scene, etc.). If the value of this property is not
initialized the environment used for the rendering is a neutral environment
(default behavior). It is recommended to create new materials using this
environment, as it does not influence the perceived color.

Assigning an environment is accomplished with a drag-and-drop from the
sidebar environment library to the interactive zone of the viewport. To return to
the default environment, open the menu item Editors > Product Environment,
then select the environment in the Environments box and apply the operation,
Remove the environment.

18-3.3 Background

18-3.3.1 Standard Assignment

You can use several types of backgrounds to simulate an environment in which
your product is placed. Backgrounds are applied to camera sensors.
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From left to right: None – Gradient – Environment.

The type of background can be selected under the menu Camera
> Background.

The assignment of a background is performed by:

l Drag-and-drop from theMatter sidebar's background library to the
Sensors editor or to the interaction zone of the viewport,

l Drag-and-drop from the Backgrounds editor to the Sensors editor
or to the interaction zone of the viewport.

An operation for removing the background from a camera's sensor is available
from Camera > Background > Remove Background.

For more information on backgrounds, see Backgrounds (page 399).

18-3.3.2 Background and Environment on Product Selection

This function enables you to assign a background to a product in the
designated viewport or to several products save considerable time.

This command offers you three modes of product selection:

l All the products in viewports,
l All the products of the model,
l All the products of all models.

This operation is performed by dragging and dropping the background from
theMatter sidebar's background library into the active viewport while holding
down the Ctrl key.

The information line located at the bottom of the active view indicates the
function of this command: [Ctrl ="Product selection dialog"] Set background
to XXXXXXXX.

These assignment modes can only be performed on environments and
overlays.



USER MANUAL Patchwork 3D Design 2019.1 X3



19-1   Definition

Lumiscaphe Patchwork 3D Design 2019.1 X3 p.351

19 MATERIALS

19-1 Definition

A digital material, like a physical material, is the source of a surface's visual
aspect. The materials in your database reproduce the visual properties of the
physical materials that they represent.

Each surface is assigned a material. In some cases, a surface can be dressed
with multiple materials. This is the case when you apply labels or when you
make use of aspect layers.

Patchwork 3D Design allows you to change the aspect of your product in real
time by assigning new materials to a surface. No calculation is carried out, but
the product is updated instantly while you continue navigating around it in the
3D world.

Seven types of material exist. A type is defined by the function of the surface to
which the material is assigned:

Material
type Use

Standard The default material can duplicate most types of physical materials using
two layers, a diffuse layer and a reflective layer.

Environment This material represents the environment of a scenario. It is used to dress a
skydome, which is a hemisphere surrounding a product.

Matte
This material only shows the shadow of a product. When assigned to a
plane on which your product is placed, it increases the realism of the scene
when your scenario consists of a simple 2D background.

Mirror This material is used to dress surfaces in which the reflection of other
surfaces in the scene are visible.

Multilayer This material is designed for the advanced user. Its precision is useful for
creating complex and detailed materials.

Seam This material is used to represent the particularities of a sewn seam.

Label All standard materials can be assigned as labels, but this type of material is
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Material
type Use

designed specifically for that use. It can therefore be employed with
another material on a single surface, or even assigned several times to the
same surface. This can be useful in the case of certain patterns such as
stickers, printed marks, engravings, stamps, or other marks that aren't part
of the aspect of the physical material itself.

The Patchwork 3D Design materials are managed from theMatter sidebar's
material library.

Their settings, including their colors, can be modified via Materials (Editor)
(page 166).

Positioning and Orienting Materials (page 382) describes the two manipulation
modes used to interactively position and orient materials.

19-2 Material Library

NEWFEATURES IN PATCHWORK3D DESIGN2019.1 X3.

In theMatter sidebar's  library tab, the material library manages the
groups of materials and the materials available in your database.

Groups of materials are listed in the upper part of the library:

Icon Description

Create a new group.

Duplicate the selected group.

Rename the selected group.

Delete the selected group.

The list of materials shows all of the existing materials in the selected group.
Using the buttons below the list, you can:
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Icon Description

Create a new material.

Duplicate the selected material.

Edit the selected material by opening theMaterials editor.

Rename the selected material.

Import materials that you have previously saved (*.kmt or *.axf1).

Export the selected materials in *.kmt format.

Delete the selected materials.

Purge materials that have not been used (materials that are not applied to any
surface of any product).

Modify the way in which the list is displayed.

Right-clicking on a material opens a context menu offering the following
options:

Icon Function Description

Set active Make the material you have clicked active and shows it in the lower
part of the library.

Edit Edit the selected material by opening theMaterials editor.

Duplicate Duplicate the selected material.

Rename Rename the selected material.

Usage
list Show a list of all products in which this material has been applied.

1Patchwork 3D Design imports only SVBRDF files. This import requires a
specific license option and may not be available in your software version.
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Icon Function Description

Import Import materials that you have previously saved (*.kmt or *.axf).

Export Export the selected materials in *.kmt format.

Delete Delete the selected materials.

The active material is shown in the lower part of the library:

Icon Description

Thumbnail Double-clicking on the thumbnail opens theMaterials editor.

Use the eyedropper to pick a material from a surface in a viewport and render
it active.

Open theMaterials editor for the active material.

Select the active material in the list of materials.

19-3 StandardMaterial

AMatter standard material allows you to simulate materials such as metal,
wood, plastic, stone, paint, etc.

A standard material is designed to reproduce the characteristic behavior of a
material immersed in a lighting environment. It is above all a visual simulation,
in the field of perception.

The settings of a standard material are take into account the elements that
define of the matter, i.e. the color and pattern, capacity to reflect or tint the
environment, surface texture, transparency, and behavior during rendering by
raytracing.

A standard material is broken down into a Diffuse coat, or layer, over which a
Reflection layer is applied, each of which may be textured. The interaction
between the two layers allows most materials to be simulated realistically.

TheMattermodule offers standard materials belonging to the following
classes:
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l Diffuse only: The material has color, pattern, and texture attributes,
but does not reflect the environment. The reflection settings are not
available.

l Diffuse and Reflection: The material has color, pattern, and texture
attributes, and it reflects or tints the environment.

l Transparent Filter, or reflection layer only: The color of the material
serves as a transparent filter. The material can be textured and
reflects or tints the environment. The diffuse settings are not
available.

19-3.1 Basic Principles

In order to give you an idea of the characteristic features of a standard material
and to introduce the parameters associated inMatter, here is the breakdown of
a slightly reflective fabric.

To replicate the appearance of a photorealistic material, theMattermodule
proceeds by layer:

l Diffuse: When created, a new material is slightly gray and has the
appearance of perfectly smooth rubber.

n Color and pattern: The Color Map field is used to apply a
pattern mimicking fabric fibers.

n Texture: In the Bump tab, the Bumpmap field encodes
the surface texture used to simulate the unevenness of
woven fabric. The depth of this unevenness is modulated
by the Diffuse Depth setting.

l Reflection: The overlay of a reflection (type Diffuse and Reflection)
without taking into account the unevenness of the texture on the
reflective layer simulates a thin film of plastic on the fabric.

n Color: A reflective layer has a tendency to lighten the
material.

n Texture: Final, to finish the material, enable and set the
Reflection Depth in the Bump tab.
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Diffuse layer Diffuse layer + color

Diffuse layer + diffuse texture Diffuse layer + color and pattern + diffuse texture

Diffuse layer + color and pattern + diffuse texture
+ reflection

Diffuse layer + color and pattern + diffuse texture
+ reflection + reflection texture
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19-3.2 Diffuse

Light does not pass through a diffuse layer. Light is either absorbed, or
returned to the eye of the observer. The Diffuse tab groups the settings related
to this diffuse layer.

19-3.2.1 Diffuse Color

The color of the diffuse layer is influenced by several settings: the color Filter,
the lighting environment conditions, the ambient color, and the illumination
color, among others.

The color Filter setting corresponds to the color perceived when the material is
lit by white light. As the material reacts like a filter, it reflects part of the light it
receives. The perceived color of an object is thus greatly influenced by the
lighting environment. If we consider that white light is made up in equal parts
of green, red and blue (empirical computer model), then a black body absorbs
all these components, a white body reflects them without alteration, a red body
absorbs the green and blue, etc.

Influence of the lighting environment conditions on the color of a material.

The creation of a new material should thus imperatively be performed in a
neutral light environment, for example, the default environment in theMatter
module.

The Intensity parameter allows you to amplify by a multiplication factor the
effect of the lighting environment on the material.

The Ambient color parameter allows you to add a constant color. It is common
practice to add a light gray to lighten a material. However, we would advise you
to limit the amount of ambient light since a material of relatively dull
appearance originates from a relatively dull environment.
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The effect of an ambient color on the appearance of a yellow material. Left: gray
ambient color. Right: red ambient color.

The effect of an illumination color on the appearance of a yellow material. The same
samples from the preceding figure are shown here with a blue illumination.

19-3.2.2 Color Map

Some materials have a pattern or motif that is created by repeating an image
across the surfaces to which the material is assigned. The Color Map settings
are used to assign, resize, and position the first instance of such an image.

Color maps are image or video textures. To use a texture as a color map, drag it
from the sidebar texture library and drop it in the color map zone. To be shown,
the color map must also be enabled by ticking the checkbox next to the color
map zone.

The texture dimensions are used by default for an image texture.

For a video texture, the longest edge of the format is scaled to one meter by
default. The format's aspect ratio is respected.

Any texture used as a color map will repeat.

Allow repeat in U and Allow repeat in V allow you to choose to repeat the
texture in U and/or V.

By checking theMirrored check box you can reflect the texture in U and/or V.
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19-3.2.3 Filter According to View Angle

Some materials have a color that changes according to the angle of
observation. This effect is implemented using a gradient ramp. Click on the

Gradient Editor button in order to modify the gradient that is used.

19-3.2.4 Transparency of the Diffuse Layer

The transparency of a standard diffuse-and-reflection material can be adjusted
directly from theMaterials Editor using the Opacity modulator:

The Use alpha map parameter lets you use a texture for controlling the
transparency of the material. The alpha layer contained in the images (PNG
format) is used to define the transparency of the texture.

If the texture used as image alpha does not have an alpha layer (JPG image), it
is the luminosity of the image that is used as the alpha layer. In this case, the
darkest colors correspond to the most transparent areas:
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Allow repeat in U and Allow repeat in V allow you to choose to repeat the
texture in U and/or V.

By checking theMirrored check box you can reflect the texture in U and/or V.

19-3.3 Reflection

The reflection layer is an additive layer. This layer can be used in two ways.
When combined with a diffuse layer (Diffuse and Reflection class standard
materials), it helps to simulate materials that reflect the light of the
environment such as metals, varnished woods, smooth or metallic paints, or
opaque plastics.

This layer can also be used alone (Transparent Filter class standard materials)
in order to simulate transparent materials. This transparency is obtained by
removing the diffuse layer that blocks the light from passing through the
material.

Diffuse+Reflection (left) - Diffuse (center) = Transparent Filter (right)
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19-3.3.1 Color Filter

The color Filter setting in the Reflection Color zone is used to tint the
reflection. This coloration reproduces the behavior of metals and of certain
paints. This parameter may optionally serve to gradually attenuate the effect of
the reflection by selecting a filter ranging from white to black.

Variation in the Filter parameter.

19-3.3.2 Diffuse Filter

In the case of a standard material of the Diffuse and Reflection class, the
additive aspect of the reflection layer tends to lighten the material when the
reflection layer is superimposed.

This standard material class has a Diffuse filter to compensate for this
lightening while conserving the original color.

A diffuse-free material (chromium, gold, steel, aluminum, etc.) is obtained by
using the black filter.

Correcting lightening of a Diffuse and Reflection class standard material. From left to
right: diffuse layer; diffuse layer + reflection layer without a filter (white filter); diffuse

layer + reflection layer with a gray filter.

19-3.3.3 Transparent Filter

A standard material of the Transparent Filter class has a Trans. Filter setting,
which plays the role of the transparent filter. This corresponds to the color of
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the transparent material.

Variation in the Trans. Filter setting of a Transparent Filter class standard material.

19-3.3.4 Intensity

The Intensity setting allows you to adjust the amount of reflection emitted by
the material. The Intensity value varies in principle between 0 and 1, but a
higher value makes it possible to counterbalance a rather dull lighting
environment.

A perfect mirror appearance is obtained with the value 1. Even though the color
filter parameter enables you to attenuate the reflection, we would recommend
modifying the Intensity value, since it gives access to a more precise
adjustment without any risk of coloration.

Variation in the attenuation of the reflection using the Intensity setting, set to values
from 1 to 0.005.

19-3.3.5 Roughness

NEWFEATURES IN PATCHWORK3D DESIGN2019.1 X3.

The reflection of a frosted or brushed material is always hazy and coarse, the
details disappear, and the reflection runs and spreads over the surface of the
material. Only the silhouettes of the reflected objects are still apparent. This
diffusion of the reflection on the surface of the material is due to a very
perturbed surface state. The Roughness parameter replicates this behavior.
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Variation of the Roughness of the reflection, set to values from 0 to 6.

The roughness describes the surface irregularities that cause differentiated
diffusion of light. The reflected light varies randomly depending on the
roughness of the surface. This change the direction of the light without
affecting its intensity because it remains constant. The rougher surface have a
larger and variable highlights than smooth surfaces that have concentrated
specular reflections. Smooth surfaces may look brighter with the same amount
of reflected light.

The Roughness map is a grayscale texture where the black corresponds to a
roughness of 0 (smooth) and white corresponds to a roughness value of the
material.

In the Roughness map accordion section check Enable and then click on the
None button to load the texture that will serve for the roughness or glossiness
of the material.

On the other hand, the Gloss map is a grayscale texture where the black
corresponds to ta value of the material roughness and the white corresponds
to a roughness of 0 (smooth).
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Gloss map example

Rendering without a gloss map Rendering with a gloss map

Allow repeat in U and Allow repeat in V allow you to choose to repeat the
texture in U and/or V.

By checking theMirrored check box you can reflect the texture in U and/or V.

19-3.3.6 Fresnel

The Fresnel is an optical effect. The greater the oblique angle at which a glossy
surface is observed, the less visible will be the color of the surface, which forms
a white reflection.

In the case of a glossy transparent material, the Fresnel will make the surface
increasingly opaque the more the viewing angle is reduced.

If no change appears in the rendering, return into Shaper in the lighting
module to verify that none of the boxes of the lighting cube dialog box are
checked.
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To produce a material of motor vehicle bodywork paint type, it is necessary to
enable the Fresnel effect.

Without the Fresnel Effect: no colorless reflection appears when the product is viewed at
a sharp angle.

With the Fresnel Effect (refraction index = 1.518).

Preset parameters let you allocate the refraction index and extinction
coefficient values corresponding to common materials such as aluminum,
silver, chrome, copper, gold, etc. Custom presets can be added to this list from
the User Presets tab in the Patchwork 3D Design Settings.

The extinction coefficient is a feature specific to the metals; this parameter
can be left at 0 in the other cases.

The Fresnel also applies to transparent materials.

19-3.3.7 Modulation Image

You can also restrict per pixel the intensity of the specular reflection of a
material by using specular texture modulation (STM). This gray scale texture
encodes the attenuation factor for each pixel the attenuation factor to be
applied to the reflection (reflection = STM * specular).

A value of 255 encodes a maximum reflection and 1 encodes a virtual absence
of reflection. This approach makes it possible, for example, to simply simulate
embroidered fabrics. The value 255 is attributed to the pixels corresponding to
the embroidery pattern, and the value 1 to the fabric.
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Reflection filtering without a modulation image. From left to right: diffuse layer,
reflection layer without a modulation image, and result with a lightening effect.

Reflection filtering with a modulation image. From left to right: diffuse layer, reflection
layer with a modulation image, and result with a filtered lightening effect.

Allow repeat in U and Allow repeat in V allow you to choose to repeat the
texture in U and/or V.

By checking theMirrored check box you can reflect the texture in U and/or V.

19-3.4 Bump

In the Bump tab, the parameter Diffuse depth adjusts the depth of the
unevenness encoded in the Bumpmap. It is a surface state roughness, i.e. not
very deep. From a geometrical viewpoint, the surface is not altered, and
remains perfectly smooth.

Variation in the Diffuse Depth setting with values from 0 to 6.

The parameter Reflection depth adjusts the depth of the hollows and bumps
encoded in the Bumpmap. The grain levels of the diffuse and reflection coats
have been dissociated to produce thin reflective films.
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Variation in the Reflection Depth setting with values from 0 to 3.

19-3.4.1 Enhanced Relief

Variation in the Relief depth setting with values from 0 to 10.

Standard materials using a height map can be rendered with textural relief that
is even more realistic. This option offers an enhanced perception of depth
thanks to the way it handles parallax.

The use of enhanced relief is best suited to contexts where a standard material
uses a texture that requires more visual depth than that which can be rendered
using diffuse depth and reflection depth.

The relief setting provides a rendering which, while robustly real-time, requires
more time to calculate. It is therefore recommended to use this option where
appropriate, without overloading a scene.

19-3.4.1.1 Enabling Enhanced Relief

Enhanced relief is not compatible with the use of diffuse depth or reflection depth.
Enabling enhanced relief will disable the diffuse depth and the reflection depth, if
they were enabled, and vice-versa.

Enable enhanced relief in the Bump tab of theMaterials editor for a standard
material:

1. Tick the Relief checkbox in the Depth section and provide a value
for the depth.

2. Assign a texture as a Bump Map.
3. Make sure that the bumpmap's Usage is Height map.

Disabling one of these elements will also disable the enhanced relief.
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19-3.4.1.2 Settings

The settings for this type of render are found in the Bump tab of theMaterials
editor:

Setting Description

Relief depth

The depth defines the distance between the white and the black
zones of the height map. The white zones are aligned on the mesh
of the surface.

Because the perceived depth of the map's black zones is set using
this parameter, the height map should make use of the full range
of elevation available, fromwhite to black. When this is not
possible, make sure that the map's maximum elevation will be
aligned with the modeled surface, that is, that it is represented in
white on the height map.

A negative value will invert the depth of the texture: depth is
rendered as rising from the surface instead of as incisions carved
into the surface. While possible, this rendering is not optimal and is
not recommended.

Values between 0 and 10 are usually sufficient. Using values that are
too high can create visual deformations when viewing surfaces at low
angles or when viewing curved surfaces.

Bump map

A height map is required. This map is a black and white texture that
is assigned to the material as a bump map.

The texture to be used as a height map can be square or
rectangular. The height and the width of the texture in pixels must
both be powers of two.

Although Patchwork 3D Design will resize height maps whose
dimensions are not useable, choosing textures with dimensions that
are powers of two is highly recommended in order to preserve the
particularities of the height map.

Usage of the bump
map

The usage of the bump map as a height map is required.

Enhanced relief is not compatible with bump maps used as normal
maps.

Dimensions and
Transformation of
the bump map

These settings are modifiable as normal in order to adjust the
dimensions, the orientation, and the position of the height map on
the surface.

Allow repeat in U and Allow repeat in V allow you to choose to repeat the
texture in U and/or V.

By checking theMirrored check box you can reflect the texture in U and/or V.
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19-3.5 Label

The label Properties apply when a material is used as a label.

Allow repeat in U and Allow repeat in V allow you to choose to repeat the
texture in U and/or V.

By checking theMirrored check box you can reflect the texture in U and/or V.

19-3.6 Raytracing

Each material behaves differently during a rendering by raytracing. The
Raytracing tab gives you control over the settings for this behavior.

19-4 Environment Material

The environment material is generally applied to a hemisphere modeled about
your object. The HDRI environment will be visible on this hemisphere. Your
object will be integrated in this environment, the advantage of this method
being that the environment changes interactively when you are zoom and pan
around the scene.

After you have applied this material to your hemisphere, it is often useful to
edit your environment and to change its altitude. You will thus obtain a better
sense of scale and realism.
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19-4.1 Using an Alternate Background Texture as an Environment
Material

In order to reduce the resources used by the graphics card as well as the size of
.kdr files, a high-dynamic range, average resolution (typically 1024×512 pixels)
environment may be coupled with a low-dynamic range, high-resolution
(4096×2048 pixels) texture instead of using a high-dynamic range, high
resolution environment.

This feature applies to the environment material. The most common use of the
environment material consists in creating a skydome using a Hemisphere
primitive enveloping the whole scene (typically with a diameter of five to ten
meters) and applying the environment material on it inMatter.

In order to couple a high-dynamic range, average-resolution environment to a
low-dynamic range, high-resolution texture, the following steps must be
performed:

1. InMatter, import a HDR or EXR file of reasonable resolution
(1024×512 or 2048×1024) and apply it to the product.

2. Open the Environment Properties Editor for this environment. The
Background box indicates that no alternate background texture has
been defined.

3. Select a texture with a higher resolution in a low dynamic range
format (jpg, png…) and couple it with the active environment by
drag-and-drop onto theNone button in the Alternative
Background Map box. The texture is automatically applied on the
environment material. The filename replaces the mention None.

The environment and the texture chosen must be in the same format, which
means they must use the same projection (Longitude-Latitude, Angular or
Vertical cross). In general, the most appropriate texture is a version of the
environment on which a tone mapping is applied and used as an omnidirectional
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plate.

The Alternative Background Map has the following functions:

l The button is for deleting the active alternative background
texture.

l Clicking on the button taggedNone or the name of the file defined
as an alternative background texture opens theMatter sidebar's
texture library and selects the texture associated with the
background chosen.

19-5 Matte Material

The matte material inMattermakes it possible to view only the shadow of an
object. It is generally applied to a plane placed under your object. It will allow
you to compose your 3D object on a 2D background; it will help to "set" this
object in the scene.

19-6 MirrorMaterial

The mirror material is most often applied to a plane. It will allow you to
simulate a mirror or a pane of glass in which the other surfaces in the scene
will be reflected.

You can filter the surfaces that will be reflected using the Tag for Reflected
Surfaces option. This option uses the tags assigned to surfaces in Shaper to
limit the surfaces that are reflected. In a complex scene, this can significantly
improve rendering time.

For more information on tags, see Tag Manager (page 226).
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19-7 MultilayerMaterials

Multilayer materials allow you to combine effects which previously required
the use of labels. Thus you can easily create metallic and pearlescent paints,
carbon fiber, varnished wood, perforated leather, etc., which can be assigned
directly as a single material.

The technique to assign a multilayer material on a surface is identical to that of
a single material.

Layers are created one after another in the upper part of theMaterials editor.

When a layer is created, using theNew Layer button, you have the choice of
three different types: diffuse layer, specular layer, illumination layer.

The order of the layers is important: if a completely opaque layer is on top, it
will mask all layers beneath it. You can move a layer in the list by clicking and
dragging.

Each type of layer is represented by a different icon: a top-lit ball for a diffuse
layer, a luminous ball for an illumination layer and a mirror-finish ball for a
reflective layer.
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19-7.1 Types of Layers: Diffuse Layer

In general this is the first layer created, the one giving the basic color. For a
standard material, the parameters are given under the diffuse tab. The same
semi-transparency options as those for the standard materials apply.

In fact there are only two differences: the illumination parameter has
disappeared (an illumination layer must now be created) and the diffuse grain
is incorporated directly.

The diffuse layer parameters operate in the same way as those of the diffuse
tab for the standard material.

Mixing the diffuse layer is standard: if the diffuse layer uses a see-through
image, the layer underneath is shown in proportion through it.

Diffuse layers can accept a video texture as a Color Map.

19-7.2 Types of Layers: Specular Layer

NEWFEATURES IN PATCHWORK3D DESIGN2019.1 X3.

In the same way that a diffuse layer incorporates its own diffuse grain, a
specular layer incorporates its own specular grain. This approach provides
better hierarchy of the layer parameters and provides more options. The
specular layer is parameterized in the same way as the parameters under the
reflection tab for the standard material.

A specular layer operates in additive mode: the reflection is added to the
combination of lower layers, but provides overall filtering of the lower layers
and variable attenuation according to the Fresnel reflection. If the
Transmission attenuation option is ticked, then some of the reflected light on
the surface is not transmitted to the lower layers, making the light behave
realistically.

The Roughness map is a grayscale texture where the black corresponds to a
roughness of 0 (smooth) and white corresponds to a roughness value of the
material.

On the other hand, the Gloss map is a grayscale texture where the black
corresponds to ta value of the material roughness and the white corresponds
to a roughness of 0 (smooth).
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Allow repeat in U and Allow repeat in V allow you to choose to repeat the
texture in U and/or V.

By checking theMirrored check box you can reflect the texture in U and/or V.

19-7.3 Types of Layers: Illumination Layer

This layer combines the parameters previously distributed in the standard
material under the diffuse and reflection tabs.

The illumination color is found in the standard material under the diffuse tab
and allows a certain luminosity to be generally added to the material. The
brightness may be greater than 1.

The velvet effect in the standard material is found under the reflection tab,
but also acts as a light addition, this time depending on the viewing angle on
the surface. The added luminosity is given by a gradient ramp multiplied by a
specifiable factor, which may be greater than 1.

If a modulation image is activated, it filters the modulation color on the surface.
If the velvet effect is used, ticking the Use modulation image box modulates
the effect so as to provide a more realistic appearance.

Note that an illumination layer includes a grain, which affects only the velvet
effect if activated. The grain reinforces the realism, especially of fabrics.

An illumination layer operates in additive mode: its contribution is added to the
lower layers.

Most standard materials may be recreated in the form of multilayer materials
with a single diffuse layer and a single specular layer.

For more complex materials, nothing prevents you from using several layers of
the same type. For example, a 3D open mesh fabric may use one diffuse layer
for the lower textile and another diffuse layer, made visible using the
transparency effect, for the top layer.

If the underside is glossy, then the latter diffuse layer will be on the specular
layer of the lower layer. The organization of the material would thus be:

l Specular layer, upper textile
l Diffuse layer, upper textile
l Specular layer, lower textile
l Diffuse layer, lower textile
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If you also want to use the velvet effect because the surface of the fabric is
partly soft or textured, inserting an illumination at the right place will do the
job:

l Specular layer, upper textile
l Illumination layer, upper textile
l Diffuse layer, upper textile
l Specular layer, lower textile
l Diffuse layer, lower textile

The number of layers that can be used is limited only by the capacity of your
graphics card. If you want to go further, the system will still operate but at a cost
of slowing down the display.

19-7.4 Enhanced Relief

Multilayer materials using a height map can be rendered with textural relief
that is even more realistic. This option offers an enhanced perception of depth
thanks to the way it handles parallax.

The use of enhanced relief is best suited to contexts where a standard material
uses a texture that requires more visual depth than that which can be rendered
using bumpmaps in diffuse and specular layers.

The Relief tab gives access to settings that provide a rendering which, while
robustly real-time, requires more time to calculate. It is therefore
recommended to use this option where appropriate, without overloading a
scene.

19-7.4.1 Enabling Enhanced Relief

Enhanced relief is not compatible with the use of bumpmaps to create the
impression of relief. Enabling enhanced relief for a layer will disable the bump for
that layer, if it was enabled, and vice-versa.

Enhanced relief must be enabled:

l globally for the material in the Relief tab,
l then for the required layers in the Layers tab. By default, it is
disabled in all layers.
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Enable enhanced relief in the Bump tab of theMaterials editor for a standard
material:

1. Tick the Relief checkbox in the Depth section and provide a value
for the depth.

2. Assign a texture as a Bump Map.

Switch to the Layer tab:

3. For the layer or layers that should use enhanced relief, tick the Use
enhanced relief checkbox in the Bump section.

Disabling one of these elements will also disable the enhanced relief.

19-7.4.2 Settings

The settings for enhanced relief are found in the Relief tab of theMaterials
editor:

Setting Description

Relief depth

The depth defines the distance between the white and the black
zones of the height map. The white zones are aligned on the mesh
of the surface.

Because the perceived depth of the map's black zones is set using
this parameter, the height map should make use of the full range
of elevation available, fromwhite to black. When this is not
possible, make sure that the map's maximum elevation will be
aligned with the modeled surface, that is, that it is represented in
white on the height map.

A negative value will invert the depth of the texture: depth is
rendered as rising from the surface instead of as incisions carved
into the surface. While possible, this rendering is not optimal and is
not recommended.

Values between 0 and 10 are usually sufficient. Using values that are
too high can create visual deformations when viewing surfaces at low
angles or when viewing curved surfaces.

Height map

A height map is required. This map is a black and white texture that
is assigned to the material.

The texture to be used as a height map can be square or
rectangular. The height and the width of the texture in pixels must
both be powers of two.

Although Patchwork 3D Design will resize height maps whose
dimensions are not useable, choosing textures with dimensions that
are powers of two is highly recommended in order to preserve the
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Setting Description

particularities of the height map.

Dimensions and
Transformation of
the bump map

These settings are modifiable as normal in order to adjust the
dimensions, the orientation, and the position of the height map on
the surface.

19-8 SeamMaterial

The seam material simulates lines of stitching. The seam material is
transparent, except where the threads are visible. This material is generally
applied to a thin, straight surface that has been superimposed over the main
surface.

Lines of stitching created with a seam material.

The structure of this material is similar to that of the standard material. It is
composed of two layers, a diffuse layer and a reflection layer, and it has texture
properties.

19-8.1 Diffuse

The diffuse parts of the seam material represent the thread.

The Diffuse Color, which is principally given by the Filter color, is the thread
color.

The Color Map gives the pattern of stitches. It is generally the same as the
image used for the Seam Map in the Bump tab.
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19-8.2 Reflection

Based on the type of thread used, the stitches can appear more or less shiny. As
for a standard material, the Reflection Color as an additive value, the
roughness, and the diffuse filter can be adjusted.

19-8.3 Bump

The realism of the stitching’s appearance is due, in part, to the bump texture.

The texture of this type of material is assembled from two different image
maps: a Pleat Map and a Seam Map.

The Seam map gives the pattern for the individual stitches. Without this map,
the material would be entirely transparent. The color of the diffuse filter will fill
in the lighter areas of this image. The zones with an alpha background will
remain transparent, showing the material assigned to the surface below the
seam surface.

Example of a seam map. The checkered zones represent an alpha background.

If the material is gathered or pleated under the stitching, use the Pleat map
settings to impose the texture.

19-9 Label Material

19-9.1 Definition

A label is a material pattern that can be applied to a surface and oriented,
similarly to a physical sticker.

The surfaces ofMattermay receive an unlimited number of labels. These labels
are used to position product graphical elements such as a logo, documentation,
a mark, iconography, and so on, interactively on model surfaces.

Any standard, multilayer, seam or environment material can be applied in label
mode. In fact, the label material is a standard material for which the label mode
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is imposed by default. In this mode, the textures defining the material are no
longer repeated on the surface. The labels are overlaid in successive coats
according to their order of creation on the surface. This order can, however, be
modified later in the Surface Properties Editor.

Successive layers of labels.

Furthermore, if the alpha coat of the diffuse texture is present, it defines the
transparency zones of the label. A value of zero in the alpha coat encodes a
transparent pixel.

Left: with alpha zones. Right: without alpha zones (RGB only).
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19-9.2 Managing Applied Labels

You have access to the list of labels of a surface, of which you can modify the
order, the transformation and the name.

This function is available via the contextual menu of the selected surface. Right-
click on the surface then select Surface > Edit the properties, and then select
the Label tag.

To click on a surface, the surface must be visible. Display all surfaces by right-
clicking within the viewport and choosing the option, Show All (Ctrl+Shift+R)

The label placed at the top of the list in the Labels manager is the one
perceived in the foreground in the active view.

The up and down arrows   allow you to change the layer order of
the labels. Select the label and click on the arrows according to the desired
arrangement.

You have the possibility of renaming the labels by entering a new name in the
input field located at the bottom of the Labels zone.

The U and V axes and the rotation parameter of the transformation zone allow
the label to be placed more precisely by entering numerical values directly or
by using the keyboard cursor arrows.

19-10 Assigning a Material to a Surface

To assign a material to a surface, you can:

l Drag and drop from theMaterials editor,
l Drag and drop from active element in theMatter sidebar's material
library,

l Drag and drop from a selected element in theMatter sidebar's
material library.

The use of the key modifies, Ctrl, Alt, and Shift, can optimize the assignment of
materials to one or several surfaces of the active model.
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From right to left: Starting scene; CTRL = replace on all surfaces with same material;
MAJ = apply as label.

Ctrl: The Ctrlmodifier replaces a given material with a new material on all of
the product surfaces to which the first material was assigned. The new material
will thus be identically assigned to all of the same surfaces as the previous
material had been.

Alt: The Altmodifier resets the material's position in the scene. This reset is
carried out according to the surface mapping that was calculated in Shaper. If
you have transformed the surface with the rotation or translation modes, using
the Altmodifier will recalculate its original position. This command can also be
combined with the Shiftmodifier in order to position a material according to
an absolute grid determined by the surface mapping.

Ctrl+Shift: Combining the Ctrl+Shiftmodifiers gives access to the context
menu containing advanced assignment options:

l Apply material to:
n this surface, in the visible aspect layer,
n this surface, in the active aspect layer,
n all of the surfaces that are currently using the same
material as this surface,

n all of the surfaces that have the same tags as this surface.
l Apply as label on active aspect layer to:

n this surface, with the choice among the mappings
calculated for this surface,

n all of the surfaces using the same material on the same
mapping,

l Replace a label applied to this surface,
l Replace a label applied to this surface and to all of the visible
surfaces where that label is also used.
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19-11 AssigningMaterials as Labels

Shift: The Shiftmodifier assigns a material as a label. To assign a label to a
surface, you can:

l Shift+drag and drop from theMaterials editor,
l Shift+drag and drop from active element in theMatter sidebar's
material library. If multiple UV mapping have been assigned to the
surface targeted by your cursor, a drop-down menu will appear
allowing you to select the UV channel.

l Shift+drag and drop from a selected element in theMatter
sidebar's material library.

The center of the label is placed exactly at the location where you drop the
material. Precise positioning of the label on the surface is accomplished
using the two interactive modes.

19-12 Positioning andOrientingMaterials

When a material positioning mode is enabled, it applies to all viewports. The
interactive positioning begins when you click to begin to drag a material or a
label.

The mode:

l Translate a material moves the material or the label on the
surface in an intuitive way.

l Rotate a material pivots the material or the label around the
point where you have clicked.
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20 LIGHTING ENVIRONMENTS

20-1 Definition

A lighting environment is an omnidirectional image (360 x 360 degrees) that
memorizes the incident lighting at a particular point in space.

Patchwork 3D Design supports the light probe, latitude-longitude and vertical
cross formats of HDR images for use as environments.

HDR Environment formats: light probe, lat-long, and vertical cross.

Patchwork 3D Design environments are HDR environments (High Dynamic
Range). The data stored in an environment are encoded in order to maintain
the full range of light dynamics, at multiple orders of magnitude.
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The measured physical quantities of the lighting allow image details to be
maintained, even within a single image, in the full range of lighting dynamics,
from very dark areas to very bright ones.

With the aid of an environment, theMattermodule computes the diffuse
global lighting environment that serves to render the lighting on the surfaces,
and generates the visible reflections in the reflection coat of the materials.

20-2 Manipulating the Environment

In addition to the standard operations provided in theMatter sidebar's
environment library, theMatter interface provides other actions, such as
Environment orientation, Link diffuse environment rotation or Initialize
environment orientation.
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l Environment orientation: Found in theModemenu. This tool
allows you to move the environment about the product. Since the
environment enables lighting of the product, it can thus be
positioned so as to bring out the areas of interest, for example.

l Diffuse environment rotation: this operation is available from the
Product > Environmentmenu. It allows the lighting to be rotated at
the same time as the environment.

20-2.1 Manipulating the Environment from Editors

The editors Surface Properties (inMatter), Product Environments, and
Environment Properties allow the orientation of the environment to be
specified as a modification along the three axes X, Y, and Z.

20-3 Examples of Environments with a Product

We present here an object lit by two different environments, a car-park
environment and an exterior environment. Notice that even though the same
geometry is represented, the environment plays a major role in the lighting of
the model.

Car-park type environment.
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Port type environment.

It is also possible to set up an environment as a background. To do this, simply
right-click on the top left corner of the image. A window opens, and, by
selecting Background type, you have the possibility of setting the background
type to Environment. By default, the active environment will be used.

To use an environment as a background, a sensor must be assigned to the camera
in the viewport in which you want to use the environment as a background. If this
is not the case, you will first need to create a sensor and drop it on the viewport.

20-4 Local Environments

Patchwork 3D Design supports local environments so that materials used by
certain geometries can reflect their immediate, or local, surroundings.

The button Create a local environment allows an environment of the
Local Environment type to the list of available environments.

To assign this local environment to a group of surfaces, just hold the Shift key
down and drag-and-drop the local environment onto the desired surfaces (see
section Multiple Environments).

By default, the local environment initializes at scene coordinate 0,0,0 and
"captures" its immediate environment.
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Depending on the scene, a plane or a surface can hide the environment nearest to
the initial point of capture, in which case the local environment will appear dark
and very few elements will be discernible.

20-4.1 Setting Local Environment Parameters

To show the environment around a gear lever knob in the reflection of
chromed material, parameters have to be set for the local environment.

To do this, open the Environment Properties by double-clicking on the Active
Environment thumbnail.

1. Select the Pick the capture origin tool , then click on a point
on the gear knob to position the origin of the capture point.
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2. The Display and move the capture box tool allows the
capture box to be displayed and moved, showing the zones from
which the local environment images are going to be captured.

It is possible to adjust the size of the capture box by changing the value of the
Radius parameter.

Capture of the environment must be consistent with the object to which the local
environment is assigned.

It is therefore necessary to exclude from the capture the surfaces relating to the
object:

l either by using the tool for exclusion of surfaces and entering the
name of the surface.

l or by ensuring that the box is larger than object in question.
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3. The Refresh environment button allows the environment to
be updated by recalculating the images captured by the local
environment box.

The environment thumbnail then displays the captured environment.

The chromed material applied to the gear lever knob reflects this new
environment.
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4. The reflection of the environment on the material can be adjusted
with precision by manipulating the value of the adjustment
parameters in the General properties zone.

20-5 Multiple Environments

It is possible to simulate separate environments on different surfaces. To do
this, drag and drop environments of your choice onto a surface while holding
down the Caps Lock key.
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20-6 Environment Library

In theMatter sidebar's  library tab, the environment library
manages the groups of environments and the environments available in your
database.

Groups of environments are listed in the upper part of the library:

Icon Description

Create a new group.

Duplicate the selected group.

Rename the selected group.

Delete the selected group.

The list of environments shows all of the existing environments in the selected
group. Using the buttons below the list, you can:

Icon Description

Create a new environment using the HDR Light Studio Live plug-in. For more
information on this plug-in, see HDR Light Studio Plug-In (page 253).
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Icon Description

Open the HDR Light Studio Live plug-in to edit the selected environment.

Get an HQ environment for the selected environment.

Create a new local environment.

Refresh all visible local environments.

Open the Environment Properties for the selected environment.

Open the Textures editor to view the selected environment as a texture.

Rename the selected environment.

Refresh the selected environment.

Import environments that you have previously saved.

Export the selected environments. You can then choose the folder where the
environments will be saved, the type of file to save (Patchwork 3D Environment,
Radiance HDR or OpenEXR Bitmap) and the desired environment format
(Longitude-Latitude, Vertical Cross or Light Probe).

Duplicate the selected environment.

Delete the selected environments.

Purge environments that have not been used (environments that are not applied
to any surface of any product).

Modify the way in which the list is displayed.

Right-clicking on a environment opens a context menu offering the following
options:
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Icon Function Description

Edit Edit the selected environment by opening the HDR Light Studio
Live plug-in.

Refresh Refresh the selected environment.

High Quality
Environment Switch to a high quality environment.

Set active Makes the environment you have clicked active and shows it in the
lower part of the library.

View View the environment as a texture in the Textures editor.

Edit Edit the selected environment by opening the Environment
Properties.

Duplicate Duplicate the selected environment.

Rename Rename the selected environment.

Usage list Shows a list of all products in which this environment has been
applied.

Export

Export the selected environment. You can then choose the folder
where the environment will be saved, the type of file to save
(Patchwork 3D Environment, Radiance HDR or OpenEXR
Bitmap) and the desired environment format (Longitude-
Latitude, Vertical Cross or Light Probe).

Delete Delete the selected environment.

The active environment is shown in the lower part of the library:

Icon Description

Thumbnail Double-clicking on the thumbnail opens the Sensors editor.

Use the eyedropper to pick an environment from a viewport and render it
active.

Open the Environment Properties for the active environment.

Select the active environment in the list of environments.
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21 TEXTURES

21-1 Definition

A texture is an image or video file used to provide a visual pattern in many
different contexts.

The following images formats are supported:

l *.ktx
l *.png
l *.jpg
l *.tif
l *.bmp
l *.tga
l *.xpm
l *.hdr
l *.exr

Video files under 1GB in the following formats are supported:

l *.avi
l *.mkv
l *.mpg, *.mpeg

21-2 Using Text as a Texture

A series of characters of text can be used in all of the same contexts as an
image, thanks to the internal editor that generates an image based on the text
provided.

For additional information on using this function, please refer to the following
sections:



21    TEXTURES

p.396 Lumiscaphe Patchwork 3D Design 2019.1 X3

l Text Image (Editor) (page 228)
l Texture Library (page 396)

21-3 Using Video Textures

Video textures can be integrated as the image used by a background, the
diffuse color map in standard type materials or as the color map of a diffuse
layer in multilayer materials.

To view the playback of video textures, the texture must be present in a
background being used or in a material applied to a surface of a product. The
texture must then be added to a Textures track in a timeline. When a timeline
containing texture clips is played, the corresponding videos are animated for
the background and for all materials using those textures that are present in
the active viewport.

21-4 Texture Library

In theMatter sidebar's  library tab, the texture library manages the
groups of textures and the textures available in your database.

Groups of textures are listed in the upper part of the library:

Icon Description

Create a new group.

Rename the selected group.

Delete the selected group.

The list of textures shows all of the existing textures in the selected group.
Using the buttons below the list, you can:

Icon Description

Import textures (images or videos saved on your hard drive or on your network).
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Icon Description

Create a new text texture by opening the Text Image editor.

Duplicate the selected text texture.

Edit the selected texture by opening the Textures editor or the Text Image
editor, depending on the type of texture selected.

Rename the selected texture.

Update the selected texture.

Export the selected textures.

Delete the selected textures.

Purge textures that are not currently in use.

Modify the way in which the list is displayed.

Right-clicking on a texture opens a context menu offering the following
options:

Icon Function Description

Edit Edit the selected texture by opening the Textures editor or the Text
Image editor, depending on the type of texture selected.

Update Update the selected texture.

Rename Rename the selected texture.

Usage
list

Show a list of all resources, such as textures and backgrounds, that
use the selected texture.

Import Import textures from your hard drive or from a network location.

Export Export the selected textures.
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Icon Function Description

Delete Delete the selected textures.
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22 BACKGROUNDS

22-1 Definition

A background is a 2D visual placed behind the objects in the 3D world. It does
not move when you navigate in the 3D world, but remains stationary with
regard to the screen.

Backgrounds are associated with camera sensors. For more information on
how backgrounds are created and applied, see Backgrounds (Editor) (page 113)
and Sensors (page 423).

InMatter, two types of backgrounds are available:

l Environment type: displays the lighting environment used to
calculate the reflections and the diffuse lighting of the materials.

l Gradient type: replaces the uniform background of a view with a
color gradient or with an image. The gradient is defined by a Start
color and an End color, which are respectively associated with the
top and bottom edges of the viewing zone.

Left: Gradient type background - Right: Environment type background
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22-2 Assignment

To assign a Gradient-type background, you can:

l Drag and drop it from the start zone in the Backgrounds
editor.

l Drag and drop it from the active background at the bottom of the
Matter sidebar's background library.

l Drag and drop it from the selected item of theMatter sidebar's
background library.

22-3 Background Library

In theMatter sidebar's  library tab, the background library manages
the groups of backgrounds and the backgrounds available in your database.

Groups of backgrounds are listed in the upper part of the library:

Icon Description

Create a new group.

Duplicate the selected group.

Rename the selected group.

Delete the selected group.

The list of backgrounds shows all of the existing backgrounds in the selected
group. Using the buttons below the list, you can:

Icon Description

Create a new background.
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Icon Description

Duplicate the selected background.

Edit the selected background by opening the Backgrounds editor.

Rename the selected background.

Import backgrounds that you have previously saved.

Export the selected backgrounds.

Delete the selected backgrounds.

Purge backgrounds that have not been used (backgrounds that are not assigned
to any camera sensor).

Modify the way in which the list is displayed.

Right-clicking on a background opens a context menu offering the following
options:

Icon Function Description

Set active Make the background you have clicked active and shows it in the
lower part of the library.

Edit Edit the selected background by opening the Backgrounds editor.

Duplicate Duplicate the selected background.

Rename Rename the selected background.

Usage
list

Show a list of all sensors to which this background has been
assigned.

Import Import backgrounds that you have previously saved.

Export Export the selected backgrounds.
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Icon Function Description

Delete Delete the selected backgrounds.

The active background is shown in the lower part of the library:

Icon Description

Thumbnail Double-clicking on the thumbnail opens the Backgrounds editor.

Use the eyedropper to pick a background from a viewport and render it active.

Open the Backgrounds editor for the active sensor.

Select the active background in the list of sensors.
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23 OVERLAYS

23-1 Definition

An overlay is a 2D image (often a logo) that is displayed in front of the objects
in the 3D world. It does not move when you navigate in the 3D world, but
remains stationary with regard to the screen.

Overlays are associated with camera sensors. For more information on how
overlays are created and applied, see Overlays (Editor) (page 168) and Sensors
(page 423).

Overlays are managed in theMatter sidebar's overlay library.

23-2 EnablingOverlays

Overlays are enabled by default. They can be disabled and re-enabled using the
button in the toolbar at the top of theMattermodule.

l : Enable or disable overlay display.

23-3 Overlays in Configurations

The layers of each overlay can be used in configurations in the same manner of
other types of layers in Patchwork 3D Design.

Configuration rules accept one or more overlay layers as targets. When a user
chooses such a configuration, the configuration rule is met and the layers that
are targets of the rule are displayed. The other configurable layers of the
overlay are hidden.
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For the effects of overlay configuration to be visible, the overlay containing the
configurable layers must be assigned to an active camera sensor and overlay
display must be enabled.

For more information, see the following sections:

l Product Configurations (page 447)
l Configurations (Editor) (page 141)

23-4 Overlays in Animations

Overlay display can be handled in a timeline animation by using channel
animations.

Configurations containing layers of an overlay can also be animated. To do so,
use configuration keys positioned in the Configurations track of a timeline.

For more information, see the following sections:

l Timelines (page 491)
l Timelines (Editor) (page 231)
l Channels (Editor) (page 128)

23-5 Overlay Library

In theMatter sidebar's  library tab, the overlay library manages the
groups of overlays and the overlays available in your database.

Groups of overlays are listed in the upper part of the library:

Icon Description

Create a new group.

Duplicate the selected group.

Rename the selected group.
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Icon Description

Delete the selected group.

The list of overlays shows all of the existing overlays in the selected group.
Using the buttons below the list, you can:

Icon Description

Create a new overlay.

Duplicate the selected overlay.

Edit the selected overlay by opening the Overlays editor.

Rename the selected overlay.

Import overlays that you have previously saved.

Export the selected overlays.

Delete the selected overlays.

Purge overlays that have not been used (overlays that are not assigned to any
camera sensors).

Modify the way in which the list is displayed.

Right-clicking on a overlay opens a context menu offering the following
options:

Icon Function Description

Set active Make the overlay you have clicked active and shows it in the lower
part of the library.

Edit Edit the selected overlay by opening the Overlays editor.

Duplicate Duplicate the selected overlay.
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Icon Function Description

Rename Rename the selected overlay.

Usage
list Show a list of all sensors to which this overlay has been assigned.

Import Import overlays that you have previously saved.

Export Export the selected overlays.

Delete Delete the selected overlays.

The active overlay is shown in the lower part of the library:

Icon Description

Thumbnail Double-clicking on the thumbnail opens the Overlays editor.

Use the eyedropper to pick an overlay from a viewport and render it active.

Open the Overlays editor for the active overlay.

Select the active overlay in the list of overlays.

23-6 How toMake an Overlay

To create an overlay, you must have previously created a texture image (for
example, in Photoshop) of the logo or the text you wish to display.

Begin by opening the Overlays editor from theMatter editor toolbar.

Next, create a new layer and adjust the position of your overlay. This is
managed in the Transformation zone, which allows you to indicate the
horizontal and vertical position, and the overlay offset.

You can also add a background color by adjusting the parameters of the
Gradient field.

Finally, apply the texture image by drag-and-drop to the part of theMap field.
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The overlay is now created, and by dragging and dropping it from the sidebar
library to the viewport, you can add the overlay to the product.

There are three actions in the Camera > Overlay menu that allow you to hide
(or display) the overlay, to edit it or to remove it from the camera sensor,
namely:Overlay visibility, Edit overlay andDelete overlay.

23-6.1 Examples

Here are a few examples of overlays prepared with the same texture image, in
this case the Lumiscaphe logo.
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Different styles of overlay.

For the last example, we have varied the Alpha parameter (transparency) for each
color It is also possible to adjust it at the start in the global Parameters. In this
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case, the same Alpha parameter value is applied to both the background colors.



USER MANUAL Patchwork 3D Design 2019.1 X3



24-1   Definition

Lumiscaphe Patchwork 3D Design 2019.1 X3 p.411

24 POST-PROCESSING

24-1 Definition

Post-processing filters an image to produce a certain look or effect. Patchwork
3D Design has a powerful 2D post-processing tool for creating, combining and
inventing spectacular rendering effects. Because Patchwork 3D Design's post-
processing is real-time, you can continue navigating in the viewport; the filter
will remain in place and navigation will still be fluid.

Post-processing is managed in theMatter sidebar's post-processing library.

24-2 Enabling Post-Processing

Applied post-processing is displayed by default. This setting can be disabled
and re-enabled using the button in the toolbar at the top of theMattermodule.

l : Enable or disable the display of 2D post-processing blends.

24-3 Post-Processing Effects

Patchwork 3D Design offers 17 basic effects as well as three types of tone
mapping. Each has programmable properties. Effects can be added one after
the other or blended together using the options in the Advanced sub-menu to
produce a unique result.

The basic effects are:

l Gaussian blur.
l Film grain.
l Hand drawing.
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l Negative.
l Black and white.
l Sepia.
l Grayscale.
l Color filter.
l Adjust color.
l Bloom.
l Sharpen.
l Edge detector.
l Erode.
l Dilate.
l Vignetting.
l Camera response.

You will find examples of the main effects below.

Initial image.

Gaussian blur.
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Film grain.

Hand drawing.

Negative.
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Black and white.

Sepia.

Grayscale.

Color filter.
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Adjust color.

Bloom.

Sharpen.
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Edge detector.

Erode.

Dilate.

24-4 ToneMapping

A tone mapping operator is a tool for displaying a High Dynamic Range image
(with no intensity limitation) on a Low Dynamic Range screen (with an intensity
limited to 1) which is unable to manage the range of light intensities present in
the image. Using a tone mapping operator to display HDR images can reveal
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details otherwise invisible. However, tone mapping operators can change the
appearance of the colors, shadows and lights.

The three tone mapping effects are detailed below.

Automatic tone mapping.

24-4.1 Reinhard Tone Mapping

Two parameters may be set for the Reinhard Tone Mapping: these are
Saturation level and Brightness factor.

Saturation level is the input intensity level that will be brought back to 1.
Setting this parameter to a high value preserves high-intensity lights.

Brightness factor enables the user to control brightness after processing.
Setting this parameter to a high value leads to a light final image.

In order to use Sub-pixel correction, the corresponding box must be ticked.
The Sub-pixel correction option limits aliasing phenomena in the HDR images.

Options for the Reinhard Tone Mapping effect.

The following images show the effect of Reinhard Tone Mapping for different
saturation levels and brightness factors.
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A Patchwork 3D Design scene with no tone mapping applied.

Reinhard tone mapping with a saturation level of 0.6 and a brightness of 0.6.

Reinhard tone mapping with a saturation level of 1.5 and a brightness of 0.8.
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24-4.2 Drago Tone Mapping

The following parameters can be set for the Drago Tone Mapping effect:
Average Luminance, Bias andMaximum Input Luminance. The user may
also choose to use Sub-pixel correction by ticking the corresponding box.

Average Luminance is for controlling the average intensity of the original
image. Setting this parameter to low values leads to an overexposure of the
final image.

Bias parameter enables users to control the final image contrast.

Maximum Input Luminance parameter is for controlling the maximal
intensity in the original image.

Options for the Drago Tone Mapping effect.

The following images show the effects of Drago Tone Mapping for different
average luminance, bias and maximum input luminance levels.

A Patchwork 3D Design scene with no tone mapping applied.
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Drago tone mapping with an average luminance of 0.5, a bias of 0.6 and a maximum
input luminance of 10.

Drago tone mapping with an average luminance of 0.5, a bias of 0.6 and a maximum
input luminance of 1.

Drago tone mapping with an average luminance of 0.5, a bias of 0.2 and a maximum
input luminance of 10.
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24-5 Post-Processing Library

In theMatter sidebar's  library tab, the  post-processing library
manages all post-processing effects. From this sidebar library, you can create,
duplicate, save, import and delete the post-processes you have generated.

Post-Processing Groups: 
Find below the available actions.

Icon Description

Create a new group.

Duplicate the selected group.

Rename the selected group.

Delete the selected group.

Post-Processing is the list of the available post-processing blends. Using the
buttons below the list, you can:

Icon Description

Create a new post-processing blend.

Duplicate the selected post-processing blend.

Edit the selected post-processing blend by opening the Post-processing editor.

Rename the selected post-processing blend.

Import post-processing blends that you have previously saved.

Export the selected post-processing blends.
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Icon Description

Delete the selected post-processing blends.

Purge post-processing blends that have not been used (post-processing blends
that are not assigned to any camera sensor).

Modify the way in which the list is displayed.

The active post-processing blend is shown in the lower part of the library:

Icon Description

Thumbnail Double-clicking on the thumbnail opens the Post-processing editor.

Use the eyedropper to pick a post-processing blend from a camera sensor
used in a viewport and render it active.

Open the Post-processing editor for the active post-processing blend.

Select the active post-processing blend in the list of sensors.
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25 SENSORS

25-1 Definition

A sensor is one of the basic resources inMatter that allow you to dress a
product. Sensors are used to specify view-related information, such as the
aspect ratio and type of projection, and to group 2D elements applied to a
rendering.

To use a sensor, you must assign it to a camera or to a viewport. Assigning a
sensor to a viewport assigns it to the viewport's free camera. You can assign a
sensor to as many cameras as you would like.

Sensors are managed in theMatter sidebar's sensor library.

25-2 Default Values

When no sensor is assigned, a camera, including the free camera in a viewport,
uses sensor default values.

The default values include an aspect ratio of 3:2, equivalent to the full-frame
sensor in physical cameras measuring 36x24mm, and the use of a perspective
projection. No backgrounds, overlays, or post-processing effects are used.

25-3 Attributing a New Sensor to a Viewport’s Free
Camera

You can attribute a different sensor to any viewport’s free camera. This will
replace the default sensor values in that viewport until the sensor is deleted or
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the viewport is closed. Remember that all viewports are closed when you close
your database.

Drag the sensor that you want to use from theMatter sidebar's sensor library
and drop it onto the view in which you would like to use it.

25-4 Sensor Library

In theMatter sidebar's  library tab, the sensor library manages the
groups of sensors and the sensors available in your database.

Groups of sensors are listed in the upper part of the library:

Icon Description

Create a new group.

Duplicate the selected group.

Rename the selected group.

Delete the selected group.

The list of sensors shows all of the existing sensors in the selected group. Using
the buttons below the list, you can:

Icon Description

Create a new sensor.

Duplicate the selected sensor.

Edit the selected sensor by opening the Sensors editor.

Rename the selected sensor.
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Icon Description

Import sensors that you have previously saved.

Export the selected sensors.

Delete the selected sensors.

Purge sensors that have not been used (sensors that are not associated with an
open viewport or with a camera).

Modify the way in which the list is displayed.

Right-clicking on a sensor opens a context menu offering the following options:

Icon Function Description

Set active Make the sensor you have clicked active and shows it in the lower
part of the library.

Edit Edit the selected sensor by opening the Sensors editor.

Duplicate Duplicate the selected sensor.

Rename Rename the selected sensor.

Usage
list Show a list of all cameras using the selected sensor.

Import Import sensors that you have previously saved.

Export Export the selected sensors.

Delete Delete the selected sensors.

The active sensor is shown in the lower part of the library:

Icon Description

Thumbnail Double-clicking on the thumbnail opens the Sensors editor.
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Icon Description

Use the eyedropper to pick a sensor from a viewport and render it active.

Open the Sensors editor for the active sensor.

Select the active sensor in the list of sensors.

25-5 Using Sensors

25-5.1 Opening a Database from anOlder Version

When you open a database created with a Patchwork 3D Design version prior
to v6.0, sensors will be created automatically in order to conserve the settings
applied to your products. The sensors created by this conversion include
information for:

l Any applied post-processing and the visibility of post-processing
blends,

l Any applied overlays and the visibility of overlays,
l The background mode and any applied background texture,
l The depth policy,
l The viewport policy.

25-5.2 Assigning a Sensor to a Camera

A sensor can be assigned to a camera or to multiple individual cameras.

In the Camera Editor, switch to Edit current camera mode for the
camera to which the sensor should be assigned. Drag the sensor from the
Matter sidebar's sensor library and drop it onto the Sensor field in the Camera
Editor.
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25-5.3 Assigning a Sensor to a Viewport

A sensor can be assigned to the free cameras in individual viewports. Assign a
sensor to the free camera by dragging it from theMatter sidebar's material
library and dropping it onto the viewport while the free camera is active.
Because the free camera for each viewport functions independently, only the
sensor for the free camera in the chosen viewport will be replaced.

You can verify the sensor assigned to the active viewport at any time. If a
sensor has been assigned to the active camera in a viewport, it is displayed in
the upper right-hand corner with the name of the camera. This information is
also available in the Camera Editor. When a camera is active, its information is
displayed on the right-hand side of the editor. The sensor used by the active
camera is shown in the Sensor field. Click on this field to locate the sensor in
theMatter sidebar's material library.

25-5.4 Modifying the Sensor Used in a Viewport

The sensor assigned to the camera that is active in a viewport can be modified
without opening the Sensor Editor. To replace the sensor’s current post-
processes, overlays, and environments with new ones, drag and drop the new
effects onto the viewport.
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26 GEOMETRY LAYERS

26-1 Definition

Geometry layers enable the surfaces of a model to be grouped and organized
in a hierarchical structure. This facilitates editing. Geometry layers can also be
used with the configuration system to hide or display surfaces in a given layer.

The Surfaces tab in the Shaper sidebar contains each of the surfaces
contained in the layer you are editing.

Each layer is represented by a zone containing its name and its properties. All
the operations that modify the state of a layer are applied by default to the
active model that is shown highlighted.

Initially, a model has only one layer. You can create new layers via the Layer >
New menu. You can then distribute the surfaces into the various layers to form
logical assemblies of surfaces.

26-2 Operations on Geometry Layers

Each geometry layer is listed with several status indicators:

Indicator Description

Visible layer.

Hidden layer.

Unfrozen layer.

Frozen layer.

Layer that contains the active layer.
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Indicator Description

Active layer.

Select all surfaces in this layer in a single click.

Operations on the layers can be carried out using the buttons below the list of
layers:

Icon Description

New layer.

New layer within the selected layer.

Duplicate the selected layer.

Rename the selected layer.

Find and select the surfaces in the selected layer.

Delete the selected layer.

Each layer has properties that directly affect the surfaces it contains. These
operations are available via a right-click on the name of the layer.

The most commonly used operations are the following:

Operation Description

Show
these
layers

Modifies the visibility of the active layer. The surfaces in an invisible layer do
not appear in the geometry of the model and cannot be modified in Shaper.

You can use the visibility of the layers to momentarily hide the surfaces on
which you are not working and to simplify accessing the other surfaces. You
can also vary the visibility of the layers to test the geometrical variations of a
model.

Freeze
these
layers

Modifies the editable state of the active layer. The frozen layers are still
included in the geometry of the model, but can no longer be modified in
Shaper. The frozen surfaces appear differently in the 3D view of Shaper: they
are shaded. You should only freeze a layer when the surfaces of the layer no
longer need to be edited.

Duplicate
Duplicates the active layer and also all of the surfaces it contains. If the active
layer is not the only layer in the model, you can delete it by right clicking on
the layer and choosing Delete.
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The principal operations on layers are also available via right-click on a
geometry layer in the sidebar. The right-click context menu also provides
access to the following operations, among others:

Icon Operation Description

Duplicate layer
with symmetry

Creates a duplicate of the selected layer but reflects all of its
surfaces over a given plane: YX, XZ or YZ.

A window will open and you will be asked to choose the plane
of symmetry.

Show child layers Modifies the visibility state of all child layers in order to make
them visible.
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27 POSITION LAYERS

27-1 Definition

Position layers allow Shaper objects to have multiple positions, one in each
layer. Position layers can then be used in the configuration system to create
variants of a model or a product in which the position or the presence of
certain objects is not the same.

27-2 Displaying Position Layers

Surfaces using position layers are displayed taking the layer hierarchy into
account. Position layers indicated as visible are analyzed in the same order as
they are listed in the Position Layers editor. For each surface, the first position
assignment found is displayed.

For more information on creating position layers, see Position Layers (Editor)
(page 169).
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28 LIGHTING LAYERS

28-1 Definition

A lighting layer is a grouping of light information that contains multiple lights.

The lighting that is visible on a model is the result of an analysis of the stack of
lighting layers. Each surface is lit based on the first visible layer in which an
lighting is assigned to the surface.

Lighting layers can be used just like other layers, as targets of configuration
rules. This allows, for example, indicator lights, LEDs and other lights to be
turned on or off when a configuration symbol is enabled in the configuration
browser, or according to the position of configuration keys in an animation
timeline.

In the Illumination tab in the Shaper sidebar, the Illumination Layer
zone provides the tools to create, adjust, and delete layers.

28-2 Operations on Lighting Layers

There is a maximum limit to the number of lighting layers. The total number of
layers must not exceed 32. Once you have reached this limit, no additional layers
can be created.

To change the position of a layer in the list, drag and drop it on a new position.
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The main buttons are available below the list of layers:

Icon Description

New lighting layer.

Duplicate lighting layer.

Add new lighting color to the layer.

Rename lighting layer.

Import lighting layer.

Export lighting layer.

Delete lighting layer.

The buttons to rename, duplicate, export or delete a layer affect only the
selected layer. When multiple layers are selected, these buttons only affect the
leader of the selection. The leader layer has a dotted border and is highlighted
in light gray.

Each lighting layer has its own set of active values for modulation color,
intensity, visibility, and configuration use. The active set of color values is
marked with a check in the visibility column in the Layers list. When more than
one layer is visible, the active values for each layer are combined.

The columns to the right of the name of the layer display the value of each of
these properties. To change the value, click on its representation in the
corresponding column.

Property Description

Modulation
color

The color of the lightmap is multiplied by the color of the layer. This color
is always white by default. Click on the colored rectangle to open the color
chooser and modify the color.

Intensity
The intensity of the lighting can be modified. You can set it to 0 or to any
positive decimal value. By default, the intensity is set to 1, which
represents a normal lighting.
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Property Description

Visibility

Illumination layers can be visible or hidden. During the analysis of the
stack of layers, hidden layers are skipped. New layers are visible by default.
Lights in a visible layer are shown in blue in the viewport. Lights in an
invisible layer produce no effect and are displayed in red in the viewport.

Configuration
If the layer is used as a target of a configuration rule, the icon is
displayed. Clicking on this icon will select the corresponding rule in the
Configuration Editor.

You can also right-click on a lighting layer in order to copy its lightmaps to
another layer in the list.

When you open a database created with a version of Patchwork 3D Design prior
to version 6.0, each lighting set is converted to a lighting layer. To maintain the
original settings, the layer that corresponds to the active lighting set is visible; all
of the other layers are hidden.

When a new lightmap is first calculated for a surface, the other lightmaps for this
surface may also need to be recalculated if they were generated with a version of
Patchwork 3D Design prior to version 6.0.

28-3 Using Lighting Layers

Illumination layers can require significant computing power. To limit this,
lighting layers have been optimized for certain uses.

28-3.1 Substitution

Use a lighting layer when you have multiple geometric versions of your model.
For example, you might be working on a seat that can be marketed with or
without a headrest. Without a lighting layer, you must calculate the lightmap
for the whole model. When you view the version with no headrest, however,
the zone where the headrest would have been remains black: no lightmap was
calculated for this zone.

To correct this, use a lighting layer.
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28-3.2 Configuration

Use a lighting layer when your light sources need to be animated or
configurable.

Put only the lights that must be turned on or off together in a separate layer.

The activation of layers is configurable. As with other types of layers, lighting
layers can be dropped onto the Configurations editor.

The set of color and intensity values of each layer is also configurable. The
lighting color set can also be dropped onto the Configurations editor.

28-3.3 Recommendations

To improve performance, follow these recommendations:

l Put all related lights in the same layer.
l Make sure that it isn't possible to have multiple layers containing
sky lights active at the same time.

l Use the minimum number of layers that you can.
l Avoid using multiple sky lights to create the effect of an exterior
environment. This effect can be created inMatter with a lighting
environment and a real-time sun.

28-4 Settings for a Lighting Layer

Select a lighting layer by clicking on it. The light sources in this layer are now
shown in white in the viewport. Theyarealsolistedbelow intheLight Settingszone.

In addition to the lights contained in the layer, layers also contain additional
settings that determine the aspect of their illumination. These settings are
found in the Lighting Settings zone. They apply to all lights in the layer.

l Exposure
l Contrast
l Lightmap format:

n Color: To obtain shadow rendering that takes the lighting
colors into account, choose the Color format.
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n Luminance : Use the Luminance format to obtain a
relatively rapid rendering.

n Luminance HQ
n Luminance HDR: The Luminance HDR lightmap texture
format is designed for the shadow rendering of HDR
images and manages light sources significantly more
intense than the Luminance and Luminance HQ
formats.

l The lightmap settings:
n The resolution of the textures to be produced,
n The size of the shadowmaps,
n The choice to render the unlit surfaces using
Environment-type lighting.
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29 ENVIRONMENT LAYERS

29-1 Definition

Environment layers allow for the creation of several product variants with
different environments and can be used in configurations.

You may be interested in learning more about:

l Product Environments (Editor) (page 173)
l Lighting Environments (page 383)

29-2 Using Environment Layers

The principle of using environment layers is best illustrated through an
example.

First, a layer named "Dock Layer" is created in which a global environment is
allocated to all surfaces.

A second layer named "Warehouse Layer" is created, in which a global
environment is allocated to all surfaces.

Finally, a layer named "Body Layer" is created. This layer contains an
environment allocation specific to the vehicle body.
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From top to bottom, the Dock Layer, Warehouse Layer and Body Layer.
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Now it is possible to enable the visibility of all three layers. The "Dock Layer,"
which contains the highest global environment in the hierarchy, is displayed in
the product. The surface-specific allocation of the environment to the body in
the "Body Layer" is also displayed: it is the highest-ranking surface-specific
environment allocation in the hierarchy.

Result of the environment layers stack evaluation.

In the Products Environments editor, for "Warehouse Layer", surfaces to
which the higher-ranking global environment is affected are displayed in italics
and crossed out. Similarly, the listing for the body surface in "Dock Layer" is
also in italics and crossed out.
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30 ASPECT LAYERS

30-1 Definition

Aspect layers allow different materials and their UV mapping projections to be
assigned to the same surface in different layers.

Using aspect layers will allow you to create configurations for the materials
used to dress your product. This approach makes it easy to create many
variants and derived versions of products.

You may be interested in learning more about:

l Aspect Layers (Editor) (page 109)

30-2 Accessing All Aspect Layers with Assignments

Once a surface is selected, it is possible to obtain the list of aspect layers in
which there’s a material or one or more labels assigned to it.

This list may be reviewed in the Surface Properties accessed by right-clicking
on a surface and selecting Edit properties.

For each aspect layer in the list, the following attributes are displayed:

l The aspect layer’s name,
l The mention hidden if the layer is not visible,
l The number of material assignments for the selected surface in the
layer if relevant,

l The number of label assignments for the selected surface in the
layer if relevant.

Selecting an aspect layer in the list displays the corresponding assignments in
the Layer Assignments box.
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30-3 MovingMaterial and Label Assignments

Material and labels assignments may be moved from one aspect layer to
another.

Moving a material or label assignment is performed by selecting the source
aspect layer in the Layer drop-down list of the Surface Properties accessed by
right-clicking on a surface and selecting Edit properties.

Material and label assignments defined in the selected layer are displayed in
the Layer Assignments box. The assignment to be moved must then be
selected and the destination aspect layer chosen from the list opened by

clicking theMove Assignment button .
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31 PRODUCT CONFIGURATIONS

31-1 Introduction to Configurations

The product configuration system in Patchwork 3D Design is designed to offer
the possibility of displaying product variants in real time. The configuration
tools allow you to elaborate a complete product range. This range can then be
used directly by our configuration exploration software programs, such as
Patchwork Explorer and Web Render.

The configuration system requires the use of geometry, aspect, position,
environment, illumination, or lighting color layers. A minimum level of
knowledge is necessary to be able to manipulate and use the configuration
features of Patchwork 3D Design to the best effect.

In order to obtain a configuration system, you will build geometry, illumination,
lighting color, aspect, position , overlay, and environment layers and create
combination rules by dividing a model into several layer groups, that is to say,
by partitioning it. Product variants are combinations of these layers.

31-2 Definitions used in Configurations

l Partition: A partition is an element or aspect of a product that can
have several alternatives. A partition includes all of the possible
states, either "enabled" or "disabled," or a user-defined list of states.

The truck’s bin color is a partition with three states: red, gray, and blue.

l Symbol: A symbol is a variable that represents a selection state in
the Configuration Browser. Symbols are not created directly; they
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are automatically extracted from rules.
o Defining a symbol: The Configuration Browser allows
a set of symbols to be chosen via checkboxes and drop-
down lists. Only one symbol per partition can be
"defined" (selected) at a given time.

Two defined symbols in the Configuration Browser: Bin.Blue and Ground.

l Rule: A rule is a logical expression that links user selections in the
Configuration Browser to the visibility state—displayed or
hidden—of layers. Rules are conditions that depend on a set of
symbols being defined (selected in the Configuration Browser).
When the condition is fulfilled, the layers associated with the rule are
visible. If one or more symbols needed to validate the rule are not
defined, the layers will not be visible.

o Simple rule: A rule is called "simple" when a single
symbol is necessary to validate it and the only operator
used is "defined".

Ground

(defined "Ground")

This rule is validated when "Ground" is defined, that is,
when it is selected by the user in the Configuration
Browser.

o Complex rule: A rule is called "complex" when its
validation depends on the analysis of a Boolean
operation.

Roof_Rails

(and (defined "Roof_Accessories")(not (defined
"Convertible")))

This rule is validated when "Roof_Accessories" is defined,
that is, selected in the Configuration Browser, and
"Convertible" is not.
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31-3 Preparing a Model

A configuration, or product variant, consists of a set of layers.

Creating a variant can be thought of as defining which layers among those you
have prepared will be visible and which will be hidden. Consequently, creating
configurations depends on having prepared product layers before you define
the configuration rules.

In this section, the chapters Understanding Partitions and Using Meaningful
Layer Names will help you think about layers used in configurations, and how
to name and group layers in order to create configurations.

If you need more information on creating layers, documentation dedicated to
aspect, position and environment layers is available.

31-3.1 Understanding Partitions

A partition with three possible states.

To create a configurable model, begin by identifying the partitions within which
several alternatives are possible. In the above image, the truck’s bin can exist in
multiple colors. The bin color is an example of a partition. Partitions can be
related to model surface geometry, aspect or position, or to the environment of
the model. In this example, for ease of understanding, aspects and colors are
used to illustrate the principles of configurations.

There are two types of partitions. Some can be enabled or disabled, while
others require an element to be chosen from a list of multiple alternatives.
Partitions are listed in the Configuration Browser, where you or your end user
can select their state:
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Associating two partitions (left) with five rules (right).

Next, the partitions must be associated with rules.

In the above image, the partition "stickers" can be enabled or disabled. By
ticking the checkbox "stickers" (on the left in the image), you define the
corresponding symbol. The associated rule, "stickers" (on the right), states that
when the symbol "stickers" is defined, the aspect layer containing the stickers
is visible.

In this image, the partition "paint" refers to the color of the paint, which can be
any one of several options: red, blue, yellow, black… By making a selection in
the drop-down list (on the left of the image), you define one of the symbols
"paint.red", "paint.blue", "paint.yellow", "paint.black" in accordance with
your choice. The associated rules (on the right), "paint.red", "paint.blue",
"paint.yellow", "paint.black," state that if the corresponding symbol is
defined, the layer with the right color is visible.

This example, therefore, contains a total of five symbols and five rules (one for
the stickers and four for the paint), but only two partitions ("stickers", and
"paint").
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31-3.2 Using Meaningful Layer Names

It is highly recommended that you give your geometry, position, illumination,
aspect, overlay, and environment layers meaningful names. A meaningful name
expresses the layer’s function clearly. This will greatly simplify the procedure of
creating target layers for the rules governing your configurations.

Where configurations are concerned, using meaningful names does not only
mean using names that allow you to remember what the layer is and does. It
also means using names that allow you to make the connection between the
layers themselves and eventual configuration symbols and partitions that you
will create.

Name your layers according to the partition they will belong to.

Give the same prefix to all layers referring to the same configurable element, or
partition. If the layer is part of a group of options in a single partition, like the
paint partition in the example in the chapter Understanding Partitions, we
recommend using a multi-part name constructed as follows:

l use the partition name as a prefix,
l followed by a point (.),
l followed by a meaningful descriptor.

This will lead to layer names such as "paint.red" for an aspect layer with red
paint, or "lever.raised" for a position layer in which a lever is in the up position.

When you create configurations rules, you will be able to use meaningful layer
names to automatically generate simple rules and their symbols in the
appropriate format.

31-4 Configuration Rules

The configuration system is based on user-defined rules. These rules establish
the visibility of the layers that they are associated with. These associated layers
are called target layers. Consequently, your model must be organized into
meaningful layers before you set up your configuration rules.
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31-4.1 Definition of a Rule

Configuration rules are the expressions that determine which options to
display, and under which conditions to display them.

Configuration rules are expressed as Boolean expressions. A rule consists of:

l The definition of one or more symbols in the form "partition" or
"partition.value_n". Each symbol represents a condition that can be
true or false based on selections made by the end user.

l Optionally, the logical operators (AND, OR, NOT, XOR) that express
relations between the symbols.

l The assignment of target layers.

Rules are evaluated logically. This evaluation leads to one of two values: true or
false. When a rule is true, the rule’s target layers are visible. Otherwise, they are
hidden.

Using the Configuration Browser in this software and other display software,
you or your end user can select the options to display. This selection
determines which simple rules are defined, and which are not defined. The
evaluation of complex rules is carried out based on these user-indicated
definitions.

You can create as many rules as necessary in order to create a complete range
from a base product.

31-4.2 Understanding Functional Principles of Symbols

All symbols follow one of two functional principles:

l Activation/Deactivation Principle

These symbols take the form "partition". They are activated or
deactivated individually.

l Exclusion Principle

These symbols take the form "partition.value_n". They are grouped
by their prefix "partition."; activating any symbol in the group
"excludes" or cancels the activation of all other symbols in the same
group.

When creating a rule, you determine which principle is will be followed by
giving the appropriate format to the symbol used in the rule.
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31-4.2.1 Activation/Deactivation Principle: "partition" Symbols

All "partition" symbols follow the activation/deactivation principle.

They represent partitions that can be activated or deactivated. You might have
symbols armrests and headrest and footrest for a seat product. Any, all, or
none may be selected at a given time: your product variants could include a
seat with both a footrest and a headrest without causing a conflict.

Each "partition" symbol may be either defined (true) or undefined (false)
independently from other "partition" symbols, unless restricted by a complex
rule. Many "partition" symbols may be defined, or selected, at the same time.
The visibility of the target for each of the rules is activated or deactivated
separately.

Once your simple rules for defining "partition" symbols are set up, the
Configuration Browser will present you with a label "partition" and a check
box to activate or deactivate the symbol for each rule of this type.

Checkbox for a "partition" label in the Configuration Browser

31-4.2.2 Exclusion Principle: "partition.value_n" Symbols

All "partition.value_n" symbols follow the exclusion principle.

They represent partitions that can have many values, such as the color of paint
or the position of a moving part. You might have paint symbols paint.red,
paint.blue, paint.yellow or position symbols position.up, position.middle,
position.down.

Only one of these symbols can be selected at a given time: the paint cannot be
both red and yellow at the same time; the part cannot be in both its up position
and its middle position at the same time. Only one "partition.value_n" symbol
can be defined, or selected, at a time.

The Configuration Browser will group these symbols by their "partition."
prefix. For each prefix, it will present you with a label "partition" and a choice
from a drop-down list for all of the corresponding ".value_n" rules. You may
choose only one "value_n" to activate at a time.
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Drop-down list of "value_n" values for a "partition" label in the Configuration
Browser.

31-4.3 Creating Simple Rules

A simple rule is a rule that is evaluated as true when the symbol it uses is
selected by the user. If the simple rule is evaluated as true, its target layers are
displayed.

Simple rules contain only one symbol. They do not contain logical operators or
relationships between symbols.

31-4.3.1 Creating Simples Rules by Dragging and Dropping

31-4.3.1.1 Creating "partition" Rules by Dragging and Dropping

To create a "partition" rule with a symbol that follows the
activation/deactivation principle, drag and drop a single target layer onto the
rule list in the Configuration Editor. It will follow the activation/deactivation
principle by default.

1. Open the Configuration Editor. Go to the Editorsmenu > Create

configurations .
2. Select a layer that you want to use as a target layer from any of the

following:
l Shaper: the model’s Geometry Layers list in the sidebar,
l Shaper: the model’s Illumination Layers and their
colors from the list in the sidebar,

l Shaper/Matter: Position Layers editor,
l Matter: Aspect Layers editor,
l Matter:Overlay Layers list in the Overlays editor,
l Matter: Environment Layers list in the Product
Environments editor.

3. Drag the selected layer onto the Rules box in the Configurations
editor. The Simple Rules editor will appear.
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Dragging and dropping an aspect layer into the Rules zone makes the Simple Rules
editor appear.

4. In the Simple Rules editor, you can rename the symbol that will be
automatically added to the Configuration Browser. The name of
the layer is proposed by default. You can also rename the rule itself
by unticking the checkbox Use defined symbol as rule’s name.
Even if you rename the rule or the symbol, the name of the layer
itself will remain unchanged.

This method creates a single simple rule for a "partition" symbol that will follow
the activation/deactivation principle. It is not possible to create multiple simple
rules for multiple "partition" symbols at the same time. Dragging and dropping a
selection of layers will create a group of rules for "partition.value_n" symbols
that follow the exclusion principle.

31-4.3.1.2 Creating "partition.value_n" Rules by Dragging and Drop-
ping

To create a set of simple rules for "partition.value_n" symbols that follow the
exclusion principle, drag and drop multiple target layers together onto the rule
list in the Configurations editor. This will create multiple rules simultaneously.
They will follow the exclusion principle by default.

1. Open the Configurations editor. Go to the Editorsmenu > Create
configurations
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.
2. Select a group of layers that you want to use as target layers from

any of the following:
l Shaper: the model’s Geometry Layers list in the sidebar,
l Shaper: the model’s Illumination Layers their colors
from the list in the sidebar,

l Shaper/Matter: Position Layers editor,
l Matter: Aspect Layers editor,
l Matter:Overlay Layers list in the Overlays editor,
l Matter: Environment Layers list in the Product
Environments editor.

3. Drag the selected layers onto the Rules box in the Configuration
editor. The Parameters editor will appear.

Dragging and dropping a selection of aspect layers into the Rules zone makes the
Parameter Editor appear.

4. If the layer names are not in the "partition.value_n" format, the
Parameters editor requires that you provide the prefix "partition."
to use for the set of symbols generated from these layers.

This method creates a single partition with a single "partition." prefix for the set
of layers being dragged and dropped.

It is not possible to create sets of "partition.value_n" symbols with different
prefixes simultaneously.
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5. Provide value labels for each individual rule. If your layer names
were already in "partition.value_n" format, the Parameters editor
will propose the "value_n" value for each layer as the value label.
The names of the layers themselves will remain unchanged.

Renaming a value label.

31-4.3.1.3 Creating "partition.value_n" Rules by Dragging and Drop-
ping a group of layers

To create a set of simple rules for "partition.value_n" symbols that follow the
exclusion principle, drag and drop multiple target layers together onto the rule
list in the Configurations editor. This will create multiple rules simultaneously.
They will follow the exclusion principle by default.

1. Open the Configurations editor. Go to the Editorsmenu > Create

configurations .
2. Select a group of layers that you want to use as target layers from
Matter: Aspect Layers editor.

3. Drag the selected group onto the Rules box in the Configuration
editor. The Parameters editor will appear.
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Dragging and dropping a group of aspect layers into the Rules zone makes the
Parameter Editor appear.

4. If the layer names are not in the "partition.value_n" format, the
Parameters editor requires that you provide the prefix "partition."
to use for the set of symbols generated from these layers.

This method creates a single partition with a single "partition." prefix for the set
of layers being dragged and dropped.

It is not possible to create sets of "partition.value_n" symbols with different
prefixes simultaneously.

5. Provide value labels for each individual rule. If your layer names
were already in "partition.value_n" format, the Parameters editor
will propose the "value_n" value for each layer as the value label.
The names of the layers themselves will remain unchanged.

Renaming a value label.
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31-4.3.2 Adding Targets to Existing Rules by Dragging and Dropping

Aspect and environment layers are stored at the product level. This means that
using a given aspect or environment layer as a target only affects the product with
which it is associated. To apply the rule to several products, add the appropriate
target layers for each additional product following the procedure below.

To ensure visibility of configurations with overlay layers, the overlay in question
must be assigned to a sensor used in the viewport camera. Overlay display must
be enabled.

Once a rule is created, you can also add additional target layers:

1. In the rule list of the Configurations editor, select the rule you want
to add target layers to.

2. Drag and drop the additional target layers onto the target list.

You cannot use a given layer as the target for two different rules.

To express the condition set up in the following case:

l If the symbol "partition.value1" is defined, show layer A.
l If the symbol "partition.value2" is defined, show layer A.

Use a single complex rule:

l If the symbol "partition.value1" or the symbol
"partition.value2" is defined, show layer A.

31-4.3.3 Creating Simple RulesManually

To create a simple rule, use the new simple rule button in the Configurations
editor.

1. Open the Configurations editor. Go to the Editorsmenu > Create

configurations .

2. Click on the New Simple Rule button. The Simple Rule
Editor will appear.

3. In the Defined Symbol text zone, enter the name of the symbol you
want to create.
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l Use the format "partition" to create a symbol that will
follow the activation/deactivation principle. This will
create a partition and add a checkbox in the
Configuration Browser.

l Use the format "partition.value_n" to create a symbol
that will follow the exclusion principle. Create multiple
rules with symbols that share the same "partition." prefix
to add them to the same partition and populate the same
drop-down list in the Configuration Browser.

Defining a "partition" type simple rule.

4. The name of the symbol is used by default as the name of the rule.
To change the name of the rule, uncheck the option Use the defined
symbol as the name of the rule. Provide a new name in the Rule
text zone.

Renaming a simple rule.

5. Validate by clicking OK.

Your rule has been created, but you still need to assign target layers to it:

1. Return to the Configurations editor. In the rules list, select the rule
you have just created.

2. Drag and drop your desired target layers onto the target list. You
can drag layers from any of the following:
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l Shaper: the model’s Geometry Layers list in the sidebar,
l Shaper: the model’s Illumination Layers their colors
from the list in the sidebar,

l Shaper/Matter: Position Layers editor,
l Matter: Aspect Layer editor,
l Matter:Overlay Layers list in the Overlays editor,
l Matter: Environment Layers list in the Product
Environments editor.

You cannot use a given layer as the target for two different rules.

To express the condition set up in the following case:

l If the symbol "partition.value1" is defined, show layer A.
l If the symbol "partition.value2" is defined, show layer A.

Use a single complex rule:

l If the symbol "partition.value1" or the symbol
"partition.value2" is defined, show layer A.

31-4.4 Creating Complex Rules

Complex rules are rules that define relationships between defined symbols
using the logical operators "and", "or", "not", and "xor". When the conditions of
the complex rule are true, the target layers are displayed.

Complex rules are created manually by typing the desired expressions. To
create a complex rule, use the new complex rule button in the Configurations
editor.

1. Open the Configurations editor. Go to the Editorsmenu > Create

Configurations .

2. Click on the New Complex Rule button. The Complex
Rules editor will appear.

3. In the first text box, the editor proposes a default name for your
rule. Replace "Rule" with a meaningful name.
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Replacing "Rule" with a meaningful rule name.

4. In the Expression text box, type out the Boolean expression. Refer
to the chapter on Rule Syntax for more information on expression
syntax.

5. You can use the Insert Tool to insert simple rule expression within
your complex rule:

l Select the desired existing symbol from the drop-down
list.

l Click "defined" to insert the expression at the current
cursor location in the Expression text box.

Using the Insert Tool to insert the simple expression "(define "paint.black")" in a
complex expression.
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6. Click OK to validate your rule. If the rule cannot be validated, the
validation problems will be listed in the Compiler Output box.
These problems must be corrected before you can validate your
rule.

Compiler output error for missing final parenthesis.

The tools found in the Inspection tab are particularly helpful to analyze the
evaluation of complex rules.

Your rule has been created, but you still need to assign target layers to it:

1. Return to the Configurations editor. In the rules list, select the rule
you have just created.

2. Drag and drop your desired target layers onto the target list. You
can drag layers from any of the following:

l Shaper: the model’s Geometry Layers list in the
sidebar,

l Shaper: the model’s Illumination Layers their colors
from the list in the sidebar,

l Shaper/Matter: Position Layers editor,
l Matter: Aspect Layers editor,
l Matter:Overlay Layers list in the Overlays editor,
l Matter: Environment Layers list in the Product
Environments editor.

Aspect and environment layers are stored at the product level. This means that a
given aspect or environment level only affects the product with which it is
associated. To apply the rule to several products, add the appropriate target layers
for each additional product.

You cannot use a given layer as the target of two different rules.

31-4.5 Rule Syntax

Rule syntax is based on the following principles:
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l All rules have names.
l All expressions are enclosed in parentheses.
l All rules begin with an operator, followed by an operand.

31-4.5.1 Simple Rules

Simple rules are expressions using the "defined" operator only. This operator
takes a single argument, a user-defined symbol, which follows it. The symbol is
set off by a space and must be set inside double quotes.

Simple rules are written as:
Rule

(defined "symbol")

Symbols can take the form "partition" or "partition.value_n". In the case of
"partition.value_n" forms, multiple rules will have the same "partition." prefix.

Rule1

(defined "partition1")

Rule2

(defined "partition2")

Rule3

(defined "partition3.value_1")

Rule4

(defined "partition3.value_2")

Rule5

(defined "partition3.value_3")

31-4.5.2 Complex Rules

Complex rules are Boolean expressions. They may combine several of the
available operators: "defined" and the logical operators "and", "or", "not", "xor".
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Each logical operator takes two arguments in any order. The arguments of the
logical operators are expressions enclosed in parentheses, and can be either the
expression of a simple rule or the expression of another complex rule.

Operators are placed before operands in the Boolean expression. Nested
parentheses indicate the grouping of expressions and their order of evaluation.

Rule(and (defined "symbol_p")(defined "symbol_q"))

This rule is true if symbol_p and symbol_q are defined.

Rule(or (defined "symbol_p")(defined "symbol_q"))

This rule is true if symbol_p or symbol_q is defined.

Rule(and (or (defined "symbol_p") (defined "symbol_q")) (defined "symbol_
r"))

This rule is true if symbol_p or symbol_q is defined ("or" is evaluated first), and
if symbol_r is also defined.

31-4.6 Example: Creating Configuration Rules

This example uses an old interface theme.

This example of configuration rule creation for the color of a truck cabin is based
on database toy_truck_tuto.pd3. You can obtain this database by downloading
this file here.

First, aspect layers need to be created for the configurable elements.

https://www.patchwork3d.com/resources?utm_campaign=v8.1.0&utm_source=p3d&utm_medium=app_desktop&utm_content=help_pdf
https://www.patchwork3d.com/resources?utm_campaign=v8.1.0&utm_source=p3d&utm_medium=app_desktop&utm_content=help_pdf
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1. InMatter, open the aspect layer window by clicking on this icon

at bottom of the interface.
2. Select the Split by picked material tool.
3. Click on an element linked to the configuration to create an aspect

layer.
4. Rename the aspect layer created by following the naming principle:

"partition.value" (for example: Cabin.Blue).

The use of this naming system lets you automatically create configuration rules
(see next paragraph). Using it therefore saves considerable time.
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5. Click on the Duplicate the Aspect Layer button to create a variant
of the element linked to the configuration.

6. Drag-and-drop a new material on the element in order to assign to
the aspect layer the new value taken by the element linked to the
configuration.

7. Rename the aspect layer according to the newly assigned value (in
our example: Cabin.Yellow).

l Create as many variants as necessary by repeating steps 5 to 7.
l Create new configurable elements by repeating steps 2 to 4, and
then create their derivatives by repeating steps 5 to 7.

Patchwork 3D Design also lets you create product derivatives relating to
geometry.
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Aspect layers Cabin.Yellow, Cabin.Red and Cabin.Blue.
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Click on this icon to show dialog Configurations. In Browser tab select
Yellow in the drop-down list. Name all layers using the same prefix "Cabin.",
then drag and drop the layer selection into the Rules tab of the Configurations
editor. The interface builds the following rules:

Cabin.Yellow(defined "Cabin.Yellow")

Cabin.Red(defined "Cabin.Red")

Cabin.Blue(defined "Cabin.Blue")

Rule Cabin.Blue determines the visibility of aspect layer Model/Product/Cabin.Blue.

This rule set follows the exclusion principle: only one of them is evaluated as
true at a time. Each of these new rules targets one aspect layer. Symbols
Cabin.Yellow, Cabin.Red and Cabin.Blue are added automatically as a drop-
down list to the available symbols in the Configurations editor. Selecting
Yellow means defining the symbol Cabin.Yellow. Since only one of these
symbols can be defined at a time, only one of the new rules is evaluated as true.
A partition corresponding to the color of the cabin was created.
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Drop-down list generated automatically from the symbols involved in the new rules.

Yellow is highlighted in green since it is true. The aspect layer
Model/Product/Cabin is then visible. Rules Cabin.Red and Cabin.Blue are
displayed in red since they are false. The target layers of these rules are hidden.

Inspection tab shows the result of rules evaluation.
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Create a configuration rule for enabling or disabling the displaying of a
material on the ground in the same manner. First, create the aspect layer
Model/Product/Ground corresponding to material assignment on the ground.
Generate the rule "Ground" by dragging and dropping the layer from the
Aspect Layers editor to the Configurations editor: the Simple Rule editor
pops up, allowing for specifying the rule name and the symbol involved.

Rule Ground creation using the Simple Rules editor.

The rule "Ground" follows the activation/deactivation principle and is written:

Ground

(defined "Ground")

A partition corresponding to the ground was created and a check-box for
defining the symbol Ground added automatically to the list of available
symbols in the Browser tab in dialog Configurations. Ticking the check-box
defines the symbol.
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Check-box for defining symbol Ground.

31-5 Configuration Annex: Auto-Partitioning

31-5.1 The Concept of Auto-Partitioning Aspect Layers

The geometry, lighting, and position layers belong to the model, whereas the
aspect layers belong to the products. As a consequence, aspect partitions
defined through configuration also belong to each product and not to the
model. They cannot be transferred from one product to another product
created from the same model directly.

You might find yourself in this situation if you are working on a multi-product
database.
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Auto partitioning operating principle.

In order to access all product partitions inside a single product, auto-
partitioning is required. Auto-partitioning gathers all product partitions related
to aspect layers and assigns them to a single product.

To auto-partition a product, use automated functions available in the Aspect
Layers editor.

1. From theMattermodule, create a new, blank product.
2. Open the Aspect Layers editor. Click on the Editorsmenu > Aspect
Layers.

3. Click Import Aspect layers . This imports all aspect layers
into a product.

4. Select all imported layers. Click Expand Selected Layer Selection

by Assignment . This creates the partitions.

It is best to rename the aspect layers at this point. To simplify this task, you can

use the Replace String function in the Aspect Layers editor.

An example of how to implement auto-partitioning is included below.
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31-5.2 Example: Creating a Configured Product with Auto-Par-
titioning

This example uses an old interface theme.

This example of configuration rule creation for the color of a truck cabin is based
on database toy_truck_versions.pd3. You can obtain this database by contacting
the Lumiscaphe Support Department at support@lumiscaphe.com.

This example uses the database toy_truck_versions.p3d. It contains several
product versions including a single aspect layer each. The following tutorial
explains how to gather all the versions into a single configurable product to
create a complete product range.

The product versions available in the database show different colors for the
cabin on the one hand and the bin and rims on the other hand. The configured
product will then require two configuration rules.

The six product versions created from the same model.

31-5.2.1 Step 1: Creation of a Blank Product and Layers Import from All
Product Versions

Create a new product named Configured Product.

Aspect layers belong to the product versions and not to the model. The product
created only has a blank base aspect layer. In order to create the configuration
system, the aspect layers of the different product versions must be imported in
this product. Use the function Import Aspect layers

mailto:support@lumiscaphe.com?subject=Request%20for%20tutorial%20database:%20toy_truck_tuto.p3d
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accessed through the Aspect Layers editor to import aspect layers into
the new product. The imported layers are displayed in the Aspect Layers editor
of the Configured Product in addition to the base layer.

Importing existing aspect layers into the blank product.

31-5.2.2 Step 2: Auto-Partitioning

Select all imported layers in order to split them by assignment. This operation is
performed by using the Expand Selected Layer Selection by Assignment

function from the Aspect Layers editor. The partitions obtained are
presented below.

Partition 0 Partition 1 Partition 2

Partition 3 Partition 4 Partition 5
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Partitions obtained by expanding the layers by assignment.

The partitions obtained are listed in Aspect Layers in addition to the base layer of the
"Configured Product".

31-5.2.3 Step 3: Renaming the Layers

Now that partitions have been obtained, configuration rules may be created for
the cabin color in one instance and the bin and rims color in the other.

Renaming the layers.
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First, rename the layers according to the "partition.value_n" format using the

Replace String function of the Aspect Layers editor. In this example,
rename layers Partition0, Partition1 and Partition2 into BinRims.0,
BinRims.1 and BinRims.2. In order to work with explicit names, rename these
layers into BinRims.Blue, BinRims.Red and BinRims.Silver. In the same
manner, rename layers Partition3 and Partition4 into Cabin.Yellow and
Cabin.Silver. Layer Partition5 is renamed into Base. The material assignments
in this layer don’t require a configuration rule.

Renamed aspect layers of the "Configured Product".

31-5.2.4 Step 4: Rule Creation

Create the rules by drag-and-drop of the selection Cabin.Yellow and
Cabin.Silver layers on the one hand, and BinRims.Silver, BinRims.Blue and
BinRims.Red on the other hand. The rules created are displayed in the
Configurations editor. The Configuration Browser was also updated.

Configurations editor and the Configuration Browser after rule creation.

l The different product versions can be deleted.
l In the Aspect Layers editor, the product versions are available as
bookmarks.
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32 CAMERAS

32-1 Definition

A camera is a set of several elements:

l a sensor: a set of information concerning the rendering that is
applied when the camera is used for viewing. Its modifiable settings
include:

n Sensor size / Aspect ratio,
n Type of render (post-process, overlays, backgrounds),
n Type of projection : isometric/perspective ,

l a lens: information linked to the position of the object viewed in
relation to the camera:

n Focal distance / Field of view angle (FOVX or FOVY),
n Depth of field (aperture, focal point distance),

l a camera position: the position and the orientation of the camera.

Cameras are used to prepare rendering by setting up a particular view of a
product in a viewport. This view can then be saved, recalled, or used to create
films and images.

32-2 Identifying the Camera Used in a Viewport

The name of the camera that is active in a given viewport is indicated in the
upper left corner of that viewport, followed by the name of its sensor, if one is
used. In the case of the free camera, if a preset is used, the name of the preset
mode is indicated: top, bottom, left, right, front, or back.
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32-3 Recalling a Camera's Settings in a Viewport

A camera's settings can be recalled in a viewport. This replaces the current
settings of the active camera in that viewport with the settings being recalled.
Any of the following actions will recall a camera's settings in the current
viewport:

l Double-clicking on an entry in the list of cameras in the Cameras
editor to load the selected camera's settings,

l Selecting one of the cameras via the viewport context menu. Right-
click on the active camera name to open this menu.

l Clicking on one of the four favorite camera buttons in the toolbar or
using their keyboard shortcuts, if you have assigned favorite
cameras for the product in the current viewport.

The position, orientation, sensor effects, and lens properties change
instantaneously.
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32-4 Modifying a Camera's Settings

To modify a camera's settings, the Edit current camera mode must be
enabled. Enable this mode for the selected camera in the Cameras editor by

clicking on the Edit current camera button. You can also enable this
mode by choosing Edit camera from the context menu that opens when you
right-click on the camera in the Camera List.

The settings shown in the Cameras editor are the settings for the active camera
in the current viewport. When the camera's settings are displayed on the right
of the Cameras editor, the viewport shows what is seen by the camera. The
name of the camera is indicated in the upper left-hand corner of the viewport.

As you navigate in the world, you modify the camera's position and orientation.
To explore the 3D world, you can use the various navigational modes, Pan,
Zoom,Orbit, Fly,Walk, andHead, as well as the mouse and keyboard
shortcuts assigned to them.

To return to the free camera, disable the Edit current cameramode.

32-5 Default Camera: the Free Camera

32-5.1 Viewport Free Camera

The free camera exists only in its viewport and is deleted when the viewport is
closed. If you have marked a camera as the favorite camera 1 for a product, that
camera's settings will be used to initialize the viewport's free camera when the
product is loaded.

The free camera's settings can be modified in the camera editor. They are also
edited as you navigate in the viewport.

You can change the sensor used by the free camera by dragging and dropping
a new sensor onto the viewport or onto the Sensor field in the Cameras editor.
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32-5.2 Viewport Camera Presets

Each viewport has a series of camera presets: top, bottom, left, right, front and
back views.

You can change the preset at any time. Right-click on the name of the active
camera, which appears in the top left corner of the viewport. In the contextual
menu that appears, select View, then choose the camera preset that you would
like to activate.

It is not possible to modify these camera presets.

32-6 Generating Bookmarks from a Kam File

Access: Editorsmenu > Cameras

The frames in a *.kam file can be converted to cameras by the Cameras editor

. To do this, at least one .kam file must already be loaded before you
generate bookmarks.

To load a *.kam file:

1. Open Timelines under Matter > Editorsmenu > Timelines.
2. On the right-hand side of the editor, click on the Camera
Animations library tab. Create a new camera animation using the
New button below the Camera Animations list.

3. In the dialogue box that appears, choose the type Kam File.
Validate this step.

Choosing the animation type Kam File.

4. Double-click on the name of the animation you have just created.
The Camera Animations Editor will open.
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5. In the Kam Files zone, click on Import a Kam File. Select
your .kam file and validate.

You can import several .kam files. You will be able to choose later on which of the
open files you want to use to generate bookmarks.

To generate the bookmarks:

6. Open the Cameras editor: go to the Editorsmenu > Cameras.

7. Select the option to open a .kam file.

The Import Cameras window will open. In the first drop-down list,
choose Import from kam file.

9. In the second drop-down list, choose the group in which the
cameras will be placed. By default, the cameras that will be created
will be placed at the root of the camera hierarchy. You can choose
from among any of the existing camera groups.

10. In the drop-down Kam file list, choose the file to use. If you have
opened several .kam files, they will all be shown in the drop-down
list.

Choosing the .kam file to use.

10. The editor will provide a name for each new camera in the format
<prefix_number>. By default, it proposes the .kam file name as the
prefix. You can change the prefix in the Camera Prefix text zone.

11. Camera count is the number of cameras to be generated. Each
frame of your .kam file can be used to provide a view for a camera.
Consequently, you can generate, at most, one camera for each
frame. You will manage the offset of the first camera and the frame
spacing between cameras in the next steps.

12. By default, the first camera is created from the first frame of the
.kam file. If you prefer to change this, use the sliding bar to offset
the first camera.

Modifying the offset of the first camera.
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l 0 offset: the first frame will be used to generate the first camera.
l N offset: the frame N+1 will be used to generate the first camera.

13. Use the Current camera preview slider to check each camera to
be created. If you are not satisfied with the automatically calculated
spacing, you can adjust the frame that will be used to generate
each individual camera. Use the Camera adjustment tool to move
each camera forwards or backwards in the frame sequence.

Adjusting a camera within the frame sequence.

14. Once all the settings have been adjusted, click Import to begin
generating the cameras.

32-7 Product Favorite Cameras

Four favorite cameras per product are available via shortcuts in the toolbar.

To mark a camera as a favorite:

l Use the keyboard shortcuts from the active viewport:

Shortcut Function

Ctrl+F9 Use the current camera settings as favorite camera 1.

Ctrl+F10 Use the current camera settings as favorite camera 2.

Ctrl+F11 Use the current camera settings as favorite camera 3.

Ctrl+F12 Use the current camera settings as favorite camera 4.

l Select the favorite you would like to assign the current camera
settings to from the menu Camera > Store Favorite.

l In the Cameras editor, select the camera to use as a favorite and
click on the corresponding favorite button at the bottom of the
editor.

This creates favorite cameras for the product in the active viewport.
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To call up the favorite cameras of a product in a viewport:

l From the main interface ofMatter, click on the button
corresponding to the favorite camera you would like to call up.

l Select the favorite camera to be restored from the menu
Camera > Restore Favorite.

l Use the keyboard shortcuts:
Shortcut Function

F9 Restore the favorite camera 1 in the viewport.

F10 Restore the favorite camera 2 in the viewport.

F11 Restore the favorite camera 3 in the viewport.

F12 Restore the favorite camera 4 in the viewport.

l In the Cameras editor, double-click on the name of the camera listed

as a favorite and marked with a icon.
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33 ANIMATION

33-1 Animating Geometries

Geometries of models can be animated in Patchwork 3D Design using the
kinematics hierarchy available in Shaper.

Nodes, or parts, in the hierarchy are animated in one of three ways: freely (by
rotation or translation along any of the three principal axes), by rotation along
an axis or by translation along a vector. As part of a hierarchy, child nodes are
animated with their parent nodes. This allows you to create functional
hierarchies and complex moving parts.

For example, a car door part might rotate along an axis running through its
hinges. The range of its rotation is delimited by the angles of its open and
closed positions. You might also have a child part for the car window, which is a
constituent part of the door but which can also be raised and lowered
independently of the door's position. In this example, when the door is opened,
the entire door, including the window at its current position, moves. This
hierarchical configuration allows you to animate both parts of your model
distinctly and simultaneously, though the position and orientation of one has
an influence on the position and orientation of the other.

Each part in the hierarchy consists of two elements:

l A null object, a translation vector or a rotation axis for which
animation parameters are defined.

l A group of surfaces belonging to the part, which are animated
according to the parameters for the null, vector or axis they are
associated with.

Animating the geometry of your model begins in Shaper:

l To animate the geometry of your model, you will first need to define
a functional kinematics hierarchy of parts for your model. This can
be accomplished in the Kinematics tab of the Shaper sidebar. At
this stage, you will indicate what type of motion is necessary for
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each functional part: will it be freely transformed, will it rotate
around an axis or will it move along a vector?

l For each part, you will need to set the properties that define how it is
supposed to behave when animated. You define the degrees of
rotation and the translation distance for each part. You also have
precise control over the position and orientation of the null object,
the axis of rotation or the translation vector along which the part will
be animated.

l A group of surfaces must be selected and assigned to the part as
children.

It is also possible to link animated changes to the position and orientation of a
part or a surface to those of another part or surface using the animation
constraints available in the Kinematics tab.

Once animation has been added in Shaper, theMatter tools allowing you to
visualize this animation on a product will be available. You can:

l Review moving parts using Animation Sliders ,
l Add moving parts to a timeline using channel animations for real-
time playback, use in Livemode or for generating videos.

33-2 Animation Utility Objects

The movement of an animated group of surfaces is defined using one of the
three utility objects: nulls, rotation axes, or translation vectors.

Nulls, rotation axes and translation vectors possess representations to help you
to visualize them and to position them in the 3D space.

The mode , enabled by default, allows objects such as surfaces to be
transformed when their parents are transformed. Deselect this mode in order to
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reposition objects that are already part of a parent-child relationship. This will
prevent objects such as surfaces associated with a part from being moved when
you reposition the representation of the null, axis, or vector.

33-2.1 Null

A null, is an empty object, invisible in the final rendering, that groups together
object that can be affected by a free transformation. A free transformation is
one that is not limited to a single type of transformation (rotation or
translation), nor is the transformation limited to a single axis or direction in the
3D world.

In the Shaper interface, a null is represented by an intersection of axes.

A null object can be selected by clicking on it. The rotation and translation
gizmos position and orient it in the world.

33-2.2 Rotation Axis

The rotation axis is a visual representation of the axis around which an
animated group of surfaces will turn. To modify the position and orientation of
this axis, you will manipulate the representation.

The rotation axis can be selected at one of three points that allow it to be
manipulated: its center, and its two endpoints. When it is selected at an
endpoint, only that endpoint is moved during a translation to position the axis.
This will change the orientation of the axis. If it is selected at its central point,
both endpoints are moved during a translation. As a result, the entire axis is
repositioned.
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Before (left) and after (right) adjusting the placement of a rotation axis. The top
diagram illustrates selection at an endpoint; the bottom diagram illustrates selection

at the central point.

33-2.3 Translation Vector

The translation vector is a visual representation of the line along which an
animated group of surfaces will move. To modify the position and orientation
of this line, you will manipulate the representation.

The translation vector can be selected at one of three points that allow it to be
manipulated: its center, and its endpoints. When it is selected at an endpoint,
only that endpoint will be repositioned, which will change the direction of the
vector. If it is selected at its central point, both endpoints are moved when the
position is modified. This results in the entire vector being moved.
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33-3 Timelines

A timeline is a set of animation tracks. Every new timeline is initialized with
tracks for Products, Cameras, Configurations, Channels, and Textures. Each
track accepts a given type of animation keys or clips, which are available in the
libraries on the right-hand side of the editor. You will find more information
about the editor in the corresponding chapter: Timelines (Editor) (page 231).

Tracks accepting channel animation clips and video textures are added below
the existing tracks. To simplify creating and deleting additional tracks, the
following strategy is applied:

l There will always be one empty track of each kind: if a clip is inserted
into the last empty track, a new one is created at the bottom of the
list of tracks.

l Only one track of each type is empty: if a track no longer contains
any clips, and if another empty track already exists, the newly empty
track is deleted.

A slider allows you to scroll through the tracks if the window is not big enough
to display them all.

33-3.1 Items in Tracks: Clips and Keys

Add clips and keys to the timeline by dragging them from their library tab and
dropping them onto their corresponding track.
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l Keys impose an instantaneous state change. They are positioned at a
given point in time. Drop them at the time at which the change
should occur.

To help you identify the elements you have loaded, the stretch of time during
which the key is active is assigned a solid color and the name of the key is
shown. Each key is activated at its position in time and continues to be active
until it is replaced by a different key.

In a key track, the absence of a key at the beginning of the timeline range is
handled differently depending on the type of key.

See the sections on the types of keys (Product Keys and Configuration Keys) for
more information.

l Clips are sequences of changes over a defined period of time. Drop
them at the time when the sequence should begin.

To help you identify the animations you have loaded, each clip is assigned a
striped color, and the name of the animation is shown within the clip on the
timeline. The length of the clip is a visual representation of the time required to
play it. If your clips overlap, the clip that begins first will play until the
beginning of the next clip, which will then play instead. The clip that begins last
will always have priority.

Some clips contain keys that mark points within the clip. This is the case with
bookmarks in a camera animation clip and key frames in channel animation
clips. You can reposition a key within a clip. First, select the clip. Then, click on
the key and drag it to a new position within the clip.

Once added to a timeline track, items can be:

l Selected,
l Repositioned,
l Removed: Pressing the Delete key removes the selection from the
timeline.

33-3.2 Selecting Individual Items

Select a single item in any track by clicking on it.

If only one item is selected, its information will be shown and can be edited if
the corresponding editor is already open.

To clear a selection, click on an empty area in the tracks.
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33-3.3 Selecting Multiple Items

Select multiple items by holding down the left mouse button and dragging to
create a selection zone. This zone will select the keys whose central point lies
within the zone as well as the clips that are entirely enclosed by the zone.

Using a selection zone to select multiple items.

You can also select multiple items by holding down the Ctrl key and clicking on
the items in the tracks that you wish to include in your selection.

While the Ctrl key is held down:

l Dragging to create a selection zone will add items in that zone to the
current selection,

l Clicking on an item that is already part of your selection will remove
it from the selection.

To clear a selection, click on an empty area in the tracks.

33-3.4 Repositioning Items

To reposition an item or group of items already in a timeline track, begin by
selecting the item or group. Then:

l enter the start time in the Item field,
l drag and drop the selection within its track or, in the case of channel
animation clips, onto another channel track.

In the case of a multi-item selection, entering a value on the Item time zone will
align the activation of all of the selected items at the new time value.

A magnet effect allows you snap both keys and clips to the beginning and the
end of the timeline range. This magnetism also helps you to position clips one
after another with no pause in between. Additionally, you can use it to align the
activation times of elements in one track with elements in other tracks.
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33-3.5 Resizing Clips

To change the duration of a clip, position the mouse over the left or the right
end of the clip. Click and drag the end; this will change the length of the clip.

Resizing a texture clip has no effect on its playback speed. The video will be
stopped before its end, or its playback will be looped in order to fit the length
of time established by the size of the clip.

You cannot resize selections of multiple clips at once.

33-3.6 Loop, Reverse, and Delete Elements

A right-click on a selected timeline key or clip in a track, or on a selection
containing one or more elements, opens a menu from which the following
actions are accessible:

l Erase the selection (keys and clips) from the track,

l Reverse the playback direction (clips only, excluding texture
clips) ,

The background chevron shading indicates the playback direction of a
clip. The chevrons point to the right when the clip is played forwards.
When the playback direction is reversed, the chevrons point to the left.

l Loop the playback of the selected clips (excluding texture clips) by
selecting the type of loop:

n Repeat: This mode repeats individual clips an
infinite number of times. At the beginning of each
repetition, the values that have been modified are reset to
their initial value, and the animation is replayed
identically. A clip that rotates an object five degrees will
be returned to its initial position and will then move the
object the same five degrees again.

n Increment: This mode repeats individual clips an
infinite number of times. It is available only for channel
animations. Any values that have been modified retain
their modification, and each new repetition of the clip
adds the new modification to the previous one. A clip that
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rotates an object five degrees will move it from zero to
five degrees on the first repetition, from five to ten on the
second, from ten to fifteen on the third, and so on.

n Disable: This option removes looped playback for the
selected clips.

33-4 Bézier Curve Primitives

Access:Matter or Shaper > Toolbar > Create Bézier path

Patchwork 3D Design Bézier curves are supports for camera and camera target
paths in animations. The camera, its target, or both can be animated along any
existing curve in your product.

The simplest form of a Bézier curve is a curve calculated between two control
points. The shape of the curve is manipulated by modifying the position of the
tangents running through these control points. The Bézier curves in Patchwork
3D Design consist of two or more points, with a curve passing through each
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pair of points. This chain may have two endpoints (an open curve) or the two
ends may meet and join together (a closed curve).

When creating a Bézier curve, you provide the following information:

l The name of the curve being created.
l The number of points to position along the curve. You can also add
or delete points later.

l Whether the curve will be an open or a closed shape. Select Closed
Path to create a closed curve. This property may be modified later
on.

The curve that is created is placed on the grid. An open curve will be placed
aligned on the X axis. A closed curve is placed so that its points are positioned
equidistantly on an invisible circle centered on the origin in the 3D world.

33-4.1 Modifying a Bézier Curve

You can Display or Hide Bézier curves using the toolbar toggle
button. Bézier curves are visible by default.

A single click selects the curve. When the curve is selected, the various points
and tangents along the curve are displayed.

Right-click on a curve to open the curve's context menu. From this menu you
can:

Icon Function Description

Insert point Insert a point on the curve at the location you right-
clicked.

Delete the curve

Close path /Open
path

Modify the path's shape by deciding to Close path or
Open path.

Place start here Set the start point for animations along this curve.

Reverse path
direction Reverse the direction of animations on this curve.
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A point can also be added to the curve by Alt+clicking on the place on the
curve where you wish to add a new vertex. An existing point can be deleted by

right-clicking on it and choosing Delete point from the context menu.

33-4.2 Bézier Curve Position and Orientation

The position and orientation of the curve, as well as those of its points and
tangents, can be modified using the translation and rotation gizmos.

l Use the translation or rotation gizmos to manipulate the entire curve
if no specific point or tangent is selected.

l When a point is selected, the translation gizmo moves the point in
the 3D space; the rotation gizmo changes the orientation of its
tangent.

l When a tangent's endpoint is selected, the translation gizmo moves
the endpoint in the 3D space; the rotation gizmo has no effect.

By holding down the Ctrl key of the keyboard you can move the
direction point (end of the tangent) regardless of the other direction
point.

By holding down the Ctrl key of the keyboard, the anchor point of the tangent is
shifted bymoving the direction point.

Multiple points on a single curve can be selected and repositioned at the same
time. However, only one curve or only one tangent endpoint may be selected and
repositioned at a time.
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33-5 Live Mode

Livemode is an interaction mode in which you have access both to the
navigation modes that allow you to explore your product and its animations
and configurations. Animations and configurations can be activated by using
triggers, that is, a keystroke or click on a predefined surface.

To make an animation available in Live mode, assign it a trigger in the Live
mode editor, then switch to Livemode.

When Livemode is active, the menus and buttons in the interface are no longer
available.

l To leave Livemode, press the Esc key.
l Navigate within your scene using the navigation shortcuts.
l Play animations by using the triggers you have defined.

A trigger can be used multiple times while the animation is playing. The
playback behavior will depend on the trigger's play mode.

Triggers can also be created to cycle through configuration values when a
trigger surface is clicked. To create configuration triggers, use the Tag
Manager in Shaper.

Livemode can be viewed in full screen. To do so, switch the active viewport to
full screen (keyboard shortcut: Y) before switching to Livemode from the
editor.

33-6 Animating Channels with Advanced Con-
figuration

The advancedmode in the Channels (Editor) (page 128) can be used for
precise control over one or more channels of animation.

Creating an animation curve using the advanced mode follows these main
steps:

1. To the left of the graph, select the curve you wish to edit.
2. Place the time cursor at the time position where you would like to

make a change by adding a new key frame.
3. In the active viewport or in the editors associated with the selected

channels, make the changes you would like to see at this point in
time.
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4. Click on Capture current values. This will add a key point in
each selected channel, using the values set in the editors and the
active view. The new key points are aligned with the time cursor.

You can also add new key frames by hand: enable theNew key

frame mode and click on curves on the graph where you
would like to place new key frames. Once a key frame has been

added, enable one of the repositioning modes ( , , or

) to reposition your key frames interactively by dragging the
point with the mouse. If one of these modes is already enabled, you
can place a key frame without changing modes by using the
function Alt+click.

5. By default, the curve drawn between two points has a curve form 

. In this case, the change in the channel value in this interval of
time does not occur at a constant speed. The speed of change of this
value on either side of the key point is represented by the angle of
tangents to the curve to the left and to the right of the key point. To
modify the speed of change, you will need to reposition the
tangents. To do so, set the mouse to one of the repositioning modes

( , , or ) and click on any key frame to show its left
and right tangents.

6. By default, the tangents are horizontal. Clicking and dragging a
tangent's end-point modifies the tangent used to calculate the curve.
The tangents to the left and to the right of the key frame are
modified independently of one another.

7. To modify the type of progression used between two key frames,

open Key Frames . Clicking on the option shown next to Left
or Right allows you to modify the progression mode for the curves
to the left and to the right of the point, respectively. This opens a list
of choices:

l Select Linear to impose a constant (linear) change
from the initial value to the final value over the time
available between the two points. This appears as a
straight line on the curve.
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l Select Step to impose an instantaneous change of
value at the key frame's time. This appears as a step
(horizontal and vertical lines) on the curve.

l Leave the Curve form to add ease to the animation
slope. Tangents are available at each key frame that has
been set to Curve. Use them to adjust the shape of the
curve.
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34 CLIPPING PLANES

34-1 Definition

Clipping planes can cut through a model to reveal cross-sections, internal
structures, or other details that are usually hidden by outer pieces.

Three customizable clipping planes are available. They can be placed and
modified manually, or automated during an animation using a channel
animation.

You may be interested in the following topics:

l Clipping Planes (Editor) (page 134)
l Channels (Editor) (page 128)

34-2 Animating Clipping Planes

Three types of animation channels exist for clipping planes. These allow you to:

l Enable/Disable the clipping plane
l Position the clipping plane along the X, Y and Z axes
l Orient the normals for the X, Y and Z axes

It is strongly recommended that you use all three position or all three normal
channels together in the same clip when animating clipping planes.
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35 REAL-TIME SUN

35-1 Definition

In contrast to the lighting defined in Shaper, the real-time sun available in
Matter provides light that is calculated on a product in real time. The real-time
sun provides light similar to that projected by a sun type light source. The
source is not visible. Its beams are infinite and parallel to one another. The
source can be positioned in terms that are used to describe the real sun: angle
above the horizon, position on a compass, etc.

Data related to the real-time sun is included in databases exported in KDR
format.

The real-time sun can be animated using a channel animation.

You may be interested in the following topics:

l Lighting (page 317)
l Real-Time Sun (Editor) (page 182)
l Channels (Editor) (page 128)
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36 IRAY

This feature requires a specific license option and may not be available in
your software version.

Patchwork 3D Design includes Iray, a physically realistic raytracing engine
designed to work with Nvidia graphics cards. Iray provides an interactive
rendering with progressive refinement, which approximates the physically
realistic behavior of light and its interaction with materials. Among other
advantages, this allows for the use of effects such as global illumination.

In Patchwork 3D Design, modifications to Iray-specific settings are saved in the
database. If an Iray database is later opened by an equivalent version of
Patchwork 3D Design that does not include the Iray module, the Iray settings
will be ignored, but will be preserved.

36-1 Conversion of a Patchwork 3D Design scene for
Iray

The various elements in a Patchwork 3D Design are converted for rendering
with Iray, with certain limitations. The following elements are not converted, or
are only partially converted:

l Environment type materials
l Labels in Add andMultiply modes
l Video textures: supported in video snapshots only
l Overlays
l Post-processing produced by Patchwork 3D Design
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36-2 Rendering with Iray

To start a render using Iray, enable Iray rendering with the button.
Rendering will begin in the active viewport.

To increase interactivity, you may choose to keep the Patchwork 3D Design
rendering in the active viewport and to send the Iray rendering to a remote
window. To do so:

1. Open the Iray settings editor

2. Enable the rendering in a remote window with the button

3. If the remote window is hidden, show it by clicking on the
button

During refinement, the number of passes and the current rendering time are
displayed at the top of the Iray settings editor and at the top of the remote Iray
rendering window, if the remote window is enabled.

A message is also displayed in the Patchwork 3D Design status bar when
refinement has finished.

36-3 Activation and viewing controls

In theMatter interface:

Icon Function

Enable Iray rendering

Pause refinement

Show the Iray settings editor
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In the Iray settings editor:

Icon Function

Enable Iray rendering in a remote window

Show / hide the remote rendering window

Synchronize the aspect ratio of the remote rendering window with that of the
active viewport

Show the remote rendering window in full screen. To quit the full screen mode,
press the Esc key

Show the rendering log

Access connections to remote rendering servers

36-4 Scene

36-4.1 Iray Rendering Modes

Iray Photoreal: This is the photo- and physically realistic mode in Iray, which
uses complex global illumination effects. This mode offers a maximum quality
but takes longer to calculate the refinement of the image.

Iray Interactive: This raytracing mode uses progressive rendering that allows
you to take advantage of the effects of a raytracer without giving up interaction
and editing capabilities. This mode does not provide physically realistic
rendering.

Blend: Render convergence begins in Interactive mode and then switches to
Photoreal mode after a certain level of refinement is achieved. In high-
interactivity situations, this mode allows for more fluid interaction while still
aiming for increased realism once the interaction has ended. Because both
rendering modes are used, this mode consumes more memory resources
during the conversion of the scene.
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36-4.2 Refinement stop criteria

Multiple criteria are available to define the end of the refinement phase. The
rendering will stop as soon as the first limit is reached.

Max samples per pixel: the higher the limit, the better the quality and the
longer the rendering time

Max quality: expressed as the rate of convergence per pixel, from 0 to 1,
where 1 represents an infinite convergence

Max time: maximum duration of the calculation in hours, minutes and seconds
before stopping the refinement

Max path length: in number of bounces

36-4.3 Render Settings

The optimization settings favor certain phenomenons or characteristics that are
physically present in the scene in order to make the final convergence for these
elements visible earlier during the rendering.

Caustic sampler: uses a sampling strategy to favor the calculation of caustics

Architecture sampler: allows earlier appearance of the light in interior spaces

36-4.4 Ground

The ground, when enabled, simulates an infinite plane, covered in the
equivalent of a matte material. In background mode, it includes the reflections
of and influence of the product's environment.

Altitude: height of the ground along the Y axis

Shadow intensity

Scale: adjusts the scale of the environment

Glossiness: glossiness of the ground

Reflectivity: reflection color for the ground
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36-4.5 Filtering Settings

Filters reduce certain artifacts associated with the non-convergence of pixels.
Filters can impose an additional calculation load, which can taken up, in part, by
the CPU.

Fireflies: filters bright points

Degrain filtering: produces a smoothing of the rendering. Five modes are
available:

l Pixel clipping
l Smart median
l Smart average
l Limited blur
l Limited auto blur

In ascending order, the Pixel clipping produces a soft smoothing while the
Limited auto blur produces a strong smoothing.

36-4.6 Denoise filtering

The Patchwork 3D rendering engine supports NVIDIA Iray's new intelligent
noise reduction algorithms.
During the progressive refinement it is now possible to obtain a rendering
without noise from a threshold defined in advance.

From the user-defined threshold of theMinimum iterations, intelligent noise
reduction algorithms perform a process to make the image look sharper.

l The higher the threshold, the more intelligent noise reduction occurs
late in rendering.

l The lower the threshold, the more intelligent noise reduction occurs
early in rendering.

36-5 ToneMapping

Tone mapping is disabled by default in order to insure a continuity in the
colorimetrics and the rendering between the real-time OpenGL engine in
Patchwork 3D Design and the Iray raytracer.
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Exposure: compensation for the exposure of light in the scene

Burn highlights

Crush shadows

Saturation

White balance: can be set via a choice of standard values, a personalized
Kelvin value, or with the color chooser

Photographic tone mapping: replaces the exposure value with photographic
exposure settings. These settings include the Cm2 factor, the sensor sensitivity
ISO, the F-number of the aperture, and the shutter speed.

The reset button restores the default tone mapping settings.

36-6 Camera effects

These camera effects are specific to Iray and are fully independent with respect
to their equivalents in Patchwork 3D Design.

Bloom: when enabled, the radius, threshold, and brightness scale can be set

Vignetting: provide a value and press Enter. Increasing the value increases the
effect.

Vignetting is only available when Tone Mapping is enabled.

Depth of field, for which the setting are available in the camera editor, is also
taken into account.

36-7 Materials

36-7.1 Surfaces as light sources

It is possible to use a surface as a light source by selecting a material to be used
as a source and assigning that material to the surface.
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All of the standard and multi-layer materials in theMattermaterial library can
be selected as light sources. This selection is made from the Iray settings editor.

Materials are selected simultaneously in the Iray settings editor and in the
Matter library; you can therefore select the material in whichever interface is
more convenient.

The renders of materials used as light sources can be noticeably different
between Patchwork 3D Design and Iray.

MULTI-LAYERMATERIALS: Iray does not support infinite layers. Materials
conflicting with the Iray limit will appear in orange in the list, and a
warning is printed in the log. During rendering, Iray will automatically
simplify the conflicting material.

36-7.1.1 Override Patchwork 3D Designmaterial

Certain material settings can be overridden by Iray-specific settings. The
available settings vary with the type of material.

In the Iray settings editor, select a material in order to enable the settings
override.

l Any Patchwork 3D Design material can be used by Iray as a matte
material.

l Iray accepts AXF files to override materials. AXF is a file format that
encodes digital material representations, including those of
materials measured using X-Rite material scanning technologies. In
Patchwork 3D Design, Iray will support version 1.5.1 of AXF files.

36-8 Lighting

All active lights in Shaper have an effect on the Iray rendering. You can
override certain settings of these lights.

In the Iray settings editor, select a light to enable the setting override. When a
light source uses Iray's settings instead of Patchwork 3D Design's, a check mark
appears in the Iray settings editor next to the name of the light.

You can override:
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l The intensity
l The use of intensity as radiant exitance

For spot type lights, it is also possible to modify the exponent.

For area lights in the form of rectangles and cylinders, the option use as portal
light is available. A portal designates a zone, defined in this case by the surface,
that allows exterior light to reach and enclosed area. This option produces an
effect only when the caustic sampler optimization is enabled.

36-9 Snapshot layers

The Iray engine is available for image, video, VR object and VR panorama
snapshots. In the corresponding Snapshot editor, select Iray as the render
engine.

When the snapshot will be saved in a format that supports layers (PSD), Iray
can split the image into different layers.

Render direct and indirect contribution separately: renders separate
layers for the direct illumination (light sources) and indirect illumination (global
illumination).

Available layers:

l Diffuse layer
l Specular layer
l Glossy layer
l Emission layer
l Alpha layer
l Depth layer
l Normal layer

The calculation of layers does not include transmission.

36-10 Sun and Sky

The Patchwork 3D Design real-time sun cannot be used at the same time
as the Iray sun and sky. If both lights are enabled simultaneously, only the
sun and sky in Iray will be used.
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Iray offers a simulation of the light of the sun and the sky.

When the Sun and sky option is enabled, a sun type illumination is added, an
infinite plane is used as the ground, and an environment representing the sky is
displayed.

TheMultiplication value adjusts the environment's luminosity.

The sun settings include:

l The solar disk intensity
l The solar disk scale
l The glow intensity
l The sun's position, which can be set in the Position of the Real-
time sun editor

The sky settings include:

l The night color
l The haze level
l The red- or blueshift. Positive values will produce a redshift, while
negative values produce a blueshift.

The ground settings include:

l The ground color
l The horizon height
l The horizon blur

36-11 Choice of graphics card

This information is specific to each session and each machine. Changes to
settings in this section are saved on your machine but are not saved in the
model database.

Iray can use multiple graphics cards at a time.

All cards available on the machine being used are listed.

Iray can also use CPU threads. This option is disabled by default to prevent Iray
from monopolizing the computer's processing power. This is an option
provided by Iray that was designed to be used only on a machine used as a
rendering server.
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36-12 Hardware

This information is specific to each session and each machine. Changes to
settings in this section are saved on your machine but are not saved in the
model database.

You can use a machine on your network or an Nvidia VCA to process rendering
remotely.

Set up a remote rendering server by clicking on the button in the Iray
settings editor.

A check mark indicates an active connection.

Remember to disconnect at the end of a session: in certain cases, including the
use of VCAs, other users cannot access the remote service while you are
connected.

If a connection is underway when Patchwork 3D Design is closed, the
connection will be automatically disconnected.

See the following sections to configure each type of server.

36-12.1 Iray server

The software Nvidia Iray Server is available from Nvidia.

The Iray server is any machine on your network on which the software Nvidia
Iray Server is installed. You will need the IP address and the connection port for
the server. You will also be asked to provide the ID and password.

A button is added to the snapshot editors: Add to queue. This sends a deferred
render request to the Iray server. You will then need to manually run the
rendering of the queue on the server. This can be done after the Patchwork
3D Design session has been closed and does not require either Patchwork
3D Design or access to the original computer that requested the render.
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It is not possible to encode a video from the Iray server render queue. When a
render request for a video is made, each frame will be rendered separately and
the output will be made available as an archive file containing all frames.

The preparation for sending a of a video render request to the server may take a
few moments. The Rendering window will open while the timeline is evaluated
and each video frame is prepared.

For more information about Iray Server, see details in Iray documentation that
came with the purchase of this product.

36-12.2 VCA

A VCA is a calculation device for network use for graphic purposes, notably for
use with Iray. VCAs offer a multiplication of the strength of Nvidia GPUs. You
must have access to a VCA. An ID and password will be requested.
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37 ANTIALIASING

37-1 Real-Time Antialiasing

Patchwork 3D Design includes an antialiasing function for real-time rendering.

Real-time antialiasing can be set up under the Rendering tab in the Settings
and in the Render Presets available from the context menu of the 3D viewport.

The effect of the antialiasing is particularly effective in the case of sharp borders
and strong contrast between the start and end colors of gradients.

When the point of view changes, artifacts due to high intensities may occur in
specular reflections. These artifacts consist in white dots due to highly-localized
reflections. Consequently, filtering is deactivated by default during and at the
end of interactive phases.

However, as the software antialiasing eliminates the artifacts efficiently and the
filtering removes a light blur from the specular reflections, the anisotropic
filtering is automatically enabled when the software antialiasing kicks in.

The anisotropic filtering may be set separately for interactive rendering phases,
for the end of these phases, and for idle phases. To do so, activate a custom
preset in the Render Quality Settings of the Render Presets submenu of the
viewport context menu. Use the Specular anisotropic filtering slider to set the
level of filtering.
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38 ENHANCED TRANSPARENCY

38-1 Definition

Enhanced transparency provides improved rendering for transparent surfaces.
Rather than using surfaces' bounding boxes to determine their distance from
the viewpoint, enhanced transparency utilizes pixel-by-pixel analysis to
determine the order in which the surfaces must be rendered.

Using enhanced transparency increases the consumption of GPU memory and
reduces the number of images per second. This option is disabled by default.

The option Enhanced transparency is not compatible with the use of
transparent mirrors. When enhanced transparency is enabled, transparent mirrors
are treated as simple transparent surfaces.

38-2 Enabling Enhanced Transparency

Use the button in theMatter toolbar to enable or disable enhanced
transparency.

38-3 Standard versus Enhanced Transparency

This technique for calculating transparency can be costly. In order to improve
the rendering of transparency without resorting to enhanced transparency,
avoid grouping transparent surfaces together in Shaper. A group is treated as a
single surface, which can prevent Patchwork 3D Design from correctly
analyzing which geometric elements should be visible through a transparent
surface.
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Standard Transparency Enhanced Transparency

Affected
materials

l Standard
materials with
alpha,

l Standard
materials of the
transparent
filter class,

l Multi-layer
materials with
no diffuse layer,

l Mirror materials
with
transparency.

l Standard materials
with alpha,

l Standard materials of
the transparent filter
class,

l Multi-layer materials
with no diffuse layer,

l Mirror materials with
transparency (treated
as standard materials
of the transparent
filter class).

Calculation
method

Handled surface-by-surface,
using the position of the
bounding box to determine
the order of surfaces from a
given point of view.

Handled pixel-by-pixel, analyzing all
of the surfaces present at each
pixel from a given point of view.

Advantages Renders quickly and is suited
to most uses of transparency.

Prevents situations where the
position of the bounding box is not
enough to determine the order of
surfaces from the point of view.
This can occur with complex
transparent surfaces, intersecting
transparent surfaces, transparent
surfaces that surround other
surfaces...

Intersecting transparent surfaces rendered with standard transparency (left) and
enhanced transparency (right).
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39 RAYTRACING

39-1 Raytracing Engine: General Principles

The raytracing engine is directly accessible from Patchwork 3D Design, which
makes it particularly easy to use. Each rendered view can be saved in the
database, making further operations like applying a post-process easier.

The raytracing engine uses the Patchwork 3D Design materials from the
current product. The render of the materials with the raytracing engine remains
true to the one calculated with the Patchwork 3D Design OpenGL rendering
engine. Product views are prepared with the tools available in the Patchwork
3D Design Matter interface. The default environment can be replaced by any
environment.

Multicore architectures are supported and recommended. A minimum of 16 GB
of memory is required and 24 GB are suggested for heavy scenes.

39-2 Raytracing a View

39-2.1 Raytracing Part or All of the Active View

Raytrace rendering may be costly in calculation time. Therefore, the raytracing
engine gives you the ability to render either a part or all of the active view.

To render the entire active view, use the function Raytrace active viewport

. This function is available in the Visualization toolbar located in the
upper part of Patchwork 3D Design user interface.

To render a part of the active view, use Select raytracing area in the
Visualization toolbar and draw the rectangular region you want rendered in
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the active view. As long as this mode is active, raytracing rendering is limited to
this defined region. The rest of the view is rendered with the OpenGL rendering
engine.

Raytracing rendering limited to a region of the view.

For additional information, see:

l Raytracing Settings (Editor) (page 179)

39-2.2 Creating Snapshots Using the Raytracing Engine

The following types of snapshots may be created using the raytracing engine:

l Image snapshots,
l Video snapshots,
l Cubic VR panorama snapshots,
l VR object snapshots.
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When you create a snapshot, select the proper engine in the Rendering engine
box of the snapshot editor. Rendering is started by clicking the Render button
at the bottom of the editor. Alternatively, it can be postponed for later with the
Snapshot Batcher. In that case, use the Add to Snapshot Batcher button to
save the view and its associated parameters to the Snapshot Batcher. You can
also replace the current snapshot in the Snapshot Batcher with the new view
and its associated parameters by clicking on the Replace Current Snapshot
Batcher Item button.

For more information, see:

l Snapshots (Editors) (page 199)
l Snapshot Batcher (page 195)

39-2.3 Creating Snapshot Using Remote Raytracing Engine

Patchwork 3D Design allows you to configure and use remote CPU from units
(cluster) to generate a snapshot with raytracing rendering engine.

39-2.3.1 Raytracing cluster unit 2019.1 X3 release 1 step by step setup
guide

Raytracing cluster unit 2019.1 X3 release 1 installer

1. Install Patchwork 3D Design Raytracing cluster unit 2019.1 X3
release 1 application on each remote unit (PC).
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2. Click Next when Raytracing cluster unit application pop-up.
3. Check to accept the license agreements.
4. Click on Next.
5. In the next window you can choose to install the application in a

different location.
6. Click on Install.
7. Click on Finish.
8. Start the application by double clicking on the shortcut desktop icon.
9. Accept Windows Firewall warning by clicking on Allow access

button.
10. The software will open a port to communicate with remote units.

11. Start Patchwork 3D Design on main PC and load a p3d database.

If you restart Windows on one of rendering unit calculating remote raytracing, you
have to relaunch Raytracing cluster unit application. You can add it to Windows
startup programs.

l For Windows 8 & 10 users: Copy-paste the Raytracing cluster unit
shortcut located on Windows desktop in this following folder:
C:\ProgramData\Microsoft\Windows\Start
Menu\Programs\Startup

l For Windows 7 users: Drag and drop the application into the following
location Start > All Programs > Startup.

39-2.3.2 Cluster configuration in Patchwork 3D Design

1. On the main PC, in the Editor toolbar (at the bottom left) of
Patchwork 3D Design, click on this icon
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to configure the raytracing.
2. Click on the Remote tab
3. Check Use remote raytracing

4. Click on the button to add unit using its IP address (use
copy/paste to set IP address faster).

5. Click on OK to add the unit.

You can also use this icon to import a list of units using a text file.

Syntax is :

192.168.10.134

192.168.10.134

192.168.10.134

//192.168.10.12 ignore this IP address.

Use the basket icon to remove unit from the cluster.

39-2.3.3 Creating Snapshot

In the Snapshotmenu, select Snapshot image, in the Rendering Engine
select the Raytracing radio button as rendering engine.

Patchwork informs the user once the image is calculated. It takes times first to
upload the data to all the render units. Progress bar shows how the cluster is
working.

For more information, see Raytracing Settings (Editor) (page 179)
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40 RENDERING SNAPSHOTS, VIDEOS,
AND 3D ENVIRONMENTS

40-1 Snapshot Menu

The Snapshotmenu provides access to the functions that allow you to export
the rendering in the active viewport as media content: videos, images, or 3D
virtual reality objects or panoramas. It contains the following menu items:

Icon Tool Description

Snapshot
Image

Opens the Snapshot Images editor to access the settings and
render a view of a product that will be saved as an image file. See:
Snapshots (Editors) (page 199).

Snapshot
Video

Opens the Videos editor. This editor generates animations or
sequences of images based on an initial point of view and a
predefined animation. See: Snapshots (Editors) (page 199).

Snapshot
Panorama

Opens the Panoramas editor to modify the settings and generate a
panoramic 360-degree video. See: Snapshots (Editors) (page 199).

Snapshot
VR Object

Opens the VR Objects editor to modify the settings and generate a
VR object. See: Snapshots (Editors) (page 199).

Snapshot
Cubic VR
Panorama

Opens the Cubic VR Panoramas editor to modify the settings and
generate a cubic VR panorama. See: Snapshots (Editors) (page 199).

Quick
Snapshot

Creates snapshot of the current active viewport. The snapshot is
generated by the editor that was most recently used, and the
settings of the last snapshot rendered are applied. If no snapshot
has been created before, the Snapshot Images editor and its default
settings are used.

Show Info
Enables or disables the Show Info option in any of the snapshot
editors. This option displays, along the bottom of the active
viewport, a summary of the snapshot dimension settings.

Snapshot
Batcher

Opens the Snapshot Batcher. Use this tool to group snapshots and
render them as a batch at the time of your choosing. See: Snapshot
Batcher (page 195).
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41 PRINTING

Patchwork 3D Design's printing functionality is used to print the image
displayed in aMatter viewport on paper or to a digital file. It is available only if
a default printer is defined on the computer.

41-1 General Print Window

Available in:Matter: File >  Print (Ctrl+P)

The general print window is for selecting the printer to use and adding new
printers, as well as defining the Settings for the printer and the pages to print.

The Print in a file function is for saving the image in a file in the *.pdf format.
When printing as a PDF a new window will automatically open.
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41-2 Printing to a File

Print in a file window.

The Configure Printers button recalls the general print window.

When Print file information is enabled, the file information in the box is
added under images in the *.pdf file generated.

The image position on the page is selected by using options Center, Top Left
and Custom, for which the margins’ width is entered in the fields.

The Dimensions box contains the image dimension options:

l Fit Page,
l Specification of imageWidth andHeight in the fields and unit
selection. The images printed from theMatter viewport are
considered vector images and will be rendered with the ideal
resolution for the required printing dimensions. The renders with
raytracing are fixed and will be resized for printing.
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42 INDEX

A

Alpha Background

applying to
snapshots 200, 202

Animated Meshes 108, 239,
262

creating 263

reproducing original
animation 131

Animation 487

changing curve mode
(advanced) 133, 499

channels 131

standard 130

parenting parts 310

parts 487

Animation objects
(Shaper) 487-488

Animation Sliders
(Editor) 108, 309, 488

Anisotropic Filtering 200,
517

Antialiasing 64, 78, 517

applying to
snapshots 200

Application Shortcuts 67

Aspect Layers 445, 472

saving visibility sets 112

viewing assignments per
surface 445

Aspect Layers (Editor)

use in configuration 454,
463

Auto-Orientation 281

Auto-Partitioning 472, 474

B

Backface Culling 77, 134,
178, 223, 225

Background

color in snapshots 205

Background Library 400

Backgrounds 113, 399

applying to sensors 194

using textures as
materials 370

Backgrounds (Editor) 113,
400-401

Bézier Curves 495

add/remove points 496

open/close 496

show/hide 496
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Bézier Path 119

Bookmark Animations 117

example of use 121

Boolean

configuration rules 452

Bump 366

C

Camera Animations
(Editor) 116

Cameras 479

favorite cameras 484

landscape/portrait
orientation 125

lens properties 125

photo/CG tabs 125

position bookmark
shortcuts 347

properties 124

Cameras (Editor) 123, 480

Clipping Planes (Editor) 134

Collisions 92

Color Books (Adobe) 60, 140

Color Chooser 137

Color Management 64, 66,
145

Color Palettes 139

Complex Rules (Editor) 461

Compression 202

Configuration Browser 142,
447, 452

Configuration Keys
(Editor) 144

Configurations 447

complex rules 448, 461

creating rules 141

example of rule
creation 465

layers 451

linking in viewports 98

partition 447, 449

rule (definition) 448, 452

rule syntax 463

simple rules 448, 454

symbol 447

symbol (types) 452

Configurations (Editor) 141-
143, 454, 461

Context Menus 53

viewports 78, 95

Cross Sections See Clipping
Planes (Editor)

Cubic VR Panoramas
(Snapshot Editor) 215

D

Database Properties 145

Denoise filtering 509

Depth (of a material) 366,
375
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Depth of Field 126

Depth Range 127

Distributed Lightmap
Rendering 337

configuration
window 339

interrupting 342, 344

setting the port 63

Dressing Tab (Shaper) 298

E

Editors 53, 103

Enhanced Transparency 519

Environment Layers 173

example of use 441

Environment Library 254-
255, 384, 391

Environment Properties
(Editor) 146, 254, 387,
392

Environments 253, 383

local environments 386,
390

orientation 177

positionning 384

real-time sun 177

removing from
product 348

setting brightest
point 178

Explorer (Matter) 60, 92, 102

Export

CAD models 259

Matter products 272

P3Dxml 260

settings 60

F

FBX

import 260

kinematic hierarchy 266

File Origins 146

Fly Mode 92, 95

Fresnel Effect 364

Full Screen Mode 97

G

Geometry Layers 429

list (Shaper sidebar) 429,
454, 463

visibility 162

GPU

purging unused
resources 102

Gradients (Editor) 156, 158

csv import 158

H

Hardware Configuration

architecture type 35

minimum
requirements 35
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recommended
requirements 35

HDR Environment 253, 383

HDR Light Studio 253

Head Mode 95

High Quality Filtering 147

I

Import

CAD models 257

FBX 260

NX 271

P3Dxml 260

settings 62

SolidWorks 271

Wire 267

Information Bar 52

Interaction Modes 45

Matter 94

Shaper 75

Interface 47, 61, 73, 91

Isometric projection 194

K

Kam Files 116, 482

generating bookmarks
from 482

loading 116, 482

Keyboard Shortcuts 67

Kinematic Tab (Shaper) 307,

487

L

Labels 378

positioning 382

Lancer de rayons See
also Raytracing

Layer Visibility (Editor) 161

Layer Visibility Bookmarks
(Editor) 162

Light Sources 322

Area Lights 332

attenuation 325

color 324

IGS Profiles 325

intensity 325

Omni 331

positioning 326

Sky 329

Spot 329

Sun 331

Lighting 317

settings 63

types of rendering 318

Lighting Layers 435

list (Shaper sidebar) 454,
463

Lighting Tab (Shaper) 337
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Lightmaps 318

selecting surfaces 320

Live Mode 498

LRU 337

M

Mapping 297

complex surfaces 216,
241

list of operators 299

Material Library 352

Materials 166

assignation 380

assignation (as
labels) 382

Environment
material 369

using background
texture
instead 370

Labels 378

Matte material 371

Mirror material 371, 519

Multilayer material 372

positionning 382

positionning on
surfaces 226

preparing surfaces
(Shaper) 297

Seam material 377

Standard material 354

transparency 359-360

Materials (Editor) 156, 158,
166, 353, 372

Matter Resources

listing 101

loading 101

purging unused 101

Maya

import 264

Measurement Units 67

Measuring Tool (Editor) 167

Menus 48, 527

Models 275

Motion Blur 127

N

New Features 54, 290, 352,
362, 373

list 33

Normals 287

Nulls 307, 487, 489

definition 489

NX

import 271

O

OpenGL Settings 64, 200

Overlay Library 404

Overlays 403

applying to sensors 194



p.536 Lumiscaphe Patchwork 3D Design 2019.1 X3

enable/disable
display 403

example 406

Overlays (Editor) 168, 405

P

P3Dxml 260

Panoramas (Snapshot
Editor) 209

Parameters (Editor) 456, 458

Patchwork Lightmap Render

installation 337

unit status (listening) 340

unit status
(rendering) 341

Pivot Tab (Shaper) 295

Pivots 295

light sources 327

positionning multiple
surfaces 89

positionning pivot-surface
couples 87

Point of View 127

Position Layers 433

Position Layers (Editor) 169

use in configurations 454,
463

Post-processing (Editor) 421

Post-Processing (Editor) 170

Post-Processing Effects 411

advanced settings 172

applying to sensors 194

list 411

Post-Processing Library 421

Primitives 292

Printing 529

Product Environments
(Editor) 173

use in configuration 454,
463

Product Library 347

Product O (Editor)

use in configuration 454,
456, 461, 463

Product Properties 178

Products 347

general properties 348

removing
environment 348

PSD images 202, 204

R

Raytracing 521

instructions 521

settings 65

Raytracing Settings 201

Raytracing Settings
(Editor) 179

Real-Time Sun 182

global settings 63

raytracing 186
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use with
environments 177

using with Shaper
lighting 183

Real-Time Sun (Editor) 182

Recent Databases List 60

Reflections 371

applying to
snapshots 200

Relief 366, 375

Rendered Views History 189

Replace String 112, 473

Rotation Axis 307, 487, 489

Rotation Gizmo 45, 82, 286

Roughness map 363

S

Save and Clean 54

Saving

as pdf 529

Selections (Editor) 191

Sensor Library 424

Sensors 423

assigning to cameras 125

default values 423

definition 479

use of 426

Sensors (Editor) 193, 424

Settings (application-
wide) 59, 517

Settings (Editor) 59

Shadows 326

with real-time sun 184

Sidebar 52

Matter 91, 347

Simple Rules (Editor) 454

Snapshot

Quick snapshot 527

Snapshot Batcher 195, 205,
523

Snapshot Image (Snapshot
Editor) 205

Snapshots 198, 527

3D environments 214-
215

images 205

multilayered images
(psd) 202

example of use 204

raytracing 522

SolidWorks

import 271

SpaceMouse 60

Start Screen 54

Statistics

Matter viewport
rendering 97

Stitch 280

Surface Carving
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